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Inteffectal Propery Moffces

@ 2008 Palm, Inc. All rights reserved. Trade mark, copvright, patart, and other intellectual property notices are set
forth on page i within the Basics Guida

Dizcfaimer and Limitation of Habifify

Palm, Inc. and its suppliers assume no responsibility for any darrage or loss resulting from the use of this guide.
Palm, Inc. and its suppliers assume no responsibility for any loss or claims by third parties that may arise thiough
the use of this software. Palm, Ing. and its suppliers assume no responsibility for any damage or loss caused by

deletion of data as a result of malfunction, dead battery, or repairs. Be sure to make backup copies of all imporant
data on other media to protect against data loss.

Palm Take Back and Recveding Proaram

This symbol indicate s that Palm products should be recvcled and not be disposed of in unsorted
muricipal waste. Palm products should be sent to a facility that properby recycles electrical and
electronic equipment. For information on envirenmental programs visit palim com@rminnmant

As part of Palm's corporate commitment to be a good steward of the ervironmeant, we strive to use
ervironmentally friendly materials, reduce waste, and dewelop the highest standards in electronics
tacycling. Our recweling program keaps Palm handheld device s, smart devices, and mobile
cormpanions out of landfills through evaluation and disposition for rruse and recucling.

Palm custormers may participate in the reovcling program free of charge. Visit palm.comyrecydle or inthe U.S. call
877-069-7256 for additioral details and information about how vou can help reduce electronic waste.

EndUser Motice
Microsoft® Vioice Command Yearsion 1.6 for Windows Mobile®

AP RTANT: Do not baecorme digtracted from driving safely if operating a motor vehicle while using Device
Software.

Opearating certain parts of this Device requires user atlention. Diverting atte ntion away from the road while driving
can possibly cause anaccide nt or other sarious conseguences. Been cocasional, shor diversions of attention can
be dangerous if wour atiertion is diverted away from vour driving task at a critical time. Do not change system
settings or entar data norrverbally (using vour hands) while driving. Stop the vehicle ina safe and legal manner
before atternpting these operations. This is important since while setting up or charging some functions vou
rright be required to distract vour afte rtion aweay from the road and remove vour hands from the wheel.

Microsoft rmake s ne epe sentations, warranties or othar determinations that ANY use of the Sottware Product is
legal, sate, o inany manner recommendad or intendad while driving or otharwise oparating a motor wehicle.
General Operation

Voica Command Control: Many of the functions of the Device Software can be accomplished using only voice
cormmands. Using voice commands while driving allows vou to initiate the command with a button and then
oparate the Device mosthy without removing vour hands from the wheel.



Profonged Views of Screan: [f vou are driving, do not access any function requiring a prolonged view of the
sorean, Pull over ina safe and legal manner before attermpting to acce ss a function of the systern requiring
prolonged attertion. Bven occasional short scans to the screen may be hazardous if vour attention has baan
diverted away from yvour driving task at a critical time.

Volurma Saffing: Do not raise the volume exce ssively. Keap the volume at a level whare vou can gill hear outside
traffic and ermergency signals while driving. Driving while unable to hear thess sounds could cause an accidant.

Lafvour fudgmant Praval: The Device Software is only an aid. Make vour driving decisions based onvour
ohservations of local conditions and existing traffic reaulations. The Device Software is not a substitute for vour
parsoral judgrment.

Usaof Speach Recognition Funciions: Speech recognition sofwars is inherantly a statistical process which is
subjact o errors. It is vour responsibility to monitor the speach recognition functions and addre ss any arrors.
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Welcome to Sprint

Sprint and Nextef have come fogether, offering you more choloe and flexibifity to do whalever
you want whenever you want

This powerful combination brings you access to more products, more services, and more of
what you need to do more of what you want.

Weicome and thank you for choosing Sprint
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How to Use This Guide

14

We know you're eager to start using your Palm® Treo™ 800w smart device right away, and the
sections of this guide are designed to help you do just that

Section 1: Your Setup guides you through the process of setting up your new Treo, your
Sprint service, and your computer.

Saction 2: Your Palm® Trec™ 800w Smart Device shows you the basics of your Treo and
senvice with quick, easy-to-follow instructions, This section also describes the phone
featuras on your device and shows you how to use Sprint service features such as
voicemail and call waiting.

Saction 3: Your Sprint Power Vision™ and Cther Wireless Connactions shows you how to
Use Web browsing, messaging, and email. It also describes cther types of wireless
connactions, such as Wi-Fi and Bluetooth® wireless tachnol ogy.

Section 4 Your Portable Media Device shows you how 1o use the camera feature on your
Treo and how to transfer and listen to music files on your deavice.

Section 5. Your Wireless Crganizer guides you through the process of using the built-in,
full-featured organizer that gives you instant access to your Contacts, Calendar, Tasks,
Memos, Calculator, and more.

Section 6: Your Information and Settings describes the tools for managing files and
applications and the preferencas that enable you to customize your Treo.

Section ¥: Your Resources answers frequently asked questions and shows you what to do
if something goes wrong. It also includes a helpful glossary of terms.

Section 8: Your Safety and Specifications outlines recommended safety and maintenance
guidelines and lists the technical specifications for yvour Treo.

Please refer to Imporiznt Safely Information” on page 343 o leam about
informafion faf will halp vou safely usa your phona Failtine fo read and
foftow the Importaint Safaly Information it this phone guida may rasulfin
SErous Bodily iniury, death, or property damage




Where fo Learn More

For a Quick Introduction

Quick Tour: The Quick Towr highlights many features of your Treo. It is already installed on
your Treq, and you can open it at any time. Press Start [ &, select My Treo, select the
Supporttab, and then select Quick Tour,

While Using Your Treo

Hedp:-Many of the built-in applications include on-device Help, so that you can leam
about the tasks you can perform in that application. To access Hefp, go to the application
or screen you want help with, press Searf (&, and select Help.

Onfine support from Patm: For up-to-date downloads, troubleshocting, and support
information, check out palm.com/treo800wsprint-support,

Setup assistance from Paim: For help with setting up your Treo and getting up and
running, call T-866-700-PALM (1-866-750-7256). This service is complimentary within 90
days of purchase. (Cffer subject to change without notice.)

My Treo: Find setup tips and support info, including access to Palm’s knowledge library
and a version of this Usar Guida thal wou can view on your device, Prass Start [8], selact

My Treo.
{f You Need More information

Books: Many books on Windows Mobile® devices are available from local or online
book retailers {look in the computers section), or visit pakn.com/trep S00wWsprintsupport,
Onfine fortms: Consult online user discussion groups to swap information

about your Treo and learn about topics you may find nowheare else,

Wisit palm.com/iracd00wsprint-support for details,

Sprint Customer Service: For quastions about vour account or features available on
the naetwork, contact Sprint or visit wwwesprintcom for the latest information and halp,

15



Managing Your Account

Onfine: wwwi sprint com
Access your account information.
Check minute usage {depending on your Sprint senvica plan).
Yiew and pay your bill.
Enrall in Sprint onling billing and automatic payment.
Purchase accessories,
Shop for the latest Sprint phones.
Yiew available Sprint service plans and options.
Learn more about Sprint Power Vision™ and other great products like games, ringtonas,
screen savers, and more.
From the Today Screen on Your freo
Enter *4 and then prass Phone/Tati ||| to check minute usage and account balance.
Enter *3 and then press Phone/Tati ||| to make a payment.
Enter *2 and then press PhonefTali ||| to access a summary of your Sprint service plan or
to get answers to cthar questions,
From Ary Other Phone
Sprint Customer Service, 1-888-211-4727.
Business Customer Service: 1-800-9272199,

Sprint 411

16

You have access to a variety of services and information through Sprint 411, including
residantial, business, and governmeant listings; assistance with local or long-distance calls;
movie listings; and hatel, restaurant, shopping, and major local event information. There is a
par-call charge and yvou are billed for airtime.

Go to your Today screen (SAccessing Your Today Screen” on page 76), enter 471, and
then press Phone/Tafc ||| to dial



Sprint Operator Services
Sprint Cperator Services provides assistance with placing collect calls or with placing calls
billed to a local telephone calling card or third party,

Go to your Today screen, enter @ and then press Phone/Talf ||| to dial,
To learn more and to see the latest in products and sericas, visit Sprint online at
WwMLSoRINE Com,

17
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Section 1

Your Setup

Sprint ~ ahead
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Section 1A

!
Setting Up Your Palm Treo 800w i
Smart Device g
in This Section

Wihat You Need

Your Treo Smart Device
Inserting the Battery
Charging the Battery

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 21



What You Need

The box containing your Palm® Treo™ 800w smart device includes the following:

Hardware

Treo.

Fechargeable batteny.
AC charger.

USB sync cable.
Stereo headset,

Documentation
Get Started.
Expeariance SprintSpead.
Basics Guida
Sat Up Your Email
Terms & Conditions.
Warranty.
Software License Agreement.



Software
Getting Started CD for Palm Treo 800w smart device, which includes the following:
Deskiop synchronization scftware.
Additional software for your Treo.
User Guide (this guide).
“ou also need the following items to complate the installation and activation:
An activated Sprint service plan,
A location with wireless coverage for your Treo.
An electrical outlet,
The computar with which you want to synchronize your information,
Microsoft® Gutlook® 2003 or later (sold separatah, installad on the computar with which
you want to synchronize,

e
©

=
2

%)
o
=
h=

Ifyou don't have Oultook 2008 orjatar jnstalad on Wols compuas insart the
Gefling Starkd CD for Paim Treo 800w smart device into your compuiars

CD drive salact Palm Support Center, and fhan sact Microsoft
Cutlook 2007 (B0-daytrial) o download & &zl version of this sofivare.

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 23



Your Treo™ Smart Device

24

Front View

1. Indicator Light provides status information for yvour Treo based on the color of the light,

Volume Butfon adjust the volume level for the earpiece, speaker, and ringer.

3. Side Button opens the Motes application by default. You can alsoreassign this button to

open your favorite application (see “Reassigning Buttons™ on page 324),

4 Left Softiey gives you guick access to the oplions availalile for the current screen.
. Phone/Talicdials a phone number that you select or enter, and answers an incoming

phone call. When you press Option I__'; + PhonefTaik |||, the Internet Explorer® Mobile
application opans, -

. Startopens the Start menu to access all the applications on your Treo, When you press

and hold Option | + Start | &2 .!, the Camera application opens, so you can take a
picture or switch to video mode to record a video,

Secition 1A: Setting Up Your Paim® Treo™ 800w Smart Device
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4.

15

Calendar opens the Calendar application, so you can view and manage appointrments.
When you press and hold Opéion '_ + Cafendar | B8 |, the Contacts application opens.

Microphone serves as the mouthpiece on your Trao.

Farmplece lets you hear your phone calls. Hold the earpiece to your ear to listen, unless
yoU're using the speakerphone or a headseat,

. Right Softley gives you quick access to the options available for the current screen.

Typically, pressing this softkey opens a menu.

OK confirms any information you entered and closes the current screen. It then returns
you to the prevous screen. When you press and hold Opfon | | + OK v |, the Task
IManager scraen opens, '

Power/End turns the phone feature of your Treo on and off, wakes up and turns cff the
screan, goes to the Today screen when the screaen is already awake, and hangs up
calls.

inbox opens the Inbox application, s0 you can write and read email messages. When
you press and hold Opflon [ | + fnbox |, the Messaging application opens, S0 you
can write and read text messages.

a-way Mavigator with Center Butfon gives you one-handed access to move around on
the Treo screen and selact options (see *WMoving Around on the Screen” on page 56).
After highlighting an iterm with the &-way, yvou can select or activate it by prassing
Center (.

Opfion enables you to access the characters that appear above the letters on the
keyboard.

Bea carsful not o soratch or arush vour Treo sorean. Do not storg #in &
pace whe othar iflams might damage it Visit

j fo find & vadaly of useful 2002ss0n08s,
inciuding camying casas hat proket he sorean

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 25
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Back View

26

1. Camera Lens enables you to take pictures using the built<in camera.
. IR {infrared) Port uses infrared technology to transmit information to and receive

information from other infrared-enabled devices that use compatible scftware.

. Expansion Card Slot allows you to expand the capabiliies of your Treo using a microSD

card or microSOHC card,

. External Antenna Port enables you to connect an optional external antenna (scld

separately).

5. Self-Porrait Miror enablaes yvou to include yourself in a picture,
6. Speafer plays ringtones and alarms, and serves as the speaker for the speakerphone

feature and other audio playback.

7. Battery Door protects the battery compartment,
8. MicrolJSB Connector enables you to attach the sync cable, the AC charger, or a

hands-free headset to your Treo. Use only headsets that are compatible with wour Treo.

Secition 1A: Setting Up Your Paim® Treo™ 800w Smart Device



The Trao spearar ncitidas & farge magned w0 Be suig fo Kaap volr davos
away from ocradif cards or ofher ilams that could bacome dema mebzad.

)

o)

Top View f,-
1. Wi-F Buttonturms the Wi-Fi feature on and e @ a
=]

S

off and enables you to search for and
connect 1o available Wi-Fi natworks,

2. Ringer Switch controls the ringer setting. f
Whean the Ringer switch is set to Sound (
Off o, it silencas all sounds at once,
including music; so you don't need to
navigate through menus to turn sounds on
and off. See “System Sound Settings™ on
page 319 for details on changing the settings.

3. Shtus allows you to tap oplions on your Treo screen, To use the stylus, slide it out of the
slot and hold it as you would a pen or pencil,

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 27



Inserting the Battery

25

Use only batires and chargars hatare approved By Sprant or Palm with
vour device Failre fo use an approved baflery or charger may pravent Yo ur
davice from fwning on or Gharging: may void your Treo warranty; and may
increase the riski of your device overhealing catohing fire, or exploding,
which may aheo sl in sedous Bodily injury, death, or property damags,

1. Gently press the battery door while sliding it downward to remove it

1 Battery Contacts
2 Device Contacts

2. Alignthe battery contacts with the device contacts, and then press the battery into place.

3. Slide the battery door onto the back of the Treo until it clicks into place. (Your device
scraen tums on and the Palm logo screen appears, Wait for the progress bar on the
Palm logo screan to fill and for the Windows Mobile® screen to appear. If your Treo
doesm't turn on, you need to charge it by connecting it to the AC charger. If it still doesn’t
start, do a soft reset, See “Resatting Your Palm® Treo™ 800w Smart Device” on
page 349).

Secition 1A: Setting Up Your Paim® Treo™ 800w Smart Device



4 Follow the onscreen instructions to finish the installation.

Tip For Jong fips of heavy use buy & spare batkery that is approved By Sprint
aid fs compalibie with your Treo, Visff padm comydfeo S00wsprintsupport

o
)
=,
2
%)
o
=
i=

Charging the Battery

The battery comes with a sufficient charge for you to complete the setup process and activate
wour phone, After activation, we recommend charging your Treo for 3.5 hours (or until the
indicator light is solid green) to give it a full charge. See “Maximizing Battery Life” on page 31
for tips on maximizing the life of the battery

1. Flug the AC chargar into a wall outlat,

*Indicator Light

2. Connect the charger cable to the microlJSE connector on the bottom cf the device,
IMaka sure the symbol on the cable is facing up, toward your Treo screen.

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 28



3. To confirm that your Treo is being charged, wait about 30 seconds and then check the
indicator light,

Sofid red:-Your Treo is being charged and the battery is less than 9096 full.
Sofid green: our Treo is charged and the battery is at least 0% full,
[f the battery is fully drained, it may take a few minutes for the indicator light to tum on when

wou connect your Treo to the AC charger. If the indicator light still doas not turn on,
double-check the cable connection and the electrical outlet to which it is connacted,

Although Jt faras longer fo charge, Wou can also charge your Treo through
yolr complitr By connacting fam with the sync cable (Sa2 “Sunchronizing
With & LS8 Conneclion” on page 50, Howaver, (f ihe Dafkeny ks fully drained,
you must use e AC charger

Checking Battery Power

The onscreen battery icon displays the power status:

" Battery lcon

Lightning bolt (B, : Battery is being charged.
Gray fightning boft @ : Battery is connacted to a power source and is fully charged.
Fult batlery @] Battery is fully charged.

30 Secition 1A: Setting Up Your Paim® Treo™ 800w Smart Device



Partial battery [_1]: Battery has power but is partially drained.
Exclamation pof’nr(—_?: Battery needs to be charged immediately

Tip Tapping the battery icon opans & window showihg the percantge lavel of
charge faft in the batlary

e
©
=
2
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o
=
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Maximizing Battery Life

Battery life depends on how you use your Treo, Consumption factors include signal strength,
use of accessories with Blustooth® wireless technology, speakerphone usage, and the type of
calls you make (data or voice). Increase battery life by following these easy guidelines:

Charge your Treo whenewver you're at your desk, or charge it overnight each day. The
battery in your device has a much longer useful life when it is topped off frequently, versus
being charged after it is fully drained.

If wou spand a lot of time using the camera, gameas, media players, or dther applications,
keep an eye on the battery icon and charge when necessany,

The wireless features of your Treolphone, email, messaging, Web, and any applications
that use a Sprint Powar Wision™ or Wi-Fi connection) generally consume more power than
the nonwireless features (Calendar, Tasks, Notes), If wou dom't plan to use the wirelass
featuras on your device for a while, turm off wour wireless services (see “Tuming Wireless
Services On and Off” on page 340), You can forward calls 1o a different number or lst all
calls be picked up by voicemail (see “Forwarding Calls” on page 88). To quickly turm
wirgless services (phone, Blustooth, and Wi-Fi) on and off, tap the signal-strengih T““
icon, and then select Wireless Manager,

If wou sync email and athear information directly with your corporate Exchange senver
using Microscit® Exchange ActiveSync®, set the synchronization intenval to a maximurm of
avary 15 minutes during peak times and every hour (or turned off completely) during
nonpeak timeas (see “Setting the Synchronization Schedule™ on page 3100,

Turn off the Blustocth feature on your Treo when you do not need to make a Blustooth
connaction.

Section 1A:-Seiting Up Your Paim® Treo™ 800w Smart Device 31



By default, the Wi-Fi feature on your Treo disconnects and turns off when the screenis off.
If vou change the default Wi-Fi settings, be sure to turn off the Wi-Fi feature when it is not
in use (see “Turning Wireless Services On and Cif” on page 340, You can also turn on
the Enable PowerSavings cption in Wi-Fi Settings to conserve battery power (see
“Customizing Wi-Fi Settings” on page 194).

Aswith any wireless phone, if your phone is on and you're in an area with no wirelass
coverage, your Treo continues to search for a signal, and that consumeas power. If ywou
cannot mcve to an area of better coverage, termporarily turn off your phone (see “Turning
“our Phone On and Cff” on page 38).

Turn down the screen brightness (see “Adjusting the Brightness” on page 322).

Sat your scraen to tum off automatically after a shorter period of inactivity (see “Viewing
and Cptimizing Power Settings” on page 338).

Keap your battery and your Treo away from direct sunlight and other sources of heat,
Temperatures over 113 degrees Farenheit {45 degrees Celsius) can permanently reduce
the capacity and life span of any lithium-ion battery.

il [ your batfery becomeas fuly drainad, your information remaing safely stored
o your Treo. Recharge e batlry o 2 coass your information

Secition 1A: Setting Up Your Paim® Treo™ 800w Smart Device



Section 1B

Setting Up Service

%]

in This Section g
&

Tuming Your Palm Treo 800w Smart Device On and Off %

%]

Wiaking Your First Call 5
Setting Up Your Voicemail %I

Creating Sprint Account Passwords

Setting up service on your naw Palm® Treo™ &§00w smart device is quick and easy. This
section walks you through the necessary steps to unlock your Treo, s&t up your voicemail,
and astablish passwords,
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Turning Your Palm® Treo™ 800w Smart Device On and Off

34

Throughout this guide the frms Treo and device are used fo desaribe the
physical aspacts of your Treo. The am phone fs tsed b dascribe the

faature of your Treo that enablas vou o connact fo the Sprinf Natonal
Mefwork

You can tum the phone and the screen of your Treo off and on separately. This means you
can wake up the screen to use just the organizer features of your device—such as Contacts,
Calendar, and other nonwireless applications—without turning on the phone, Also, whean the
scraen is turnad off, the phone can be on and ready for you to receive calls or massages.

Waking Up the Screen and Tuming ft Off

Wake up the screen and leave the phone turned off when you want to use only the organizer
featuras of your Treo, for example, when yvou're on a plane and want to look at your calendar.
You can also turn off the screen without turning off the wireless features of your Trao.

1. Towake up the screen, press any of the following buttons:
Power/End |

PhonefTalk
Cenfer ()
Start 2]
Catendar [ |
fnbox
2. Press Cenfer () to turm off Keyguard,

3. When you're ready to turn off the screan, briefly press Power/End 1| to go to the Today
sCrean.

4. Briefly press Power/End 1| again toturn off the scraan.
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You can sathow fong Hha scaan siays on duidng 2 parfod of ineclivily Frass
Start, sefect Setfings. seket the Systemn 28 and then sekbaf Fower. Sakcf
the Advanced &b and then adiust the On battery power setfing.

Tuming Your Phone On and Off

Whean you turn on your phone, it connects to a wireless network so that you can make and
receive phone calls and use other wirgless servicas.
1. If you are not on a call and your screen is off, briefly press Power/End || (or one of the
other wake-up keys listed in the previous section) to wake up the screen.

Press Center () on the S-way to tum off Keyguanrd.

.~ Press and hold Power/End || to turn on your phone When your Treo locates a signal,
Sprint and the signal-strength T,||| icon appear at the top of the screen, indicating that
yoll can use the phone and Internet featuraes, if suppored Ly the local network)

4. Press and hold Power/End 1| again to turn off your phone (When your phone is off,
Phone Off and the phone-off Tx icon appear at the top of the screen. Your Trea is not
connected to any wireless network, but you can still use the organizer and other
features.)

If the Ringer switch is set to Sound On o), you hear a series of tones whan you turn your
phone on and off. For more information, ses “Setting the Ringer Switch” on page 320
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Whean the phonea is on and the scraan is off the dake and fime sorean saver
appears You can disable the sorean saver Prass Start, salect Setings,
salact tha System f28 and then salect Power. Salact the Screen Saver izh,
and then unchecr the Enahle Screen Saver box
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Making Your Arst Calf

The battery comes with a sufficient charge for you to activate your Treo and make your first
call. After activation, we recommend charging your device for 3.5 hours (or until the indicator

light is solid green) to give it a full charge.

If you purchased yvour Treo atf a Sprint Store, it probably has already bean
aclivated, [Fyolwr phong isnof aciivated, s the Get Stared poster for
datails on aotivaling vour new devics

1. Press Power/End || to display your Today screen (see
“Using Your Today Screen” on page 72).

2. If prompted, press Cerfer () to furn off Keyguard (ses

“Locking Your Treo and Information”™ on page 326 for more
information).

3. Make sure your phone is on (see “Tuming Your Phone On
and Cff" on page 3&).

4. Press the numbers on the keyboard to enter the phone
number you want to call,

Press Phone/Talic ||| 1o make the call,

If prompted, enter your four-digit lock code. {In most cases you are not prompted to
enter a lock code, For securnty purposes, the lock code is not visible as you type.)

Mofe If your Gan't racal your loak codea fry using fhe fast four digits of your
wirgless phone number. If this doasi'f work, call Sprint Cushmer Service af
1-888-211-4727. Sea “Where o Leam More” on page 15 for other ways fo
get haip fom Spintif you are having fouble with your senvdoa.

7. When your call is complate, prass Power/End |i to end the call,
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Adjusting Calf Volume

While a call is in progress, press the Vofume button on the side of your Treo to adjust the call
volume,
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" Volume Button

What's My Phone Numbei?
1. Maka sure your phone is on (see “Tuming Your Phone Cn and Cff” on page 35).

2. It you donot see your Today scraen, press Power/End |1 (see “Using Your Today
Scresn” on page 723,

Section 18- Setting Up Service 37



@ oW

K
&

*  Look Here for Your Phone Number

Press Menu —— iright softkey).

Select Preferences > Phone Setiings.

Cn the Phone tal, ook for your phone numbear below the title bar,
Pross O [6],

IF your phone number doasn’t appeaar on the Phone Settings soean prass
Ok, and then fum vour phong offand back on again. Repeat staps 2
through & Jf your phone number Sl doasn't appeas your phona has not
bean aclvaled. Tumn your phone off, waita faw hours, and then repaat thase
steps. I youwr phone number still does not appear, contact Sprint for
asyfstance aF 1-888-211-4727.
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Setting Up Your Voicemaif

All unanswered calls to your Treo are automatically transferred 1o your violcemail, even if your
phone is in use or turned off,
To a2t up yourvoicemaii:
I you do nat see your Today screen, prass Power/End |i].
2. Press and hold ¥ on the keytoard to dial Sprints voicemail
system,
3. Follow the voice prompts to do the following:
Create your password.
FRecord your name announcement.
Record your greating.
Choose whethar to activate Skip Pass Code—a featurs
that lets you access your voicemall simply by prassing
and haolding 1, bypassing the need for you to enter yvour password, (f vou do naot
activate Skip Pass Code, your Treo uses the Voicemail Pass Code feature, which
requires you to enter your password sach time you want to accass your voicemail)
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Ifyou are concarned aboul Unauthorzad aCoass 1o your Voicamal account
wea racommend that you usa the Voicemal Pass Codfe falua

For maore information about using your voicemail, see “Using Voicemail” on page 83.
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Creating Sprint Account Passwords

Asa Sprint customer, you enjoy unlimited access to your personal account information, your
voicemail account, and your Sprint Power Yision™ account. To ensure that no one else has
access to your information, you nead to create passwords to protect your privacy.

Account Password

[f wou are the account owner, you create an account usarmame and password whan you sign
on to wwwesprint.coim, (To get stanad, click Meed to register for access? in the sign-in area of
the Web site) If you are not the account cwner (if someone elsa receaives the bill for your
Sprint service), you can get a subaccount password at wwassprintoom.

Voicemaif Password

You create your voicemail password when you set up your voicemail. See “Satting Up “Your
Yolcemall” on page 39,

Sprint Power Visfon™ Password

With wour Treo, you can choose to st up a Sprint Power Vision password, This optional
password can be used to authorize the purchase of Premium Services content and to protect
parsonal information on multiphone accounts,

To learn more or to change your passwords, sign on 1o wwwsprinicom or call Sprint
Customer Service at 1-888-211-4727.
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Section 1C

Connecting to Your Computer

In This Section

Synchronization Methods
Wihat Can | Synchronize?
Setting Up Your Computer for Synchronization

Synchronizing Wth a USE Connection

Synchronizing means that information that has baen entered or updated in one place—your
Palm® Trec™ &00w smart device, your computer, or your corporate server—is automatically
Updated in the other, Tharg's no need 1o enter information twice, Some typeas of
synchronization can happen on an automated schadule, so wou dom't even have to think
about it.

After yvou get into the hakit of ssnchronizing regularly, vou can see what a powearful tool
synchronization is for transferring, updating, and backing up large amounts of information on
wour Treo,
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Synchronization Methods

There are a number of ways to make synchronization occur, You can install deskiop sync
software on your computer to synchronize, or you may be able to synchronize wirelessly with
an Exchange server. You can also maximize your sync options and sync with both an
Exchange server and deskiop sync software,

Synchronizing With Desktop Sync Software

To synchronize the information batween your Treo and your computer, the deskiop
synchronization software must be installed on your computer and you must connect your
davice to your computer using one of the following methods:

Connect using the UUSEB sync cable- When you connact your davice to your computer
using the sync cabls, synchronization begins automatically, (Ses “Synchronizing With a
USB Connection” on page 50.)

Connect using Bluetooth® wireless technofogy: You must first sat up tha Bluatooth
connaction. (See “Synchronizing Cwver a Bluetooth® Wireless Technology Connaction” on
page 312)

Connect using infrared (IR} technology:rou must first set up your computer to receive
infrared beams. (See “Synchronizing Cwver an Infrared Connection™ on page 313.)

if yvou have a Windows® XP computer:- The daskiop sync scftwars is called ActiveSync®
desktop software. You must install this software from the Getting Started CD for Palm Treo
800w smart device that came with your Treq, even if you have already installed a previous
varsion of deskiop sync software, (See “Installing ActiveSync® Daskiop Software: Windows
¥P" on page 46.)

ffyou have a Windows Vista® computer- The deskiop sync software is called Windows Mobile
Device Center. This software may already be installed on your computer. However, we
recommeand that you usea the Getting Started CD for Palm Treo 800w smart device to ensure
that the sync scitware is properly installed. ou can also use the CD to install this Usar Guide
on your computer and bonus software on your Trec.
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Fegardless of the deskiop sync software you uss, the sync application on your Treo is called
AdtiveSync,

Synchronizing Wirelessiy With the Server

You can sat up your Treo to synchronize email and other information wiralessly with Microscft®
Exchange Server 2007 or with BExchange Server 2003 upgraded to Service Pack 2 using
Microscft Exchange ActiveSync (see “Setting Up Wireless Synchronization™ on page 308). If
wou chooss this mathod, synchronization takes place automatically after setup, You do not
need to install the software from the Getting Started CD for Palm Treo 800w smart deavice.

Mofe If youi have & Windows 4P compltan, we recommend that you instal the
daskiop syne soffware from the CO aven if you synchroniza wiralkessly with
the saver You nead e daskiop sync soffware fo synchronize piciuss,
videos, music fites, and ofher informafion direclly with your computar

What Can | Synchronize?

You must have Microsoft® Cutlook™ 2003 or later installed on your computer to synchronize
the information in these applications:

B3 Contacts [F] Calendar (&) E-mail Tasks
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The information in thase applications synchronizes with Cutlook by default whether you Use
deskiop syne software or wirelass synchronization with Microscit BExchangs ActiveSync.

I you don't aleady have Oulfook fnstalled on your computar, inserf the CD
info your computars CO dive, sadect Palm Support Center, and then
lectMicrosoft Qutlook 2007 (B0-day trial) ©o downtoad & izl varsion of
this sofivare.
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If wou set up synchronization with the deskiop sync software, information in the Favorites
application is synchronized by default as wall,

Synahronizing favorias geas your an aasy way fo gel favorigs from thea Wb
Browssr on your compulr info the Wb Browssr on your Treo, Just add
them fo the folder calfed Mobile RRvonigs WhIGh Shows up i your
compuiers browses Whean you gine, thay Become availzbla on your device
a8 wall Backup copies of any favorias that you add on the Treo browser zra
also stored in the Mobile Fvoritas fokdar

“ou can choose which applications sync—provided the application appears in the sync list,
for example, you can choose not to syne Tasks, See “Changing Which Applications Synd” on
page 314 for details on choosing applications from the sync list,

You can also use the Files sync folder to sync files from applications that dom't appear in the
sync list, For example, you can sync files such as Microsoft® Word, Microsoft® Excal®,
Microsoft® PowerPoint® Microscoft® CneNote® and Adobe Acrobat® (FOF) files, as well as
picturas, music, vidaos that originate on your Treo, See “Synchronizing Microsoft® Office and
Cther Files™ on page 260 and “Synchronizing Your Media Filas™ on page 205 for details on
using the Files sync folder.

If wou want to synchronize music, pictures, and videos from your Windows Media® Player
library you need Windows Media Player 10 or later on your computer, in addition to deskiop
synchronization scitware,

o I you dorrt have Windows Media Plaver instalad on vour computs;
downtoad it for fee from Www.microsoftcom.

[f wou want to synchronize with a personal information manager (PIM) other than Microsoft
Ctfice Cutlook, you must install a third-party solution. Contact the PIN's vendor to learn
wheather scftware is available for your Treo.
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The following table lists the types of information you can synchronize and the methods to use.

information lype . Method . Where fo feam more
Cutlock Contacts, Deskiop sync software “Setting Up Your Computer for
Calendar, Tasks (sync with computer) or Synchronization” on page 46 or

Exchange ActiveSync

“Setting Up Wireless
{direct sync with server) 9-p

Synchronization” on page 308

Cutlock Email Deskiop sync software “Setting Up Your Computer for
or Exchange ActiveSync Synchronization” on page 46 or

“Setting Up Wireless
Synchronization” on page 308

Word, Excel, Deskiop sync software “Setting Up Your Computer for
PoweerPoint, Synchronization” on page 46
Chnelote, and

“Synchronizing Microsoft® Cffice
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PDF files and Other Fileg” on page 260

Pictures, music Deskiop sync software “Setting Up Your Computer for

and video files and Windows Media Synchronization” on page 46

Player “Synchronizing Your Media Files” on

page 205

Cutlook Motes Deskiop sync software “Setting Up Your Computer for
Synchronization” on page 46
“Synchronizing Microsoft® Cffice
and Other Fileg” on page 260

Files to be Deskiop sync software “Setting Up Your Computer for

transferred to an Synchronization” on page 46

expansion card “Synchronizing Microsoft® Cffice

and Other Fileg” on page 260
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Setting Up Your Compuiter for Synchronization

Before you can synchronize, the deskiop sync software must be installed and you must
connect the sync cable to your computer, If you have a Windows XF computer, you must
install the software that came with your Treo on the Getting Started CD for Palm Treo 800w
sman device, even if you already have a previous version of the deskiop sync software
installed on your computer,

System Requirements

Your computer must meet the following minimum systerm requirements:
Windows XP Service Pack 2 or Windows Vista (later varsions may also be supported).
32ME of available memory (RAM).
170ME of free hard disk space.
CD drive,
Awvailable USE port.
USB sync cable {included with your Treo).
Adobe Flash Flayer {required for running the installation programy.

Tin IFyou do nothave Adobe Flash Player on vour Compuly You can download
it for free fom wivwadobe com

Instalfing ActiveSync® Desktop Software: Windows XP

If wou have a Windows XP compltear, the deskiop sync scftware is called ActiveSynec deskiop
software. The Getting Started CD for Palm Treo 800w smart device recognizes that you have a
Windows XP computer and automatically directs you to install ActiveSync deskiop software,
On your Treo, the sync application is called ActiveSync,
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Do the following:

« W you g instaling the soffivae on 2 compuler 2T work, make stire
Wour company aifows vou fo install new soffwara. Contaof your
companys 1T depariment for halp,

I you want o syne pictuies, videos, and music from your Windows
Media Library, you must install Wind ows Media Player 10 or later
before you nstil AcieSine desidop soffwane

1. Close any applications that are currantly running on your computer, including those
running in the background. {Your computer must have all its resources available before
yiol can install the software,)

2. Inser the Geliing Starfed CD for Paim Treo 800w smart device into the CD drive on your
computer,

3. Follow the installation instructions that appear on your computer, (When offered the
option to sat up synchronization with an Exchange server, select Mo, See “Satting Up
Wireless Synchronization™ on page 308 for instructions on synchronizing with a server)

4. Connect your Treo to your computer to sync for the first time {(see “Synchronizing With a
USE Connection™ on page 507,

Diring soffwarg instaizlion vou can sakect 21 oplion o S$nchronizz emai,
contzots, calandar avants, and fafes dirgctly with vour informea fon stored on
& sanes running Microsoft Sichange Sanar 2007 of Exchange Sanver 2003
upgraded fo Sanioe Peor 2. 0f ol choose this opfion, You are promplked B
antar your mail server address and domain name and your Bcchangs senver
0CoUnt Usamame and Lesswod.
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Setting Up Windows Mobile Device Center: Windows Vista®

[f wou have a Windows Vista computar, the deskiop sync scftware is called Windows Mobile

Devica Cantar, The Getting Started CD for Palm Treo G00w smart device recognizes that you
have a Windows Vista computer, and directs you to install Windows Mobile Device Center (if it
i5 not already on your computer), ©n your Treo, the sync application is called ActiveSync,
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1. Close any applications that are currently running on your computer, including those
running in the background. (Your computer must have all its resources available before
yiol can install the software,)

2. Inser the Getting Started CD for Palm Treo 800w smant device into the CD drive on your
computer,

3. Follow the installation instructions that appear on your computer, (When coffered the
option to set Up synchronization, with an Bxchange server, select Mo. See “Setting Up
Wireless Synchronization” on page 308 for instructions on synchronizing with a server)

4. Connect your Treo to your computer to sync for the first time (sse “Synchronizing With a
UZE Connection™ on page 507,

Using the Deskiop Sync Software

After the deskiop sync scftware is installed on your computer, synchronization happens
automatically anytime you connact vour Treo to your computar, as described in the next
section. You can also open the deskiop sync software window on your computer to perform
the following tasks:
Install applications from your computer to your Treo (see “Installing Applications From
Your Computer” on page 298) or to an expansion card inserted into the expansion card
slot on your device (see “Installing Applications Cnto an Expansion Card™ on page 299).
Change which applications synchronize,
In ActiveSync deskiop software on a Windows XP computer, enter settings to synchronize
wirelesshy with Microsoft Exchange Server 2007 or with Bchange Server 2003 upgraded
to Service Pack 2.

You can also change which applications synchroniza (sea “Changing Which
Applications Sync” on page 314) and enfer selfings fo synchronize
nirskasaty faee “Saffing Lin Winkess Synchmonizaiion” on page 308
Whather vou enfer changas on Your Teo or on your computen e changes
are ransferad b e ofier location the next Ime you synchronize.
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To open the deskiop sync software, do one of the following:

Windows XP: To open the ActiveSync deskiop software window, double-click the AciiveSyne

2 icon in the taskbar in the lower-right corner of your computer screen. (If you dom't see the
AdtiveSync icon in the taskbar, click Start = Aff Programs > Microsoft ActiveSyne to open the
ActiveSync window,)

You can saf tha AciesSyne window o open aubmalically when you
connact your compliar and vour Treo. in the AchiaSine window, salectFile
= Connection Settings and hen check the Open ActiveSync when my
device connects box

The ActiveSyine icon furns grean whan your davice js connectad o your
computer. The joon is gray whean your Theo fs not connacikd & your
compuir

Windows Vista: To open Windows Mobile Deavice Center, click Start > Af Programs > Windows
Mobite Device Center.

Desktop software installation also creates a folder for your Treo on your computer, By default,
this folder is namead MyTreo800 My Documents; the folder name changes whean you assign
wour Treo a name. When your device is conneacted to your computer, opening My Compliter
or Windows Explorer (Windows XF) or Compier (Mindows Vista) displays an icon
representing your Treo, Double-click this icon to display folders containing items you
synchronized, such as music files, picturas, and videos,
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Synchronizing With a USB Connection

Bvery time you conned your Treo to your computer, the deskiop sync software automatically
turns on and checks whethar changes you made on the computer or on the device need to
be synchronized.

Lize the USE syne cable that came with vour Treo i vou nead o Use
fepiacamant cable, matke sur@ i is approved By Palm for use with your
Tren 800w smart davios, Using an unapproved cabile may Cause S amors

If yourse switching from a pravious Windows Mobie® devica or from a device
using Paim OS® by ACCESS, you can fazm how o move conknt o your
Tao By going o paim comdaododwsanintsunport
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1. Plug the sync cable into a USE port or a powered USE hub on your computer,

*

For bast parforman e, piug your sync cable direcy fnfo & USE port on Your
computer If Wolr computar has USE ports o1 both the front and back we
suggast using the back port If you use 2 USE hub, make sue it is 2
powerad hub
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Your Treo is being chamed through Yolr compuisr whenever the swne
cabla is connackd b & powered USB porf on your compuler Howewer, i
fatias longer to change your device through your computer than with the AC
charger that came with your Teo.
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3. Check for synchronization progress: {|f you don't see the corract icons, make sure the
dasktop synchronization software that came with your Treo is running on your

COMmpUtar)
On your Trao, look for the animated ActiveSyne 4¥ icon at the top of your screen.
On your computer, look for the animated Sync icon in tha taskbar: & MWindows
XPyor @ (Windows Vista),

[f wou have any problems synchronizing, see “Synchronization” on page 360 for
troubleshocting suggestions.

Wi racommend that yvou also wse the included Sprite Backup ity fo back
Lp your information This backup-and-asihe uliily presenas the dal and
Saffings that ara not bedied up during synchronization Sprk Backup also
profacts vour datz and saffings if vour Treo s ever 1ost or Sfolar, or if yau
avar nead I do & hard asat
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Section 2A

Moving Around on Your
Palm Treo 800w Smart Device

In This Section

hoving Around onthe Screen
Using the Keyboard
Opening and Closing Applications

Using Your Today Scraen
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Moving Around on the Screen

58

To move around on the Palm® Treo™ 800w smart device screen, you can use the S5-way
navigator or you can tap items on the scresn with the stylus, With use, you can find your own
faworite way to scroll, highlight, and select items.

sing the b-way, press Right b, Left <, Up o, or Down + to move around on the screen.
Press Cenfer () to highlight and select items.

Up

Right
Doy

Left

Center ()

[ N e o B e

Some third-party applications may not wosk with the S-way navigator, and
YOU MUST Lisa e shtus instkead,

The arrow jeons that indical direcfons on the S-way are diffarant from tha
onscraan sorol arows and he arows that indical etz fistis avaiable
(3me “Saelectng Oplions in g List" on pege 62),
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Scroffing Through Screens

As on a computer, on your Treo you scroll to mave from field to field or from page to pags,

or in some cases to highlight an item or option in a list, There are several methods

of scrolling;
On the d-way (see “Moving Around on the Screen” on page S6), press Right », Leff 4,
Up o, or Down w tomove to the nex field, button, or action in that direction.
Press and hold Option || (below the A key on the keyboard—see *Your Treo™ Smart
Device” on page 24) while pressing Up o or Down + to scroll one screen at a time.
(These keys work just like the Page Up and Page Down Keys on a computar keyboard.)
Press and hold Option | while pressing Leff < or Right > to jump tothe top or bottom of
the current screen.
Whean viewing a scraen with tabs, such as when adding a contact, press Down w to scroll
to the tats, and then press Leff < or Right b 1o move between tabs,
When inside a text field, press Right » or Left < to mova tothe naxt character, and press
Up o or Down v to move betweasan linas.
When inside a list, press and hold Up o or Down + to rapidly scroll through the list,
Tap an onscresn scroll arrow,
Tap and drag the slider of an onscreen scroll bar.
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eaim neeting
1o &M

“ienthing with Financlal Departnment
op A g

1 Scroll Arrows
2 Slider
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Whan vou ae using applicalions such as inbol intmet Soplosa’™ Mobils,
and Waord Mobile, prass and hold Option whike prassing Left or Right on the
S-wiay f0 o fo the baginning or end of the currant iine.

Closing Screens

To accept the information you entered on a screen and to return to the previous screen, do
one of the following:
Prass OK [@].
Use the stylus to tap or in the upper-right corner of the screen. (These buttons are
not accessible Using the S-way)

Whan you close & scraan, the application S8 ains in mamony. Sea Wawing
Mamorny Usage” on page 338 for insfructions on viswing the amount of
MEmOory in Use Versus Wewing the available memory See *The Applications
A Running Stowes Than Ustal™ on page 353 for mstructions on aosing
applications and fresing up memory

Highlighting and Selecting ftems

On most scresns, one iterm—a button, a list entry or a check bow—is highlighted by default,
The highlight identifies which itemn is affected by your next action. Use the &-wayto move the
highlight from one item to ancther before opening or selecting it.

The highlight can take one of two forms, depending on what is highlighted:

Border: This rectangular border highlights items such as an onscrasn button (0K,
Dismiss, or Hide), a check bax, an option, or a Web link.

James Vasquel - * I‘I wl ¢
verr [Gelectapitore., |, N ETE @
campar TT Manager 121550,

" Border
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Light text on a daricbactground: This highlights items such as a phone number, an email
addrass, text, or an item in a list.

After highlighting an item with the 5-way, you can select or activate it by pressing Cenfer ()
or by tapping the item with the stylus.

The bast way fo jearm b use tha 5-way s fo apedmeant Prass the 5-way
butfons and as you do, folow the movement of the bosder around the
screan The Rehavior of the S-way varks slighlly in each applicaton

Highfighting Text

“ou can use the stylus to highlight text on the scraen:
Tap and drag the stylus across the text you want 1o highlight,
To highlight a word, double-tap it
To highlight a paragraph, triple-tap it

[l When & is highlighted, you can press Backspace fo defek the
highlighled it

Using the Softkeys

The laft and right softkeys give you guick access 10 tasks that you can do on the current
screan, so the softkey items vary from application to application and from screen to screen.
Look on the screen directly above the softkeys to see the actions that they make available in
the current application. If vou dom't see a label above thase Keys, the keys are inactive from
the current screen. In most cases the right softkey opens the menu and the |&ft softkey
activates a specific itern, such as Mew or Edif, Remember that softkey functions vary from
screen 1o screen, so be sure to check the onscreen label before pressing the softkeys.
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s

1 Left Softkey Activates This ltem
2 Right Softkey Activates This tem

Sefecting Menu flems

In many applications, a menu provides access to additional features. The menu is hidden
Lntil you prass Menu —— (right softkey). To gat the most out of your Trag, its a good idea to
familiarize yourself with the additional features available through the menu in various
applications.

1. Press Menu — (right scitkey). W =
2. Press Up o or Down w tohighlight a menu item, ot 1nor SN .
3. If an arrow appears nextto a menu itemn, press Center () - _u_l' ;
or Right b to display additional options for that item, and oo | G0 0 Tode
then press b o or Down w to highlight a menu item. (To e
return to the main menu without making a selection, press  [1%00M | '
Left <) Vieeting with Finar| |
4. Press Center () to select the menu item, or press Left i

or Menu — (right softkey) to close the menu and cancel
your salaection,
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You can salact most mant ims By prassing & Kay on e Keyboard. To
guickly accass 3 manu flam, prass Menu {rght soffiey) followad by ihe
undedined lefler v the ment fam's nama

Sefecting tems in a Shorteut Menu
Most applications also provide access to context-sensitive M

shaortcut menus—similar to tha right-click menus on a computer.

o 17,07 EMT TFS - 4 »
The shortcut menu items vary based on the highlighted ECEE N O EE )
selection. :
1. Highlight the itarm or taxt for which you want to see a serlentihad
shortcut menu, Veam mceting
SRV PRORY ¢
Press and hold Center () to open the shortcut menu. Meeting with F

Press Up 4 or Down w to highlight a menu item.

Press Cemter () to selact the menu item or press Left < 1o
cancel your selection.

Tin You canalso fap and hold the shdus on an fiam o open the shortout mant
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Sefecting Options in alList

Lists enable you to select from a range of options. You can identify whether a list is available
when you select tha field. If a rectangle appears around the field, along with a
downward-pointing arrow, a list is available. Lists are different from the menus dascribed
earlier in this section.

When salacting fialds, vou mighfnot s the downwaa-poining arow ung!
you press Center on e 5-way. I falds whade you sos g

dowrnwand- pointing arow butno recingle you must2p the arow with the
shius o display the st

You can do any of the following with a list:

lUse the S-wayto highlight the field, and then press Center () to display the items in the
list. Press Up o or Down w to highlight the item you want, and then press Cender () to
makea your selaction.

Use your stylus to tap the arrow, and then tap the item in the list.
Press Leff < to axit the list and cancal your selaction.

e * v Mest with -
soere 10417007 12:00 PM rery Lunch I
Fae 10/17f07 100 PM = Fes. [Dinner -
WPy NO Ay, VS
Call
kT e T Birthday
= Remind me Retirads . .
15 minutels) i 15 minUte(s) -]
v._Nocategories.. |7 i, No categories,,, |7
Apprordmmard, | Mol | appearipd, | M —|
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Using the Keyboard

When using the keyboard, most people find it easiest to hold the Treo with two hands and to
Use the tips of both thumbs to press the Keys.

1 Cption

2 Shift

3 Space

4 Backlight

5  Backspace g

6 Return g.

TOAl <
3

Understanding the Backiight =

=1

“our Treo includes both a keyboard backlight and a screen backlight for low light conditions.
Both backlights turm on when you turm on the screen, The keyboard backlight tums off
automatically after 30 seconds, When you use the keyboard again and the screen is already
awake, the keyboard backlight tums on for ancther 30 seconds.
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The screen backlight remains on until there is no keyboard activity for 30 seconds, and then

the

screen dims. The screen backlight turns off automatically when the screen turns off or

when yiou are on a call or playing music in the background for longer than the time specified
in Bactdight Settings. The screen backlight also tums off when an application’s powear-saving
featuras turn it off, vou can set different shut-off intervals depending on whether the Treo is
operating on battery power or is connected to an extermnal power source,

To change the screen backlight shut-off interval, do the following:

1
2.
B
4
5

Press Startf [ ] and select Seftings

Select the System tab, and then selact Bacldight w .

Cn the Batlery Power tab, selact a shut-cff interval from the list,

Select the External Power tab and select a shut-off interval from the list.
Fress OK [@].

o You can also aaiust e bactiight bighiness See “Adiustng the Brighiness”
on page 322 for datzils

Entering Lowercase and Uppercase Letters

By default, the first letter of each sentence or field is capitalized and the remaining text you
entar is lowearcase, To enter other Uppercase lettars, do one of the following:

64

Press Shiff (12 and then enter a letter, (You don't need to press and hold Shift while
entering a letter. When Shift is active, this symbol appears at the bottomn of the screen: )
Press Shift (77 twice to tum on Caps fock, and then enter a serias of letters, (When Caps
Lockis on, this symbol appears at the bottomn of the scraen: 4. To turn off CapsLock,
press Shiff i) again,)

Tin You can fum off the frstleffer capitaiization selfing For datails s “Seffing
Input Oplions” on page 326
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Entering Numbers, Punctuation, and Symbols

MNumibers, punctuation, and symbols appear abowve the letters on the keys. To enter these
characters, do one of the following:
Press Option || and then press the key of the desired character, (vou don't need to hold
Opition whila pressing the key, When Option is active, this symbol appears at the bottom of
the screen. @.)
Press Optionr || twice to turn on Option Lock, and then prass the desired keys to enter a
sares of characters, (Whean Option Lockis on, this symbol appears at the bottom of the
screen: @, To turn off Option Lock, press Opfion [ again,)

il When you enter a phone number in the Dial Lookup field on the Today
scraan you don't nead o press Option fo antar numbears or the # and *
smbots,

Entering Passwords

You can't see your password as you entar it, so be carsful, Be sure Caps Lock and Option
Lock are not on unless you need them. For information on how to enter characters, ses
“Entering Lowarcase and Uppercase Letters™ on page 64 and “Entering Numbers,
Punctuation, and Symbols” on page 65,

Entering Other Symbols and Accented Characleis

You can enter symbols and accented characters that don't appear on the Keys by using the
affernate characlerslist.
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Press Aff (w) 1o display the afternate characters list.

2. Marrow the list by pressing the key that corresponds to the charactar you want, (See the
following table for a list of corresponding characters.)

The alferna e chars clrs are grouped aocording fo thalr simigity f the
COrrBSPONGING ey For exampla, the allrnate character avalable for the R
Key iz and for the Thayis . If you prass e wrong ey, prass
Backspace fo refum fo the full list of afarnate chara clers. You can fthen
Prass another ey

3. Press Up o or Down w to highlight the desired charactar,
4 Press Center () toinsert the character,

[f wou dor't know which key to press to narrow the list when entering a symbol, you can scroll
through the full list until you find the character you want,

Tip If your want fo enter an underscome (), salect it from the list that appears
when you prass Alt by fself
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Symbafs and Accented Characters

Press Aff (w) and then press. . fo sekect. ..

a dadadam

A AMRA A AL

bor B B

> @

C C¢o

d tt

D 10

) EEER

E EEEF

[ RN

| i

lorlL 2

n fi %

N f 5
a

o bobdeed §

0 COLOED g

porP 1

rorR G

5 B3

5 B3

torT ™
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Press Aff (w) and then press. .. to-sefect...
u aoun
U Duoo
xoaor X ']

Y V¥

Y Y ¥

0 o
1(+8B 1 14
2(0+R 2
3(0+T 384
i+ ) i

S0+ H) €R¥¢
P+ KD -0
T+ N) 4

Press Alt (a0 by itself to selact these additional characters: _ + %=+ * [ {1 <Z«» ~ V@ p|
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Opening and Closing Applications

Using the Buttons
The front of the Treo has four buttons that wou can use to open and close applications.
1l =
L :: - i (“__k:' fd - ALl 9
\ \ @) =i
IS Ei S B o
1 Start
2 Calendar
3 Ok
4 Inbex

Each of the buttons has two functions. To use a buttom’s primary function, simply press the
button, To use a button’s secondary function, press and hold Option || while you press the
button. Pressing Phohe/Taftc or any of the buttons {axcept OK) automatically wakes up your
Treo screen, See “Waking Up the Screen and Turning It Off” on page 34,

-

3

Bitton Primary Function Secondary Function §

] Start menu [+ &2 | Camera tg,:,

Calandar (0)+[EE] Contacts g

OK (close window) (()+[@ ] Task Manager Q.
Inbox ([)+[83] Messaging

Nl You can open intarnet Explorer Mobile by prassing and hoiding Option
whik prassing Phone/Talk You can also custmize many of the functions
assignad B e butfons; sea ‘Reassigning Bufians” on page 324 for daiis
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Using the Start Menu
You can access all the applications on your Treo through the Start menu:
1. Press St (5] to open the Starf menu.

2. Use the S-waynavigator to highlight the application you want to use. (To view additional
applications, select Programs)

Hofe If an application appears in e Start many, i doas not appear i the
Programs folder For exampia you see Ak Expiosar when you press Start
BUf you o not sea Fie Cxploder When You select Programs

3. Press Cenfer () to open the highlighted application.

(Optionaly Press OK [@ ] to return to the previous screan. (Tha current application
continues to run in the background.)

GAres ActhveSyne  Caladaror e

le) 0 -

CanieTa et Podkel Trmtant

[ Messadineg

e = 0

_internct

__ Leiiearch  Maps ||

You can custormiza the Start menu Sea “Aranging the Start Manu™ on
page 324 for defails
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With the Start menu opean, you can press e lafer underined in the
applicalion's name o open the application. For exampla prass H fo opan
Help. You can also use the S-way o salact the shorfout icons at e fop of
the Start menu whean you wanf i open recanfly Lused applications

In Programs, press & feffer fo fump o the frst appliicalion that beging with
that flar Forexample prass C fo jump fo Calculator, Prass © again fo
jLmp fo Camera, and so on.

Closing Applications

You can have several applications open at once, 50 you don't nead to ext an application to
open ancther one. In most cases, applications close automatically when available memory is
liowy, but wou can also close applications manually:
1. Press and hold OK [@ ] to open Task Manager.
2. Do either of the following:
Select the application you want to close and press End Tasfc (— (laft scitkey).
Prass Menu (— (right softkey) and select End Aff Tasksto close all your
applications.

MNote If you prass OK o feave an application the currentapplication confintas fo
s i the background. Manuzlly dosing appications halns consana bafkry
power i freas U mamory
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Using Your Today Screen

From your Today screen yvolu can guickly ook up a contact, make a call, see your latest
calendar appointments, see the number of unread amail messages, and do a Web search.

¥

2,

72

To accass your Today scraan, prass Power/End |1 |,

Tip You can also aocess your Today strean by prassing Start and seecting
Today.

Tie Bar and Status information: See “Chacking Signal Strength and Phone Status” on
page 107 1o learn about the icons that appear in this area.

Diaf { ookup: Enter a faw [atters of a contact’s name to ook Up a number, or simply
enter the number itself, Press Phone/Tafic | I} or Center () to maka the call, See “Dialing
by Contact Mame”™ on page 77 for more information.

Point of Inferest Loofwup: Enter the type of location you want to find and press

Center () to view a list of search results, See “Finding a Point of Interest” on page 182

for details.
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4. Speed-Dial Entres: Select a speed-dial button—either a picture or text—to call the
number assigned to it (Speed-dial buttons are not displayed by default; see “Salacting
Which ltemns Appear on Your Today Screen™ on page 319 to learn how to show or hide
speed-dial buttons. To learn how to create your own speed-dial buttons, see “Seatting Up
and Managing Speed-Dial Buttons™ on page 91.)

5. Inbox Status: View the number of unread email messages for each of your email
accounts. Selact this field to open the Inbox application.

£. Messaging Stafus View the number of unread text messages. Seled this fisld to open
the Messaging application.

Scroll down 1o access more fields:

7. Live Search: Enter a term you want to look up, and press Cenler () or Refum 4] 1o
view a list of search results from the Internet (data services connection required).

8. Cafendar Status:View upcoming appointments, Selact this field to open the Calendar
application,
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You can select a picture for your Today screen background and selact which itemns appear on
the Today scraen, See “Today Scraen Settings™ on page 3186 for details,

You can acoass the Today screen dudng a cafl by pressing Dawn fo
minimize Active Call view. To refum o Aclive Call view, sskct it on e
Today scraan fiust balw fhe Dial Lookup fiald).
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Using the Phone Features

In This Section

Accessing Your Today Screen

Making Calls

Receiing Calls

Jsing Vaoicemail

Wihat Can 1 Dowhen ImOna Call?

Managing Multiple Calls

Setting Up and Managing Spesd-Dial Buttons
lUsing a Phone Headset

Customizing Phone Settings

Controlling Your Roaming Experience

Checking Signal Strength and Phone Status
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Accessing Your Today Screen

You can make and receive calls and store speed-dial entries right from your Today scraen.,
1. To go to your Today screen, press Power/End [i].

Making Calls

Your Palm® Trao™ 800w smart device offers several ways to make phone calls, Try them all to
discover which methods you prefar,

Diafing With the Keyboard
1. Gotoyour Joday screen.

2. Using tha numbers on tha keyboard, enter a phone
number,

3. Press Phone/Tafk ||| 1o dial.

You do not neaed to press Oplionto access the numbers on
the keyboard, However, when dialing shor numbers, such as
A1, the Dial Lookup feature may display a list of contacts that
include the short number, [0 this case, selact the antry you
want and press Phone/Taft ||| to make tha call,
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Diafing by Contact Name

You can look up contacts quickly by entering just a few lettars of
a contact’s name directly from your Today screan, Before you can

dial a call by contact name, you must create some contacts (see
“Adding a Contact” on page 238) or import them by
synchronizing (see “Connecting to Your Computer” on page 413,
1. Gotoyour Today screen (see “Accessing Your Today
Screen” on page 76). Wt uomomng ppontments
2. Use the keyboard to type the first or last name of the
contact you want to call. {If you entar both the first and last
name [or the first letters of each], enter a space betweean
the two names,)

Tin To delel jeffars when cormecting a misspatiad mame, press Backspace |

3. After yvou find the contact you want, select the number you want to call.
4. Press Phone/Talic ||| to make the call.

After you look up a contact, you can select how you want to communicate with that person.
Highlight the contact's name, prass Center () {or tap and hold with the stylus), and then

select the communication method you want to use.

Tip To sae g contachs addmass, company, and ofher dedafls, highlight the name,
prass Center an fhe 5-way, and than sgjact Open Contact.
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Diafing With a Speed-Dial Button

Before you can use a speed-dial button, you must create some
speed-dial entries, See “Setting Up and Managing Speed-Dial
Buttons” on page 91,

You can make a call with your speed-dial buttons Dy doing any
of the following:
Highlight a spead-dial button with the S-way, and then prass
Canter ().
Tap a speed-dial button with the shdus.

Press and hold a (Jdck Key that you assigned 1o the
spead-dial button,

By default, speed-dial buttons do not appear on the Today screen. When your spead-dial
buttons are hidden, you can still use your Quici Keys to call a speed-dial number. To leam
howe to display your spead-dial buttons, see “Selacting Which ltems Appear on Your

Today Screen” on page 319, YWhen your speed-dial buttons are wisible, you can see more
speed-dial buttons by highlighting the picture speed-dial area and prassing Right b or Left
repaatadly, or by highlighting the text speead-dial area and prassing Up o, Down «, Bight I,
or Left

Nl You can dial ananothar number for 2 confel with 2 spead-dial buffon.
Highlight the speed-dial buiton, press and hold Center on fhe 9-way, and
than sajact & number from Hea shorfouf mant
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Diafing by Company Name

1. Gotoyour Today screen,
2. Press Menu —— iright softkey) and select Contacts.

3. Press Menu — iright softkey) and select View By =

Company.
4. Press Power/End [i| to return to your Today scraen.
5. Using the keyboard, begin entering the first few letters of ' e

the company name.
6. Selact the number you want to dial.
7. Press Phone/Tall | to dial.

Diafing From a Web Page of Message
Your Treo recognizes most phone numbers that appear on Web
pages or in messages (fext or amail).

1. Press Up o or Down w to highlight the phone number
you want to dial on the Web page or in the message.

2. Prass Cenfer () to open the Phone dialog baow, and then
select Yes to dial.

If you carn't dizl & phona number diracty from 2 Web page or 2 messags
fhen highlight the number, prass and hoid Center on the 5-way, and sgject
Copy. Opan #he Dial Pad, and then prass and hold Center on the 5-way fo
Paste. Press Phonel Talk o d'izl
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Redialing a Recently Calfed Number

80

To diaf the fast number you catied: Go to yvour Today screen, and then press and hold
PhonefTaik || .

To sefect from your most recentfy diated numbers: Go to your Today screen, prass
PhonedTalt ||, highlight the number or contact name you want to call, and than prass
Phone/Taik || to dial. (If more than one number is associated with a contact, highlight the
contact and press Right I 10 access any alternate numbers for that contact)

To sefectfrom a chronological fist of calfs: Go to your Today scraen, prass Phone/Tali ||,
and then select Ca#f Log. (Highlight the numbar you want to call, and then press Caf —
[left softkey] to dial)

Smith, John

Wy MO U] mestages
ol Pt 1OACES) Yol 3] w
Lo Feller, Rl sl w2
Ay BRI .

Daarwadia. Pl

You can also access the Call Log and Dial Pad from the Today soeean by
prassing Menu {hght soffey) and saleciing Call Log or Dial Pad.

You can dlear the list of recenily dialed numbers. Fom the Call Log, prass
Menu (dght soffrey) and saject Delete Redial List
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Diafing Using the Onscreen Diaf Pad

The onscreen DHal Pad provides large numbers that you can tap =

with your finger or stylus, The numbers also include the =

corresponding letters so you can dial numbers that are 555-1684

expraased as letters.
1. Gotoyour foday screen. (B e |
2. Prass Menu —— (right softkey) and select Diaf Pad. s 9 |
3. Tapthe onscreen D¥af Pad to enter the numier, o (sl e
4. Press Phone/Tafc ||| to dial. M

You can paste numbears direcly info the Dial Pad. Copy a number fom
another applicaton, switch fo Dial Pad, press and hold Center on fhe
S-way, and then selact Paste @ insart the number in the Dial Fad.

Receiving Calls

To receive calls, your phone must be on,
To answer a call, do one of the following:
Press Phone/Taik

Press Answer —) (left softkeyd.
If the headset is attached, press the headsat button,

Tin Seea pichine of the person Galling you Leam how & assign & cafler 1D
picture fin “Assigning & Picture and Ringfone 1D fo 2 Contact” on page 107
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To ignore a call and send it to voicemail, do one of the following:
Press Power/End i,
Press Menu (— (right softkey) and select ignore.

You can also ignore & call and sand a fad messaga Prass Menu {right
soffiey) and sefect lgnare with txt message. Duning & voice cafl vou can
s faxtmassagas, butyou cannof use dals fasfuras suah a3 Wab
Browsing and sending and reoaiving emai

To silence the ringer while your device is ringing, do any of the following:
Press any key or button except Phone/Tafi, Power/End, Start, OK, or Aff
Use the Yoftme button to turn the ringer sound all the way down,

Slide the Ringer switch 1o Sound Off of 1o immediately silence all system sounds
including the ringer, {Your Trao vibrates briefly when you set the Ringer switch to Sound
Off o . All sounds rermain off until you slide the Ringer switch back to Sound On «f).)

When you silence the ringer, you can either press Phone/Tafic || to answer the call, press
Power/End |1 to send the call directly tovoicemall, or let it ring through to voicemail,

If music is piaving when & call arrivas, the music pauses as Soon as ihe
davice strts fnging and remains patsed duding your call Music plavback
fesumes automatically when the call ends or the dnging stops The
Windows Meadiz® Player screan ramaing on if you don't answer the call and
it Glosas if you do. When playback resumes, the Windows Media Player
SCraan ramains in the baokground aven afir piayback resumes.

Whan you are on a plans, you can fum off yolr phone and all winsless
sarvicas using Wireless Manager (sae ‘Tuming Wisless Sandaas On and
Off" on page 3401 But you can stil warke up the screan and use any
application hatdoasn’t require wirdlass senvicas, lie the calendar, music
plaver, and games. You can even read and write email and Xt messages
while your phona is off, buf your cannof send or recaive email or Bt
MESSEges.
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Using Voicemalf

Your violcemail number is preset when you activate your device, The first time you call
voicemail, you are prompted to create your voicemall password, If necessary, please contact

Sprint for assistance with your voicemail password,

Setting Up Voicemaif
1. Gotoyour Today screen (see “Accessing Your Today Scresn” on page 76).
2. Press and hold T on the keytooard to dial the Sprint voicemail system,
3. Follow the voice prompts to set up your vioicemail.

If your spead-dial Butfons ar visihia you can fap fhe Voicemail spead-dial
butfon with yvour SBius fo call tha Spdnt vojcamall systam. Sea “Selacting
Wihich ffiams Appear on Your Today Scraan” on page 379 fo learm how fo
display your spaad-diz! buffons

Retrieving Voicemail From aNotification
YoU can retrigve voicemall messages when you receive a notification, or you can dismiss the
notification and retrisve the messages later,

When you have a new voicemail messages, the following
notification appears:
To hear your massage now, press {isfen —— (right softkey).

To retrieve your message latarn, press Dismiss (—) (laft -
Soﬂkeyjl M

Retrieving Voicemail Messages From the Today Screen

When you have unretrieved voicemail messages, the Missed Cak Q...E icon appears on the
scraensaver, and when the screen is awake, a Volcemall €2 icon also appears at the top of

WOUr sCraen,

$O.MBe DUy
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G0 to your foday screen.
Press and hold ¥ on the Keyboard to call the Sprint voicemail systam.

Enter your voicemall password using the keyboard, or press Extra Digits — (l&it
softkeyd if you defined this option {see “Creating a Speed-Dial Button™ on page 92

for details).
Select Play b tolisten to your messages. —
5. Use any of the following onscreen controls while listening 8, O
o your messages: 1)
% Play the previous message. :f:i’;‘:")'w ;o';
@ Save the current massage. hae]a . {ﬂ
» Play the current message.
&
@ Delete tha curment massage. -
= Hepeat the current message.

w Play the next massage.

You do not need to prass Oplion to entar numbers, ¥, or # while chacking voicemail or during
any other call that requires interaction with an automated voice system.

Tip Wihen & Voicermail jcon appears at the fop of the soreen, you can Bp he
fcon fo reffave Your vofcamail

Ifyou have frouble acoassing a voicamal sysim, Iy changing the Dial Pad
e sefing See *Sefacting Youw Call Selfings” on page 107,
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Clearing the Voicemaif fcon

After wou retrieve your voicemail messages, the Volcemal icon at M

the top of your screen usually disappears. If it doesm’t, you can

claar the Yoicemai icon manually, e e

1. Press Start [#2] and select Settings.

2. On the Personal tah, select Phone (.

3. Select the Servicestab,

4. Select Clear Volcemalt fcon and then press Center ().

What Can | Do When I'm On a Calf?

When you make or receive a call, Active Call view appears on your Today screen.

Smilla Anderson A live
(312) 555 6957 w 00:11 o

Current Duration of Call
Caller’s MName and Number
ute

Speakerphone

ok —

Tin When a call jasts longer than 30 seconds, the screan dims To wake up the
Serean prass any kel except Power/ End.
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During a call, you can do any of the following:

MNavigate around the Today screen: Press Down + to minimize Active Call view into a
field on the Today screen (just below the Dial Lookup field). Then press Up o or Down

to move around on the Today screen. To expand Active Call view to its original size,
highlight it and press Center ().

Put the calt on hold: Prass Hold (— (left softkey). (To take the call off hold, press Off
Hold — [left softkey])

{/se the speakerphone: Select Speaterphone ¢z | (Toturn cff the Speakerphone,
select [PEEW )

Mute the microphone 50 you can'tbe heard: Seladt Mufe . & |, (Toturn the microphone
back on, select Mute FTEBET )

Switch to another appfication: Press Start [&] and select the application. {You can also
press Catendar (B8 | or inbox 1o switch to those applications.)

il You can send and receive Bad messages duwing a call This is a great way b
stay connedciad with collsaguas duding & long call

Retumning to a Calf From Another Appfication

56

You can use many other applications on your Treo while holding a phone conversation,
including the organizer and Messaging features. However, to browse the Web or chack email
during a call, you must connect to a Wi-Fi network, You cannot uss the Sprint network to
open a Mobile Broadband (EVDC) or Sprint 1xHTT data connection during a call; wou can
Lse the Sprint network for one activity at a time; phone or data, How can you tell which kind of
network yo're connected 107 See “Checking Signal Strength and Fhone Status” on

page 107,

From any application, press Phone/Talc ||| to return to Active Call view on your
Today screen,
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EndingaCall

Do one of the following:
Press Power/End 1.
Press the headset button (if the headset is attached and has a button on it). (Some
headsets do not have a button,)

Saving Phone Numbeis

After you complete a call, you are prompted to add the number if it is not already in your

Comtacts list,
To create a new contact for this number, select Create New

Contact, .
To add this number to an existing contact, select Copyand easptechh
Add and then select a contact name. Gowy and Add..

To decline adding the number, press Disnss (— {left - - : >
[ O

softkeay),
To permanently disable the Add Contact prompt, select Dot show this again.

Al T an incoming Gall Lsas calar ID Blocking, vou do nof sae the Add Caontact
prompt

You can fum the Add Contact prompt on and off af any time. From your
Today scraan, prass Menu {right soffiey) and salect Freferences = Fhone
Settings On fhe Phone &8 cheoi the After callsfrom numbers that are
notin Contacts, ask if | want to add them box fo &urn on the Add Contact
promet or ichaeck s Box fo fun off the Add Contaof promplt

If wou dorm't add a number right away, follow these steps to add it later:
1. Gotothe Caltlog (ses “Redialing a Recently Called Mumber” on page 80).

2. Highlight the numtbzer you want to sava,
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3
4.
5.

Press and hold Cenfer () to open the shortcut menu, and then select Save fo Contacts.
Enter tha information for the antry,
Fress OK [@].

Tip You can also save confact information fom ofher applications, such as
hessaging.

Forwarding Calfs

“ou can forward calls to ancther phone number. Flease chack with Sprint about availability
and pricing of forwarded calls; additional charges may apply.

1.
2

Gotovour Today screen (see “Accessing Your Today Screen” on page 76).

Enter *72 tollowad by the number towhich you want to forward your calls, (For exampla:
*7e4155551234)

Press Phone/Talc ||, (A confirmation tone sounds)

4 When yvoure ready to turn cff call forwarding, dial *720 and then press Phone/ Tatk

IF*F2 and 7720 do not fum calf forwanding on and off please contact Sprint
o obtain the forwarding codas for Wour area.

Aftar your fum on call farwarding call your Trao fo confinm that call
fonwaniing is acte

Managing Muftiple Calls

“our Treo cifers many advancead telephone features, including call waiting and threa-way
calling. When you'ra handling multiple calls at tha same time, Kesp the following in mind;

88

When you're on a call, you can make a sacond call and create a thres-way confarence
call, but you cannct swap between the two calls.
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Whean you're on a call and a second call comes in, you can swap between the two calls,

but you cannct create a three-way conference call.

When two calls are active, you can returm to the first call by asking the person on the
second call to hang up, or you can hang up bath calls by pressing PowerdEnd ||,

Answering a Second Calf (Caff Waiting)

When you're on a call and you receive a second call, the call-waiting notification appears.

You can do any of the following:

Place the first calf on hold and answer the new cali: Press Answer (— (|&ft softkey) or

PhonelTaik || .

Send the new caller a text message: Press Menu —— [right scoftkey) and select fgnore

with fext message.

Hang up the first cali: Press Power/End || (The second call becomes an incoming call

alert, which you can choose to answer or ignore.)

Send the new calf to voicemali: Press Menu — (right softkey) and select gnhore.

Making a Second Call
You can make a second call while your first call is till active.
1. Press Hoid —— (laft softkey) to put the first call on hold.

2. Todal a second number, Use any of the methods
described in “Making Calls” on page 76. {If you're dialing
by contact name or with the keyboard, you must first Lse
the d-way to select the Diaf foofup field)

When two calls are active, your Today screen includes two call
statls sections, each representing one of the calls,
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Making a Conference Calf
Whean you're on a call, you can make a second call and create a M

three-way conference call, Additional charges may apphy, and ., O
minutas in your account may be deducted for sach active call, @
Please contact Sprint for more infarmation. s

roup Conference B live

1. Put the first call on hold, and then place a second call. 0041 3

2. Press Conference (— (l&ft scitkay); this joins you and the St

two cther calls in a conferance.
3. After you finish, press End conference — (| eft softkey); v [&]

this ends the second call and returns you to the first call,
(It vou're ready to hang up bath calls, press PowerdEnd |
instead.)

gl /T one of he people you called hangs up you and the remaining caler stay
conneckd The scraan doas nof change fo indicate that one of the callers
has hung up I vou inifated the call and are the first fo hang up afl thies
callers arg disconnaciad,

Using Hash Mode During a Calf

Flash mode is an alternate way to manually manage your calls while one or more calls are
active, The preferred meathods are described in *Making a Second Call” on page 89,
“Answering a Second Call (Call Waiting)” on page 89, and “Making a Conferance Call” on
page 90. Flash mode is often used during a conference call when one cf the calls has ended

but the other remains connected.
1. While a call is in progress, press Phong/Tafic || from Aclive Calf view:,

2. Select Send Key (Hash) to enter Hash mode,
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3. Depending on the state of your active call, pressing Alash (— (left scitkey) or the
headset button (if the headset is attached and has a button on it) doss one of the

following:
If you have two independent active calls (nct a conference call), you can swap
betwaan tham if the second call is an incoming call,
If you have one active call, you can dial ancther number, You can press Fash —
{left softkey) again to set up a conference call.

If you have two calls in conference with you, press Flash (— (left softkey) to hang
Up the saecond call, and then dial another number to create a new threa-way

conference call,
4. Press Power/End |i| to axit Hashmode and end all calls.

Setting Up and Managing Speed-Dial Biitions

“our Treo lats yiou create both picture and text spead-dial buttons so that you can use Quick
Keys or selact a button on the Today screen to quickly dial a number.

When vou highlight & spead-dial butfor and prass and hold Center on the
S-way, you can choose another number for that contaat For eampia if you
oreak a spead-dial butfon for your ffand Skw’s home phone numbern; you
can hightight Seve's spead-dial butfon prass and holf Center, and fhan
choose his wirelaess number instead of his home number,

$0.MBe DUl
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Creating a Speed-Diaf Button
You can create up to 20 picture buttons and 50 texd buttons. By w
Lk Brgrden, Macr F=

default, speed-dial buttons do not appear on the Today screen.
To learn how to display your speead-dial buttons, sse “Salacting
Which ltems Appear on Your Today Screen” on page 319.

1. Gotoyour foday screen (see “Accessing Your Today
Screen” on page 76).

2. Press Menu (— (right softkey) and select Mew Speed Dial
3. Do either of the following:
Select Link fo contact, selact the contact you want to
link to this button, and then saelect the number you want to dial with this button,
Select Labef and enter a name for this button, and then select Mumber and enter
the phone numiber you want to dial with this button,

You canenkr addifions! numbers fo dizl such as & password or exansion
(You can atso anfar the star M7 and pound [#] symbols) To enter 2
one-second pause, enler & comma (] To entr & wo-scond pausa

anfer p. To hdicale hat you want fo prass the Bxra Digits so fiey bafore
dizting the addifional numbers, antarw followad By fhe addifional numbears.

4 If this button is linked to a contact entry with a picture, selact either Text Speed Diaf or
Picture Speed Diaf to indicate which type of button you want to create,

Tip You can add a spedal rivgfone fo 2 conBof asso ciated with the spoad-dial
bution See Adding 2 Contact” on page 238
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5. {Optional) Select the Advanced tab and set any of the
following options:

Quick Key. When the Today screen is displayed, you
can press and hold the Quick Key to instantly dial this
numbear—awvan if your speed-dial buttons are hiddan,
{Quick Keys can be lettars or numbers, but you can't
use both the letter and number for the same key, For
example, the voicemail Quick Key iz 1. The letter
aquivalent forthat key is B so you cannot assign E as a
(e Key 1o ancther spead-dial button. You can create
up to 50 Quick Keys for spead-dial buttons and 20 QuickKeys for pictura speed-dial
buttons.)
Show voice mail buttons: Display voicemail playback controls after you dial this
spead-dial number. (When this option is checked, you can entar numbers below
each contral to tailor the controls to your voicemail system. ou cannct select these
controls with a stylus)

% Play the pravious message.
@ Save the current message.

[» Play the currant message.

1

7 Delete the current message.
w Repeat the current massagea.
v Play the next message.

B. Press OK [&].

The playbact controls for he Spant Volcemall spead-dial butfon are zleady
st up for the Sprint voicamail system. You can also create spead-gial
butfons for ofhar voicemail swskms, such a8 ol offica or homea and you
i et the volcamal! plavback confols i worr with those volcamail!
Ssem.s
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Editing a Speed-Diaf Button

1.

S

Gotovour Today screen,

Press Menu — (right softkey) and select Speed Dial Options.
Highlight the speed-dial button you want to edit.

Press Menu — (right softkey) and select B3

Make the desired changes.

Fress OK [@].

If your spead-diz! butfons are visibie, you can edif & spead-dial butfon by
highlighfing the buffor vou want fo adit prassing and holding Center &
opan the shorfout manuy and then sekcling Edit Speed Dial.

Deleting a Speed-Dial Button

¥,
2
3
4.
5

G0 toyour foday screen.

Press Menu — iright softkey) and select Speed Dial Optons.
Highlight the speed-dial button you want to delate.

Press Menu — (right softkey) and select Dedete

Select Yes to confinm deletion.

Arranging Your Speed-Dial Butions

94

1

G0 toyour foday screen.

2. Press Menu ——) (right softkey) and select Speed Dial Opfions.
3
4. Press Opfion | | + Up &, Down w, Right b, or Leff < to move the button in that

Highlight the button you want to move.

diraction.
Press OK [@ ],
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Using a Phone Headset

You can connect a phone headset for hands-free operation.

If diving white using & phone s permifled in your area, we recommend
using & hesdset or & hands-fras car Wit (sold sepans i), Howaver, B2 awans
that use of & head'set that cowers both ears impairs your a Bility o hear ofher
Sounds Lse of such a headsal white operaling a mofos vehicle or dding a
hicycle may creata & sarious hazand o you and/or others and may be
iltegal Jf ot must Lse & skreo headset while drving, place a speater in
ol one ear Leave the ofher ear frea fo haar outside noises and use the
hezdset only if 1t is legal and you can do S0 safaly

To charge Your Treo while using & wired headsal vou must use & Palm Trao
SO0 Powar/Aldio Adaplar fsold separa i, For informafon on this

200as80ry, VST palmeomy e 800w sRinESumnort
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1 Microphone
2  Headset Button
3 Speskers

The headset button is context-sensitive, and it performs various actions based on the

98

situation, You can press the headset button to perform any of the following tasks:
Answer an incoming call,
Respond to call waiting.
Hang up all calls.
Swap between calls if the second call is an incoming call,
Create a conference call if the second call is an outgoing call,
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Headiset Specifications

You can use the headset that came with your Treo or compatible third-party headsets. Here
aretips for selecting a headset:
Your Treo works with headsets that have a microlUSE standard B connector that is USB
2.0 compatible. To use a headsat with a 2.5mm, 3-pin connactor, you must attach an
adapter (sold separately).
Wheanin doubt, ask the third-party headset manufacturer if the product is compatible with
your Treo 800w smart device, (If you hear a headset buzz or poor microphone
parformance, your headsst may be incompatible with your Trao)
Headseats designed for pravious Treo smart devices are nct compatitls with the Treo S00w
smart device.

The skrao headsat included with your devica ailows you i sk fo music
in skrao. You do not nead o Use a sfaeo adaplr For Mok information on

compatible audio acoassorias, visit palm comyirea 800w snnn-suppors

Using a Hands-Free Device With Bluetooth® Wireless Technoilogy

Your Treo is also compatible with many headsets enabled with Bluetooth® wireless
technology version 1.2 or 2.0, For a list of compatible hands-free devices with Bluatooth
wireless technology, go to pain.comfreod00wsprintsupport,

Mofe You can wee & stergo Sluatooth haadsat that s A2DP-anabiad fo liskn fo
MP3 filas on your Treo, You cainnol however, Use 2 mono Suatooth headsat
o sk o MPE filas.
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Bafora you can fransfar 2 call balwaan your Trao (with or withouta wirad
headsaf) and & Blustooth hands-free device, the Blusfool device must be
within nge of your Trao and you must have praviousty sef up e parinership
with the Bitiafooth davica. To faam how fo saf up and connact fo Bluafooth
davicas, saa “Connacting fo Davicas With Slusfooln”™ Widlass Technology”
on page 196

Here ara tips for working with a Blustocth hands-rese device:

To answer a call from a Blustocth hands-ree devics, prass the button on the hands-free
device when the phone rings. {If you answer a call from your Treg, the call audio stays on
your Treo, unless you transfer the call to your hands-free device)

To make a call using a Bluetooth hands-free device, enter the numiber on your Treo and
then press Phone/ Taf

To transfer a call from the handseat to a Blustooth hands-fres device during a call, press
Menu (— (right softkey) and select Connect Bluetooth. (To transfer the call back to the
handset, press Menu (— [ight softkey] and select Cancel Bluetooth)

Totransfer a call from a wired headset to a Bluetooth hands-free device, unplug the wired
headset and prass the button on thae Blustooth hands-free device.

If wou have more than one compatible Blustooth hands-ree devics, the ons you
connacted to your Treo last becomes the active device.
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Customizing Phone Setlings

Tum on your phone fo 2ocess your phone safiings. Sea *Tuming Your
Phone On and Off" on page 35,

Selecting Ringtones and Vibrate Seltings

You can st various tones for various types of incoming phone calls and notifications.

You can dowinload MP3, MID, QCELR, WAV and WA dnglones directy fo
your Treo (see *Downloading Fles and Images From a Wb Page” on
page 178 You can ako download dnghnes & your computar and than
email tham fo vour davice

1. Press Siart [&] and select Setiings.
2. Onthe Personaltab, select Sounds & Notifications (.3 .
3. Select the Notifications tab, - -
4 Select the Event list, and then select which type of call or
naotification you want to sat the ringtone for: Fot [T R |

Phone: Known Calter- The ringtone for an incoming

call from someone in your contact list or speed-dial list,
{The caller's name appears on the screen when you e T
receive the call) | vieate wren novpe swit oe

Phone: Missed cak: The natification tone for a call you [Fom.dick | |
did not answer, [ —

Phone: Roaming: The ringtone for a call that comes in when youre outside the
Sprint National Metwork,

Phone: Unfrown Caffer- The ringtone for an incoming call from someone who is
nat in your contact list or speed-dial list,

$O.MBe DUy
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10.

Phone: Voice malk:- Tha natification tone for a new voicemail,

Tio For the Missed call and Voice mail oplions. you can select sound and
dispiay opffons instead of ring fype and dnglone opfons.

Select the Ring ipe list, and then select the ring style for the selected type of call.
Select the Ring fone list, and then select the sound for the selected type of call,
(Cptional) Select Play [v] to preview the sound.

Chack the Vibrate when. .. boxes to tum the vibrate feature on or off based on the
Ringer switch seatting.

Repeat steps 4 through 7 to select ringtones for other types of calls.
Press O [@].

To racord, praview, dalats and sand sounds on your Trao, salact iha
Manage b To record & sound, press Menu (dght sofffey) and select New
Sound. To play a sound, salect it To dalak & sound, hightight if and prass
Backspace To send & sound, highlight i, pass Menu (right softiey), and
salectSend Sound.

You can aiso salect fonas for avents ofer than phone calls For example
salact 2 fone o faf you know when & new email message armvas, of whan
your Treo debects & wingless nefwork

Adiusting Volume Setltings

100

Calt volume:While a call is in progress, press the Volume button (on the side of your Tred)
to adjust the call volume,

Music/VMideo voiume: \While playing music or a video, press the Voftime button to adjust
the music/video volume.
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Ringer volume:When a call is not in progress and you are not playing music or a videg,
press the Vofume button to adjust the ringer volume.,

ll You can also el sounds for massaging nofifications and calendar
ramindars. Ses "Selectng Sounds & Nofficafons” on page 320

Assigning a Picture and Ringtone ID o a Contact
1. Gotoyour Today screen (see “Accessing Your Today Screen” on page 76).
2. Press Menu —— (right softkey) and selact Contacts.
3. Highlight the contact that you want to give a picture caller ID.
4. Press Menu — iright softkey) and select E4it
5. Select Picture.
£. Select Camera totake a picture and add it to this contact entry, or select an existing
picture for this contact entry.
7. Scroll down to the Ring fone field and then sealact a tone for this contact antry,

Selecting Your Call Settings
1. Press Star [#2] and select Setiings.
2. On the Personattab, selact Phone (.
3. 0Onthe Phone tab, set any of the following options: — T
Dialpad- Set the stye for the Dialpad tones (OTMWF)
when making calls. el - 2
Short fones:Seat tha tonas to sound briefly as you
el e T et v
Long fones: Set the tones to continue to sound S o
until vou release the key.
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Aftercalis from numbers that are not in Contacts, ast iff want fo add them: Sat
wheather yol are promptad to add contact entrias for numbears that are not already in
yiour Contacts list,

4. Prass OK [@] tofinish.

el If you have froubla acoassng a volcamall syskm, Iy changing the Dialpad
Wne saffing

Setting Your Dialing Preferences

Dialing preferences let you assign a prefix to your phone numbers. For example, you can
automatically dial a 1 before all 10-digit phone numbers, You can add a different prefix based
on the length of the phone number,

1. Press Start (8] and selact Seflings.
2. 0On the Personaltab, salect Phone .
3. Cnthe Diafing tab, set any of the following options: —

Diating from North America: Format phone numbers
using Morth American convantions (XXX T

and sat the International Dialing Prafix to 011, 1f you [#] Amays 33l 1~ ot of area coce
travel outside Morth America and service is available in
your location, remember to disable this option bafore

yviou place phone calls. Abbreviated Cishing
Atwaysdial T in fronfof areacode; Add a 1 infront of e | s oo | s

10-digit phone numbers, This option is available onlby
when Dialing from MNorth America is enabled.

International Diaffing Preffx, Add the speacified numiberin front of international phone
numbers when you dial from outside North America. (When you dial an
international number baginning with + [plus sign), the + is replaced by the number
in this field))

4. Press OK[&],
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Setting Your Abbreviated Dialing Preferences

Abbraviated dialing lets you simulate dialing numbers from your coffice’s phone system, so

that you can dial an extension number rather than the complate number,

For example, if your co-worker's phone number is 1-555-222-1234, you may need to dial only
the last five digits when you're Using a phone that's part of your company’s phone system. In
that case, you would dial 21234, If yvour co-worker’s phone number appears as 21234 in your
contact list or corporate Global Address List (GAL), your Treo can dial that number once you
configure abbreviated dialing settings to complate shortenad numbers, sothat you don't need
to modify wour office phone list,

For example, if all the phone numtbers in your office begin with 1-555-22, followad by a
five-digit extension, sat your Treo to automatically entar 1-555-22 as the prefix before any

five-digit number. When you dial your co-worker's five-digit extension, your device
automatically dials 1-555-22 plus the 5-digit extension. The complate number is

1-5655-222-1234.

1.
2. On the Personal tah, select Phone (.

3

4. Check the box that corresponds to the number of digits you

Fress Starf [a2] and select Settngs.

Select the Diating tab, and then select Abbreviated Diafing.

must dial (4, 5, 6, or 7y when you dial an extension.

Enter the prafix you want to add to the abbreviated
numbers.

. Press OK[@].
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Selecting Your Data Settings

1.

Press Starf [22] and selact Seftngs.

2. On the Personattab, selact Phone (.
3
4. Select any of the following:

Select the Sendcestab and then select Data Setéings

Do notaffow a voice caff o Inferrupt my data session:
Set whether you can receive calls during a Sprint
Paower Vision™ data session,

Altow connection to the Internet: Sat whether an
approval meassage appears each time you conneact to
the Internet.

|(J|Izwr Wuicesnail Toon |

5. Press OK [ @ | to return to Phone Settings.
5. Press OK [@] tafinish.
Sefecting Your Privacy Settings

1. Press Start [&] and salact Setiings. - =

2. 0On the Personaltah, select Phone .

3. Select the Senvicestab and Location Privacy. ittt

4 Set whether yvour Treo broadcasts your location at all times, [ Stk

or only during a 911 call, R —

5. Press OK [@] to return to Phone Setiings. ey

6. Press OK [@] to finish, [ o e |
For guick acaass i the Location Privacy seffing, &p the Location Privacy
icon on yvour Today scraan For mose infoarmation on e Localion Privacy
icon, e “Chadioing Signal Stength and Fhone Siaus” on page 107
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Selecting Your HAC Settings

Your Treo complies with Hearing Ald Compatibility (HAC) standards and includes an HAC
setting. If you use a hearing aid that is equippad with a telecoil and the HAC setting is on,
wour device sends the audio from your phone calls to the telecail rathar than to the

microphone of your hearing aid. ou are likely to hear calls much better because volurme is

increased and background noise and feedback are diminishad. The HAC setting improves
only the calls you listen to through the sarpiece. It does not affect calls heard on the
speakerphone or with a headsst HAC requires extra battery power, 50 watch your battery
consumption whean it's turned on,

Do not furm on the HAC saffing uniess you Use a heanng aid with 2 falecol
Lising this sefting Without & hearing ald or with 2 haaring aid without 2
lecoil may Be harmiul 1o your hearning.

1. Press Start [&] and select Seftings. — —rT

2. 0On the Personaltah, select Phone .

3. Selact the Servicestab and then select Hearing Aid
Compatibifity (HAC).

4 Indicate whether you want HAC set to On or Off,

5. Prass OK [@] to returm to Phone Settings.

6. Press OK [@] to finish.

Controliing Your Roaming Experience

“our devics is digital dual-band. This means that you can make and receive calls whils on the
Sprint Mational Network, It also means that you can connect to ather digital networks {called

roaming) it Sprint has implemented a roaming agreement with the network provider,
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When you roam outside the Sprint National Netwark, the Roarming g4 icon appears al the top
of your screen. Additional charges may apply if you use your Treo while roaming. To leam
more about roaming, visit winw.sorint com.

Feature Avaifability

“ou can make and raceive calls while roaming.
YoU can access voicemail while roaming.

Cther features that are standard on the Sprint Mational Metwork, such as call waiting, and
Sprint Power Yision, may be available depending upon your rcaming natwork,

Data services may not be availalble when you are rcaming on partnar natworks,

Setting Roaming Preferences

Use Roaming Preferences to set specific options for using your phone while roaming. For
example, you can set options to be naotified that you are roaming before placing a call or
making a data connection, so that you are aware that you might incur extra charges.

1
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Fress Starf [a7] and select Settngs.

2. On the Personaltab, select Phone (.
3
4. Select the Metwork sefecion list and select the networks

Select the Servicestab, and then select Roaming.

with which you want to allow your phone to make a
connaction:
Aftow roaming: Set your phone to determine the best
network—eaither home or roaming—with which to
connect,

Home networiconly, Set your phone to connect only to
the Nationwide Sprint PCS netwiork,

Roaming nefworks onfy, Set wour phone to connect to
roaming networks anly,
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5. Selact the following roaming warning options: e -
Before outgoing calls: Set an alert to appear, warning =
you that you are on a roaming network whean you
attemnpt to dial an outgoing call, (Select Auto, Always, or
fMever, Auto displays a warning whean you roam outside
the U5, and Atways displays a warning when you W esrocmireg, war: e
roarmn outside your home netwark) s ik
Before data connections: Prevent data connections

whila rcaming. (Select Automatic, Always, or Mever,
Atdomaitic displays a warning when you attempt 1o
make a data connaction while roaming cutside the LS, and Afways displays a

warning when you attermpt to make a data connection while roaming outside your
home network, To dismiss the warning and allow data connections, select the Dont
show this again. Alvays connectwhen roaming bad Yol can then attempt tomake a
data conneaction again, If you want to restore you previous roaming selaction, you

must return to this screen and select Atdfomatic or Always again.)
5. Prass OK[@].

Checking Signal Strength and Phone Status

You can monitor the status of the signal strength and several other items on your Treo, usi
icons at the top of your Joday scraan;

Sprint  Your phone is on and you're inside the Sprint Mational Network, If you are
outside a coverage area, No Service or Roaming appears instead. Mo Service
means that there is no coverage at all, and Roandng means that ancther

ng

wirgless service providers natwork is available, When you turn off your phone,

Phone Off appears.
w You missed an incoming call.
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“fou have a voicemail message.

“You have a new email message.

YoU have a new text message.

“ou have more than one of the preceding conditions.

An error occurred during synchronization.

Your phone is on. The bars display the signal strength. The stronger the signal,

the more bars that appear.

“our phone is on and you are outside a coverage area. To save battery power,
consider turning off your phone,

“our phone is off,

A call isin progress,

Acall is on hold.

You are outside a Sprint coverage area and are roaming on ancther wireless

senvice providers network,

“fou are outside an area that supponts data senvices, o your phone is off, and
therefore a data connection is not available.

You are in an area that supports mobile broadband (EVDO) data services.
EYDO (BEvolution Data Optimized) is a wireless broadband technology that is
designed for very high-speed data transter, with average download speads of
400 to 600KEbps. It is capable of reaching download speeds up to 3.2Mbps
and upload speeds up to 1.8MbEps.

“our phone is onand is connected to a mobile broadband network, but you
are nct actively transmitting data. You can still make and answer calls,
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“Your phone is on, and a mobile broadband data connection is active, You can
still make or answer calls, When you make or answer a call, the data
transmission is automatically interrupted,

ou are inan area that supponts Sprint 1¢RTT data services, The 1xRTT
(single-carriar [1x] radio transmission technology) wireless tachnology can
provide fast data transfer and Internet access with average speeds of 60 to
80Kbps and bursts up to 144kKbps.

Your phone is on and is connected to a Sprint 1xHTT network, but you are not
actively transmitting data. ou can still make and answer calls.

Your phone is on, and a Sprint 1:1TT data connection is active, When you
make or receive a call, the data transmission is automatically interrupted.

The Wi-F feature on your Treo is turned on, but you are nct connected 1o a
Wi-Fi network:

You have a Wi-F natification waiting, For example, it Wi-Fi is turmed on, and
you are not within rangs of a preferred naetwork, you can tap this icon 1o view
available netwarks,

Your Trao is connacted to a WI-Fi netwiork, and you are activaly transmitting
data.

Your Treo is connected to your computarn, and you are actively transmitting
data using your computer's Internat connection instead of a Sprint Power
Yision connection, You can still make and receive calls,

Synchronization is in progress with AdtiveSync® technology.
The battery is empty and needs to be charged.

The battary is 10w,

The battery is being charged.

The device is connected to a power source and the battery is fully charged.
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The battery is fully charged.

Location privacy setting is set to Locafon On “our location is available to

the Sprint network and to other applications. Tap the icon to quickly access the
L ocation privacy settings. See “Selecting Your Privacy Settings” on page 104
for additional information.

{ocation privacy setting is sat to 817 onfy. Your location is available to the Sprint
natwork during emergency calls only, Tap the icon to quickly access the
{Location privacy sattings, Ses “Selacting Your Privacy Settings” on page 104
for additional information.

An ffernet Sharing connection is active, To end the connection, tap this icon
and press fsconnect .—) (laft softkey). See “Setting Up an Internat
Connection With Your Computer” on page 116 for additional information.

An fmlernet Sharing connection is not active, To establish a connection, tap this
icon and press Confect (—) (left softkeyd. See “Setting Up an Internat
Connection With Your Computer” on page 116 for additional information.

The Bftetoothicon appears in gray whean this feature is off, in blus when this
feature is on, and as white with a blue B when your Treo is connected to
ancther Blustooth device. To quickly turn the Bitefooth feature on and off,
select the Bluetfooth icon to access the Giuetooth Selings screan,

A callis in progress and the call audiois on a Bluatooth hands-ree device that
is connected 1o your Treo,

You have a reminder., If you do not see the reminder on your Today screen, tap
the icon to open the reminder,

You have an alert from Microsoft, If you do not see the alert on your Today
screen, tap the icon to open the alert.
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Sprint Power Vision™ The Basics
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In This Section

Getling Started With Sprint Power Vision

Accessing Sprint Power Vision

Using Your Palm Treo 800w Smart Device as a Modem
Using Sprnt TV

lUsing Pocket BExpress
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Geltling Started With Sprint Power Vision

Sprint Power Vision™ provides wireless access 1o the Intemet anywhere on the Sprint National
Metwork, To sign up for Sprint Power Yision senvices or to access complete instructions, visit
wwnsprint com. For information on charges associated with features that use a Sprint Vision
connaction, refer to your Sprint service plan,

Enabiing Sprint Power Vision

1. Make sure that the phone of your Palm® Treo™ 800w smant device is turned on, as
dascribed in “Turning “our Phone Cn and Cff” on page 35,

2. Press Start [ 87 and select irfemet Explorerto open the Web browser,
3. Wait until the one-time setup process is complete.

. Press OK [@] to close fnfernet Explorer® Mobife and then reopen to bagin browsing the
Walb,

To see & connaction approval massage each fime You connact i the
Inkrnet go fo your Tod ay saean, prass Menu (fght soffey), and select
Freferences > Phone Settings. Safect the Services 28 and than salact
Data Settings Uncheck tha Allow connection to the Internet fox
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Accessing Sprint Power Vision

Onece your Treo is activated, you are signad in and ready to connect 1o Sprint Power Vision
services at any time.

Sprint Power Vision Usemame

Your Sprint Power Vision username is automatically assigned to you. Your username, which
resembles an email address (for example, name@sprintpes.com), 15 used with Sprint Mail
and Meassaging sarvices, Your Sprint Power Yision usarmame is simply an additional addrass
that identifies your Sprint Account. When your Treo is enabled with Sprint Power Vision
services, your usemame automatically appears on the Abouf screen.
To find your username:

1. Press Siarf [&2] and select Setings.

2. Seledt the System tah, and then select About ).

3. Selact the Phonetab, and then scroll down to Data user name.

Sprint Power Vision Symbols onh Your Screen

Whean you are connected to Sprint Power Vision services, a data conneaction icon appears at
the top of the Today screen. See “Checking Signal Strength and Phone Status™ on page 107
for a description of the various data connaction icons.

Sprint Power Vision Billing Information

See your service plan or contact Sprint for details on Sprint Power Vision billing.

Section 3A:- Sprint Power Vision™—The Basics 115
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Using Your Palm® Treo™ 800w Smart Device as a Modem

Internet Connection Sharing (ICS) is the feature that converts your Treo into a modem so that
wou can access the Internet from your laptop computer anywhere on the Sprint advanced
wireless high-speed data network, You can use this feature to send and receive email, browse
the Internet, and access your company’s network amywhere on the Sprint Mational Metwaork.

Mofe To tsa this servica you may be reguirad fo sfgn up on 2 Sprint Phore as
Modeam plan Go o www spoint com or visit & Spadnt Storg for Fhone &8s
Modam plan details and more information

Setting Up an Internet Connection With Your Computer

You can set up Internet Connection Sharing in one of two ways:
Connect your Treo to your computer using the USE sync cable
If vour computer is enabled with Bluetooth® wireless tachnology; you can set up your Treo
as a wireless modem using the built-in Bluetooth technology.

While your mobile broadband datz connaction is active, you can feoaive
incoMing cals and place oulgoing calls; however doing effher of these
suspands the dak connection uni you haing up the call

Sprint Fower Vision services are avaiabie on fhe Sprnt Nalional Network;
mobjje broadband (EVDO) sanicas work amavhana on tha Sprint Nafonal
MNetwork, but broadband-lie downioad speads are avaiizble only in acas
covered By the mobie broadband nefwork For information a bout mobile
broadband senicas i Your area, contact Sprint

To a=tup a USE fnfernet Sharing connecton:

1. Connect your Treo to your computer, using the sync cable. (f you're prompted to set up
synchronization, see “Satting Up Your Computer for Synchronization™ on page 46 for
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details, or you can cancel synchronization. The sync software is nat required when you
Use your device as a modam.)

2. Make sure the phone on your Treo is turned on (see “Turning Your Phone Cn and Cff”
on page 35) and that one of the data servicas icons (3 or (B4 appears at tha top of
the scraen. (f you don't sae eithar of these icons, then you cannct Use your Treo as a
modem.)

3. Onyour Treo, gotoyour Today screen (see “Accessing Your Today Screen” on page 76)
and select the fntermet Sharing 2., icon,
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Tin You can also open Infamef Sharing by pressing Start. selecting Programs,
and then salacking Internet Sharing.

Select the PC Connection list, and then select LISE, w

5. In the Network Connection list, maka sure that Power Vision =
is selected.

6. Press Connect — (l&ft softkey). (When your computer il
detects the connection, a connaction @ icon appears in I |
the taskbar in the lower-right corner of your computer P —
screen.) e wamr

T On your computar, open your YWab browser to confirm that
you can connact to the Intarnet, [ o
“ou now have an Internst connaction on your computer via your Treo, and you can do
anything you would do using your usual Internet connaction.
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To setup an interet Sharing connection with Bluetooth”™ wireless technology:

18

Creafe 2 partnership befwean your Treo and your compuler; and be sure fo
chaar the Make this device discoverahle to other devices box Wi
recommend that you inffiate the parfnership from your Treo (se "Saffing Up
& Blugtooth Connaclion™ on page 196,

Cn your computer, double-click the icon to open the Bluetooth connactions window,
{For instructions, check the documentation included with your computer)

Selact the option to view devices within rangea.

You should see an icon reprasenting your Treo, Double-click this icon to make sure that
“Metwork Accass Point” or “Personal Access Networking” or something similar appears
in the list of Blustocth services associated with your Treao.

Don't sa your Trao foon on the list of sendoas? Checx the documeanizfon
included with your computer, or contact your complitr mantfaciurer for
help Varous compular modals wse vadous rms for the Blieboh
coinnecton feafiras

You can also open infamef Sharing by pressing Start, selecing Programs,
and then salackng Internet Sharing,

Selact the PC Connection list, and thaen select Bluefooth PAN.
Press Connect (— (laft softkey) and follow the wizard to set up Internat Sharing.

Cn your computer, follow the steps to accept or enable a Blustooth PAN connection
with your Trec. Check the documentation included with your computer for instructions.

Cn your computar, double-click the Metwork AccessPointicon to estallish the Bluetooth
PAMN connection,
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9. After you have connected, on your computer, open your Web browser to confirm that
yoll can connect to the Intarnet.,

You now have an Internet connection on your computer via your Treo, and you can do
anything you would do using your usual Internet connection.

Using Sprint TV
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With Sprint Power Wision, you can watch live TV on the go right on your Treo, Accessing your
Sprint TY channels is as easy as using the remate control in your living room. Browse through
the available free channels or subscribe to one of the premium offerings. Wherever you go on
the Sprint Mational Network, you can get more out of your Sprint TV sarvice.

To access your Sprint TV channels:
Press Start [82] and select Programs
Select Sprnt TV B2
Select Sprint TV, Premitum Channets, or Sprint TV £n Vivo to procesd 1o the channel
listings.
4. Browse through the available programming and select a clip or channel to view the
prograrm.

The first fime you acoass 2 channal that reguias 2 subsaiplion, wou ae
prompled i purchase accass Selact Subscribe o purchase aocass, of
salect Preview fo saa & praviaw of the seleclad channgl
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Using Pocket Express

With Sprint Power Vision's exclusive Pocket BExpress feature, you can personalize the data
services on your Treo to suUit your neads, The Pocket Express feature makes it easier than ever
to retrieve the most popular Web information and categories instanthy. Pockat Express uses
the ZIP code you provide to customize the content you receive, 5o you can get the information
woLU want, when you want it

inftializing Your Pocket Express Service
1. Press Starf [#2] and select Programs
2. Selact GetPoctet Express 0
3. Selact View Terms & Condifions, review the terms for your account, and then press
oK [@],
4. Enter your preferred ZIF code.
5. Press fAgree (— (left scftkey).

£, When the Woukd you file fo add Pociet Express fo vour Today screen prompt appears,
press Yes (— (l&ft softkey) or press Mo — (night softkey). {If you press Mo, you can
access Pocket BExprass from the Programs folder)

T Wait for Pocket Express to retrieve information based on vour selected location,

Accessing Pocket Express information

Finding the information you're looking for with Pockat Express is as easy as navigating a Web
browser on your computer. (The following example illustrates how to access News
information,)

1. Press Start [22] and select Programs
2. Selact Poctet Express o
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If you selecled the opfion b add Focke! Eqprass b your Today screen, you
can zlso opan Pockat Exprass by sakbeting the Focket Bqpress icon on
your Today soean

3. Selact Brealing Mews Photos & Opinfon. (As you highlight a category nams, the
dascription expands. For example, whan highlightad the fews category becomes
Breafing News Photos & Opirdon,)

4. Depending on which category you select, a menu appears with additional options, (For
this example, you can ssalact from subcategorias such as Top News, US Neaws, World
MNews, Red's Blog, Today in History, Politics, etc.)

5. Select a subcategory, and then select an article, (The article is then displayed.)
£. Do any of the following to navigate through the content:
Scroll to the bottom of the screen to access options that allow you 1o go back,
view the full story email the link, view associated images, or select additional
navigation options.
Use the b-way to scroll through the article.
Select Back (at the bottom of the screen) to return to the article list,
Select Fuffto view the full article.
Select Maif to send a link to the article via email.
Selact PageOne to retum to the categony list,
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From the main screen, select and explore other categories, such as Weather, Sports, and
Money, and anjcy the feature-rich content, The Showbiz categony lets you see which maovies
are playing near you, including showtimes; for select theaters, you can even purchase tickets
right from your Treo,

In addition to the standard categories, you can select optional categories for a feg such as
Maps and TV Guide. Optional categories bring the information you want right 1o your scraen
without doing a traditional ¥Web search, For additional free and fes-based options, chack the
Extras page. Check in often to ses what's being offered.
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Updating Pocket Express Information

You can set Pocket Express to update news and information automatically, or you can retrieve
Updates manually.

To manually retieve updates:
From any Pocket Exress category page, select Updatfe at the battom of the screen.
To atformaticany retieve tpdates:

1. From any Pocket Express screen, press Ment — (right softkey) and select Express
Settings.

2. Select the Accountlist in the upper-laft cormner, and select Atfo-Updates.
3. Set the Fequency and Begin Time.
4. Press Done — fleft softkeyd.
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Section 3B

Using the Email Features

In This Section

Getting Started With Email

Getting Email and Microsoft Outlook  Information From Your Corporate Microsoft Exchange
Server

Setting Up an IMAP or FOP Email Account

Sending and Receiving Email Messages

Wibrking Wwith Email Messages

Wibrking Wwth Meeting Invitations

Sending Email Messages From Wthin Another Application
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Geltting Started With Email

Just like on your computer, you can choose between emall applications to manage your
amail. Your Palm® Treo™ 800w smart device includes two options for reading and sending
email. {Additional fees may apply for email services)

fnbox: Check email from your corporate BExchange saerver, from your POP/AMAP accounts
with wour ISP (Internat service provider), and from Internet mail accounts such as ACL or
Gmail (see “Setting Up an IMAP or POP Email Account” on page 130 or “Setting Up an
Bxchange Server Account” on page 126).

Windows Live: Check your Windows Live Hotmail account (see “Setting Up Windows Live
Mail” on page 165).

If you want to, you can set up more than one application to work with separate email
accounts,

You can mosie amall massages i varfolus formats, including HTML RTE
and piain ft IFyour amail provider offers 2 Web infarfaca, Wou Can 2150 Use
Internet Explorer Mohile o manage amaif from your Trao. To feam about
using Internet Explorer Mohile, see “Browsing fhe Weah" on paga 177,

If your email account raquines & WPN connaclion for estzBlishing & sacLine
connaction, your VAN sarver may reguire thaf you install spadific VPN
soffware (soid separakli on your Trao Before you 0an 200888 Yo U email
See “Connecting fo & VPN on page 341 for details.
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Getting Email and Microsoft® Outlook” Information From Your
Corporate Microsoft® Exchange Server

“ou can wirglessly synchronize emall, contacts, appointments, and other information on your
Treo with Microsoft® Bxchange Server.

Micrasoft® Direct Push Technology

[f wou are using Exchange Server 2007 or Exchange Server 2003 upgraded to Service
Pack 2, you may be able synchronize email wirelassly and take advantage of the additional
features of Microscft® Direct Push technol ogy:

Microscft Direct Push is a two-way wireless dalivery method that keeps your Cutlook
information always up-to-date and provides more afficient communication between the server
and your device It includes features such as Global Address List (GAL), Tasks Over The Air
(CTA), and IP-basad push updating of Microsoft® Outlook® information (nbox, Calendar,
Contacts, and Tasks).

For delivery of Cutlook email using Direct Push technology, make sure that your company
uses Microsoft® Exchange Senver 2007 or Microsoft® Exchange Server 2003 upgraded to
Senvice Pack 2, and ask your system administrator if synchronization features are enabled.
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Setting Up an Exchange Server Accournt

To wirslessy synchronize your Treo With an SXchange server, you must
achivate Sprint Power Vision data senices Soa *Enabling Spint Power
Viston™ on page 114 for mose information.

Wiortc with Wour system administraton fo gather fhe following informafion:
Bichange senver addrass and domain name.
Are the Exchange server seffings detactzbla?

S& ol connecion: Doas FoLr Sanar LSS 2n ancriplad (S5L)
connacton?

Yol USername and e ssword

+ Securily meastre: 15 it OK fo s your corporale emall password on
wour Tren?

Press Start (%] and select Programs

Select AciveSync (9.

. Press Menu —— (right softkey) and select Add ServerSowrce. (|f you see Configure
Server in the menu instead of Add Server Source, then your Exchange server account is
already set Up, and you do not need to complete the rest of the setup steps.)

Enter the emall address that you want to set up. —
5. Do either of the following, and then press Mext —— (right
softhkey).
If the BExchange server is detectable, keep the check in
the Atfempt fo detect Exchange Server Selings
automatically box,
If the BExchange sarver is not detectable, unchack the
Aftempt to detect BExchange Server Setlings
automaticatly box,
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6. Enter the Serveraddress check the This server requires anencnypled {(S5L) connection
b if your server Uses an encrypted connection; then press Mext c— (right scitkey).

If your Treo was zble i dekect the Elahange saver saffings, i soraan
doas not & poesn

7. Enter the username and password you use to access your corporate mail server, and
enter the Exchange server domain.

The Exchange Server saffings are case-sansifie. Ba stre fo enfer
uppercase and lowearczss laflers properly. Ba espadially careful when
anfenng the password, bacausa it doas not appaar on the sofean &5 you
anfer it Sea “Enkring Lowarcasse and Uppercase Lalfers” on page &4 and
“Enfesing Numbers, Puncluation, and Symbols” on page &5,

— T —

8. Do either of the following and then press Mext — (right softkey):
If yiou want 1o enter your password each time you access this account, uncheck the
Save passwond box,
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If you want your password entered automatically and your system administrator said
it is OK to store your password on your Treg, keep the cheack in the Save password
o

Tin For increased securnly you may nead v anfer yotr password each Tme your
BC0RSS YouUr amail

9. Check the baoxes for the types of information you want to sync with the Bxchange senver.

10, (Optionaly Highlight an item and select Setings to change the synchronization settings
for that type of information, (Prass OK [&] to return to the Edit Server Settings scraen)

If you want fo download more Hhan fe email massage header, salact
E-mail and increase the KB sifing I vou don't increass this saffing, you
can manually download the rest of the message af your convenienca.

Not all informafion iipes have safings.

CRIKK]S

s |
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1.

12

You can set a schadule for synchronization 1o take place anytime
information is updated on either your Treo or the server, or at
specific intervals, See the naxdt section for instructions on satting
wour sync schadule,

{Cptional) Prass Menu — (right softkey) and select

Advanced to set the rules for fixing sync conflicts, and then
press Save (— (right softkey). A R
Press Anish — (laft scitkey). (Synchronization with your

Exchange server bagins automatically, A status bar =
appears onscraen indicating sync prograss.)

Setting a Sync Schedule With an Exchange Sefver

Saf Up an Sxchangs Sarver email account See “Safiing Up an Exchange
Sanver Account” on page 126

Follow these steps 1o set yvour syne schadule;

1.

2
B
4

Press Start 2] and select Programs
. Select ActiveSync (.

Press Menu — (right softkey) and selact Scheduse. =
- Set your schedule for peak and off-peak timeas, (To it

conserve power, we recommend that you change your Syne crng
sattings to synchronize every 30 or 60 minutes instead of ' e
as items arrive.) ikl
Set your roaming preference. (|f roaming charges are not a | 7] s eIk
concern, selact Use above sefings when roaming.)

Fress OK [@].
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Setting Up an IMAP or POP Email Account

You can use the Inbax application (Microscft Cutlook Mobile) to send and receive email
messages. To use Inbag you must have an email account with an Internat service provider
{I5P), an email account that you access using a YPN server connection {such as a work
account), or any other IMAP (Internst Message Access Protocol) or POP (Post Cifice Protocal)
email account.

I Yot have multinle amai aGooUNEs, Wou must antar saffings for aa ch email
account

Setting Up inbox to Work With Common Providers

Use the following steps if vou have a commaon email provider such as ACL, EarthLink, Yahoo!
Mail Flus, or Grail, If you are satting up the Inbox application to work with your corporate
email account, or if you have a less-common email provider, see “Setting Up Inbax to Waork
With Cther Providers” on page 132

Astyour email provider o System administrator for Jour ZeCount Usemanme
and password Iif vou dor't know tham.

1. Make sure your phone is on (see “Turning Your Phone Cn M
and Cff" on page 35). P o

2. Prass mbox [&], £ ol ackdress:

3. Salact Setup E-mail :

4. Enter the email address and password for the email
account that you want 1o set up. fasword

5. If you want to enter vour password each time you acceass TR
this account, uncheck the Save password box (If you want M
yiolr password entered automatically, check this bax)
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6. Press Mext (— (right softkey). m‘-

7. Do either of the following: i Betgs 9
If the setup process finds your account sattings, prass A S o g

MNext — (right scftkey). Ty
If the setup process does not find your account
sattings, see “Satting Up Inbax to YWork With Cther

Providers™ on page 132 and continue with step 8 of

that procadure,

8. Enter your name and a name that identifies this account,
sUch as “A0L" and then prass Mext (— (right softkey). (Tha account names appears
on the Today screen along with the number of unread messages for this account,)

9. (Optional) Select sither of the following:

Automatic Send/Receive: Change the fime interval for automatically downloading
amall, from every five minutes to once a day. If you do not want to automatically
download massages, select Mantafy,

Review aft downioad sefiings: Select this link to change download settings; see
“Changing Email Download Settings” on page 149 for details.

10, Press Anfsh — (right scitkey).
1. If prompted, select OK to download messages for this account now.

ACCOLINT ciplay nanve: c -

T e for T 30T O T, Qe
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On the Accounts 26 in Inbox Options, an askisi appaars naxdt fo tha
aocount thal was aciie whean vou opanad hbox Opfions.

Setting Up inbox to Work With Cther Providers

You can set up an account in the Inbox application to send and receive email messageas,
using an email account that you have with an Interneat service provider (ISF), an email account
that you access using a VPN server connection (such as a work account; see “Connecting to
a VFN” on page 341), or any cther IMAP or POP email account,

Wik with wor emal provider or syskem adminisiaior o gefher e
foowing informafon: account ipe (POP3 or IWMAF, mail sanar name for
recalving maf, your usamame and password, and any specil securily

R LTI EE, GdinG whalher i L5 OF B Siong VoL pessvor an your
Treo

Maka sure your phone is on (see “Tuming Your Phone Cn and Cff” on page 35).
Press inbox [&2], -
Salact Sefup £-maif T

Enter the email address and password for the email £l pAke
account that you want to sat up. [myasecs mt@Esam|

5. I you want to enter vour password each time you access
this account, unchack the Save password box (f you want | pasword
your password entered automatically, chack this bax) ki |

Press Mext c— (right softkey, M

. Uncheck the Tryto gefe-malf seftings auformatically from the
fnfernet bax, and then press Mext (— (right softkey).

R
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8. Selact one of the following as your email provider, and then
press Mext (— (right softkey):

Internet e-maif- Selact this option if you access amail
from an Internet providers domain name, such as
aol.com.
Exchange server: Selact this option if you access email
from a corporate email account using an Exchange
sarver, and then go to “Setting Up an Exchange Seanver
Account” on page 126 for the remaining setup steps.

Customdomain: Select this option if you access email

Your ¢ ol provider:

[

from your own domain name, such as johndosdomain.com.

accolnt his opfion doas ot appear

You Gan set up multiole email aecounts, AUt you Gan saf up oy ong
EHChangs sener 2000unt I ol have already saf Up an EXchangs server

9. If you selected Custom domain in the previous step, enter your custom domain name,

and than press Mext c— (right softkey).

10, Enter your name and a name that identifies this account,
and then press Mext c— (right softkey). (For example, if
this is your work amail account, you can name the account
“Work™ or your compary’s name. The account display
name appears onthe Today screen along with the number
of unread messages for this account.),

Section 38- Using the Email Features

133

U



12
13,

4.
15.

18.

134

. Enter your incoming mail server address, select your

account type, and then press Mext r— (right scitkey).
Enter your account username and password.

If you want your password entered automatically, check the
Save password bod if you want 1o enter your password
each time you access this account, do not check this box
{For a corporate email account, ask your system
administrator if it is Ok to store your corporate email
password on your Treo. If it is nct Ok, don't check the Save
password box)

Press Mext (— (right softkend.
Enter the following outgoing mail settings:
Outgoing (SMTPY maif server: Enter the server name.

Quigoing server frequires atithentcation: Check the bax
if your outgoing mail senver requires authentication,
{se the same user name and password for sending
e-maif: Chack the box if the server requires you to use
your account username and password whean sending
amail.

(Cptional) Selact the Advanced ServerSetfings link, selact

I o
1o g mall serger
1 rrre. erech wen your proeder v et
T
Accown fype:
o= |

[l

il et g )

Andgaing (SM1E) mal server:

e e o T o e

Bl gund ey e Sally

[

the following settings, and then press Done — (left softkeyd:

Require S5 for incoming e-mai- Check the bax if your
account regquires S50 for incoming messages.
Require S5 for Outgoing e-maii- Chack the o if your
account requires SSL for outgoing messages.
Metwork connection: Select the type of connection to
use for sending and recering email.

i Sy o
Advainced Server Hettinds
[ mogare s e tncorea e ma
[ megore 55 i crgoma emal

Petwork o e tion:

[ e
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17, On the Cutgoing (SMTF) mail server screen, press Mext (— (right softkey).

18, (Optional) Sat any of the following:
Automatic Send/Recefve: Change the tima interval for |

ETR—— |

9

automatically sending and downloading email, from R e e
avery five minutes to once a day. If you do not want to
automatically download messages, select Manuafty. Autamatic Send Receve:
Review afl downioad sefiings: Select this link to
change download settings; see “Changing Email
Download Settings” on page 149 for information. e

19. Press Anish — [right scitkey). If prompted, selact OK to
download messages for this account now:.

To debb an amail account prass OK b close #he inbox appiication jf i is
opan. Frass Inbox, highiight the acoount vou want b dekk, prass Menu
{right soffikay], and than select Delete. (To dalate an Oullook Emal account
e the ActveSync” application, not the Inbox appliication) To editan
aeccouni—for exampie, if you naad fo changa ha namea of he oufgoing mail
server—prass Menu (right softiey) and sefect Tools = Ciptions, seledt the
accout, and prass Next (dght soffiey) b reach the soreans where you
want fo change the seffngs.
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Sending and Recelving Email Messages

Sefecting Which Emaif Accountto Use

[f wou st up more than one email account on your Treo (see “Geatting Staned With Email” on
page 1243, you can choose one of two ways to select the account that you want 1o uss 1o view
or send messages:

By default, when you open the Inbox application, a list of all your email accounts appears.
Select the account you want,

If wou turn off the option to display the list of accounts (ses “Customizing Your Nk
Sattings” on page 147), you see the last account you Usaed whean you opsan the Inbo
application. Press feft 4 or Right » to cycle through your accounts until the name of the
account you want appears in the title bar,

Tip You can also fo switch fo & different zocount affar Wou finish warking in the
first accountvou selackd Fom the message st prass Left or Right

Creating and Sending an Emaif Message

You can receive plain text and HTML messages.

136

1.

Press inbox 2],

2. Selact the account you want to use to send a meassage.
3
4 Do one cf the following 1o address the message:

Press Menu — (right softkey) and select MNew.

If the recipient's name and email address are in your Conacts list, enter the first few
latters of tha recipient’s first or last name, or the recipient’s first and last initials
separated by a space, and then select the recipient's name.

If the recipient's name is in an online address book, you can find the name and add
it. (For more information, see “Using an Online Address Book™ on page 142.)
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If the recipient's name and email address are not in your Contacts list, enter the full

amall address.

To addrass 3 massage o mulfiplk ecipiants, separak e addrasaas by
pressing Option + K fo enfer 2 samicolon (). To enfer an underscose () in
an addrass, press Alt and sekdct the underscore symbol fom the fist

5. Select Subject and enter atitle for the message.
Press Down w to goto the body of tha meassage.
Enter your message, or press Menu (— (right softkey),
select My Text and then select a predefined phrase you
want 1o insert.
8. (Optional) Press Menu (—) right softkey) and do any of
the following:
Selact fnsert select the type of item you want to attach,
and then select the file or record a voice note.

Select Spel! Chectc

LT u £
Ouned Bl
bwashiilcompany com
Files

When do you need these?|

P _H

Select Message Options select the Proriy list, select a setting for the message, and

then press OK [@],
9. Press Send (— (left softkey),

To save shrage spaee on your Tieo, fum off the opfion fo save sant
massagas in the Sent folder in the Inbox application, prass Menu (ight
softiay) and select Tools > Options Salect the Message 26 and then
uncheck the Keep copies of sentitems in Sent folder Hox.
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Receiving Email Messages
Howe you receive emall messages depends on the type of account ywou are using and how
wou synchronize:

Microsoft Bxchange ActiveSync®: New email messages are sent to your Treo whean they
appear onthe sarver, according to the schedule you sat up, or whean you manually iniiate
a sync (see “Sharing Information™ on page 300).

If you sync email with Microsoff® Scchange Sanver 2003 or 2007, you can
wnchronize massages in subfolders you areata in the Inbox appiicaiion,
prass Menu (right soffkal) and salzct Tools = Manage Folders Foldars
confzining subfolders display a plus sign (). Salect tha + o viaw fha
subfoldars Chack he box fo ha laff of iy subfoldar ol wanf o sync

If you synchronize email with Microsoff® Sxchange Saener 2007, and you
facelie & massage confzining a link o & documeant on Sha@Point or an
infenng) e saner vou can view the doctmeant by salacing the ik

Desidop synchronization software: If yvou synchronize your Treo with your computer,
messages in Microsoft Cutlook on your computer are transferred to your Treo when you
conneact your computer and your device (see “Synchronizing With a USE Connection™ on
page 50).
Al other POP or IMAP accounts These include ISP accounts and accounts yoU access
using a VPN server connection (typically a work account; see “Connecting to a VPN on
page 341). Message ratrieval depends on the option you chose from the Automatic
Send/Receive list during account setup (see “Setting Up Inbox to Work, With Common
Providers” on page 130 or “Setting Up Inbaoe to Work With Cther Providers” on page 132,
as follows:
If youchose a ime inferval-vour Treo automatically checks for and downloads new
meassages according tothat intansal,
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If youchose Manually: Follow these steps to send and receive messages:

Prass inbox [&].
2. Select the account for which you want 10 receive email messages.

3. Press Menu — (right softkey) and select Send/Receive 10 synchronize your Treo with

your email server,

Parfizily downioaded messages appesr in e massage list with & partizl
aifialopg foorn B the i of the subiect To viaw e full massage afffar
prassMenu (right softkey) and sefect Download Message, or open the
message and sefect Getthe rest of thismessage.

You Can Vel messages sent as HTML with the HTML formating intg of

Receiving Attachments
You can receive and open attachments in a number of different formats, including Word®,
Excel®, CnaMots®, PowarPoint®, ZIF, and POF. To receive and open attachments, do the
following:
1. Highlight the attachment name below the subject to mark it for download.

2. Synchronize the email account that contains the massage as describad in the pravious

sactions,
3. Selact the attachment name (below the subject) o open the attachment.

To store aifzchments on an expansion card, insart the card info the
axpansion cadd st on your Treo, prass Menu (right soffiey), and select
Tools = Options Salect Storage and chack ha Vihien available, use this

storage card to store attachments box
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Downloading Attachments Automatically
If wou are synchronizing with Cutlook on your computer and want to download attachments
automatically, do the following:
1. Press Start [#2] and select Programs

Select ActiveSync (.
Press Menu — (right softkey) and select Opfions.
Selact E-maff and than select Seffings.
Check the Inciude fite atiachments box.
(Optional) To automatically download attachments up to a certain size only, check the
Onty if smafter than box and enter the maximum attachment size,

7. Press OK [@].
To automatically download attachments from an IMAP4 email account (ypically an ISP
account) or an account that you access Using a WPN server connection (typically a work
account; see “Connecting to a WPN"™ on page 341), do the following:

1. Prass fnbox [E],

2. Do one of the following:

If you see the account list, press Menu (— (right scitkey) and select Opfions.

If you see the massage list for a specific account, press Menu (— (right scftkey)
and selact Toofs = Options.

S

On the Accourtis tab, select the IMAP4 account name.
Select Download Size Setiings.
Select the Message downfoad fmit list and select Entire message.

Select the Downfoad attachments list and then select aither Al atfachmenis or one of the
size limit options.

7. Press Done — laft softkend twice, and than press OK [&].

@ oW
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il Cmbeddad imagas ahd oblects cannot ba racaied as alfzchimants, Lnjess
wou have an MAPL amall account with TNEF disabled. Mofe that TNEF must
be enzbled in ofder for you o retaie mesting requasts.

Working With Email Messages

Adding a Contact From an Emaif Message

You can add a contact name or email address to your Contacts list directly from the To, eg, or
bee field of an email message. You can select the name or address from either an outgoing
or an incoming message, and you can either create a new contact or add the information to
an existing contact,

1. In an open meassage, highlight the name or address of the contact you want to add.
2. Press Center (). - -
3. Do sither of the following: _ +

Frider o ruamee..

Prass Menu —— (night softkey) and selact Mew
@ ey oo | 4 il vy ret [pvw ?
Contact to create a new contact entry for this name or = - CHEAT 'l',

address. & Add, My [
Select an existing contact to add the namea or address :zh::: .
tothe selected entry, 2| Do, Pad !_

8] Sk, tob

4 Enter or adit the contact information. w

5. Press Save (—) (left softkey).
Adding an Online Address Book

Mary email servers can verify names with an onling address book, also called a directony
service or a Global Address List (GAL), When you set up an BExchange Server account on
wour Trao, you automatically set Up access to the Global Addrass List for that Exchange
senvar, After you sync with the Exchange senver for the first time, the fnbox application checks
wour contact list and then the directory service to verify names that you enter in the o, Ce,
and Bee fields.
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f wour crganization provides an online address book but does not use Exchange Server,
follow the steps in this section to enable Inbow to verify the names that you enter in the To, Cg,
and Bee fields.

Ast your systm administrator for the name of the direclny sanvice and the
Sanier and whather authantication is raguined for 200a59NG 217 onling
address Book

1. In the message list, press Menu (— {right softkey) and select Tools > Options.
2. Selact the Address tab.
3. Select Add.
4 Enter the name of the Direclory service.
5. Enter the Server name.
6. If your server requires authentication, check the box and enter your username and
password,
{Optional) Check the Chectcname against fiifs server box to enable this directory service,
Prass OK[@ ],
Tin To debk g direciory sanvics, highight it prass and hold Center on the
S-way, and sekct Delete.
Using an Onfine Address Book

You can access contact information, such as an email address or phone number, from your
organization’s onling address book or Global Address List (GAL). To access a GAL make
siUre you are accessing either Microsoft BExchange Senver 2007 or Microscit Exchange Server
2003 upgraded to Service Pack 2.

Add accass fo an onling addrass book fo your Treo (see “Adding an Onling
Addrass Book™ on pegs 147)
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In a new message, selact To.
Press Menu — (right softkey) and select Add Recipient,
Press Menu — iright softkey) and select Company Direciory.

R

And — (laft softkeyd, (You must spell the contact name corractly)

[f wour organizations GAL uses abbraviated exiension numbers, you can set your Treo to

Enter the contact name (in part or in full) as it appears in the directony, and then press

automatically dial the complate number, See “Setting Your Abbraviated Dialing Prafarances”™

on page 103 for more information.

You can use the Global Addrass List b find 2 contact In Contacts prass
Menu fright sofffey), and then select Company Directary. Whean sending a
mealing raguast kot Attendees, salecf Add Required Attendee or Add
Ciptional Attendee, and fien prass Menu (righf sofffey), and salact
Company Directory.

Wihan Yol Syne yolr Microsoff OuBook amall 2ecount With wour computar
{25 opposad  wikkess sychromnizafon with an Schange saner, disabla
your oniing addrass books fo avoid errors. Frass Menu (ight soffey) and
slectTools = Options Select Address salecteach onlineg addrass ook,
and then uncheck the Check name againstthis server box Be sue fo Lim
this opfion back on if you syinchioniza otar emall accounis

Finding Messages

“ou can find massages containing a specific word or phrase, The find feature searchas

names, email addresses, and subjact linas.
1. Prass fnbox 2],
2. Selact the account yoL want,

3. Begin typing the word or phrase you want to find. (The list changes to show only those

messages containing the letters you enter, and those letters are highlighted.)
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4. Continue entering letters to narrow the list until the message you want appears.

el To chkar the search fitkr and display all messages for this account prass
Backspace

Using Links in Messages

When you receive atext or email message that containg a telsphone number, amail addrass,
or URL, you can dial the number, send an email message, or go to the Web page
immediately, Your Treo automatically opens the appropriate application from the link,

1. Select a message in the list,
2. Selact the phone number, email address, or URL (appears as underlinad blue texd).

Replyingto a Message
1. Open the massage to which you want to replhy.
2. Do one of the following:
To reply to only the sender of the message, press Reply (— (|&ft softkey).

To reply to all the recipients of the message, prass Menu — (right softkey) and
selact Heply = Reply AX.

3. Enter any text you want to add.

(Optional) Select AOR senders message to adit the original sender's message text that
you include in your reply.

5. Press Send (— (left softkey).

il if vou reply fo & message st as HTML the reply is sent in HTML ais0.
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Forwarding a Message
1. Open the massage you want to forward.
2. Press Menu ——) (right softkey) and select Reply = Forward.
3. Address the message and enter any text you want to add.
4. Prass Send (— (left scitkay).

Deleting Messages
You can delete a message you are reading, or you can delste one or more messages from
the message list.
To delete a message you are reading:
Press Menu — (right softkey) and select Defefe
To delate massages from the message list;

1. Highlight the message(s) you want to delete, (To highlight multiple messages, tap and
drag the stylus across the messages in the list)

2. Prass Defefe r— (&t softkey),
3. Select Yesto confirm the deletion.

Using inbox Shortcuts

You can perform common email tasks for messages you've receivaed by pressing and holding
cartain keys on the keyboard, Either highlight a message on the message list or open a
message from the list, and then press and hold any of the following:

Pressand
froid .. To..
H ' Wiew all email shortcuts.
I Reply to the sender of a message and to all cther recipients.
R I Reply to the sender only.
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Pressand
foid To..

Mark a massage as read or unread.

Flag a message as high pricrity,

Mowve a message between folders,

Forward a massagea.

Delate a message.

Fully download a parially downloaded message.

Synchronize your Treo with tha sarver to receaive and send new
messages.

Adding a Signature to Your Messages

You can use a different signature with each email account.
1. Prass fnbox [2],
2. Do one of the following:
If you see the account list, prass Menu (— (right scitkey) and selact Opffons.

If you see the massage list for a specific account, press Menu (— (right scftkey)
and select Tools > Opfons.

3. Onthe Accounts tab, select Signatures.
4 Select the account for which you want to create a signature,
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5. Check the Use signature with this account bax to add this M

signature to new messages yol create with this account, i

6. (Optionall Check the Use when replying and forwarding box. | e s
to add this signature to messages yvou reply to and fonward b >
with this account.

7. Highlight the text in the signature field at the bcotiom of the
screan, and enter the signature text you want to use.

8. Pross OK [@].

Customizing Your Inbox Settings

1. Press inbox [62],
2. Do one of the following:
If viou see the account list, press Menuy —— (right scitkey) and selact Opfions.

If you see the massage listfor a specific account, press Ment —— (Hight softkey)
and select Tools > Opfons.

3. Cnthe Accounts tab, et aither of the following options: w

Security: Sat whethar you receive a warning message
before you navigate toa LURL or a file link that is not on T 30 st e

your Treo, e |
Display account picker when opening fnbox: Set
whether a list of your email accounts appears when
you open the Inbox application, allowing you to select
tha one you want 1o use. (f the boxis unchecked, the | s e [sases e
Inbce application opens tothe last account you used.)

Ifthe Display account picker when opening Inbox box is unchackad, open
the nbox application and than rapeatadly prass Inbox or prass Left or Hight
on e S-way B oyoe rotgh Your 2 0oounts
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4. Select the Message tab and set any of the following options:
When repfying fo e-mall, include body:Set whether the
body of a message you received appears in your
response to that message.

Keep copies of sent items in Sentfoider: Set wheather
messages you send are stored in the Sent folder,

Warn when deleting messages in the message fist: Sat
whather a confirmation massage appears whan you
delete messages from the message list.

After deleting or moving a message: Seat what you

want to see after yvou delete or move an email message
yviou are reading: the account Inbox or the next message.

5. Selact the Address tab and set any of tha following options:

In Contacts, get e-malf addresses from: Set whathar w

yiou want to check Contacts in addition to any directony

services for email addrasses. 16 Criiacts et il s Exaei- e
Check names using these address books: Set which e . b
directory sendces you want to chack for email e .-”Imn._ |
addresses.

Add- Add directory services to the list of online address

hooks, ol:-..'fl"-‘!""'.‘.'-u: Ay _.:I-w_.-r
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6. Selact the Storage tab and set either of the following options:

When available, use this storage card to store

atlachments: Sat whathear yvou want to automatically
store email attachments on an expansion card. (You . I
must have a card inserted into the expansion card slot | =os s et

on your Treo to select this option.) R e a

Empty deleted ifems: Sslact fmmediately to have the s
Dalatad folder emptied anytime you delate a message, |
Selact On connect/disconnectto have the folder acconrts | s | A | oo
emptied amytimea you open or quit the Inb

application. (Select Manuafy to manually empty the

Deleted folder)

If you choosa by manually amply ha Dalatad folder, vou dajala massages
from this foldar in fhe same way fhat vou dejala any ofhar massagas (s
‘Delafing Wazsagas” on paga 145)

7. Press OK [@].,

Changing Bmail Download Seltings

“ou can customize the download options for each email account,
1. Prass fnbox [22],

2. Do one of the following:
If you see the account list, press Menu (—) (right scitkey) and select Opfions.

If you see the massage list for a specific account, press Ment (—) (right scftkey)

and selact Toofs = Options.
3. Select the email account you want,
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4. Do one of the following:
If you =ee the Corterts list, selact Send/Receive
Schedute.
If you see the Enter Emaklf Address screen, press Mext
— (right softkey) until you see the screen to the right,
5. Selact either of the following:
Automatic Send/Recelve: Set the time interval for
automatically downloading email, from every five
minutes to once a day. (f you do not want to
automatically download messages, select Manuatly,)

Auston ot Send oo

Ld|
Urowr o s
Froe e pest 34 .|

Downfoad messages: Set the number of days’ worth of email to be retrievad for

aach automatic or manual retriaval.

intenval for the Downloaded messages saffing

To save memory limit fhe number of emails vou download fo your Tieo By
selecting & long nfarval for the Automatic Send/ Receive seffing or & shorf

£. Selact Advanced Seftings and then selact any of the following:

Send/recelve when fcfick Send: Set whether yvou can manually send and receive
messages, in addition to automatically downloading them.

Use atfomatic send/recelve schedule when roaming:
Set whether automatic downloading takes place when
wioll are roaming. (This may result in higher connaction
charges than dovmloading while in your home
network,)

When delefing messages: Set whether messages
should be deleted from the mail senver when you
delate tham on your Treo, or whather messages you
delete on your device should remain on the server.

|&

Advanced Setlings
[ senecere wher

T s T o e wher
I

Wtaer ) chele g s s
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7. Press Done — {left softkey).
8. Prass NMext (— (right softken).
9. Select any of the following:

Message format: Sef the format for sending and M
receiving messages. (f you select HTIML, messages =rem o
sent toyou as HTML are received with their formatting R
intact, If you select Plain Text all messages are received | [0 _ -
as plain text) Mg dav o
Message dowrtoad fimit: Set the size of an incoming .....';-m,,.......u..ﬂ-,r.
message that is automatically downloaded, For any [Gorvrct Dot b =]
message that exceeds this size, you must manually
download the rest of the massage. (Selecting a higher M
limit means more of wour messages are fully

downloadead, but massage ratrieval might take longer, You can also choosa to
download message headers only, regardless of size)

Download attachments: Set whether attachments are automatically downloaded
with messages.

10, Press Anfsh (— (right softkey).

il Messages sant fo you as plain kixd are always recaived as plain kad, aven if
you select HThML

Setting Email Delivery Preferences
1. Press inbox [E2].
2. Select the email account you want,
3. Prass Menu —— (right softkey) and selact Defivery Preferences.
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4. Cn the Auto Sync tab, set any of the following:

Connectand chect for messages every: Sat how frequently the Inbox application
chacks for new email massageas.

Connectfion: Set which connection settings to use when checking for email, such
as Intarnat or Work,
5. Selact the Afferstab and set any of the following:

Cnly display messages from the fast { | day(s)-Set the number of days’ warth of
amail to be retrieved for each automatic or manual retrieval,

Get. .- Set whether to download the full message or only the message header.

Include [ J KB of message body: Set the size of an incoming message that is
automatically downloaded. For any message that exceeds this size, you must
manually download the rest of the message. (Setting a higher limit means that more
of your messages are fully downloaded, but message retrieval might take longer.
You can also choose to download message headers only, regardlass of size)

When getting fuff copy, get attachmenis: Set whether attachments are automatically
downloaded with the message text.

Onfy if smatfer than:-Limit the size of attachments that are downlcaded
automatically,

6. Press OK [@].
Working With Meeting Invitations

You can receive meaating invitations on your Trao in the same way that you receive amail
messages. Here are the key features of meeting invitations:

Meeting invitations appear on your Treo in the Inbox application, not in Calendar.

From within the Inbax application, you can accept, decling, or tentatively accept a meeting
invitation.

If wou accept an imdtation, the mesting shows up as an appointment in Calendar.
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“ou can reply to and forward meeting invitations in the same way as email messages.

You can create meating ndtalions on vour Teo; e “Sanding & Mesting
Requast” on page 244

Prass inbox [&].
Select the account you want,

oL by

Do either of the following:
To accept the invitation, press Accept — (laft softkey), selact whathar to adit
finclude comments with) your response, and then select OK

Select a meating invitation to open it. (Maeting invitations appear with this icon: B3

To decline or tentatively accept the invitation, press Memu —— (right softkey) and

select Deciine or Tentative,

If you fecaive an Updatad mealing imvialion, you Gan again chooss o
acoapt decling, or fantafivaly 2coapt If you moaie 2 maeafing cancalation,
you can prass Remove feff soffray) © dekik the meating from your
calendar

Sending Emall Messages From Within Another Application

“ou can send certain files as attachments from within the application where the file is created
or stored. For example, if you take a picture with the built-in camera, you can select an option
to send the picture as an attachment to an email message. You can also use this feature with

videos and sound files, For details, see the chapter on the specific application.

Your can send files such as Microsoft Offce documents (Wod, PowearPoint
Ena, 2nd Onanok), POF documeants, piclures wdaos, and dngionas 258
aftzchments fo amall messages (e "Cragling and Sanding an Email
NMessage” on page 136
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Using Messaging

In This Section

About Messaging
Sending and Receiving Messages
hanaging Your Messages

Customizing Your Messaging Settings

Using Windows Live™

Section 3C: Using Messaging

Section 3C
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About Messaging

Your Palm® Treo™ 800w smart device offers a few ways for vou to send and receive
messages:

SMS: Enables you to use the Messaging application to exchange brief tex messages with
other wireless devices and email addresses that support this form of messaging.

M- Enables you to exchange instant messages with friends and colleagues who use
Microsoft® wind ows Live™.

To exchanga insiant massa gas with peopla who wse ofher IM sarvicas, suah
28 Yahoo! and ACL, prass Start, sefact Programs and fhen safact Instant
Messaging. Sedect Yes fo dowmioad the appiication, and fhen prass Install
faff zoffey), o compiek e nstalafion When the sk fon is complas
prass Start, selectPrograms, and fhen selact Instant Messaging fo sign in
B wour N acoounis).

Before you use your Treo 1o send or receive massages, consult Sprint for pricing and
avallability of text and instant messaging, as well as for data services.

Make stire your phone s on and that you'e inskie 2 cowrage aes hafon
VOU By B Sand OF feceiie Massages,

This chapter describes the various messaging options and walks you through setting tham
up, so that you can use your Trec to send and receive messages.
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Sending and Recelving Messages

Creating and Sending a Text Message

Each text message can hold up to 160 characters, To save time, you can salect from
pradefined My Text phrases, such as “Call ma” or “On my way” You can add your own
My Text phrases, and if you prefer, you can enter the full message texd too.
1. Gotoyour foday screen {see “Accessing Your Today Screen” on page 76) and press
Messaging — (laft softkey),

You can also open e Massaging applicafion by prassing and holding
Option + Inbax, or By pressing Start, selecting Programs, and fen
salecting the Messaging jicon.

2. Press Mew (— (l&ft softkey),

3. Do one of the following to address the message: o =
If the recipient's name and wireless numbear are in your Sl aeerson (o
Contacts list, type the first few letters of the first or last
name, or simply enter the first initial, iollowed Ky a
space and then the last initial, to find a name. (You can
also enter the first few numbers of a contact's wirelass
phone number)

Prass Center () to view a list of recently used
addresses, and select the recipient from the list,
{Select Add Reciplentto add a recipient from your
Contacts list)

If the recipient's name and wireless number are not in your Confacts list, enter the
full wireless number {including area code) or email address.

Section 3C: Using Messaging 157

buibessepy



ol ankyr e recipian s Namea mars stig Vou sakect 2 phong number et
aooepts il massagas:

You Can also addiess & message o a rame that is in an onling address
book See *Using an Online Address Book” on page 142 for datalls

To address & massage b mulliple recipiants, separais the addressas with 2
samienlon (1F vou addness a sngle fad massaga fo e paopla Wou e
hillbd for three massages

4. Enter your message, or select @, and then select a pradefined phrase you want
to inser.

5. (Optional) Select (@ and then select an ematicon to add to your meassage.
£. Press Send (— (left softkey).

You can send and recaie it Moessages avan Whiks You a2 of 2 phona
call This is easiest when using & headset or the speakarphona

T Some Smbols can't be tsed in ket messa gas. hvalid characlrs ae
auomalicaily rapiacad by the Massaging application.

Setting Message Options

You can set options for individual text messages that yvou send.

You can st genersl preferencas hat apply o &l incoming and oulgoing
Massges (s "Cusiomizing Your Massaging Saffings” on paga T63) /f vou
saf opfons for an individual message, those opfions ovarride Your genaral
prefarancas for that message onfy

1. Onthe message compose screen, press Meny (— (nght softkey).
2. Selaect Message Options.
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3. Set the following options; T
Message Priorfty: Set this message as normal or
urgent.

Add Call Back number: Enter a number where the
recipient can call you back,

4. Press OK [@].

Receiving Text Messages

When your phone is on and you are in a wireless coverage area, you automatically receive
new text messages,

Message nolifcafions include the massage B unlass vou have fumed on
privacy mode (see Cushmizing Your Massaging Seffivgs” on page 1630 7
privacy moda is on, the nofifeation stakes only e dne of coming
massage.

The new message natification may include the following options:
View: Cpen a text message so you can view its full contents,

Dismiss: Close the natification and put the message intoyour
Inbosx.

A0H L5518 7
FM

If wou hawve multiple messages, the notification includes the
number of messages.

Tip The Messaging status fisid on e Today soraan also shows You ha
numbear of Urread Mmassagas.
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Viewing a Message
There are several ways to view a text massage.
1. Do one of the following to open a message:
From a nctification, selact Wew.
From the Today screen, select the Messaging siatus field, and then select the
message you want to view.
From the Today screen, press Messaging (— (left softkey) and then selact the
message you want 1o view:,
Press Start [ar], select Programs, select Messaging |, and then select the
message you want fo view.
2. (Optionall After you open the meassage, prass Meny — (right softkey) and selact an

itern to reply to the sender, reply to evenyone sent the message, forward the message,
call the sender, or add the sender's information to Contacts,

Using Messaging to Chat

When you exchangs more than one message with a single
contact, the messages you exchange with that person are
grouped into a chat session. When you select a chat session
from your massage list, the upper part of the screen displays all
the messages you've exchanged with this contact, and the lower R Y s R
part provides a text entry area. -
1. From your Messaging Inbax folder, do ane of the following:

Saart a new chat: Select a message and reply to it 2D ) ovwane 1 messaze

Confinue an existing chat- Selact a massage with the e

chat £ icon.

2. Enter your message.
3. Press Send (— (left softkey).
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Using Links in Messages

Whean you raceive a text message that contains a telephone number, email address, or URL,
wou can dial the number, send an email message, or goto the Web page immediately, Your

Treo automatically cpens the appropriate application from the link,
1. Open a message in the Inbak or ancther folder,
2. Select the phone number, email address, or URL (appears as underlined blue tex).

Managing Your Messages

Message Status lcons

The status icons that appear next to each message in the fnbox and Outbox indicate
the following:

&3 An unread text message.

A read text message.

. Multiple messages exchanged with a single racipient (chat).

[ Anurgent message. (This icon appears balow the message size
on the right side of the screen.)

Tip Unread messages appaar i bor Massagas youve read aprear in
falizie =V ed
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Sorting Your Messages

You can arrange the messages in any folder by date or sender.
1. Gotothe fbox or other folder you want to arrange.
2. Prass Menmu (— (right softkey) and selact Sorf,
3. Select ByDate or By MName.

Deleting a Single Message
1. Gotothe fbox or other folder containing the message you want to delate,
2. Highlight the message.
3. Press Menu — iright softkey) and select Defete
4. Select Yesto confirm the deletion.

Deleting Muftinle Messages T e |

1. Gotothe fbox or other folder containing the messages
yol want to delete,

2. Press Menu — (right scitkey) and select Puge.

3. Select the age of massages to be deleted, or select Delete
alf messages.

4. Select Puge (— lleft scftkey).
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Customizing Your Messaging Setlings

1. Gotoyour Today screen (see “Accessing Your Today Screen” on page 768) and press
Messaging — (laft softkey).

2. Prass Menu — (right scoftkey) and select Opfions.

3. Onthe Messages tab, st the following options:
Confirm message defefions: Set whather you see deletion confirmation messages.
Signature: Add a signature to outgoing messages. Selact the button; then, on the
Signature scresn, chack the Use signature with new messages bax, enter your
signature taxt, and press OK [&@],

4. Select the Chattab and set any of the following options:

Create chats from messages: Set the conditions under which a chat session starts.
Show iime stamps of each message: Set whether chat session items display a date

and time indicator,

5. Selact the Mofification tab and set whether notifications for a single incoming message

display the text of the message or only the massage type.

6. Press OK [@],

2 |r..~-.'l|p ahcabon |
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|l Cpfions Wou salect fr an indiidusl message (sae "Saffing Massaga
Opfions” on page 158) ovaride the opfons vou seifor all messages

Using Windows Live™

Windows Live is a set of services that combines online search featuras, amail, and instant
messaging:

Live Search for Windows Mobile®- A search application that enables you to find local
information such as maovie timas and traffic conditions, ou can also configure this
application to take advantage of the built-in GPS features on your Trao.
Windows [ Me Malf- The naxt generation of the Hotmail Web-based amail application.
Windows Live Mail offers more storage, greater message security, and easier filing of
messages,

Windows Live Messenger: An instant messaging application that enables you 1o see

whd's onling, to exchange instant messagas (M), to make calls to phones and computers
including video calls), and to exchange pictures and other filas.

Using Live Search for Windows Mobile®

164

1.

oo Lo b

o

Pross Start [22] and selact Programs.

Selact Live Search P27,

The first time you use Live Search, follow the onscresn prompts to initiate Use.
In the search bar at the top of the screen, enter the item you want to find.

Press Down w to highlight the location field, and press Leff < and Right » to scroll
through the location list, (To enter a new location, select the Choose a new focation link.)

Press Search — (left scitkey).

~ Select the item you want from the search results.
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Setting Up Windows Live Mai{

You must have an existing Hofmall accownt o use Windows Live Mail. If your
do nothave an account use the Wab Browser on vour Treo f go o

vy mobite ive comdhim and follow fhe steps o sef up an account

Fress Starf [&] and selact Programs.

Select Windows { ve &7,

Select Signin o Windows {ive.

The first time you sign in to Windows Live, press Accepf (— (l&ft softkey).

Enter your Hotmail email address and password. (Check the box if you want to have
your password entered automatically every time you log ing

U

Lhve v ndows L £
L

Siewn i bo Wirndows | e

E-mall addioss:
3 |
@ hotmall com |

Password

I | Sawe password

[ TINT J Sp——y

£, Press Mext — (laft softken).
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7. Set the following options: m—
Check the Live Search bar box to have the Live Search L.
bar appear on your Today scraan, ekl

Chack the Windows [ e services box to have Windows
Live Email and Windows Live Messenger appear on
your Today screen.

Press Mext — (left softkey.

Select which application information—contacts, Windows M

Live Messanger, and/or email—you want to synchronize

beatween the Windows Live mail server and Windows Live on your Treo, (For the
applications you chooss, any information that appears in your Hotmail/Windows Live
account on the Web—for example, your email messages and contact list—appears in
Windows Live on your Treo when you synchronize,)

MNote If you synchronize email your Windows Live email accouwnt also & ppesrs in
fhe Inbox application. If you synchronize contacts, your Windows Live
contacts also appaar in the Contots 2 pplication

10, Press MNext — (laft softkay),
1. Press Done (— (left softkey) to display your Windows Live main page.

You can ki change wour Windows Live saftip salecions Opan Windows
Live, prass Menu (right soffiay), and then sslect Options. Changs which
iams appezr on the Today sorean or which applicafions syng saf up a sune
Schedtig, and mo
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Using Windows Live Mail

Maka sue hat your phong is on and that youre inside & coverage aes (see
“Tuming Your Phona On and OFF on paga 35).

Press Start 2] and select Programs.

. Select Windows Live 7,

3. Tosynchronize email, contacts, and/or Windows Live Massangear information, prass
Right b or Left < until Syne is highlighted, and then press Center (. (Information is
synchronized for any of the three applications you selected during setup.)

4. Toread your email, goto your Windows Live main page, and select Mall. (The Inbax
application opens and displays your Windows Live mail)

You can view, send, and work with messages in your Windows Live account in the same way
as with messages for any other emall account (see “Using the Email Features” on page 123).

Using Windows Live Messenger

You musthave an exdsting Hofmai zocount b use Windows Live Messanger
If you do not have an accolnd, use the Web browser on vour Treo fo go fo
. moBialive comdAim and follow the sfaps fo sef Up an account Make
stire that your phone s on and fhat youre hside & coverage aes (ee
“Tuming Your Phona On and OFF on paga 35).

Press Start [2] and selact Programs.

Select Windows L ive &7,
Highlight Messanger by pressing Aight » or Left <, and than press Center ().
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4. Press Signin — (left softkey).

5. It you have not already set up a Windows Live Mail ,
account (see “Setting Up Windows Live Mail® on : =
page 165), the first time you sign in o Windows Live '- ‘ e - |-
Messenger, prass Accept (— (laft acftkay). .

£, If prompted, enter your Hotmail email address L
and password. : B

7. Tosand an instant message to a contact who s

onling, highlight the contact name and press [ S

Send v — (left softkey).

If the contact you want is offing, send an emal massa ga inshead. Highlight
the contzctname and prass Send e-rmail Jeff soffey). Enfer 2 subject and
body faxt for the email message, and then press Send (leff sofffey),

8. Do any of the following:
Enter text- Highlight the text entry bar and entar your massage texd,
Record a vokce note: Prass Yoikce cffp —) (left scftkey) and record a voice note by
speaking clearly with your Treo held up and facing you.
Add anemoficon o your message: Press Menu —— (right softkey), salect Add
emoficon, and then select the emacticon you want.
Add a picture or other file: Press Menu (— [right softkey), select Send, selact

the type of file you want to send, and then capture or selaect the picture or other
file you want.,
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" Text Entry Bar

9. Press Send (— (left softkey).

10, (Optional) To exchange messageas with more than one person, press Ment —)
{right softkey), select Oplons = Add participant and then select the participant you
want to add.

11. To end the massaging session, press Menu (— (right softkey) and select End
conversation. (|f vou are exchanging meassages with more than one person, selact
£nd all corversations to stop all the sessions at once,)

Fom fhe Messangar cont cis ist soaan, prass Menu (ight soffrey) and
sailact oplions fo add, block, or ramove 2 conBel change your staius fo
Susy Away, and o on; a0d 2 display piciure or personal message; and

mose
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Section 3D

Browsing the Web

In This Section

Viewing a\veb Page
Wibrking Wth Favorites
Whorking With Wieb Pages

Customizing Your Internet Explorer Mobile Settings

Searching the Wveb From Your Today Screen

To browse the Web, vou must activate Sprint Power Vision™ data services (see “Enabling
Sprint Power Wision™ on page 1149, or you must establish a connection to a Wi-Fi network
{see “Connecting to a Wi-Fi MNetwork” on page 188).

Internet Explorer® Mobile provides quick and easy access to Web pages. You can view most
of the sites you use on your computer, including those with security and advanced features,
such as JavaScript and frames. Internat Explorer Mobile supponts JavaSceript, Secure Socksts
Layer (35L), and cookies, but does naot suppont plug-ins (Flash, Shockwave, and so on) or
Java applets.

@
g
3
z
S
=
[
3
&

For addifional information on feafurss supporked by inkmet Sgalonr Mobie,
VIS Wy iGrosoff com.
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Viewing a Web Page

By default, Intermet Explorer Mobile scales Web page content to fit your Palm® Treo™ 800w
sman device screen sothat you can view most of the information without scrolling left or right,

You can also strta Wab search fom your Today screan by salecting the
WVieh Search fiald, enfering the fam vouwant o Snd, and then prassing
Center o the S-way.

Make sure your phone is on (see “Tuming Your Phone On and Off” on page 35).
2. Press Start [82] and selact infermet Sxplorer,

el You can alzo open Internet Bxplorer &y pressing and holding Ciption +
Phonel Talk.

3. Highlight the address ling, enter the address of the
YWab page you want to view, and than press Center ().
{If you browse to a secure Web page, the Lockicon in
the address line appears closed instead of open.) i -

4. Press Ment — (right softkey), selact View, and then _
select any of the following: . .
Foom Level- Set the size of the text and images on .

Web pages. '

One Cofumn: Display Web pages in one column that is [ P ——

as wide as the screen, so that you don't have to scroll
harizontally,

Fitto Screen: Maintain a layout similar to what you see on a deskiop computer, but
iterms appear smaller and the content is arranged so that you can see most of it
without scrolling horizontally,
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Destdop: Keep the same layout and size as on a deskiop computer, which requires
bath horizontal and vertical scrolling.

Fult Screen: Hide the title bar and toolbar and fill the entire screen with the contents
of the Web page.

Show Pictures: Show or hide pictures on Web pages. (Hiding pictures speeds up
the time it takes to load pages)

5. Do any of the following:

To view the previous page, press Back (— (left softkey) or Backspace -/,

To refrash the page with the latest contant from the Internet, prass Meny — (right
softkey) and select Refresh

To scroll through the page, press Up o or Down w. {In Desfdop view, press Up
Down w, Left <, and Right » 1o scrall in all directions.)
To follow a link to another Wab page, press Up o or Down w to highlight the link,

and then press Cenfer () to goto the selected page, (You can also tap the link on
the screen with your stylus.)

To send 2 ik o the curant Wab paga prass Menu (right soffliel) and
selectTools > Send Link Sekdt fhe Inhox or Messaging account you
wantfo tse o sand the fink

To view a Web page’s properties, press Mend r— (right softkey) and selact
Toots = Properties.

To view each iterm in a list, tap the list with your stylus.

i
e
3
z
S
=
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In a list, press Down «» or Left < to cycle between items, and press Cemter ()
to make a selection.

In aform, such as a browser search field, press Center () to interact with the form,
and then press Center () to stop interacting with the form.
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Your can send emai from & Web page. Email addressas & poear 28 links on
Wiab pages. Afkr you configus an emall applicalon on your Tao, you Gan
sglact an emaill fink fo create & message b send fo that addrass.

6. Prass OK (@] to cdose infernet Explorer Moblie,
To radurn fo g recan iy viawed paga, salact fha address line list and than
prass Down. Use the S-way fo aalecta Web addrass from the list

The secunily cardificates and 128 bit SSL strong encryplion jef you browse
sEoure s such as onling shopping, banking and amail Remembear that
SoMme Sectie Siks also reguine specific Browsars aind may not wonk with
Inkrnet Egolosar Mobila, Ask the organizafion for an alferna e Web addrass
(LRL) that is compatibl with ket Sgrloser Mobile

Working With Favorites

Favorites lets you bookmark a YWeb page so that you can instantly accass it without entering
the Web address, If you set up synchronization with the deskiop sync software, your favorites
synchronize by default,

To getfavories from the Web Browser on your compuitar info the Wab
browsar on your Treo, justadd hem b the Mobile Favorites folder, which
shows Lo it your compukrs browsas When you sinc, they become
available on your Treo a5 well Backip copies of any Bvorkes that vou add
on fre Treo browser ae also siored in the Mobile Favormis folder.
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Creating a fFavortte

Create the folders whem you want (o shre your favodias Once you aeaka
favosits, vou can't move Jf fo anoter folder

Gotothe page you want to mark as a favorite. -
Press Menu (— {right softkey) and select Add fo Favorites.
(Optional) Select Mame and enter a different description.

(Optional) Select Create in and select the folder where you
want to create the favorite.

5. Select Add. e

Viewing a Favorite ;—f L

1. Press Start [22] and select fnfermet Explorer,
2. Press Ravorfies — (eft softkey),

3. Press Down w 1o highlight the page you want to view in the list, and then press
Center () to go 1o the selected page.

R

Organizing Your Favorites

You can create folders for organizing your favorites. For example, you can store travel links in
one folder, stock links in ancther, and businass links in a third folder.

Press Start 2] and select infermet Explorer.

Press Favorfles (—) (left softkey).

Select the AddiDelete tab.

Select Mew Foider,

Enter a name for this folder, and then press OK [@],

i
e
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To dekk z favodia or foldar, salact Favarites faff soffiay). Safact the
Add/Delete &b highlight the flam vou want fo dekl, and than sgact
Delete. Sejact Yes b confirm the dejafon, and then prass OK

Working With Web Pages

Downloading Files and images From a Web Page

You can download files that are usable on your Treo, such as new applications, MIDI
ringtones, or pictures that are specifically tagged for download.

1. Gotothe page that contaings the link to the item you want to download.
2. Do either of the following:

To download a file, press Left < or Right I 1o highlight the link to the file, press
Cenfer (), and then select Save As.

To download an image, tap and hold the image, select Save fmage, and then
selact Save As.

3. Select Mame and enter a new name for the file,

4 Select the focation list, and thaen select where you want to store the file;
Main memory or Storage card.

5. Selact the Fofder list, and then select the folder where you want 1o save the file,
6. Select Save.

Copying Text From a Web Page

You can copy text from a YWeb page and paste it in other applications.
1. Use the stylus to highlight the text you want to copy.
2. Press Menu —— (right softkey) and selact £EGff = Copy.

3. Gotothe application in which you want to paste the text, and then position the cursor at
the location where you want to paste the text.
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4. Press Menu (— (right softkey) and select Edit > Paste.

el Yoir can copy the et from the entine Web paga Tap and hold the page, and
wlect SelectAll Text Tap and hold the page again and select Copy.

Using the Histoiy List
The History list stores the addresses of the pages you visited recantly,
1. Press Menu (—) (right scitkey) and select Toofs > History,

2. (Optional) Select the Page Tifke list in the upper-left corner, and then select how you
want to sort the History list,

3. Select the Web page you want to view,

el For difarma §on on dleading the History st see "Cusfomizing Your inkmet
Eipboses™ Mobile Seffngs” on page 177

Customizing Your internet Explorer® Mobile Settings

1. Press Menu — (right scftkey) and select Tools 2> Options.
2. 0Onthe Generaftab, set the following options:

Home Page: Set tha page that appears whan you opan | Me~r=r

[ Garrant ] [ e ettt

Internat Explorer Mobile, (To usae the page you were on
when you opened the menu, select Use Current To
selact the original Sprint Power Vision home page,
select Use Default)

Encoding: et the character set for the Web pages
YOLI Wigw,

i
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3. Selact the Memonytab and set any of the following options: ——

Save finks fo pages visited In the past: Set how many
days of activity the History list storas,

Clear History: Empty the History list.

Delete Ales: Remove saved pages and Web files that
you viewed or synchronized with your computer,

4 Select the Securffy tab and sat any of tha following options:
Affow coofdes: Sat whathar your Treo accepts cockias
{small files containing information about your identity
and preferances). (The page sends thefile and stores it | seskie
on your Treo) St W oW |
Cilear Coofties: Delete any cookias stored on your Treo.

Warn when changing fo a page that Is not secure: Set
whether a message appears when you switch from a
securs page to one that is not secure, SN[ RISV | RS
Warn when page content is blocked due o security
seftings: Set whether a massage appears when you
attemnpt to open a page that doas not meaet the security standards of your Treo.

5. Press OK [@].

srcurity settiig

[ T when SRAran T [agR Il 1
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Searching the Web From Your Today Screen

Meed tofind information quickly? Search the Web directly from your Today screen,

1. Make sure your phone is turned on and that you are inside a coverage area (see
“Turning Your Phone On and Off" on page 35).

Gotovour Today screen (see “Accessing Your Today Scresn” on page 76).
Select the Live Search field and enter the word or phrase you want to find.
Press Search (— (left scftkey).

Use the S-wayto scroll through the results, and select the selact the information you're
looking for.

L

" Live Search Field
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Using GPS

In This Section

Finding a Point of Interest
Using Maps
Using SprintMNavigation

Section 3E: Using GPS

Section 3E
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Finding a Point of Inferest

The next time vou find yourself in unfamiliar territon you can use your Palm® Treo™ 800w
sman device to get directions to a contact’s address, find the nearest pizza place, or view a
map of the area.

Maka sure Locafon Privacy is saf fo Locafon On Go fo your Tod ay screan
and prass Menu (right soffey). Select Preferences = Phone Settings.
Salact the Services f2h seject Location FPrivacy, and then maka sure
Location On is saleckd,

Finding a Point of Interest Near Your Cuirent Location

1. Make sure your phone is turned on and that you are inside a coverage area (see
“Turning Your Phone On and Off" on page 35).

2. Gotovyour foday screen (see “Accessing Your Today Screen” on page 76).

3. Selact the Point of fmferest lookup field and enter the type of place you want to find. For
example, to find a pizza place, enter pizza; to find a post office, enter post office; or to
find an automated teller machine, antar ATM)

4. Press Center ().

" Point of Interest Field
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Finding a Point of Interest Near Another Location

1. Make sure your phone is turned on and that viou are inside a coverage area

fsee “Turning Your Fhone Cn and COff” on page 35).
2. Gotoyour Today screen.

3. Selact the Point of inferest lookup field and enter the type of
place you want to find. (For example, tofind a pizza place,
enter pizza; to find a post office, enter postoffice; or to find
an automatic teller maching, enter ATM)

4. Select the list next to the Point of iferest lookup field and
select Near other tocafion 10 opan the Maps application.

5. In the Maps application, enter the zip code, city, stats, or
address you want to use for your search,

6. Press And (— (left softkay).

Section 3E: Using GPS
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Using Maps

Mz stra Locafon Privacy £5 saf o Locafon On Go fo your Tod ay saaan
and prass Menu (ight softhey). Select Freferences > Phone Settings.
Select the Services fzh sefect Location Frivacy, and then make sue
Location Cn is saackd

1. Maka sure your phons is tumed on and that you are inside a coverage area (see
“Turning Your Phone G and Cff” on page 35).

Press Start [&] and select Programs
Salact Maps @)

Do one of the following: M

Select the Map a streef address link, enter the address
informaticon, and then press Map (— (laft softkeyd,

Sealact the Map a confactsaddress link, salact the
contact, and then press And (— (left softkey).

Select the Map your currentiocation link.

Selact the Map a recentfocaffon list, and select a L
A s Type | 10 200 1 30 O 00 Z00M out Trym |
location from the list, | —— y
Tin You can aiso find diraclions fo 2 confacts addrass fom the Today sowen

e “Vawing & Map of 8 Confacls Addness” on page 2400,
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Using Sprint Navigalion

Sprint Navigation is a GPS navigation system that gives you turn-by-turn directions by map
and by voice right from your Treo. Get audible GPS directions for an appointment, a sales call,
or even a coffes shop close by, Sprint Mavigation requires a monthly subscription. Contact
Sprint for information and rates.

Mzt stra Locz fon Priivacy is saf o Locafon On Go fo yvour Tod ay saaan
and prass Menu (right softhey). Select Freferences > Phone Settings
Salact the Services 28 salect Location Frivacy, and then mate sure that
Location Cn is salackd.

Saring Maviga fon is powered By Talanay sakellifes For oplimum
perfonmance, wse Sprint Naviga fon oulioors of dlose fo & window. The
Salellife signal is diminished when vour Teo isindoors. Also, hold the
hofforn portion of your Treo @ avold Blocking the infernal anfenng, which is
locatad in the upper Bhid of your Trao.

3. Follow the onscreen prompts to download the software and establish a subscription.

4 After you set up a subscription, and your account is T —
verfied, press Go — {right softkey) to continue. Sprint Navigation

5. Usethe &d-wayto select the icon that best describes what \
you want to do: ; L

Diive To: Get turn-by-turn driving instructions o a

spedific location, | ] f’

Maps & Traffic: View a map and traffic information for aTRAFRC 2 6xen

your current location or ancther location of your choice,

DRIVE TO SEARCH
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Search: Locate nearby services, such as the most inexpensive gas station in the
area or the closest bank or ATM,

Toofs & Extra: Set Sprint Navigation options and to access other tools. For example
VioU can view a compass and assign your current location a name, such as home.

The Exemal GRS seffngs described in *Seffing Up an Edarngl GRS Device”
on page 3537 do nofaffect Sprint Navigation.
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Using Wireless Connections

In This Section

Connecting to aw-Fi Metwork
Connecting to Devices With Bluetooth WWreless Technology

Beaming Information With IR

Section 3F: Using Wireless Connections
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Connecting to a Wi-F Network

Many ervironments, such as corporate offices, coffee shops, airports, and libraries cffer
access toa Wi-Fi network, A WI-Fi network s a wireless local area network (WLAN) that is
based on the 80211b/g standard. When you're within range of an accessible Wi-FI netwaork,
WoU can use the Wi-Fi feature of your Palm® Treo™ 800w smart device to connect to that
network and access the Web.

Why Use a Wi-F Connection?

AW connection is especially helpful in the following situations:
You're outside a coverage area and you want to access the Web.

Your Sprint service plan incurs additional charges for data services and you
want to minimize data service charges by using a Wi-Fi connection instead.

Youre inside a coverage area but outside a Sprint Mobile Broadband Netwiork,
& Wi-F connaction may provide faster throughput than a 1:3RTT data connaction,)

“ou want to maintain a Weab connection while talking on the phone

You can use a WER connection for scheduled synchronization with an
Lxchange saniar but vou must use e Sonint Mobie SroadBand Nafuo fo
fake advantage of Microsoff Direct Push fachinology for wialass
synchronization with an Echange senver

Are there different types of Wi-Fi networks?

There are two types of Wi-Fi natworks:

Open networtts: These networks broadcast their name (SS5I0) and do not require you to
enter a password or cther settings. To learn how to connect to an open network, see
“Connecting to an COpen Network™ on page 190,
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Secure networtts: These networks may broadcast their name, but at the very least, they
may also require you to enter a password that you get from a system administrator,
Secure networks may also require you 1o gat other network settings from the system
administrator and enter them during setup. To learm how to connect to a secure natwork,
see “Connecting to a Secure Network” on page 191, If you've already set up a connection
toa secure network and want to reconnect tot, see “Connecting to an Open MNetwork” on
page 190.
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V-Fi access point also calied 2 hofspot) A nelvork device with an
antenna that provides wiralass connections o & &rger nelwork

Tutning the Wi-fH Feature On and Off

*
[ O
; =] @[]« |
| [
\_n | o
* Wi-Fi button

To turn Wi-Fi on, press Wi-H (=
To turn Wi-Fi off, press and hold W-FF =

“ou can adjust the WAH Prefs saettings to keep Wi-Fi on all the time. See “Customizing Wi-Fi
Settings” on page 194 for details.
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Wi-Fi Status lcons

The Wi-Fiicon on your Today screen indicates the status of the Wi-Fi feature.

i The Wi-Fi feature on your Treo is tumad on, but you are not connected 1o a Wi-Fi
network,

(i) You have a Wi-Fi naotification waiting. For exampls, it Wi-F is turned on and you are
notwithin range of a praferred network, you can tap this icon to view available
networks.

(.i)"’ Your Treo is connected to a Wi-Fi naetwork, and you are actively transmitting data.

‘:

Connectingto ah Open Netwaork

You can connect to an open network or to a secure network for which you already set up a

connection, If you have access to multiple Wi-Fi networks, you can select which network you
want to connact 1o,

The WEP (wired eguivalant prive o) enarypion meathod is anabled by dafault
and may inkrfare with your abiily i connect o & nafwork tat broadcasts
it name S "Connecling 0 2 Sectire Melvork™ on page 167 & Jazm how
o disabie WEP encrpio n

Press WA (=] on the top of your Treo. (Your Treo scans for available networks and
automatically connects when possible)

You can narow or expend the st of nefvoris that sppear on the Configurs
Wirakess Nefworkes soreen. Select the Networks to access list, and ten
Solact the e of nefworks Yol want fo viaw

If your device was not able to automatically connedt, the Configure Wireless MNetworks
screen appears; highlight the network to which you want 1o connect,
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netwiork,

3. Press Connect (— {l&ft softkey) to connect to the selected Eiﬁ”‘i L ﬂ

4. Do one of the following:
If Connected appears next to the network name, you
are ready 1o use the Wi-Fi connection. (For example,

open fntermet Explorer” Mobile to browse the Wab) im0

If yiou are prompted to enter network settings, continue
with step 3 in the next section,
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Some locations, such as airports and coffee shops, provide an

open network, but charge a fee to use it. After yvou connact your Treo to the network, you need
to open Internat Explorer Mobile and register with the Wi-Fi service provider before you can
browse the Web.

Conneclingto a Seclire Netwoik

To set up a connection to a secure network, do the following:
1. Press Wi-H (=1 on the top of your Treo. (Your device scans for available networks and
automatically connacts when possibla)
2. When the Configure Wireless Network screen appears, do one of the following:

Highlight the network to which you want to conned, press Cohnect —) (eft
softkey), and then skip ahead to step 4 to enter security settings for the selected
network,

Select Add Mew if the network you want to connect to does not appear in the list.
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3. Enter the following settings, and then press Mext (— (right scftkey):
Metwork name: If this field is blank, enter the SSID
provided by the systermn administrator, (This field is case
sensitive)

Connects fo- Set whather this network connects tothe | ceeee [Tre et -
Internat or to Work, (vou may need to select Work to (] hes s 2
accass 4 corporate intranat) [l resaside ooty
This is a hidden networf If you had to enter the
network name, this is a hidden network, Chack this boix
to connect to this network now and in the future. [ ——
This is a device-to-device {ad-hoc) connection: Leave

this box uncheckad if you're connacting to a network (Wi-Fi access point), (Chack
this box only if youre connacting to ancther device.)

4 Enter the following settings, and then press Mext (— (right softkey):
Authentication: Zet the method used to identify
devices that connect to the network:

Open: The network Uses open authentication.
Shared: The network uses shared authentication.
WPA: The network is a WPA network that uses e
802.1x protocols. I TR
WPA-PSK: The network is a WPA network that

requires a password that is shared between the -:ﬁil el

network and your Treo. This password is also
known as a pre-sharad kay (PSK).

WPAZ: The network provides government grade security with an AES
encryption algorithim.

WPAZ-PSK: The network is a YWPAZ network that requires a pra-shared key:
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Data Encryption: Set the encryption method. (The options in this list vary based on
your Authenfication setting.)

Disabled: Turn data encryption off.
WEP: Turmn on the Wired Equivalent Privacy encryption method.

TRIP: Turn on the Temporal Key Integrity Protocol encryption method. (This
method is often used to encrypt WPA and WPA-PSK connections.)

AES: Turn onthe Advanced Encryption Standard protocol. (This method is often
Used to encrypt WPRA, WRA-PSIK, WPAZ, and WPAZ-PSK connections.)

The ey is automatcally provided: Sat whether you need to specify the network key
and key index provided by your system administrator, or whether the network
provides this information. The availability of these options varies based on your
Authentication and Data Encryption settings.

Metworlc ke y- Enter the Metwortckey provided by your systemn administrator, if it is not
automatically provided by the netwaork, The availability of this option varies based on
yvour Authenfication and Data Encryption sattings.

Keyindex:-Enter the Reyindex provided by vour system ii’ﬁ o T -
administrator, if it is not automatically provided By the s Nrtwek Ataton )

network, The availakility of this option wvaries based on [ ot o e mtwin i
your Authentication and Data Encryption sattings. e e |

=
l1e]
3
&
g
e
=
=
yv]
=
S
i

5. Enter the following settings, and then press Anish —
fright softkey):

Use fEEE 802 Tx network access controf: Set thase
parameatars if required by the natwork,

EAP fype- Set the Extensibla Authentication Protocol [
type.
6. Press OK [@].

If you also need b crezle & custom secunly carfficale see "Customizing
W5 Seffings” on page 184 for instrucions.
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Disconnecting From a Wi-Fi Network

To disconnect from a Wi-Fi network, do one of the following:

To save any settings you enterad, press and hold W-H =1 to disconnect from the Wi-Fi
network, The next timea you're within range and the Wi-Fi feature is turned on, your Treo
automatically connects to this naetwork,

Press Start [a2], select Seffings, select tha Connecfions tab, and then selact Wi-FF =,
Highlight the network from which you want to disconneact, and then prass Disconnect
— (left scitkay).

To remove the network settings from memaory, press Menu (— (right softkey) and select

Remove Sefings. The nexd time yol're within rangs and the Wi-Fi feature is turned on, you
must re-create the connection to connact to this natworl:

Customizing Wi-Fi Settings
1. Press Siart [&] and select Setiings.
2. Select the Comnections tab, and then select WA Prefs '§'. |
3. On the Powertab, set any of the following: e
Enabie Power Save Mode: Conserve battery power o

whean Wi-Fi is turned on. For optimum battany
performancs, leave this option enabled.
Connection: Set when the Wi-Fi feature is on and when
your Treo attemnpts to search for netwarks.
On Button Press: Leava the Wi-Fi feature off until you
press WI-F (=] to turn it on. After you turn the Wi-Fi feature on, your Treo searches
for available networks.
Atways On: Leave the Wi-Fi feature on, our Treo searches for available
networks whenever the screen is awake, If a network to which you previously
connected is available, your device automatically connects o that natwork, To

prevent your Treo from searching for networks, press and hold WA [=1to turn
the Wi-Fi feature off.

£
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Scan: Search for available Wi-Fi networks. If your Treo locates an available
network, you can connect ta it
4. Select the Detallstab to view information about an active Wi-Fi connection.

5. It the network you want to connect to requirss a custom > =
certificate, select the Enroff tab and set the following:

User: Enter your username for access to this Wi-Fi )
natwaork, —
Password: Entar your password, Skt

Server: Enter the name of the Intaret Information |
Server ([IS) that storas the security certificate

informaticon for this network, o e S -
Refrieve Cerfificate: Cbtain the security cenificate for “
this Wi-F network,

6. Press OK [@].
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Beiess Camloan

ASH ot nelwars administator for your usamamea, password, and sener
name for the WA natiwork you want i 2c0ass:
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Connecting to Devices With Bluetooth® Wireless Technology

With the Bluatooth® wireless tachnology feature of your Trao, you can connect to a number of
Blustocth devices, such as a headsat, printer, other phones and handhelds, and more. For a
list of hands-free devices with Blustooth wireless technology that are compatible with your
Treo, go to palm.comAreo 800w sprint-support,

[f wour computer is enabled with Bluatooth wireless technology, you can also synchnonize
wirelesshy,

The Bluetooth status icon

The Blustocth icon on your Today screen indicates the status of the Blustocth featura:;

O Bluetooth off,
0 Blusatooth on.

I:g.] Connected to a Bluetooth device.

N

|ﬁ'} Call in progress with a Blustocth hands-free device,

Setting Up a Bluetooth Connection

After you set up a connaction with a Blustocth device, you can communicate with that davice
whenever it is within range and the Blustooth feature on your Treo is turnad on. Bluetocth
range is up to 30 feat (10 meters). Performance and range are affectad by physical obstacles,
radio interference from nearty slectronic equipment, and othar factors,
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1. lf necessary, prepare the device you want to connect with 10
accept a new connection. (Check the device's
documentation for details) o

2. Gotoyour foday screen (see “Accessing Your Today
Scraen” on page 76), and than tap Bluetooth £3.

3. Select the Mode tab and check the Tum on Bitetooih box
to turn on the Blustooth feature on your Treo. (Wait about |
10 seconds for the Bluatooth featurs to activate,) e el

4. lf you're setting up a connection with a computer, check the [

Mafe this device discoverable fo other devices bax
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To pravent unwankd devicas from connadching fo your Treo, leave e Make
the device visible to other devices box unchecked axcapt whan yolre
connecing with & compuler o recaiing information fom another davica

Select the Devices tab, and then select Add new device.
Wait for your Treo to search for devices and to display the device list,
Select the device you want to connect with, and then press Mext (— (right scitkey),

If you're prompted to anter a passkey, antar the same passkey on your Treo and on the
other Blustooth device, and then press Mext (— [right scitkey).

@ o~ o

Some Bluatooth davicas have & pradefined passtay Jf vour Bluaiooth
davice has & predefined passkay your Tieo atiempts o entyr the passey
for you If the atiampt is unstccassiul, vou can find the predefined passiey
in e documentzton for youwr Bluefoo device

Other Blustooth davices provide & sorean where vou ener & passhay that
You make up. in aifher a8, you must s the same passiay on Both vour
Treo and e Blusooth davice W recommend thal whene possibla you
maka up & passkey of 16 alphanumeric characlers laffers and humerals
onty) fo improve the securify of your Treo. The longer the passiay, the mone
ditfctlt it is for he passkay fo be dadiphard.
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9. Prass Done — (laft softkey), and then press OK [@],

YoU can now communicate with this device whenever it is within range and the Bluetooth
feature on your Treo is turned on. The range varies greathy;, depending on ervironmental
factors. The maximum is about 30 feset (10 meters),

To modify or dolef an esihiishad parfnarshin with 2 devics go fo he
Bluetooth Settings soean and salact Devices Highiight the connaciion
you want fo change or remove, prass and hold Center on fhe S-way, and
than selact Edit or Delete. A daletad devica can no longer aufomafically
connect with your Treo,

Sending Information Over a Bluetooth Conneclion

You can send an individual entry or file, Eiﬁ = u

1. Maka surathe raceiving device is ready 10 raceive a
Blustocth connection.

Highlight the entry or file you want to send. Tos bty sebent v,

Press Menu — (right softkey) and select Beam. (f you
don't see a Beam command, select Send ... > Beam :
instead. The Beam and Send menu items change nameas
based on the type of itam you highlightad.)

4 Select the receiving device in the list,

[

When the transmission is complete, Done appears next to thae name of the receiving device.

Tio Checl your ballary laval bafora astablishing a Biugfooth connaction If tha
batery laval is fow you can't make & Bluatoofh connaclion.
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Receiving Information Over a Bluetooth Connection

1. Gotoyour Today screen, and then tap Bluetooth €3,

2. Selact the Mode tab and check the Twm on Biuetooth box to turn on the Bluetooth
feature on your Trao.

3. It you haven't already set Up a partnership with the transmitting devics, check the Mafe
this device discoverable to otherdevices bax to lat the device find your Treo and request
a connection.
Fress OK [@],

5. When your Treo s receiving information, a notification tells you that a transmission is in
progress. (To stop the transmission, press Cancef (— [eft softkay]; to close the
notification, press Dismiss — [right softkey])
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If youi hava froubla racaning information over 2 Bluafooh connaction prass
Start and salect Settings Select fhe Connections &b and than salact
Beam Mate sure the Feceive allincoming heams box is chacied.

Remamber fo unchad the Make the device visible to other devices box
whan you are done recaiving information fom he ofher devics

Synchronizing Over a Bluetooth Connection

Maka sufe Vour compliar is equipped with Blushoth wirdlass fachnojogy
and that your computer is saf up for synchronization See ‘Saffing Lip Your
Compuiar for Synchronizabon” on page 46

1. Set up your computer for Blustocth wireless communication, (For details, see the
documentation that came with your computer, In most cases your computer must
support the Virtual Serial Port profile, and this profile must be turned on.)

2. Set up the Microsoff® ActiveSync® softwara on your computer for Bluetocth wiraless
communication. See ActiveSync Help on your computer for details,
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Go to your Today screen, and then tap Bluetooth €3,

Selact the Mode tab and check the Tum on Bietooth box to tum on the Blusatooth
feature on your Treo.

Prass OK [@].

Fress Starf [a7] and select Programs

Select AciveSyne (9.

Press Menu — iright softkey) and select Connect via Bitetooth,

If this is the first time yol're making a Bluetooth connection to this computer, follow the
onscreen prompts to set up a Bluetooth partnership with this computer.

Salect Syne.

~ When synchronization has finished, press Menu — (right softkey) and select

Disconnect Biuetooifi,

Wi-F rotifars, microwayas, and Wirsless Riephionas using the 24GHZ band
may inferfare with Siuatooth connactions. For bast rastlts, mowe away from
this eguipment when making & Blusb ath connection. If you cannot move
away, move the Bluetooth devices closer fo improve the reception.

Beaming Information With IR

Your Treo is aguippad with an IR (infrared) port that lets you beam information to ancther
device that has an IR port. The IR port is located on the side of your device closest to the
stylus, near the top.

200
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For bast rastlfs, the path bafiwesn fhe fwo devicas must be clear of
obstzoks and both devicas must be kept stafonany If vou have difficulty
beaming, shorken the distance and avoid bright sunfght

The tvpe of informafion you can Beam dapends on fhe pe of davics vou
are beaming . Ofher Windows Mobie® 67 Professional devices ae
compaiible with vour Treo,

Beaming aRecord

1. Highlight the entry or file you want to beam.

2. Press Menu ——) (right softkey) and select Beam. (If you don't see a Beam command,
selact Send > Beaminstead. The Beam and Send meanu items change names basad
on the type of item you highlighted.)

3. Point the IR port on your Treo directly at the IR port of the w
receiving device.

4. YWhenthe name of the receiving device appears, select it to
begin the transfer. T ey it vk,

5. Waitfor “Done” to appear next 1o the name of tha receiving | 7%
deavice before you continue using your Treo.

milts, Yy

EA——
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Receiving Beamed Information
1. Turn on your screen,
2. Point the IR port on your Treo directly at the IR port on the transmitting device.
3. When the Recelving Data message appears, select Yes to receive the baam.

If you can't recae baamed informalion, prass Start and select Settings
Sekct the Connections b and then select Beam Mate sure fe Receive
allincoming bearmns box is checked. If vou a8 can't recaive information, iy
& Soff resef (see 'Reselfing Your Paim™ Treo™ 800w Smart Device™ on

page 349)

Synchronizing Over an infrared Connection

1. Set up your computer to receive infrared beams. (See AcliveSync Hefp on your
computer for details.)

Point the IR port on your Trao directly at the IR port on your computar,
Cn your Treo, press Starf [& | and select Programs.

Select AciveSyne (.

Press Menu — (right softkey) and select Connect via iR,

Select Syne.

S
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Section 4

Your Portable Media Device

Sprint ~ ahead
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Synchronizing Your Media Files

In This Section

Synchronizing Your Pictures, Videos, and Music

Synchronizing Pictures, Videos, and Music: Windows XP

Synchronizing Pictures, Videos, and Music: Windows Vista

Section 4A- Synchronizing Your Media Hies

Section 4A
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Synchronizing Your Pictures, Videos, and Music

You can synchronize pictures, videos, and music files between your Palm® Treo™ 800w
sman device and your computer, How synchronization happens, however, depends on two
conditions:
Syne direction: Are you transferring the files from your Treo to your computer or from your
computer toyour Treo?

Operaling systermn: Do you use Windows XP or Windows Vista®?

Mot Thass procaduas do mot apphy i flas in your Windows Madiz™ Plaver
fibrary Sea 'Synchronizing Windows Maoia™ Flayer Lifrary Sias” on
page 227 for details on synchronizing your Kibrarny flas

Hp For best resulfs, use Windows Madiz Playver o sine vouwr music fles—for
both Windows XP and Windows Vista compurs.

Synchronizing Pictures, Videos, and Music: Windows XP

Do the following to synchronize pictures, videos, and music files that you capiure on or copy
to vour Trao,

Mnstal Microsoff ActhesSinc® dasdop soffware from tha Gatling Starkad CD
for Paim Trao 800w smart devica (see “Instaling ActivesSync® Destdop
Soffwara Windons 0P on pags 46
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1. Sync as you normally would with the ActiveSync deskiop software (see “Using the
Desktop Sync Software” on page 48 for details).

2 Tofind synchronized pictures and videos on your computer, go to: C-\Documents and
Setiings\<Lisermame>Wly Documents\<device name>My Doctiments This folder has
subfolders for My Music, My Pictures, and My Vidaos.

Do the following to sync pictures, videos, and music files that ordginats on your computar,
1. Connect your Treo to your computer with the USE syne cable,

Most Activas e daskion soffwarg oplions are avaiiabla anly whan your
Tao iz comachd b your compuks

2. On your computer, doubla-click the [T

ActiveSync (O icon inthe taskbar in the - - =
lower-right cornaer of your computer screen 1o »
open the ActivaSync deskiop software window: (If
you don't see the ActiveSyne icon in the tasklar,

click Start = A#f Programs > Microsoft ActiveSync

to open the ActiveSync wind ows)

3. Under imformation Type, double-click Fies 1o view
a list of the files in the Files sync folder, (If wou
dom't see the Files option, open the Toofs menu, -
select Oplions, and make sure the Fes boxis
checked.)

4. Do any of the following:

To copy a file from your computer to your Treg, click Add, browse to and highlight
the file, and then click Open.

To delete a file from tha Files sync folder on your computer and from your Treo,
highlight the file namea and click Remove.

s

[%2]
3
=
)
=
&
el
&
5
S

>

Section 4A: Synchronizing Your Media Hies 207



Ifyou frecaive an erfor white simchronizing fles, make sure that all of the fies
vou'a frying f swne are dosad on both your computar and on your Trao.

If & Treo My Documents Sync folder has Bean created O Jour Gomputes;
VOU CaI 350 $ine By diagaing fles into the appropniate subfidar Lndar
that foldar

Synchronizing Pictures, Videos, and Music: Windows Vista®

Do the following to synchronize pictures, videos, and music files that you capture on or copy
o vour Treo,

208
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Make stire Windows Mobile Device Centar is MSEIaG o Jour Compiar
e *Saffing Lo Windows Mobie Davice Cantar: Windows Vista™ on
page 47).

Connect your Treo to your computer with the USE sync cable.

If Windows Mobile Device Center does not open automatically, on your computer, click
Start > Al Programs = Wind ows Mobife Device Center.

Select Connect without selting Up your device.

Select Pictures, Music and Video.

Salact X new plclures/video clips are avallable for import,

{Optional) Add a tag name for the pictures and videos you are importing.
Click fmport

Tofind all synchronized (imported) pictures and videos on your computar, click Start =
Pictures, or go to: CAlksers\<Username>\Pictures
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Each fimea wou import piciires and vidaos fom your Tao, Wind oms o bits
Device Cenfer crezles g subfolder in the Picturas folder based on the
curantdate and any g vou sakect duing the import procass

To synchronize music files that originate on yvour Treo, and pictures, videos, and music files
that originate on vour computar, use Windows Media Player (see “Synchronizing Windows
Media® Player Library Files” on page 227).
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Section 4B

Working With Your Pictures and Videos

In This Section

About Your Camera

Taking Pictures and Videos
Wiewing Pictures and Mideos
Sending Fictures and Videos
Organizing Fictures and Videos

Using a Ricture as the Today Screen Background
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Editing Pictures

Customizing Your Rctures &Videos Settings
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About Your Camera

Your Palm® Treo™ 800w smart device comeas with an easy-to-use, built-in, 2.0-megapixel
camera with 2x digital zoom. You can use the camera 1o take and view pictures and videos
and send them to your friends and family. To add a personal touch to your Trag, use your
pictures as your Today screen background and as caller ID images.

Taking Pictures and Videos

Taking a Picture

By default, pictures are stored in the My Pictures folder on your Treo. If you want to store your
piciures on an expansion card (sold separately), you can change where pictures are stored
{see “Customizing Your Pictures & Videos Settings” on page 222). For information on
accessing your pictures on your computer, see “Synchronizing “Your Media Files” on

page 205,

Picturas i capiured and stored in TE-BIt colon, PG format Rasoiufon
saffings range from & low and of 160720 pivals fo 2 high end of TEOQ0T200
piels, You can change the defaulf sefling. See "Customizing Your Picliues &
Videos Saffings” on page 222 for details

1. Press Start [ 8] and selact Plotures & Videos.

2. Select Camera || (If you see a camcorder g icon below the praview imaga, video
mode is on. To turn on the still camera, press Menti .—) (ight softkey) and select S

You can also acoess the camera featune by pressing Option + Start,
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3. Aim your Treg, as you would any camera, to frame the
sUbject in the device’s screen. (Your Treo has a self-porrait
mirror next to the camera lens on the back of your device.
Use the mirror when you're taking a picture or video and
wiol want to be in the picture too)

4. (Optional) Adjust any of the following:

Zoom: Press Up 4 to zoom in, or Down w to zoom
oL,

Brightness: Press Right b to increase the brightness,
S0 youU can take pictures in low-light environments, or press Leff < (o decrease the
brightness.

Resolfution: Press Menu — (right scftkey) and

select Resoftfion 1o change the image guality,

Tip You can also adiust the room and Brighhess by pressing Menu and
slectng Zoom or Brightness

5. (Optional) Set a five-second timer; Press Ment (— (right scitkey), select Mode, and
then select Thmer,
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Press Center () to capture the picture or start the timer,

Hold your Treo still until the picture rendars, and then press OK [@] to save the picturs,
or press Ment — (right softkey) and selact Defete to discard the pictura.

8. Do either of the following:
Press Center () to take ancther picture,
Prass Thumbnais (— (aft softkey) to return to Thumbnalis view:,

l Afer thiee minutas of macivify when you are previewing an image he
camers goas inf sEndby mode Prass any Ky or tap the soreen o relum
o the image praview.
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Taking Pictures in Burst Mode

Burstmode takes five pictures in quick succession, with one button press. Burst mode is
particularly usaful for taking pictures of situations where thera is movemeant, for example, while
photographing childran, sports, or animals.

1. Press Start [a2] and select Piciures & Videos.

2. Press Camera — (l&ft softkey).

3. Press Menu — (right softkey) and select Mode > Burst
4. Press Center ().

Recording a Video

By default, you can capture 30-second videos and store them in the My Pictures folder on
your Treo, |f you want to store your videos on an expansion card or capture longer videos
{provided you have ample storage space), see “Customizing Your Pictures & Videos Settings”
on page 222 to change your video saettings, For information on transterring your videos to
your computer, see “Synchronizing ~our Media Files” on page 205, Videos are capturad and
stored in 3G2 format. Video resolution settings range from 176 x 144 pixels to 320 x 240
pixels.

You must have QuIcKTIma Flayer varsion 6.5 or fatar insBied on your
computer o piay vidaos racordad by your Trao,

1. Press Start [#2] and select Plotures & Videos.
2. Select Camera le]|.
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3. Press Menu — iright softkey) and select Video.

4 Alm your Treo, as you would any camera, to frame your
subjact in the device’s screan.

5. {Optional) Adjust the following settings:
Brighiness: Press Right & to increase the brightnass or
Leff < 1o decrease the brightness.

Resofution:-Prass Menu —) (right softkey) and selact
Gualfty to change the video resolution.

Press Center () to start recording.
To stop recording, press Sfop — (left scitkey) or Cenler ).
Press Thumbnalls —— (left scftkey) to return to Thumbnalls view,

{Optionalh To review the video in Windows Media®Player Mobile, highlight the video in
Thumbnaits view, and then press Play (— (left softkey) or Center (). (Press OK [@] to
return to Thumbnais view.)

L

Tin I you o't it 2 vidao you racorded, dek it See *Dalaling & Pictie of
Video” on page 221 for details
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gl I you pause o ur racording for more than thiee mintts the rooding is
stopped and the video oip is awomatically saved.
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Viewing Pictures and Videos

Viewing a Picture

I addition to viewing the pictures you capture with the built-in camera, you can view pictures
that are capturad on many popular digital camearas or downloaded from tha Intarnet, Your
Treo supports the following picture formats:

JPG, JPEG, JPE

GIF

BMP

WEMP

PHG
1. Press Start (8] and select Pictures & Videos.
2. Selact the picture you want 1o viaw:,
3. Press OK [@] to return to Thumbnaifs view,

Tin To view picturas that ase stored in & difierant foldar select the list in the
uppar-alt comern and than selacttha album vou want i view

Viewing a Video

[ addition to viewing the videos you capture with the built-in camera, you can view videos
capturad on many popular digital cameras or streamed from Web sites, Your Treo supports
MPEG-4, H.264, H.263, and Windows Meadia videos with the following file extensions:

P4 (M4

3GPP (B3GR

3GPR2 (3G2)

Windows Madia (WY, ASF)
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Press Start [82] and select Pletures & Videos.

2. Selact the vidso you want o view, (For more information on viewing videos, ses “Playing
Media Files”™ on page 229.)

3 Press OK [@] to return to Thumbnalils view,

Tip To View videos that are shorad in & different folder, selact e list in he
upesaft cormen, and han salect the aiBum you want b view

Viewing a Sfide Show
You can view your piciures as a slide show on your Treo, Each picture displays for five
saconds before changing tothe nesd slide.

1. Press Starf 2] and select Pictures & Videos.

2. Selact the list in the upper-laft cormer and select the folder containing the piciures you
want 1o view as a slide show.

3. Press Menu —— iright softkey) and select Play Sfide Show.
Press Center () to display the slide show toollar

5. Use any of the following icons to control the slids show: Rolale &, Play (. Pause ().
Reverse @, Forward @, and Stop @.
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Tip You can alzo prass Right and Left on #he S-wiay fo move fovard or
baciward through the picilres
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Sending Pictures and Videos

You can send a picture or video to other picture-enatbled wireless devices or to an
email address.

|l You cannof sand copyrighiad piciues or videos that appear with & Lock
icon i Thumbnails viauw:

Press Start [#2] and salect Piotures & Videos.
Highlight the picture or video you want to send.
Press Menu (— (right softkey) and select Send.

Select the Inbax or Microsoft® Windows Live™ account you want to use to send the
picture or video.

5. Address and send the meassage. (See “Creating and Sending an Email Message” on
page 136 for details)

FoLa b

Organizing Pictures and Videos

YouU can move of copy pictures and videos to othar folders or between your Trao and an
expansion card.

1. Press Starf [27] and salact Pictures & Videos.
2. Highlight the picture or video you want 1o move or Coy.
3. Do one of the following:
To move the picture or video, press Menu (— (right softkey) and select B4 = Cut

To copy the picture or video, press Ment (— (ight softkey) and select
Edit = Copy.
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4. Select the list in the upper-laft, and select the location where you want to place the
picture or video you selected in step 2.

5. Press Menu (— iright softkey) and select Edit > Paste.

You can alsoview a specific folder or expansion card and arrange the pictures and videos by
name, date, or size.

1. Press Start (5] and select Pictures & Videos.
2. Selact the list in the upper-laft cormer, and then selact the folder you want to view,

3. Select the list inthe upper-right comer, and then select the sont method: Mame, Date, or
Size.

When you caplure new piciures and videos, they appear a5 the last flams in
Thumbnails view. To place the new ilems in the appropriake sort oder
fefrash the sorean By salacting & different sot method or dosing and
reopaning Pictures & Videos.

Using a Picture as the Today Screen Background
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Press Start 2] and select Pietures & Videos.
Highlight the picture you want to use.
Press Menu —— iright softkey) and selact Set as Today Background.

Select the Transparency Level list and select the appropriate level, (Use a higher
percentage for a more transparant picture or a lower percentage for a more
opaqgque picture)

5. Prass OK [@] to raturmn to Thumbnails view,

R

You can alen wse the Today Settings swean fo sef the Tod ay soeen
bactground. See Salacting Your Today Soean Background” on page 318
for defis.

Section 48:- Worldng With Your Pictures and Videos 218



Adding a Picture to a Contact Entry

Press Start [ 22] and select Pefures & Videos,

Highlight the picture you want to use.

Press Menu (— (right softkey) and select Save fo Contact.
Selact the contact you want to add the picture to

FoLa b

Editing Pictures

Press Start [ 2] and select Pefures & Videos,
Cpen the picture you want to edit.
Press Menu (— (right softkey) and select Edit,

R

Do any of the following:
To rotate a picture 90 degrees counterclockwise, press Rofafe (— (left softkey).
To crop a picture, press Ment (— (right softkey), select Crop, and then tap and
drag the styus to highlight the area to crop. (Tap inside the cropped area to accept
the crop. Tap outside the bax to cancel the crop.)
To adjust the brightness and contrast levels of a picture, press Menu (— (right
softkey) and select AufoComect,
To keep both your original image and the revised image, press Mend — (right
softkey) and select Save As.

5. Press OK [@] to save your changas,

Tip To undo an adif prass Menu (ight soffel) and safect Undo. To cancel aff
unsaved edits you made fo the pichire select Revert ta Saved.
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For mose exfensive edifs, syno vour picture or video fo your compudar and
adifif i1 vour favorike graphics program. Than sying the picfue or video baci
fo Wour Treo.

Deleting a Picture or Video
1. Press Start 2] and selact Pictures & Videos.
2. Highlight the picture or video you want to delete.
3. Press Menu (—) iright softkey) and select Defete
4. Select Yes to confirm the deletion,

Renaming a Picture or Video
1. Press Start [2] and select Pictures & Videos.
2. Highlight the picture or video you want to rename.
3. Press Menu —— iright softkey) and select Toofs >>Properties.
4. Enter a new name for the picture or video.
5. Prass OK [@ ] to returmn to Thumbnais view,
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Customizing Your Pictures & Videos Seftings

You can customize the camera on your Treo as described in the following section,

1. Press Starf [ 2] and select Piclures & Videos. M

2. Press Menu (— iright softkey) and select Tools =Options. | v

3. ©Onthe Generaftab, st the following options; '
{fse this picture size: Sat the size of pictures you sand 3
via amail, T TR R T
When rotating a piciure, rotate 90 degrees: Set the ;
direction in which picturas rotate.

4. Select the Shde Show tab and set the following options:
During sfide shows, optimize for viewing: Set whether
picturas are optimized for pottrait or landscape format
during slide shows, st 1
Play screensaver when connecled fo my PC and idfe ”
for 2 minutes: Set whether the pictures in your My S T e
Pictures folder are used as a screensaver on your Treo .
when your Treois connected to your computer and the FCaaidets 2t
deskiop synchronization software is not running.
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5. Selact the Camera tab and set the following options: -
Type filename prefix: Assign a name to a series of sy
picturas 1o be captured, such as Seattle001, Seattla002, e flenannc erefi
and so on. I
Save fifes to- Set whether pictures and videos are ;
stored on your Treo or o an expansion card.
St image compression levef: Seat the default size for
newly capturad picturas.

6. Selact the Video tab and set the following options:

Inciude audio when recording video files: Turn the
microphone on and off so that you can record videos kA

with or without sound. e L S
Time timit for videos: Limit the length of videos you ——
record, (You can also selact the Mo fimit option.) [Fren -l

7. Press OK [@] to returmn to the Thumbnails view,
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Playing Media Files

In This Section

Synchronizing Windows Media Flayer Library Files
Faying Media Fles

Wibrking Wth Librares

Whorking With Flaylists

Customizing Windows Media Player Mobile

Section 4C: Playing Media Files

Section 4C
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Windows Media® Player Mobile can play music, audio, and video files that are storad on your
Palm® Trec™ &00w smart device or on an expansion card (sold separatehy) in any of the
following file formats:

WA

WIVIY

WA

P33

NP4

M A

3GP

3G2

AAC

AMR

QCP
Because music, audio, and video files are so large, we recommend that vou use a microsSD
or microSDHC expansion card to store the files you want to play on your Treo, You can listen
tothese music, audio, and video files through the speaker on the back of your Treo or through

the included microlJSE stereo headset, To use a headset with another type of connector, you
must attach an adapter (sold separately.

Do the following:
Maka stre you have Wind ows Media Flayer 10 or ja&r instafled on

Wour compuier See My Windows Media® Plaver Lifary Won't Syne”
on page 364

« {Opfionzl OBz an axpanson card B stora Yo madiz flas
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an & Windows XP compuler VWindows Media Flayer must be instaliad on
your compitar bafore you install Microsoft ActiveSync desitop soffware

Your can inskl ActiveSyne deskiop soffware from the Gefting Stared CD for
Palm Treo 800w smarf device thafcame with your Treo. Windows Media

Plaver 77 is already nsBled on Windows Vista™ comptiers

Synchronizing Windows Media® Player Library Hles

Use the Syne feature in the deskiop vaersion of Windows Media Player 1o transfar your
Windows Media Flayer library files from your computer to an expansion card or your Treo.

“our librany can include digital music, audic, video, and playlist files, Using Syne ensures that

wour Windows Media Player library files transfer corractly.

Mote The pictlnes and videos you creale with the camera on your Treg are not
part of your Windows Madiz Player lifrans See "Synchromnizing Your Media
Hlas™ on page 205 for informafon on fansfering pictunes snd videos fom
the bulit-in Gamera I yoLr computarn

During setup, Windows Media Player selects tha sync method (automatic or manual) that
works best for your Treo:
Automatic: If you're using an expansion card that is larger than 4GE and your entire

library can fit on the card, Windows Media Player automatically syncs your entire library
whean you connect your Treo 1o your computer or when you change sync sattings. You

can also choose which playlists you want to sync automatically:

Manual- You indicate which files or playlists you want to transfer each time you update
digital media files on wour Treo, To remcve files from your Treg, you must delste them
manually.
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After you complete initial setup, you can switch between automatic and manual sync.

The folfowing skns ae for Windows Mediz Player 110 voure using another
version of Windows Media Player, the sliens may vary

On your computer, opan Windows Media Player.
(Optional) Insert a 32MB or larger expansion card into your Treo,
Connect your Treo to your computer with the USE sync cable.
Wait for the Device Sefup wizard to open oh your computar, and then click Anish.
In Windows Meadia Player on your computer, click the Syne tab and select Portable
media device > Set Up Sync.
£. Selact the playlists and files yvou want to sync, and then click Add.
7. Click Finish, and then click Start Sync.
Be patiant; transfarring media filas to an expansion card can take saveral minutes, To find

your synchronized files, update the library in Windows Media Player (see “Working With
Libraries” on page 231). The files appear in the updated libraries,

g W

Tin For fins on using the desidop version of Windows Mediz Flayer, go fo fhe
Help meanu in Windows Madia Playar on your compiar
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Playing Media Files

1. Press Starf [#2] and select Windows Media,

2 lf you don't see Library in the upper-left comer, press Menu —— (nght scftkey) and
select Library,

Tip To piay & fie thatis nofin & by go fo fhe Library screen, prass Menu
{right sofffeay), and salect Open File

3. Selact the folder that contains the itern you want to play, (such as a videg, song, album,
or artist nama), and if necessary select a sutfolder to select a specific item.

4. Press Play — (laft softkay).

Tio To repeat the current video or song prass Menu {ight soffey) and selact
Shuffle/Repeat

5. Use any of the following onscreen and keyboard controls
during playback:

& or Center (): Play the current file.
@ or Center ) Pause the current file,

@ or Left < Skiptothe beginning of the current file or to
the previous file, (Press and hold Leff < to rewind)

=
2
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& or Right b : Skip to the next file, (Press and hold Right
to fast forward)

==, Set the point from which playback begins. (Tap and drag the slider to change the
current position.)
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& or Volume bution: Increase the volume level,

& or Volume button: Decrease the volume lawvel,

T Turn the sound on or off,

@ Display a video using the full screen.

@ Display a Web site where you can find music and videos 10 play.

# Set your rating of the current file. (Selact the stars in the upper-right corner to change
the rating.)

6. Press Menu (— iright softkey) and select any of the following during playback:
Library: Display the Library screen so you can select a differant video or song to
play.

Play/Pause: Stop playback temporarily and restarts playtback
Shuffle/Repeat == Shuffle: Flay the Now Playing playlist in random order.
Shuffle/Repeat > Repeat Flay the Mow Playing playlist repeatedly.
Stop: End playback.

ll 7 ou cose the Wind ows Media Player Mohile window, your music
confinues o pey in the bactground. Your MUSIc pausas  ufomatically when
wol racaha 2 calt To sfop tha music. sife the Hinger switch fo Sound Off,
or open \Windows Media Flayer Mobile and press Center on the S-way.

To play & fie fom the Wieh press Menu on the Library soreen, and then
safact Open URL Sefect URL and antr the Weab oo addess, or selact
Histary and sefect a sike vou've visied befora
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Working With Libraries

A library represents each of the storage locations available to Windows Media Player hMobile,
such as your Treo or an optional expansion card (sold separately), Each library contains links
to the media files in that location. Windows Madia Player Mobile usually creates and updates
the library automatically when you add media files for the first time, For example, when you
add media files to your Treg, the My Device library is created, YWhen you inser an expansion
card containing media files, the Storage Card library is created. When you update a library, it
automatically updates video files WMWY, MP4, MAY, 3G2, and 3GP) and audio files (AMA,
WP3E, M4A, QTR WAy, AMR, and AAC),

I Yot move files Pelwas your Teo and an expansion cad, be sue &
update your fibrarias, o you woin't be 2 bl o sea the fas in thair new
location.

1. Press Starf (8] and salact Windows Media.

2. Ityoure not on the Library screen, prass Ment —— (right softkey) and select Libranyto
goto the Library scraen.
3. Press Menu (— iright softkey) and select Update Library.

4 wWait for the files to be added, and then select Done. (f yvou don't see a madia file that
you added, manually update the librany)

To delats an ffem from & fibrary: Highilight the ifem and then press and hold
Center on the S-way fo open the shorfeut menu. Then selact Delete from
Library. Salect Yes fo confirm the dalation
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Working With Playlists

A playlistis a list of media files that play in a specific order, You can use playlists to group
audio files together or video files together for corvenient playtback. For example, in the
deskiop player, you can create a playlist of upbeat songs for when you exercise and a playlist
of socthing songs for a long flight When you synchronize, your favorite playlists are
automatically copied to your Treo, Your playlists appear in your libraries (in the My Playlists
category).

A temporary playlist, called Mow Playing, appears on the Mow Plying menu, It lists the
currently playing file, as well as any files that are queued up to play next. You can add to,
modify, or clear the files on the Now Playing playlist.
1. Gotothe Mow Playing screen: e ——
If you are on the Library screen, selact the Mow Playing | - rowiuyirg
category, el
If yiou are on the Plavback screen, press Mow Playing o Thraes
— (l&ft softkey).
2. Do any of the following:
Move a fite up or down one sfot: Highlight the file and
then select Move Up 4+ or Move Down <.
Add a fife to the playfist: Select Add /% to goto your
Library ligt, highlight the file you want to add, press Ment .— (right softkey), and
then select Quete Up. (To return to your playlist, press Menu ——) [right softkey]
and selact Mow Playing.)

Defete a file from the playfist- Highlight the file and then select Remove x..

A 4

View more Information about a file- Highlight the file and select Properties 4.

Remove af liems from the Now Playing playist: Press Menu — (right softkey) and
select Clear Mow Plaving.
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Keep the playiist so you can piay It fater- Fress Menu (— (right softkey), selact
Save Playtisf, and then enter a name for the playlist,

2. Prass Menu —— (right scftkey) and select Opfions.

3. Onthe Playback tab, st any of the following options:
Show fime as: Set whether the fime remaining or time
elapsed appears on the Playback scraen, Ghow Hme: a:
Pause playback white using another program: Sat
whether playback continues if you switch to ancther bivestiriiziats
application.

Resume playback affer a phone calf- Set whether

playback continues after you finish a phone call. o e ey e

4. Select the Video tab and selact aither of the following
options:;

Playvideo in fulf screen: Set wheather videos automatically play in full-scresn format,
Scale o fit window: Set whether videos are automatically scaled tofit the Playback
scrasn,

5. Selaect the MNetwork talb and set the following options:
Profocof: Set the available protocols. (vou must select at least one protocol, You can
also set a UDP port)
Internet Connection Speed: Seat the speed of your network connection and whether
yiol want the device to detect connection speed.
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6. Selact the Librarytab and set whether the Librany screen or the Playback screen
appears when you open Windows Media Plaver Mobiie.

7. Select the Stdns tab and selact Previous or Mext until you display the skin you want as
the players background.

8. Selact the Buffons tab and do any of the following to
change any of the available button sattings:

Assign a button:- Highlight the itern you want to set, Py Pane
select Assign, and then press the button you want to sw
use for that itemn. ke

e

Resfore an ffem'’s factory seting: Highlight the item Sl

Pl

and select Reset f Il I |

Unassign an Ifem: Highlight tha itern and salact None. [ oo [t [ty [shre | s [43]
9. Press OK [@].

£

You can presenve baffery i By assigning & Buffon fo fogoie the soean off
and on duing pliaybzok On the Buttons &8 st the Toggle oplion, and
then press the assigned Key (for instance S) o fum fhe sorean on and off
during playbact.
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Seclion 5

Your Wireless Organizer

Sprint ~ ahead
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Section 5A

Using the Organizer Features

In This Section

Contacts
Calendar
Tasks
Motes

Calculator
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Conlacts

Adding aContact

238

Compuitar” on page 41 for defzis

If Yo have many contacts & anty, s bast i ander tham in Microsort
Outlock™ on vour computer and then s See “Connecting o Your

Gotoyour Today scrasn (see “Accessing Your Today Screen” on page 76).

Press Menu —— (right softkey) and select Confacts.

Tin You can alse open fhe Contacts appication by pressing and holding

Option white vou prass Calendar.

Press Mew — (&ft softkey).

If prompted, indicate whether this is an Cutlook contact or a
Windows Live contact,

Use the S-way navigator to move between fields as you
enter informaticon.

- Toenter complaete name or addrass (work, home, or othar)

information, maove the cursor to the appropriate field (such
as Work addr or Home addr), press Center (), and then

press Right & (or tap the arrow on the right side of the ling)
and enter the information in the box that appears, (To
accept the information and close the box, press Left

P

e Select a plcture. .

or tap outside the baox)
. Toadd a caller ID picture that appears when that person calls, select Picture, select

Camera, and then take a picture, or select an existing picture from Thumbnaits view.
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8. Toassign the entry to one or more categories, select Categores and then check the
categories under which you want this entry 1o appear. (To add a new category, press
MNew — (left softkey), entar the category name, and then press OK (@ 1)

9. Toassign aringtone tothe entry;, select Ring fone and selact a tone.
10, Toadd a note to an entry, select the MNotes tab.
11, After you enter all the information, press OK [&].

Ba stra o anfar wickss nUmbacs and amal addrassas in the cormact falds
50 thatInbox and Messaging can find this information when you address a
meassage, and Calendar can find your conk cis when you want o invik
tham fo mestings.

To anfer & infamaiiona phone numbear anfar g + (pius 5gi) i ot of ha
counfy code

Viewing or Changing Contact Information

1. Gotoyour Today screen.

2. Begin entering one of the following for the contact you want to view or adit:
First name.
Last name.
First initial and last initial separated by a space.

Highlight the contacts name and press Center ().

Selact Open Contact,

Press Menu — (right softkey) and select B3

Make changes tothe entry as necessary.

Press OK [@ ],

S
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You can fnd 2 contact by company namea Fom your Taday seraan, prass
Menu (dght soffeey) and salect Contacts Frass Menu {dght soffey) and
safectView By » Company. Salect & company name fo sae the confacts
Wha Wodk thera

To view & parficular group of confaets, prass Menu (dghf soffiey), salect
Filter, and then salectthe calagory you want o s,

Viewing a Map of a Contact’s Address

You can view a map of a contact's address directly from your Today scraen.

1. Maka sure your phons is tumed on and that you are inside a coverage area (see
“Turning Your Phone G and Cff” on page 35).

G0 to your foday screen.

Using the keyboard, bagin entaring one of the following for the contact you want to map:
First name.
Last name.
First initial and last initial separated Ly a space.
First and last name.

Highlight the contacts namsa and press Cerler ().

5. Selact And (The Maps application opens and displays the contact's location on a map.)

If youi subscibe o the Sprint Navigation sendos, you can also gef driing
direcons. Fress Menu (right soffiey) and sekct Directions To/From or
Drive To. Sae “Using Spdnt Navigation™ on paga 185 for addifiona)
informaton.
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Deleting a Contact

1. Gotoyour Today screen.
Press Menu — iright softkey) and select Comtacts.
Highlight the contact you want to delete.
Press Menu — iright softkey) and selact Defete Cortact,
. Select Yes:

oo e b

Customizing Contacts
1. Gotoyour Today screen.
2. Press Menu — (right softkey) and select Contacis.
3. Press Menu (— iright softkey) and select Options.
4 Set any of the following options:

Show afphabetical index: Display the alphabeat at the top of the Contacts list, Salact
a letter range to jump to that part of the alphatet.

Show contact names onfy: Hide evenything but the contact's name, which enables
you to fit maore names on tha screen when viewing your Contacts list,

Area code: Set the default area code for new contact entrias.
5. Prass OK [@].
Finding a Contact in an Oniine Address Book

In addition to having contacts on your Palm® Treo™ 800w smart device you can also accass
contact information from your organization’s online addrass book or Global Address List

(GAL).
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Do the following:

+ Make sure you are & coassing Microsoff® Eichange Sener 2007 or
Exchange Senser 2003 upgradad fo Servica Pack 2

+ Add access fo the onling addrass book, see “Adding an Online
Addrass Book" on page 147 for defails.

+  Synchronize with the Exchange server affer you add the online
address book, sea “Gelfing Email and Microsoff® Outiook™ Information
Fom Your Corporate Microsoff SBchange Sanr” on page 125
{Oharwise fra Compary Drectory opfion doas nof appear)

Gotovour Today scresn,
Press Menu (— iright softkey) and select Comtacts.
Press Menu —— iright softkey) and select Company Direciory.

Enter the contact’s name (in part or in full), and than press And (— (right scitkey).
{You must spell the contact's name correctly to find it in the online address book.)

FoLa by

Calendar

Displaying Your Calendar
1. Prass Calendar [ ],
2. Prass Menu (— (right softkey) and selact View.
3. Select one of the following views:

Agenda: View your daily schedule in list format, (Upcoming appointments are bold;
past appointmants are dimmed,)

Day View your daily schadule in day-planner format.
Weef View your schedule for an entire week,
Month: View your schedule for a whole month.

VA mormning appointment.
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A An afternoon or evening appointmennt.
M Bcth moring and afternoon or evening appointmeants.

] An all-day event.

Year: View the first nine months of the current year, (Press Down v 1o saa the nad
set of months, or press Up o 10 ses the previous set)

4 Use the d-wayto maove to ancther day, week, month, or year (based on the current
wigwn),

7 You can also scrolf frough the vadous views (Agenda, Day Wiaak, Monih,
and Year) by pressing Calendar repeakdy

Crealing an Appointment

Ifyou have sevaral appointmeants i antar (£ most efficiant o anfer tham in
Microsoft Office Ouliook on Your computar and han gmahronize your Teo
with Your comptiks For mosa informabon, sea “Connecting fo Your
Compllsr” on pegs 47

Press Cafendar [ ],

2. Prass Menu ——) (right scitkay) and selact *:fi‘fS' MH"I*IQ M i
New Appointment. vr 10/16/07 10500 AM
3. Enter a Subject (description) and a {ocation. i et i
4 Select Starts and selact the staning date and timea. o D':e
T

5. Select Ends and select the ending date and time.

e Sl Business i
6. Press OK [@] aipronimert | Nl |
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[ To pancil it 2 gppoinimant opan fha agpoinimant prass Menu (right
soffay) and salact Edit Salect Status and then selact Tentative

Creating an Untimed Event

An untimed event, such as a birthday, anniversany, or vacation,

does not occur at a particular time, Thase events appear as

ot 17,00 EMTITFS w4 b
banners at the top of your calendar; they dom't occupy blocks of [ 7 wn e s 1=
time. For example, in the illustration shown here, “Submit Final -
3 y Meet with Danna and Sardy 5l
Draft” is an untimed avent. Confirerce co
i | i wAllh Gireqy ‘i'
1. Press Calendar (B, b
TEmm mseting -
2. Press Menu — (right softkey) and select Mew : i—
Appofnfment Meetion | wailhy Crsmic b Deparbmernd "i:
3. Enter a subject (description). [ DT
4 Select the starting and ending dates.
5. Selact AffDay and then select Yes

6. Prass OK [@].
Schedufing a Repeating Appointment

1. Create an appointment or untimead avent, and then salect i,
2. Press Menu — (right softkey) and select £

3. Select Occurs and then select a repeat pattern. (To create a repeat pattern, select Bait
pattern and follow the onscrean instructions.)

4. Press OK [@].

T To enfer & birthday or an annivarsary, create an unlimed evant that repeats
avary Jaar

244 Section bA: Using the Organizer Features



Adding an Alarm Reminder to an Event

1. Create an event, and then select it.

2. Press Menu —— iright softkey) and select Edif.
3. Selact Reminder and then select Remind Me.
4

Enter the number of minutes, hours, days, or wasks bafore the avent that you want 1o
receive the alarm.

5. Press OK [@].

7 | Birthday - Che -l

A T
= Al day recurming
roos Al day recuming ™
by Yes |
Every July 20
=-mroer Remind me

2 dayls) - &
| @

1 Type of Time Units
2 Number of Time Units

Tin You can also add an alarm when you Geak the arent
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Sending a Meeting Request

You can email meeting invitations to contacts who use the desktop version of Microsoft
Cutlook or Microsoft® Cutlook® Mobile,

Craafe condacfenives with emaill addrasses for he peopia ou want fo imdk
fo & maating (s Adding & Confacf on paga 238). You cantimdl
someaone & masling Wiess You have an emall address for them in the
Contacts a ppfication.

Create an avent, and then select it.

Press Menu — iright softkey) and select B

Select Affendees and then select Add Required Affendee.

Select the contact you want to invite,

Toinvite more attendees, selact Add Required Affendee and selact the namas.
Toinvite optional attend ees, select Add Oplional Affendee and select the namas.
Pross O [@],

The next time synchronization occurs, the meeting request is sent to the attendesas.

Whan attendees accept your meeting request, the mesting is automatically added to
their schedules, As you receive each response, your calendar is updated as well,

e B

If you ara using Microsoft Exchange 2005 Sarver with Servics Pack 2, you
£2N LS Wolr corpom i Global Addrass List fo find contadt information for
an atiendea Select Attendees and sekct Add Required Attendee or Add
Optional Attendee. Fress Menu (fght soffrey). and select Company
Directary. Enfar the name of the affandes and salect Find.
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Marking an Event as Sensitive

If cther people have access to your Microsoft Cffice Cutlook calendar on your computer and
wou dom't want tham 1o see an appointment, you can mark that appointment as private to hide
it from other Microsoft Office Cutlook users,
1. Create an event and than open it
2. Press Menu —— (right softkey) and select £
3. Selact Sensifivity and then select one cf the following:
Mormal- The event displays without any notation.
Personal If the event is a mesating, recipients sees “Pleasea treat this as Personal”
near thetop of an open appointment,
Private: It the event is a meeating, recipients see “Please treat this as Private” near the
top of an open appointment. (f you sync with an BExchange server, other Users who
can access your folders can’t see your private events; private events appear as
unavaiiabla time slots)
Confidendial: If the event is a meeting, recipients see “Please treat this as
Confidential® near the top of an open appointmeant,

4. Press OK [@].

IFyoudon't see an opfon on the screan, press Down on the S-way fo saroff
o ofher options. For exampie, when editing an avant you don't see the
Sensitivity oplion unlil vou scroll foward the bolfom of the enlry

To remove sensifivify stafus from an iam, select Normal fom the Sensitivity
1ist
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Organizing Your Schedufe
Use categories to view various types of events.
1. Create an event and then select it.
2. Prass Menu —— (right softkey) and select £

3. Select Categories and then chack the categories that apply
to this event. (To add a new category, press Mew — (left
softkeyd, entar the category name, and then prass OK [&@1)

4. Press OK [@] two more times.

5. After you assign events to categories, press Menu —)
fright softkey) and selact After.

6. Selact the type of events you want to view,

Defeting an Event
1. Highlight the evant you want to dalate,

A Ful

| Holiday
o Personal

T Senonal

[T ——

2. Press Menu —— (right softkey) and select Dekete Appoinimernt,

3. Select Yes
Customizing Calendar

1. Press Menu (— (right softkey) and select Tools > Options.

2. 0Onthe Generaftab, set any of the following options:
Start In: Set which view appears when you open the
Calendar application.

Tstday of weelc Set Sunday or Monday as the first day
of the week for all Calendar views.

Weel view Set whether five, sig or seven days appear
in Weef view
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Show half hour sfots: Set whether time slots appear in one-hour or half-hour
increments in Day view and Week view,

Show weelc numbers: Sat whether week numbers (1-52) appear in Weel view:.

3. Selaect the Appointmentstab and set any of the following options;
Set reminders for new flems: Set whether a reminder is m—
automatically added to new events and how long a
before the event the reminder appears. (YouU can T
override this setting for individual events) I

Show fcons: Set which icons appear nexd to events, —— Elel al=L

i The avent has a reminder. Jrame? | Dutieos Ema B

% The avent repaats in a specified pattam. G | e
[ The event has a note attached,

@ The event has an assigned location.

#® The event is a mesting.

# The evant is marked private.

el Not all icons appear fn all Calendar viaws,

Send meeling requests via: Set the method used to send mesating requests,
4. Prass OK [@],
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Tasks

You can use Tasfsto help you remember tasks you need to complate and to keep a record cf
completed tasks.

IF you want fo use Tasks Cwver the Air (OTA) synchronization, install the
soffware Fom your Gaffing Starkad CO for Paim Treo 800w smarf davica
CTA features also require Microsoff Exchanga Sarver 2007 or Exchange
Sener 2003 upgraded o Service Pack 2. The opfion f synchroniza fzsis
wirglassy in the ActiveSync applicaion appears onfy if you have the
appropizte sener

Adding a Task

1.

oo Lo b

250

Press Start [&] and select Programs

Select Tasks ],

Press Menu — right softkey) and select New Task
Enter a description of the task in the Subjectfiald.
Sat any of the following:

£V

Priority- S et the priority level for this task, (Later you can w1 Create chart -
arrange your tasks based on the importance of each m";vmd
task) ‘et 10{18/2007
Status: Set whether the task is now completed. !

) ) o R e
Starts: Set when the task begins. 10/18/2007 E:00 A
e Set the due date for the task g [Business

[F T

Occurs: Sat whether the task repeats at regular m

intervals and how often it repeats,
Reminder: Set an alarm for this task and indicate when you want to be reminded,
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Categories: Assign the task to one or more categories.
Sensitivity: Mark this task as MNormal, Personal, Private, or Confidential,

6. (Optionall Select the Mofes tab and enter additional text for the task,
7. Press OK [@].

Tin You can also add 2 task by selecting the Tasks antry bar at e p of the
SCraen

Checking OF a Task EI_.ILLIII
1. From the Tasts list, highlight the task you want to check off. | y ot s ks -

(Overdue tasks appsarin rad) :
2. Press Compilete —) (left acftkey).

BE

create chart

Pk upy ey eheanng
sered dad a cord
Update glossary
Wrlke iy ting aneiia

RIO® =

You can also mark & sk as complekd by Bapping e check box next o
the fzstr on the Tasks list If vou nead fo mark & complalad fask as
incomplate, hightight it and prass Activate Jeff soffiey).

Organizing Your Tasks
1. In the Tasks list, press Menu (— (right softkey) and select Aifer,

2. Selact which tasks you want to view, Aff Tasks Recentty Viewed, No Categories
Active Tasts, Completed Tasls, or a specific category, such as Business or Personal

3. Press Menu —— iright softkey) and select Sort By.
4 Select the sort method; Status Priorty, Subject Starf Date, or Due Date.
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Deleting a Task
1. Highlight the task yvou want to delata,
2. Press Menu ——) iright softkey) and select Delefe Task
3. Selact Yes

Customizing Tasks
1. Gotothe Tasks list.
2. Prass Menu — (right scoftkey) and select Opfions.

3. Set any of the following options:
Setreminders for new flems: Automatically add a reminder to new tasks. (The
default reminder is s&f to §:00 on the morning the task is due You can cverride this
setting for individual tasks)
Show start and due dates: Display the task start and due dates in the Tasks list,

Show Tasks entry bar- Display the Tasis entry bar at the top of the Tasfs list,
4. Prass OK [@].

Noles

Motes are a great way to capture thoughts, questions, and meating notes on your Trao,

To fake advantage of ) the sync feafues avaiable i the Notas application
make sure the desiion synchronization soffvare is nsEled on your
computer: See “Saffing Up Your Computar for Synchronization” on page 46
for dezils
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Creating afNote =

1. Press Start (8] and select Programs ey e :
. Select Motes | . ?;; o

Cereal

2
3. Press Mew — (left scitkey).
4. Do one cf the following:
Type the text with the keyboard,
Write tha text with the stylus, 2
Enter the text by tapping the onscreen Keyboard. M
Prass Ment (— (right softkey), select Draw, and than draw a sketch with the stylus,
crossing at least three ruled lines.

5. Press OK [@].

ol You can add seweral voice nots within a singie nok.

Recording a Voice Note

You can create a new voice note or add a recording to an existing naote.
1. Press Start 2] and select Programs
2. Selact Motes

Tin You can also press and hold the Side buffon o opan the Notas application

3. Do either of the following:
To add a recording 1o a note, open the note to which you want to add the recording.

To create a new voice note, press Mew — (left scitkey).
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If the recording toolbar is not visible at the bottom of the : —
screen, prass Ment — (right softkey) and select View e s
Recording Tooibar,

Select [e] to begin recording.

Speak into the microphone on your Treo or hold it closeto
ancther sound source,

After you finish recording, selact [a] 1o stop recording. (4
Recording ( 2 icon appears in the note or in the Motes list,
depending on where you recorded the note.)

Press OK [@].

Tip To play 2 recording, salact the voica nok in the Notes fist or opan the nofe
conaining the recording and selact the Recording fcon

Crealing aNote From a Template

5

S

254

G0 to the Motes list.

Tap the list in the upper-laft cormer, and selact More Foiders >Tempiates.
Cpen the template you want to Use,

Enter the information.

Press OK [@].

Fename the note and move it to the appropriate folder. {(See “Crganizing “our Notes”
on page 255 for details.)

To grezla & nalv mmplalk, hightight the nok you want fo sava as & Bmpiata
Prass Menu (right sofffel) and salact RenamefMove. Seject Name and
then entr & name for the lemplate Select the Faolder fist and selact
Templates. Prass OK.
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Organizing Your Notes
You can rename your notes, move notes to ancther folder, and move notes betweaen your Treo
and an expansion (storage) card.

1. Gotothe Mofes list and highlight a note you want to move,

2. Press Menu (—) iright softkey) and select Rename/Move.

3. Selact Mame and then enter a new name for the note.

4 Select Folder and than sslact the folder in which you want to store the note,

To craate a naw foldar, go fo the Notes §st salact the fist in the uppaciaft
cornar, and than salact Add/Delete. Safact New enfar 2 name for
the folder, and then prass CK.

Select Location and then select Main memory or Storage Card.
Prass OK [@].
Select the list in the uppear-left cormer, and then sslact the folder you want 1o view.

Select the list in the upper-right comer, and then select whether you want to sort your
notes by Mame, Date, Size, or Type.

Deleting a Note
1. Gotothe Mofes list and highlight the note you want to delete,
2. Press Menu — (right softkey) and select Dedele.
3. Selact Yes

@ o~ o

Customizing Notes
1. Gotothe MNokes list,
2. Prass Menu — (right scftkey) and select Opfions.
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3. Set any of the following options;
Default mode: Set the default entry mode to Wifting or Tiping.
Defauftiemplate: Sat the default template for new notas,
Save fo: Set the default location where new notes are stored.
Record bution acfon: Set whether the Side button opans the Moles application or
stays in the current application.

4. Press OK [@].

To use the Record button action feafuse, the Side buffon must be assigned
o opan Motes If you assigned tha Side butfon b open anothar application,
you can reassign it fo e Notes application (See *Reassigning Suffons” on

page 324)

Calculator

“ou can use Cafctdator for basic arithmetic calculations, such as addition, subtraction,
multiplication, and division.

“ou can tap the screen or use the Keyboard 1o input numbers,

Performing Calcufations
1. Press Start 2] and select Programs
2. Select Cakcuator [
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3. Enter numbers and perform calculations, including —

the following:
56. «|
[¢] Clear the last digit.
C/T7H819:+ a/x
¢! Clear the current calculation or the displayed number, MC 415176 1o
v Calculate the reciprocal of a numier. MR '1 2)( 35 =) v
« Calculate a percantage, :_MI+: 0 N +/

~ Calculate the square root of a number, _

Switch a numiber batwean nagative and positive.

To copy & num bar, press Editand sefect Copy. You can paste the copied
number inf anofher spplication To peste & copld number Nt another
application, prass BEdit and salect Paste

Using the Calculator Memory
To store a number, selact the box to the left of the entry bad (An M appears in the box)
To add the displayed number to the number stored in mamory;, select (e,
To display the number stored in memory, select r;n
To clear the mamory, selact e,
When you store a number in memony, it replaces the number that was previously stored,

Tin For mose advanced calcullions. use Scaa™ Mobila See “Exaaf Mobis” on
page 272 for datails
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Increasing Your Productivity

In This Section

Synchronizing Microsoft Office and Other Files
Wybrd Maobile

FowerPoint Mobile

Bxcel Mobile

Onehote Mobile

FOF Viewer

Section 58:Increasing Your Productivity

Section 5B
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Synchronizing Microsoff® Office and Other Files

You can create and edit Microsoft® Cffice files on your computer or on your Palm® Treo™ & 00w
smarn device and then synchronize the files so that changes you make show up on both your
computer and your Treo, Yol can use the same method to synchronize files from cther
applications that do nat appear in the sync list, such as Microsoft® Cutlook® Notes. (To leam
about synchronizing pictures, videos, and music, see “Synchronizing Your Media Files™ on

page 205.) How synchronization happens, however, depends on whether you use Windows
¥P or Windows Vista®

Synchronizing Fites: Windows XP

Install Microsoff Acthesine® desiiop soffwara from the Gelling Starked CD

for Palm Trao 800w smart device (sea “insialing ActivesSync” Daskiop
Soffwans: Windows XP" on page 46,

1. Connect your Treo to your computer with the USE sync cable,

Most ActivaSync desidop soffivare oplions am avaiziie omly when your
Tiao is connacid o your compur

260 Section 58: Increasing Your Productivity



2. On your computer, doubla-click the [T

ActiveeSyne (O icon inthe taskbar in the - - -
lower-right corner of your computer screen to »
open the ActiveSync deskiop software window: (If
you don't see the ActiveSyne icon in the tasklar,

click Start = Al Programs > Microsoft ActiveSync

to open the ActiveSync wind ows)

3. Under information Nype, double-click Fies 1o view
a list of the files in the Files sync folder. {If you
dom't see the Files option, open the Toofs menu, -
selact Oplions, and make sure the Fies box is
checked.)

4. Do any of the following:

To copy a file from your computer to your Treg, click Add, browse to and highlight
the file, and then click Open.

To delete afile from the Files sync folder on your computer and from your Treg,
highlight the file name and click Remowe. (Can't find the Files sync folder? See
“Where Are the Changes | Made to My File?” on page 262.)

To copy a file from your device to your computer, place the file in the My Device =
My Documeants foldar on your device, and than sync.

Do

- 5
L

Nofe If you receive an eror message while synchronizing files, mate sure that alt
the filas woune fking o snc e closed on Holh your compular snd vour
Treo.
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Synchronizing Files: Windowrs Vista®
1. Do any of the following:

To copy a file from your computer to your device, copy or save the file in the
Documents\Doctiments on <gdevice name’s> Device folder on your complter,
To copy a file from your device 1o your computer, copy oF save the file in the
My Device = My Documents folder on your device.

2. Connect your Treo to your computer with the USE sync cable, (Synchronization takes
place automatically)

ll The Documents on <device name s= Device folder is area d when you
salact tha opfon B s filas

Where Are the Changes {Made to My Fife?

Don't lock for the changed file inits original location on your computer. Only the synchronized
varsion of the file contains the changes. To find the synchronized file, do one cf the following:
Windows XP:- Do either of the following:

On your computer deskiop, double-click the <device name>MyDocumenisicon. Thisis a
shortcut 1o the Files syne folder,

In ActiveSync deskiop software, doublae-click Fies The location of the Filas sync foldar
appears in the Fite Synchronfzation Seftings dialog box (under “On this computer,
synchronize the files in this folder™.

Windows Vista: Cpen the Documenis\ Documents on <device name s> Device folder.

On Your Treo: Press Start (& ] and select File Explorer, Select the list in the upper-left corner
and select My Device =My Documents.
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Word Mobile

You can create and edit documents and templates and save them on your Treo, You can also

adit Microsoft® Cifice Word® documents and templates that you create on your computer,

However, keep in mind that some of the information and formatting may be lost when you

save the document on your Treo.

The following features are not supported in Word Mobile:
Backgrounds.
Picture bullets {regular bullets are suppaorted).

Fevision marks (documents appear as though all revisions were accepted; if the
document is saved, revision marks are |ost),

Smart tags.
Table styles (some or all of the formatting is lost if the document is saved),

Password-protected files (remove password protection on your computer before opening

the file on your Tred).
Digital signatures.
The following features are partially supported in Word Mobile:
Bidirectional texd.
File conversions. Files with Office 2003 aexdensions [DOC, DOT, and so on] cannot be

saved with Microsoft Cffice 2007 extensions [DOCK, DOTx, and so on), and vice versa.

However, you can save these file types as RTF and TxT files)

Legacy Pocket Word files {you can open PSW files, but if you edit a file, you need to save

itin DOC, HTF, TXT, or DOT farmat),

Metafiles,

Aristic page borders are converted to lined borders,

IRM protection.

Rights-managed and password-protected file conversions.
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Fonts and font sizes {(original fonts are listed on your Treo but are mapped to the closest
font available).

Lists {indented lists are mapped tothe closest indentation level supported by Word
Maotbile).

Underling styles (unsupported styles are mapped to one of the four supported styles:
regular, dotted, wavy, or thick/bold/wide).

The following features are not supported on your Treg, but they remain in the file so that when
wou open the file on your computer, they appear as expected:

264

Charts.

Comments.

Footnotes, endnotas, headars, footars,

Page breaks (although undisplayed, all page breaks, except a break placed at the end of
a document, are retained in the document).

Smart4n, shapes, and text bhoxes

To copy a file from your compier B your Teo, opan My Computer or
Windows Bxplarer on your computer copy the file info the Maohile Device
fokier, You can also use the Alas swne folder fo copy filws from your
compuiar i vour Treo as descdbad in “Synchronizing Microsoft® Offica and

Other Fles” on page 260

By dafaulf filas vour craal and editin Wordd Mobik s savad in DOCK RTR
TAT or DOTA format However, vou can change the saffings o save files in
DOC RIS TXT or DOT format
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Creating aDocument

1.
2
3

Press Start [22] and select Office Mobife.
Select Word Mobile ju.

If an empty document appears onscreen, go to step 45 if the document list appears
onscreen, press Mew — (left scitkey).

4 Enter the text of the document,

5. Press OK [@] to save the file,
il When wou save a new document, it is aufomabcally named affer the first
Savera! words in the fike.
Opening an Existing Docuiment
1. Press Start [ 2] and select Office Mobife.
2. Select Word Mobite j=.
3. In the document list, selact the documeant you want to opean.

Creating aDocument From a Template

T

L e S

G0 to the doctment list.

Tap the list in the upper-laft cormner, and select More Folders >Tenplates.

Open the template you want to use, and enter the information.

Press Menu — (right softkey) and select Fie >Save As.

Select Name and enter a new name for the file.

Select the Foider list, and then select the folder where you want to save the file
Select the Type list, and then selact the format in which you want to save thefile.
Select the Location list, and then selaect Main Memory or Storage Cand.

Select Save.
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To crazle & naw famplale from & document opan fhe documeant you want

o save as 3 Bmpak Prass Menu (ight soffiiey) and selact File > Save As
Sakct Name and then enter & name for the Bmplak. Select the Folder fist
and sglact Templates. Salact fthe Type kst and than select \Word Termplate
Prgs QK.

Finding of Replacing Text in a Document

1.

Cpenthe document containing the tesd you want to find.

2. Press Menu —— (right softkey) and selact EQif > Find/Replace.

3. Select Andwhat and enter the text you want to find.

4. (Optionaly Check the Match case baxto find texd that matches the capitalization in the
text you enteraed in step 3.

5. {Optional) Check the Maich whole words ordy box to find only full words that match the
text you entered in step 3.

£. Selact And to locate the first instance of the text you antered in step 3, or select Replace
and enter the replacement text.

T Select Mexttofind the next instance of the text, or select Replace to replace it
{Toreplace all instances of the ted, selact Replace Aff)

3. When vou see a message indicating that the search is done, press OK [@ ],

Moving or Copying Text

266

1. Open the document containing the taxt wou want 1o maove or copy.

2. Highlight the text you want to move or copy.
3. Press Menu —— (right softkey) and select Copy 1o copy the texd, or select Cutfto move

the texd.

Open the document where you want to insert the texd, and position the insertion point
where you want the text to appear,

Press Menu — (right softkey) and select Pasfe.
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Tin To zoom fn or ouf open a documant prass View, salact Zoom and then
salect the zoom kval

Saving aCopy of aDocument

1.

IS

T

Cpen the document you want to copy.

Press Menu — (right softkey) and select Fie > Save As.

Select Mame and enter a naw name for the file,

Select the Fofder list, and then selact the folder where you want to save the fila.
Select the Tipe list, and then select the format in which you want to save the file.

Selact the Locaffon list, and than selact whathar you want to store the file on your Treo or
on an expansion card.

Select Save.

Fommatting Text
1. Open the document and highlight the text you want to format.
2. Press Menu —) (right softkey) and select Format > Fort,
3. Selact any of the following formatting options: Font Fontcolor, Size Bokd, fiafic,

Undertine, Highfight or Strikethrough.

. Press OK [@ ] to return to the document,

If & document was previoush ssVed on & Compur, any Lnsupporkd
formatting may be Jost whan you save the file

Fommatting Paragraphs and Lists

1.
2
3

Cpen the document you want to format,
Position the ingertion point in the paragraph you want to format.,
Press Menu — (right softkey) and select Format > Paragraph.
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4. Set any of the following options:
Afignment: Align the text with the |eft, right, or center of the paragraph.
List Create a bulleted or numbered list
Indentation: Change the paragraph margins.
Left:- Set the laft margin for the entire paragraph.
Right Set the right margin for the entire paragraph.
Special: Indent the first ling or set a hanging indent,
By Set the size of the Special indentation.
5. Prass OK [@] to return to the document,

Tio You can also wse the Formatting foobar fo oreate 2 list and © align kit To
indent it in lists, you must use the Farmatting footbar

Checking Spelling in a Document
1. Opean the document you want to chack,
2. Press Menu (— iright softkey) and select Toofs > Speliing.
3. It an unknown or misspelled word s encountered, do one of the following:
Selact the correct word in the list if the word is spelled incorrectly:
Selact fgnore if the word is spellad correctly.
Sealact Add to add a new word to the spalling dictionany.

Tip T check e spalling of specifc faxd Highiight i Before ol salect e
Spelling command.
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Organizing Your Documents

You can rename your documents, maove your documents to ancther folder, and maove your
documeants betweean your Treo and an expansion (storage) card.

1.

oo e b

e

G0 tothe documents list,

Highlight a file.

Press Menu (— iright softkey) and select Rename/Move.

Select Name and then enter a new name for the document.

Select the Foider list, and then select the folder you want to move the document 1o,

To craake & new foldar go o the documeants st saiect the B5Tin the
uppadaff cornar, and than seect Add/Delete. Safact New anfar 2 name for
the folder, and then prass CK.

Select the Locatfon list, and then select Main memory or Slorage card,

Press O[],

Select the list in the upper-left comer, and then sslect the folder you want 1o view.
Select the list in the upper-right comer, and then select the sort method,

Tin When you go 1o & folder, you Can easiy Search Your documents by sorfing
by fype.

Deleting a Document

1.
2
3
4.
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G0 tothe documents list,

Highlight the document you want to delate,

Press Menu — (right softkey) and select Defete
Selact Yes.
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Customizing Word Mobife

1. Gotothe document list.
2. Press Menu (—) iright softkey) and select Options.
3. Set any of the following options:
Defaulttempiate: Set the default template for new documents.
Save fo: Set the default location where new documents are stored.
Display In fist view: Sat the types of files that appear in the documents list,
4. Prass OK [@].

PowerPoint’ Mobile

With Microsoft® PowerPaint® Mobile, you can open and view slide show presentations created
on your computer. Mary presentation elements such as slide transitions, animations, and URL
links are also supported. Microsoft® PowerPoint® features that are not supportad on your Treo
include the following:

Custom animations and transitions,
Smart&rt layouts are replaced with supported layouts,

Text boxes, images, and shapes that use the Reflaction, Glow, Bavel, 3E Rctation, and
Transform effects,

WordArt styles and text effacts.

Fonts and font sizes not supported by your Treo.

Audiofideo content (embedded WAV files are supported).
Protection settings.

Rearrangement or editing of slides.

Filas created in PPT format earlier than Microsaft PowerPoint 97,
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To copy & fle from your compiiar o your Treo, open My Computer or
Windows Explarer on your computer copy the file info the Mohile Device
folder, and then sync.

Playing a Presentation

T;

Press Start [82] and select Office Mobife.

2. Selact PowerPoint Mobile .

3.

In the presentation list, highlight the presentation you want to play,

4 Press Center () and do any of the following:

Prass Right b to advance to the next slide, or Left < to view the previous slide
Prass Menu —— (right softkey, select Go fo Sfde, and then select the slide you
want o view:,

Press Menu — (right softkey), and select Mext or Previous to play animations.
Press Menu (— (right softkey), select Zoomfn, and then select J® to zoom in or
J to zoom out, (To scroll within the current slide, tap and drag the slide. To return to
the slide show, selact =)

Press Menu (— (right softkey), and select End Show.

Tip If & prasantafon s sofup 25 2 fmed slide show, the slides advancs
aumatically. Fresentafions pause duning Zooming

Setting Presentation Playback Options

1.
2
3.

Cpen the presentation for which you want to change the settings.
Press Center () and select Show Options.

On the Orentation tab, select the orientation you want, (To salect the orientation that
best fits the screen on your Treq, selact Defaudt)

Select the Playbacktab, and check the Override playback opfions for alf fites box
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5. Set any of the following options:
Show without animation: Turn off builds and other animations.
Show without sfide transfifon: Turn off transition effects batweaen slidas,

{Use fmings, if present Enable the timings recordad with each slide ina
presentation.

L oop continuousiy: Advance to the first slide after playing the last slidein a
prasentation.

Show withowt media: Turn off sound and other meadia effects,
6. Prass OK[@].

Tip To furn fhe prasantziion info a2 confintously looping sfide show, chadk both
fhe Use timings, if present, and the Loop continuously boxes.

Excel® Mobile

With Microsoft® Excel® Mobile you can create and edit workbooks and templates on your Treo.
“ou can also edit workbooks and templates that you create on your computar, Howeavear, Keap
in mind that you may lose some of the information and formatting when you save the
worklook on your Treo.

To copy & fa from your compufar B your Teo, opan My Computer or
Windows BEqlorer on your computer, copy the file info the Mahile Device
folder, and then syna

Mote the following formatting considerations:
Afignment: Vertical texd appears horizontal,
Artfstic borders: Appear as a single line.
Celi patterns: Patterns applied to cells are remcvead,
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Fonts and font sizes: The original font is listed on your Treo and is mapped to the closast
font availatble. Criginal fonts reappear on your complter,
Number formats: Microscft® Excel® 97 conditional formatting is displayed in number
format.
Formufasand functions: Unsupported functions are remaoved, and only the retumed value
of the function appears. Formulas containing the following are also converted to values:
Mare than 512 bytes
AN array or array argument, for example, =SUM{[1;2;3;47).
Extarnal link refarances or an intersaction rangse raference.
Reterences past row 16384 are replaced with #REF.

Tin For simple calculaiions, use the Calculator (see "Calouialor” on page 256),

Protection seftings: W ost protection features are disabled but are not remaoved, You must
remaove the password protection in Microsoft® Cifica Excal® on your computer before
editing the file on your Treo, Rights-managed and password-protected files must be saved
only in their original file format.

Zoom seffings: Workshest-specific zoom sattings are not retained. The zoom setting
applies to the entire workbook,

Wortsheet names:- Mamas that refer to other workbooks, arrays, array formulas, or
intersection ranges are remaoved from the name list, causing those formulas to be
resolved as “#MNAME? All hidden names are not hidden.

AtifoFifter Setiings: AufoFffersthat cause rows to be hidden are supported,. Use the
{nfide command to display hidden rows. Cther AufoFfifers are removead, but you can use
the AtfoFfer command in Excel Mobile to perform similar functions.

Chart Formatting - All charts are saved as they appear in BExcel Mobile. Unsupported chart
types are changed to one of these supported types: Column, Bar, Ling, Pig, Scatter, and
Area. Background colors, grid lines, data labels, trend lines, shadows, 3D effects,
sacondary axes, and logarithmic scales are tumned off,

Hidden sheets. Hidden workshests are displayed.
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Excel 2007 Binary wortdoofes. vou cannot open XL5SE workbooks.
Legacy files. PxL and PXT files can be opened, but must be saved in xLS or XLT format.

File conversions. You canndt save a file with an XLS or XLT extension as an XLSX or xLTx
file, respactively; and vice versa.

The following features are not supported in Excel Mobile and are removed or modified when
wou open a workbook on your Treo:

Dialog sheets and macro sheets,

WBA modules,

Textt boes.

Drawing objects and pictures.

Lists.

Conditional formats and controls.

Pivot table data (is converted to values).

Creating a Workbook

274

1.
2
3

e = RS B

Press Start [22] and select Office Mobile.
Selact Excef Moblie iz,

If an empty wiorkbocok appears onscreen, go to step 4; if the workbook list appears
onscreen, press Mew (— (left scitkey).

Highlight a call whers you want 1o anter text or othar information.
Enter the information in the cell, and then press et ().
Repeat steps 4 and 5 to enter the remaining information.

Press OK [@] to save the file,
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Wifer you sava & naw workbook, ifis aufomaficaly namead SookK (whana X
is the next number in & saguanca) and then placed in the workhool fist

To insart & symbol pace fe insartion poit wheare you want e symbol
Prass Menu (right softkal) and salzact insert > Symbol. Hightight the
symbol you want 0 insert, and then sefect Insert.

Creating a Workbook From a Template

1.

G0 tothe workbook list,
Select the list in the upper-left comer, select More Folders > Templates.

Open the template you want to use, and enter the information you want to include in the
template.

Press Menu — (right softkey) and select Fike > Sawe As.
Select Name and enter a new name for the workbook.
Select the Foider list, and then select the folder where you want 10 save the workibook,

Select the Type list, and select Excel 2007 Workbook
Select Save.

To arez e & new lamplate Fom & workbook, open the wotthook you want b
sEe a8 3 bmpk g Prass Menu frighf soffiey) and sgect File=Save As.
Sekct Name and then enter & name for the Bmplak. Sekct the Falders tist
and safact Tenplates. Sakct Type and salact Bcel 2007 Template. Prass
Ok
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Viewing a Workbook

276

Press Start [22] and select Office Mobife.

2. Select Excel Moblle (x:.

In the workbook list, select the workbook you want to view:.

4 Press View (— (eft scitkey) and then select any of the following;

Fuff Screen: Viaw as much data as possible on the scresen. To return to the normoal
view, select Resfore in the upper-right corner.

Zoom: Set the magnification level so that you can easily read the workshest.
Sheet: Switch to a different worksheet,

Spift:- Divide the window into two scrollable areas, To move the split bar, tap and
drag it. To remaove the split bar, select Wiew > Remove Spiit

Freeze Panes: Lock rows or columns so that they remain visible while you scroll.
Highlight the cell at the juncture you want to lock before yiou selact this command.
To unlock the rows or columns, select Wew > UnfreeZe Panes.

Tootbar: Set whether the toclbar appears onscresn,
Status Bar: Set whether the status bar appears onscreen,
Show: Set whether headings and scroll bars appear onscresan,

To fump fo 2 aall or ragion, prass Menu (right sofficay) and salect Edit = Go
To. Sekct Cell reference or name and ener the farget call information or
safect Current region. Safect CK.

You can switch worksheats by selecting the sheet ist 2t the boffom of the
SCraa
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Calctiating a Sum

1.

Press View — f(left softkey) and select Toobar,

2. Highlight the cell where you want to insert the sum.
3. Select Sum 5.
4. Tapand drag the stylus across the cells you want to add.
5. Press Retun 4.
Entering a Formula
1. Highlight the cell where vou want to enter the formula,
2. Enter an equal (=) sign followed by any values, cell references, name references,
operators, and functions, Example: =(B4/25)+ 100=Revenue-Expenses
3. Press Refurn (4.
Inserting a Function
1. Highlight the cell where you want to insert the function.
2. Press Menu —— (right softkey) and selact fnsert =
Function.
3. Selactthe Category list, and then select the type of function
yoU want to insert,
4. Selectthe Function list, and then select the spacific function
you want to inser.
5. Select OK

Al To anter symbols thatane noton tha favboard, such as tha = sign, prass Alt
and salact the symbal from the st
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Entering a Sequence Automatically

1.

2. Press Menu (— (right softkey) and selact BGf > A, o~
3. Select the Direction list, and then select the direction you e =

4. Select the Al fype list, and then select Seres . T

Highlight bath the cells containing the information you want : -
to automate and the adjacent destination cells.

want to populate,

Select the Seres e list, and then select the type of series [ cama |
you want, If yvou select Date or Number, enter a Step value “
increment,

. Select OK

Sakct Autofill s the series fpe B guickly filf calls with mpelitive data such
as numbers or frepestad faxd AUDfill Bhas the confant of the first call in the
highlighted row or column and copias fdown or a ooss the rest of the
Splechion.

Adding Cells, Rows, and Columns

278

1

. Open the workbook you want to add to.
2. Highlight the area where you want to insent elements,
3

4 Select how you want to insert the elemeants:

Press Menu — (right softkey) and select insert = Cefis.

Shiffcelisright: Insert a new call. The highlighted cell and all cells on the right move
one column o the right.

Shiff cefis down: Insart a new cell. The highlightad call and all cells balow it maove
dawn,

Entire row: Insart a naw row., The entire row in which the highlighted cell is located
and all rows below it move down.
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Entire column: Insert a new column, The entire column in which the highlighted
cells are located and all columns to the right move one column to the right.

5. Selact OK

To add & new workshee! prass Menu {right sofffey) and select Format =
Modify Sheets Sekdcf Insert, entr & name for the workshesl and then
prass OK. To change the order of the wodtsheats, highlighta worlshaest
you want fo mova and then ssfect Move Up or Move Down, Press OK

Foimatting Cells
1. Open the workbook you want to format.
2. Highlight the cells you want to format.

To name the highlighlad call or range of calls, prass Menu {ight sofffeay)
and sefect Insert = Define Name. Enter the name and sefact Add . Press
K.

3. Press Menu —— (right softkey) and select Format > Ceffs
4. Select any of the following:

Size: Seat the row height and column width.

MNumber: Set the format for the numbers in the cells.

Afign: Sat whether text wraps within the highlighted cells, and set the horizontal and
vertical alignment position.

Font Set the typeface, color, size, and shde attributes.

Borders: Turn borders on and off for various call edges, and set the border and
background colors,

5. Press OK [@].
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Formatting Rows and Columns

Cpen the workbook you want to formeat.,

Highlight the rows or columns you want to format.

Press Menu (— (right softkey) and then select Format > Row or Format > Column.

FoLa b

Salact any of the following:
AutfoFt: Adjust the size of the highlightad rows or columns to thair contents,
Hide: Hide the highlighted rows or columns.
{Unhide: Display hidden rows or columns in the highlighted area.

il You can adiust e column or fow sz by Bpping and dragging the dght
adfge of the column header or tha bofforn adge of he row header To
automaticatly fit rows and cojumins o thair contents, doulle-i2p the lower
adfge of the row heading or the right edge of fhe column heading

Renaming a Worksheet
1. Open the workbook containing the workshest you want to rename.
2. Prass Menu (— (right softkey) and selact Format > Modify Sheels.
3. In the Sheets list, highlight the worksheet wou want to rename.
4. Selact Rename, anter a naw name for the workshaet, and then press OK [@] twice,

Sorting Information in a Worksheet
1. Highlight the cells you want to sort.
2. Press Menu (— right scftkey) and select Tools > Sort,
3. Selact the Sortby list, and then salact the primary sort column,
4

- Check or uncheack the Ascending box to indicate whether yiou want to sort in ascending
or descanding order,

5. (Optionall Selact the Then by lists, and than selact second- and third-lavel sorting
options.
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5.

T

Check or uncheck the Exciude header row from sort bax to indicate if you want to sort
the headar row.

Sealact OK

Fittering Information in a Woriksheet

1. Highlight the cells that contain the information wou want to filter,
2. Press Menu —— (right softkey) and select Tools > AutoFiffer. (A list appears at the top
of each related columnj.
3. Selact one of the new lists, and then selact a filter, (This hides all rows that do not
include the selectad filter)
4. (Cptional) Select the ather lists, and then select other filtars.
Tip To dispiay all rows again, salact the filler lisf and then salact Al To fum off
fiflering, prass Menu (right soffey) and select Tools = AutoFilter again
Al You can also create cusfom fittrs whara Vo u specify comparisons Salact
the fitter list, and then sekct Custom.
Creating aChart
1. Open the workbook yvou want to create a char from.
2. Highlight the cells you want to include in the chart.
3. Press Menu (—) iright softkey) and select insert > Chart
4 Select the type of chan, and than press Mext c— (right softkey).
5. Confirm the data range you want to chart, and then press Mext (—) (right softkey).
6. Selact the data layoLt, and then prass Mext (— (right softkey).
7. Check the boxes to indicate whether the first row and column of the data range

represent labels.
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8. Selact whether you want the chart to appear as a separate worksheet within the current
worklbook, or as part of the current workshest,
9. Press Andsh (— (right softkesy).
Fomatting or Changing aChart

1. Open the workbook that containg the chart you want to format,

2. Cpenthe chan.

3. Press Menu —— (right softkey) and select Format > Chart,

4. Select any of the following:
Titles: Set the title of the chart and the headings, whether a legend appears, and the
placemeant of the legend.
Scale: Set the minimum and maximum scalas for chars with an x or v axs.
Type: Set the chart style, You can use this setting to convert your chart to a different
format.
Series: Add, modify, format, or delete related data points without affecting the
information in your workshesat,

5. Press OK [@].

Finding of Repfacing Information in a Workbook

2852

1.
2. Press Menu (—) iright softkey) and select Edif = And/Replace.
3
4

Cpan the workbook containing the information you want to find.

Select And what and enter the information you want to find.
(Optional) Check the Makchcase boxto find taxd that matches the capitalization in any

texd you enteraed.

(Optional) Chack the Matchentire cefis boxto find only full words that match any texd
yoll enterad,

Select And to locate the first instance of the information you entered, or select Replace
and enter the replacement information.
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7. Select Nexttofind the next instance of the information, or select Replace to replace it.

{To replace all instances of the information, select Replace Aff)

2. When you see a message indicating that the search is done, press OK [&].

Organizing Your Workbooks

You can rename your workbooks and move them to ancther folder and between your Treo
and an expansion (storage) card.

1

e L R

G0 to the workbook list,

Highlight a file.

Press Menu — iright softkey) and select RenameMove.

Select Mame and then enter a new name for the workbook,

Select the Fofder list, and then selact the folder you want to move the workbook to.
Select the Location list, and then select Maln memory or Storage card.

Fress OK [@],

Select the list in the upper-left comer, and then sslect the folder you want 1o view.
Select the list in the upper-right corner, and then select the sort method.

Tin When you go 1o & folder, you Can easiy Search Your documents by sorfing
by fype.

Deleting Celffs, Rows, and Columns

1.
2. Highlight the area vou want to delete,

3

4. Select how you want to remaove the elements:

Section 58:Increasing Your Productivity

Cpen the workbook containing the elements you want to delete,
Press Menu — iright softkey) and select B > Delete Cefis.

Shift celis left: Delete the highlighted cells and moveas all cells on the right one
column tothe left,
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SHhift celis up:Delete the highlighted cells and moves all cells below them up.

Entire row: Delete the entire row in which the highlighted cells are located, and
maves all rows below it up.

Entire coltmn: Delete the entire column inwhich the highlighted cells are located,
and moves all columns on the right one column to the left,

5 Prass OK[@&].

Exoel Mobile adiusts formulas o refact the new call focafions. However, &
formula thatrefers fo a deleld call displays the #REF eror value.

To dekk & WokbooK, go fo fha worscbook B3t and highiight the workbook
you want fo dalala Prazs Menu (ight soffiay) and salact Delete. Salkct Yes
o confirm.

To delats 2 worksheal open fhe workbook that confzing fha workshest your
want fo deleke. Prass Menu {right soffiey) and select Format = Modify
Sheets. Highlight thea workisheat you want o dalele, and then salact Delete.
SekctYes fo confirm the dalefion, and than prass OK

Customizing Excel Mobile

1. G0 to the workbook list.
2. Press Menu — (right scftkey) and select Opfions.
3. Set any of the following options:
Template for new workbool: Set the default template for new workbooks.
Save new workbooks fo- Set where new workbooks are storad.
Files to display in fist view: Set which typas of files appear in the workbook list.
4. Press OK [@],
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OneNote® Mobile

CneNote® Mobile lets you create digital notes that contain text, pictures, and audio and video,
You can then synchronize these notes with Microsoft Cffice CneMNote 2007 on your computer,
During synchronization, all the notes you create on your Treo are copied to a notebook called
Cnebote Mobile on your computer; you can then drag your notes to other locations on your

computer, You can use Onalote Mobile to do any of the following:
Take pictures of business cards and than insert them into CneMote,

Take pictures of flip charts and whiteboards in conference rooms and then inser tham

into Cnelote,

Enter text and insert voice recordings (for example, reminders of important events, ideas

for projects, price comparisons, recommendations, blog ideas, and =0 on) and
synchronize them with your notes,

Prepare mesting or travel information in Onelote on your computer and then transfer it to

your Treo 50 you can access the information on the road.

Creating aNew Note

Just like in Cffice OneMote 2007 on your computer, CneMNote Maobile continuously saves your

note as you create, adit, and close a note.
1. Press Starf [ 2] and salact Office Mobite.
Select OneMote Mobile §1,
Press Mew (—) (left softkey),
Enter your note tex.
(Cptional) Do any of the following:

Format fext, Place the cursor in the middle of the word that you want to format,
press Menu (— (right softkend, select Format and select a style. To clear all

oo e b

formatting for the selected ted, press Menu — (right softkey), and select Format>

Ciear Al
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Create a numbered fist: Place the cursor where you want the list to bagin, press
Menu — (right softkey), and selact List>NMumbered, To clear the numbearad list
formatting, place the cursor on any list itemn, press Menu (— (right softkey), and
select List = Clear.

Create a butteted fist- Place the cursor where you want the list 1o begin, press Menu
— (right softkey), and select List > Buffeted. To clear the bulleted list formatting,
place the cursor on any list itemn, press Menu (— (right scftkey), and select List >
Clear.

Create a hyperiintc Enter the Web site address for which you want to create the
hyperlink, For example, to create a hyperlink 1o the Microscoft Web site, type

httpA fvwww nicrosoftcom.

nserta new picture: Frass Menu — (rght softkey), selact Take Piclune, press
Cenfer () totake the picture, and then press OK [@] to insert it into your note,
Insertan existing picture: Press Menu (— (ight softkey), select fnesrt Picture, and
then select the picture to insart it into your note,

inserta voice nofe: Prass Menu —— (right softkey), select fnsert Recording, and
then select Record [e] 10 begin recarding. After you finish recording, select Stop [a].

£. Press Done (— (left softkey). (The first line of text in the note becomes the note name.
You can rename the note later)

Tip While faking noks, you can undo & misiie by pressing Menu (right
soffay) and selctng Undo,
Viewing or Editing an Existing Note

1. Press Start [a2] and selact Office Mobite,
2. Select Onefdote Mobike §1).
3. Inthe CneMacte Mobile list, select the note that yiou want to open.
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4. Do any of the following:
Open a hyperfink- Place the cursor anywhears in the link, and then press Cenfer ().

View picture defaif- Highlight the picture, press Center (), press Menti .— (right
softkey), and than select Zoomin, To zoom in further, press Menu — (right
softkey) and select Zoomfn again. Use the S-wayto view different parts of the
pictura, To zoom out, press Menu — (right softkey) and select Zoom Out:you can

also selact Actual Size or At fo Screen. To close the picture, press OK [@].
Pfaya voice note: Highlight the vioice note and press Cenfer (). To close the voice
note, press OK (@]

5. Press Done (— (left softkey) to close the note.

Renaming a Note
1. In the CneMaote Mobile list, select the note that you want to rename.
2. Press Menu —— (right softkey) and then select Rename.
3. Enter the new name.
4. Press Done (— (left softkey) to accept the naw name.

Sorting your Notes
1. From the OneMNote Mobile list, press Menu (—) (right softkey), and then select Opfons.
2. Selact the method you want to use to sort your notes: Mame or Date modified.
3. Press Done (— (left softkey) 10 sort your notes,

Deleting a Note
1. Inthe CneMote Mobile list, select the note that you want to delste,
2. Press Menu —) (right softkey) and then select Delete.
3. Selact Yesto confirm the deletion.
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PDF Viewer

Picsel PDF Viewer |ets you view POF files whether they are saved to yvour Treo, attached to
email messages, stored on an expansion card that is insered into the expansion card slot on
your Treo, or downloaded from the Web, ou can customize the document display,

You can use the Sles sno folder fo fansfer PDF fles balvaan vour
compitar and your Treo. The procass is the same as fansfering Microsoft
Offica files See “Synchronizing Microsoff Office and Other Fies” on

page 260 for detzils.

Opening a File

1.

oo e b

288

Press Start [ 2] and select Programs
Select PDF Viewer % .
Select the folder containing the file you want to open.
Select the file you want,
(Optional) Optimize your viewing of the file by doing any of o —— -
the following:
To switch between zoom mode and pan mode, prass
Cenfer ().
To zoom in and out while viewing the POF file, press
Up a or Down + while in zoom mode.

To pan the display in a given direction, prass Right I,

Left 4, Up o, or Down w while in pan mode. s s

To rotate the displayed page, press Menu (— (right
softkey) and select Page > Rotate.
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To saa which moda you are i, press Show Made feff soffiiay) fo display
the modea icon. Prass Hide Mode deff sofifey) fo hide the modea icon.

To quickly find the file wou want salect the <folder name>, Date, or Size
column heading o sorfthe displayved fibs by fhatheading

To open & Ma you hava recantly openad, open POF Yiewer, prass Menu
{right sofffay), and than salect Recent®> [the name of the file you want].

Moving Around in PDF files

To move around within a PDF file, do either of the following:
To gotothe nexd or previous page in the file, press Menuy (— (right softkey) and select
Page > Mext Page or Page > Previous Page.
To gotothe first or last page in thefile, press Meny (— iright softkey) and select Page >
Hratpage or Page > Lastpage.

Custamizing the Display
“ou can choose betwean two views for displaying PDF files, You can also hide the toclbar to
view the file on the full screen.

1. Press Menu (— (right scitkey) and selact Page.

2. Selact one of the following options:
Fit fo width: Set the width of the file to match the width of the scraan; you may naed
to scroll up or down to view the entire document.

Fitto page: Set the entire file—both width and height—o fit on one screen.
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Customizing PDF Viewer
1. Press Menu — (right softkey) and select Setiings.

2. Selact any of the following options:
Clear History: Delete all files from the Recent list, which shows the four most

recently viewed files,
Files: Set which file types can be opened with PDF Viewsr,

About View information on the FOF Viewer application.
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Section 6A

Managing Files and Applications

In This Section

Finding Information

Installing Applications

5
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Removing Applications

Sharing Information

lJsing Expansion Cards
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Finding Information

You can find information quickly with the buil-in search and GPS features on your Palm®
Treo™ 800w sman device:

Loofp: Find and dial your contacts by contact nams, company name, or phone number,
(See “Dialing by Contact Name” on page 77 and “Dialing by Company Mame” on
page 79 for details)

Search: Lock through the texd in all the applications on your Treo.

Fie Expiorer- Browse through the files and folders on your Treo or on an expansion card.
Global Address Loofup: Lock up names in your online corporate address list,

L ive Search: Start a Web search directly from your Today screen, (See “Searching the
Web From Your Today Screen”™ on page 179 for details)

Maps:-Find a point cf interest or a specific address. (See “Finding a Point of Interest” an
page 182 for details)

Using Search

Search for files and other items stored in the My Doctments foldar on yiour Treo or on an
expansion card, You can search by file name or by words located in the item, For example,
wou can search for words within notes, appointments, contacts, and tasks,

294

1.
2
3.

5 Press Search (— (left scitkey),

. Select the Type list, and than selact the kind of information

Press Start (8] and select Programs w

Select Searcfr . =

Select Searchfor, and then enter the file name, word, or i
other information you want to find.

Fesalts

you want to find.

£, Usathe d-wayto salact and viaw an item from thea results of [ S e |

the search.
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Tin To find an fam youve fooked for befora salect the Search for st and thean
salact the ifam in the list

You can also open the Search sareen by pressing Option + Shift.

Exploting Fifes and Folders

You can use Ale Exptorer to browse the contents of folders on your Treo or an expansion card
{sold separately), The root folder on your Treo is namead My Device. My Device (s similar to My
Computer (Windows XP) or Gomputer (Windows Vista® on your computer.

1. Press Starf [#] and select Fie Explorer,
2. Tapthe list in the upper-laft cormner, and than select the folder you want to explore,

5
5
2
£}
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2
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You can sort the contants of & folfer by name date, size, of iipe Salect the
listin the upperright comer, and then selact the sort method.

3. Do any of the following:
To open an item, selact it
To decomprass a ZIP file, tap it.

To comprass fleg you must Lse 2 decompression program, such 2s WinZip,
05 your computar You cannot comprass files on your Treo.

To quickly delate, renams, beam, or amail an item, highlight the itam, preass and
hold Cenfer () to open the shorteut menu, and then select the appropriate
command.
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Do not delet any files that you cannot dendfy, These files may be requied
for vour Treo fo funclion property

To move or copy a file to ancther folder, highlight the item, press and hold
Cenfer () to open the shortcut menu, and then select Cut or Copy. Cpen the

destination folder, press and hold Cenfer () to open the shortcut menu, and then
select Paste.

To highlight multiple iterms, tap and drag the stylus,
Instalfing Applications

Your Treo comes with several built-in and ready-to-use applications. You can also install any
of the additional software included on the Getting Started CD for Palm Treo 800w smart
davice, as wall as othar third-party applications that are compatible with devices running
Microsoft® wWind ows Mobile® 81 Professional edition, such as business scftware, gameas, and
maore,

Applications you download to your computer are likely to be in a compressed format, such as
AP i the file is compressed, yvou need to decompress the file before you install the
application on your device, You can decomprass the file on your Treo in File Explorar or on
your computer in a decompression program, such as WinZip.

You can also send the file o vourself a5 an emall aflachmentand then opan
the email message on your Treo, and Bp fe atlz chment i aufomalically
dacompress the fila

The following instructions tell you how toinstall basicfiles onto your Treo, Some software uses

an installer or wizard to guide you through the process, For details, consult the documeantation
that came with tha software.
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If an applicafion doas not have & Microsoff Mobile fo Market carfificats a
message appears ndicafing that the applicafion is unfusked. i this ocours,
you can indicale whether you want fo confinue the installation

Be sure fo sebat and instal applicafions that are compatibl with Windows
Mobile 6.1 Frofassiona). Applications thatare designed for other versions of
Windows Mobie may not be compatble with your Treo.

instalfing Bonus Software From the CD

The Getting Started CD for Palm Treo 800w smant device includes several bonus software
applications that you can install on your Treo. You can install these applications whean you
install the deskiop softwars, or you can install them later.

1. Insert the Getting Started CD into the CD drive on your computer,

Click Bonus Software,

Click the name of the application you want to install.

Click instaff (on the right side of the screen).

(Optional) Repeat steps 3 and 4 to install additional applications.

_ Synchronize your Treo with your computer to install the application (g an your device.

Purchasing Applications From the Sprint Mobife Software Store
You can use Software Store to purchase and install applications directly from the Sprint
Motbile Software Store Web site onto your Trec.
1. Make sure your phons is on (see “Turning Your Phone Cn and Off” on page 35).
Press Start [ &2 | and select Programs
Select Software Store €.
Selact a categony link,
Select the Buy Mow link below the item you want to purchase.
Follow the onscreen prompts to complete the transaction.

5
5
2
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instafling Applications From Other Web Sites on the Internet

You can use Internet Explorar® Mobile to install Windows Mobila applications in the CAB file
format directly from the Internet, For files in the ZIP file format, you must unzip the files in File
Explorer before you install them, For files in army format other than CAB or ZIF, you must first
download the files to your computer and then install them to your Treo by synchronizing.

1.

oL

~ o o,

5.

IMaka sure your phone is on (see “Tuming Your Phone Cn and Cff” on page 35).
Fress Starf [a7] and select infernet Explorer,
Gotothe page that contains the link to the application you want to download.

Press Leff < or Right I to highlight the link to the file, and then press Center () to start
the download process.

If prompted, select the folder where yvou want to store the file.

When the download is complete, press Starf [ 2] and select fie Sxpforer.
Gotothe folder vou selected in step 5.

Select the file you downloaded to start the installation program.

installing Appfications From Your Computer

There are many applications available for your Treo, To get started, check out the selection at
palm.com/treod00wsorint-support,

To dnstall an applicalion fom your computer; vou must finst install the
deskiop e soffware on Your compulr (s “Sefling U Your Compuks
for Synchronzalion” on page 46

- Onyour computer, open My Computer or Windows Explorer (Windows XF) or Compier

findows Vista).

2. Copy the application file(s) into the j Mobite Device folder.
3. Connect your Treo to your computer to synchronize and install the application(s) on
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your device,
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instafling Applications Onto an Expansion Card

1. Insert the expansion card into the expansion card slot on your Treo (see “Inserting and
Removing Expansion Cards™ on page 302).

2. Connect your Treo to your computer,

3. On your computer, open the ActiveSync® window (Windows XP) or Windows Mobile
Device Center (Windows Vista),

- Click Explore | STg
5. Double-click My Windows Mobite-Based Device Ej o open the Mobile Device folder,
Copy the application file(s) into the Storage Card folder inside the Moblte Device folder.

Getting Heip With Third-Party Appfications

[f wou encounter a problem, such as an error message, with a third-party application, contact
the application’s author or vendor, For general troubleshooting of third-party applications, see
“Third-Party Applications” on page 373

5
5
2
]
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2
&

Makea sure that the third-party application supports 320 x 320 screen resolution. Some older
applications have screen-size limitations. Third-party applications should also be written for
Windows Mobile version 61 or later, Programs written for earlier versions may nat support
S-way navigation or softkays and can have performance problems.

Bafore purchasing & third-party program, ry the free varsion (f svailabis) fo
make stre the program wodes propeny with Windows Mobile 67 and youwr
Tren,
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Removing Applicalions

To free up storage space on your Treq, you can remove
applications that you no longer use, You can remove only
applications, patches, and extensions that you install; you cannot [
remove the built-in applications that reside in the [ T
Read-Cnly-Memory (ROM) portion of your device,

1. Press Start 2] and select Settings.

2. Selact the Sysfem tab, and then select Remove [ wemove_|
Programs L_—-:I Tota ST remary avalite ?

3. Highlight the application that you want to remove. [ ——

4. Select Remove.

5. Selact Yesto confirm the deletion.

Tin Some applicafons are fachrsinsEled on Your Treo znd cannot be deletad.
These are notinciuded on the Remove Programs fist

Sharing Information

Your Treo comes equipped with a variety of options for sharing information, so that you can
choose the guickest, most convenient way to send your information or to receive information
from ancther device,

When you have a file open in a program such as Motes or Picfures & Videos you can
sasily share this file by pressing Menu 2 [right scftkey) and then selecting either
Beam, FAke >5end via, Tools > Send, or Tools > Beam.

When you're viewing a list of filas, such as the Motes list or PowerPaint® Mobile list, you
can share a file by highlighting the file in the list, pressing Menu (=2 (right softkey), and
then selecting Send via or Beam Fie.
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In the Inbox application, you can insart a picture or attach a note or other file to an email.
“ou can also recsive pictures and attachments,

You can synchronize to share files with your computer, (You can add or remove files
directly from the <device name> My Documents folder, located in your My Docurments
directory on your computer. These files are updated the nexd time you sync)

“You can beam files and applications between your Treo and the device of someone near
you, using the IR port or Bluetocth® wireless technology.

“ou can also store files on an expansion card and share the expansion card.

Using Expansion Cards

5
5
2
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The expansion card slot on your Treo enables you to add microSD cards and microzDHC
cards to extend the storage capacity of your device. (Expansion cards are sold separately)
For example, expansion cards can store the following, and more:

Documents (Office, taxd, and POF)
Email attachments

Pictures

Yideos

Audio and music files

Games

Applications

Wi recommend that vou purchase preformatied expansion cards To format
& cand on polr o Wou nesd B connact a2 cand raadar (solf sanarakai) fo
YOLr GOMmpUtey.

Section 6A: Managing Fies and Applications 301



{nserting and Remaving Expansion Cards

1. Open the door to the expansion card slct by liting the |t edge of the door and then
ratating the door dowrward,

2. Do either of the following:
To insert an expansion card, hold your Treo with the screen facing you and the card
with the label facing you, and then inser the card into the expansion card slat until
you feel it lock into place. (The contacts on the card should be facing away from
oL
To remove an expansion card, press the card into the expansion card slot until it is
released from the slot,

Your Treo has & push-push mechamism.: push in gently fo insert & card, push
i gendly o remowe it

Ifthe Ringer switch is sef fo Sound On, you hear & confirmalion fne whean
Yol st OF fmova 20 aXpansion

Opening Applications on an Expansion Card

After you insert an expansion card into the expansion card slat, you can open any of the
applications stored on the expansion card.
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Insert the expansion card into the expansion card =lot.

Fress Start [a2] and salect Afe Expforer,

Select the list in the upper-left corner, and then select Sforage Cand,
Select the application you want to open.

R

Tip TO £U &1 PRNCATON 01 A1 GXPANSION CaA, vour Treo must Nave anough
frea spacs in the intwnal mamory:

Saving Fifes to an Expansion Card

YoU can save space on your Treo by saving files to an expansion card, For example, whean
you craate new Word Mobile documents, notas, Excel® Mobile workbooks, picturas, videos,
and audio files, you can save them directly to an expansion card. (Some applications may not
support this feature)

5
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1. Insert an axpansion card into the axpansion card slat,
2. Open the application that contains the information you want to save.

3. Press Menu (— (right softkey) and select Opfions or Tools (depending on the
application).

. Select the Save folist, and then select Storage Card.
5. Prass OK [@].

If you dor't see the Save to st on the Options saean, fook on the othear
fahs (if presant). If wou s8f can't find & Save to fist the application may not
support fhis feafure

You can ceate folders on your expansion card so that ifs easy fo find your
files wihen you need tham.
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Moving Information Between Your Treo and an Expansion Card
Insert an expansion card into the expansion card sict,

Cpen the application that contains the information you want to move.
Gotothe list view and highlight the item({s) you want to mowve.

Press Menu — iright softkey) and selact Reramediove.

Select the Location list, and then select where you want to move the information:
Storage Card or Main Memory.

6. Press OK [@].

L

Capying of Moving Applications and Fifes Between Your Treo and an
Expansion Card

1. Insert the expansion card into the expansion card sict,

2. Press Start [ 8] and select Afe Explorer,

3. Selact the file or application that you want to copy or move (see “Bxploring Files and
Folders™ on page 295),

4. Press Menu (— (right softkey) and select Edit > Copy or Edit = Cut

5. Gotothe folder where you want to place the selected item.

£, Prass Menu —— (right scoftkey) and select £dff = Paste.

7. Press OK [@].

i) Your applications are usually localed in the My Desce/Program Files folder

Viewing Available Expansion Card Memory

You can visw how much space is available on the expansion card that is currently in the
expansion card slof.

304 Section 6A: Managing Files and Appfications



S S

Insert the expansion card into the expansion card =lot.
Fress Starf [a7] and select Settngs.

Select the Systemn tab, and then select Memory T

Select the Storage Card tab.

After vou finish viswing the information, press OK [@],

Exploring Files on an Expansion Card

S e

Insert the expansion card into the expansion card =lot.

Fress Start [a2] and select Afe Expforer,

Tap the list in the upper-left cormner, and then select Sforage Cand.
Select the folder or files you want to view.

After yvou finish viswing the information, press OK [@],

Renaming Files on an Expansion Card

[f wou change the contents of an expansion cand, you may at some point want to rename the
files or folders to better match their contents.

1.

e S

Insert the expansion card into the expansion card =lot.

Fress Start [a2] and select Afe Expforer,

Tap the list in the upper-left comer, and then select My Device.
Highlight the file or foldar you want to rename.

Press Menu — iright softkey) and select Rename.

Enter the new name, and then press Cerfer ().
Prass OK [@].

Bafore copyving informaton fo or renaming the files or foldars on an
apansion cafd, make sure the cand is not wik-rokckd For daiRis we
the instructons faf came with vour cad
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Encrypting an Expansion Card

Whean you encrypt an expansion card, the info on the card can be read only by your Treo—so
no one can see what's on the card if it is lost or stolen.
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1.
2. Press Start [ 2] and select Setdngs.

3

4. Cheack the Encrypt fifes placed on storage cards b

Insert the expansion card into the expansion card slot.

Select the System tab, and then selact Encnypdion p

I Yol ofganization enforcas an encryplion policy Wot can sea haf the box
is Ghackad but you cannot Uncheck it
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Section 6B

Synchronizing Information

In This Section

Setting Up Wireless Synchronization
Otherays to Synchronize
Changing ¥hich Applications Sync
Stopping Synchronization

When you synchronize, the information you enter on your Palm® Treo™ 800w smart device,
WOLIr computer, or your corporate servar is automatically updated in the other location. There's
no need 1o enter the information twice, This is true whather you sync with your computar
using desktop synchronization software (see “Satting Up Your Computer for Synchronization”
on page 46) or you sync wirglesshy with yvour company's Exchange server (see “Setting Up
Wireless Synchronization” on page 308),

)
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Setting Up Wireless Synchronization

If wour company uses Microsoft Exchange Server 2007 or Exchange Server 2003 upgraded
to Service Pack 2, vou may be able 1o take advantage of Microsoft Direct Push technology.
Direct Push tachnology is a two-way wiralass delivery mathod that keeps your Microsoft®
Outlock® information up-to-date by providing efficient communication between the server and
wour Treo, Yol may also have access to other features such as Global Address List; Tasks
Crwver The Air (OTA); and IP-based push updating of Calendar, Tasks, and Inbox.

Baca uze vour daskio p copy of Qullook also synes with the sans, whataver
Wnes 0 the sener from your Treo also shows up in Ouliook; and whakler
you anter or change in Oulloor on your computsr synes fo the senwy and
then shows up on your Trao,

If you instaled AciveSyne dasidop soffware on @ Windows XP compuiar
you may hava aimady af up your Trao fo smahroniza wirskssiy with ha
saner To chack, on your Treo, prass Start, selecf Programs, and thean
salactActiveSync, Press Menu (dght soffiey). ff Configure Server appears
instead of Add Server Source, winaless sync fs atready sef up and you can
Skip this procadua.

1. Work with your system administrator to gather the following information for your
Exchange Server account:

Mall server address and domain name.
The usemame and password you use to access your corporate mail server,
Security connection: Does your senver Use an encrypted (S50) connaction?
Fress Starf [a2] and select Programs
Select AciveSyne (.
Press Menu — iright softkey) and select Add ServerSource.
Enter the emall address that you want to set up.

S e
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6. Uncheck the box to detect the Exchange server settings, and then press Mext —
{right softkey).

T If prompted, enter the Senver address and check the bax if the server requires S50
encryption, and then press Mext (— (right scitkey).

8. Enter the username and password that wou use to aACCess your corporate mail server,
and enter the Exchange server domain.

The Exchange Sarver seffings are case-sansifve. Da stire fo anfer
uppercase and lowercase fellers properly. Be aspadially careful when
antanng e passwond, Bacause it doas Nof appaar 01 e SC8an 2.5 You
enfer it Sea "Bnkering Lowarcase and Uppercase Lalfers” on page &4 and
“Entedng Mumbers, Punciiation, and SYmbols” on page 65,
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9. Askyour systermn administrator if it is OK to store your corporate email password on your
Treo, and then do sither of the following:

If it is OK, check the Save password box and press Mext (— (right softkey),

Ifitis not Ok, donot check the Save password box and press Mext .— (right
softkey). (You must synchronize manually; see “Initiating a Wireless Sync Manually”
on page 311 for details).
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10.

2.

12.

Check the boxes for the types of information you want —
to sync with the Exchange searver, P — @

{Cptional) Highlight an itam and select Seffings to change
the synchronization sattings for that type of information,
(Fetiings are not available for all itams,)

TRRRE

(Optional) Press Menu —— (right scftkey) and select
Advanced to set the rules for fixing sync conflicts. |

Press Arish — (laft scitkey). (Synchronization with .
your Exchange server begins automatically and onscreen M
messages indicate sync prograss.)

To aufomaticaly download more of an incoming emal message than tha
dafault saffing salectE-mall in skp 10 skt Settings, and slecta highar
number from the Daownload size limit st I vou don't ingrease s sefing,
you can manualy downioad tha rast of fhe massage 2fyour Convanian ca.

“ou can set a schedule for synchronization to take place anytime information is updated on
aither your Treo or the server, o at certain intervals (see “Setting the Synchronization
Schedule” on page 310), or you can allow synchronization to take place only when you
initiate it manually (see “Iniiating a Wirgless Sync Manually” on page 311).

Setting the Synchrohization Schedluife

By default, wireless sync takes place anytime information is updated on either your Treo or
the server using Diract Push technology, To save battery life, howevear, yvou can set
synchronization to take place at intervals that you specify.

gk
2
3

310

Press Starf [27] and selact Programs

Selaect ActiveSyne (.
Press Menu (— (right softkey) and select Schedude.
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4. Set any of the following options: — o T

Peatc times: Set the frequency for high-traffic time v @
pariods, such as when you are at work or when amail [ s

volume is high. G = =T
Off-peak imes: Set the fraquency for low-traffic time —
periods, such as late at night. [F] Servtt ecene sber1cb2h 5arv9

{fse above seftings when roaming: Set the frequency

whila you are roaming outside Sprint's natwiork, You Adpaal gk s 1 B yoer Khecie
should keep this bax chacked to ensure that wireless [
sync works properly:

Send/receive when | click Send: Set whether itemns are —— ———
sant as s00n as you select Send in the Inbax T ' @
application, or whathar they are held until the next TR
synchronization. iociid

5. (Optional) To customize your high-raffic periods, select it | -
the peakimeslink at the bottorm of the screen and adjust | bopbtta il O
the days and times. (For example, if you work Thursday 0609 £
through Tuesday, you can salect those days as your peak

timas instead of Monday through Friday) n

6. Prass OK[@].
Initiating a Wirefess Sync Manually

If wou want to control exactly when a wireless sync takes place, or if it is not Ok to store your
corporate email password on your Treg, you can initiate sync manually,

1. Toset up manual syne, follow the preceding procedure, “Setting the Synchronization
Schedule” on page 310, In the Peaft imes and Off-peak fmes lists, select Manuafty.

2. Toinitiate a manual sync, press Start [& | and select Programs
3. Select ActiveSync (.
4. Press Sync (— (&ft softkey).
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Other Ways fo Synchronize

Synchronizing Over a Bluetooth® Wireless Technology Connection

If vour computer is equipped with Blustooth® wireless technology, you can use a Bluatooth
connaction to synchronize your computer and Treo.

e L S

10.

312

Make stife your compitr is Sef Lp for Smahronizaion (see ‘Selfing Up
Your Computar for SYnchonization” on page 46).

~ Do one of the following:

Windows XP:- Cn your computer, right-click the ActiveSynic ) icon in the taskbar in
the lower-right comer of the screen, and select Connection Settings

Windows Vista®: Click Start > All Programs > Windows Mobile Device Centfer, Selact
Connect without setfing up youwr device, and then select Connection settings.

Cheack the Affow connections fo one of the folfowing bax, and then select the Blustooth
COCM port yiou set Up on your computer,

On your Treo, press Starf [ & | and select Setfings

Select the Connections tab, and then select Biuetooth qj

Select the Mode tab and check the Tum on Bfuetooth boi,

Press Starf [&] and select Programs

Select AciveSyne (.

Press Menu — iright softkey) and select Connect via Bitefootf,

If this iz the first time you're making a Bluetooth connection to this computer, follow the
onscreen prompts to set up a Blustooth partnership with this computer, See
“Connecting to Devices With Blustooth® Wireless Technology” on page 196 for more
information on partnerships.

Select Sy

Section 68: Synchronizing Information



11, When synchronization is complete, press Menu (— (right scitkey) and select
Disconnect Biuetooif,

Synchronizing Over an Infrared Conneclion
[f wour computer has an IR {nfrarad) port, you can synchronize with your computar wirelassly
using the IR port on your Trec.

1. Turn on the IR feature on your Treo (see “Beaming Information With IF" on page 200).

2. Set up your computer to receive infrared beams. Ses Windows Halp on your computer
for details.

On your Treo, press Start [& | and select Programs.

Selact AciveSyne (.

Press Menu — (right softkey) and select Connect via IR,

.~ Point the IR port on yiour Treo directly at your computer's 1R port,

S

Synchronizing With Multivle Comptiters

You can set up your Treo to synchronize with up to two computers as well as with Exchange
Server 2007 or Exchange Server 2003 upgraded to Service Pack 2. When synchronizing with
multiple computers, the items that you sync appear on all the computers.
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For example, if yvou s&t up to sync your Treo with twio computers, named C1 and C2, when
wou sync Contacts and Calendar on wour Treo with both computers, you get the following
results:

The contacts and calendar appointments that were on C1 are now also on C2,
The contacts and calendar appointments that were on C2 are now also on C1,
The contacts and calendar appaointments from both computers are on your Treo.

Microsoff® Offce Qutiook” Exmal can syne with oy ane compuler
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Changing Which Applications Sync

On wiour Treo, you can choose which applications you want 1o syna.,

1.

2.
B
4

314

Press Start [ 2] and select Programs

Select ActiveSync (.
Press Menu —— iright softkey) and select Options.

Do any of the following: e~ o la
Check the box next to any itermns you want to i o
synchronize, If you cannot check a boe, you may :
need to uncheck a baox for the same information
type elsewheare in the list.

Uncheck the boxes ned to any tems you want to stop
synchronizing.

Selact an itemm and then select Seffings to customize
the settings for that itemn, (Settings are nct available
for all items.)

For jnformaion on Synchromzing Microsoft Word documents, Microsofd®
Excal™ spreadshaats, and Microsoff® PFowaPoin® prasaniations, and
Microsoff® Onefok noles, see "Synchronizing Microsoff Offica and Other
Hles” on page 260 For informa §on on smchronizing piciunes videos, and
music files, sea "Synchronizing Your Media Fles” on page 205,
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Stopping Synchronization

If yvou ever need to manually stop synchronization, follow these steps:
1. Press Sart [ 2] and select Programs
2. Selact ActiveSync (.
3. Prass Stop — (laft softkey).

To and the sy ralaionship befwean your Treo 2ad 2 compulks, so that
fems afe no fongar synchronzad with Hat compuler, salact tha complikar
name on the ActiveSync screan, and then salect Delete,
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Section 6C

Customizing Your Palm Treo 800w
Smart Device

In This Section

Today Screen Seftings

Systemn Sound Settings

Display and Appearance Settings
Application Settings

Locking Your Treo and Information
Entering Owner Information
System Settings

Connection Settings

Furchasing Accessories for Your Treo

o
&
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g
=
&
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Today Screen Settings

Selecting Your Today Screen Background

1.
2
3

4. Select Browse,
5. Selact the picture you want to use.
6. Press OK[&@].

Tin For phone satfngs, s “"Custmizing Fhone Seffings” on page 99 ‘

Press Starf [22] and selact Seftngs.
On the Personaf tab, select Today .

On the Appearance tab, chack the Use this picture as the
bactground box,

Tip To adjust the fransparency of your background picture, see “Lising a Piciuie
a5 te Today Soean Backgrournd™ on page 219

Changing the System Color Scheme

1

318

Fress Starf [&7] and selact Settngs.

2. 0n the Personaltab, select Today &
3,
4. Prass OK [@].

On the Appearance tab, select a theme in the list,
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Selecting Which fems Appear on Your Today Screen
1. Press Starf [#2] and select Settings. = r
2. Onthe Personaftab, select Today 0.
3. Selact the flemstab.
4

- Check the boxes next to the iterms that you want to appear
on your foday screen, and uncheck any items you want to
hide. (For example, to display your spead-dial buttons on
the Today scraen, check the Speed Diaf box)

5. (Optionall Highlight an item and select Move Up or Move
Down to change the order in which items appear on the
Today screen.

6. (Optional) Highlight an tem and select Options (if available) to configure the settings for
the itern, and then press OK to return to Today Setings.

7. Press OK [@].

Lofs of third-parfy plug-ins are avafiable for your Today soeen For clocks,
calouiators, MP3 plyers, waather guides, and much mo visit
paim. comyeo 800Ws prnsupport

Systern Sound Settings

o
&
)
g
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I certain situations, such as masatings and theaters, you neead to tumn off all sounds on your
Palm® Trao™ 800w smart device, You can immediately silence all sounds on your davice,
including phone ringtones, Calendar natifications, and system sounds, This doas not mute the
speakar during phone calls.
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Setting the Ringer Switch
1. Slide the Ringer switch to Sound Off of .
2. Tohear all sounds again, slide the Ringer switch to Sound On «f)).

® o

4 3

|r .@: ‘»:;.g l

| /
e | A

1 Sound Cn
2 Sound Cff

If the Ringer switch is set to no Sound Off ¢, the Ringer setting overrides the sound settings
and all sounds are turned off, including any music you may be playing, When you slide the
Ringer switch back to Sownd On o), it restores the pravious sound settings., All sounds are as
loud or as soft as they were before you turned them off.

ll Your Treo includas & sitent alarm that can vibrafe even when e Ringer
switch is st fo Sound Off

Selecting Sounds & Notifications
1. Press Starf [&7] and salact Setfings.
2. 0On the Personaltab, select Sounds & Notifications () .
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3. 0On the Sounds tab, set any of the following options: == e

Fvents:Tum sounds on and off for system warnings

and error messages. R

Programs: Turn sounds on and off that are specific to (] o3 ]

the applications on your Treo. il
Notifications: Turn alarms and remindars on and el P
off in all the applications on your Treo. &% ®

Screen faps: Set whether tapping the screen generates |

a sound, and setthe volume level when this sound is

turned on.

Hardware butfons: Set whather pressing buttons generates a sound, and sat the

volume level when this sound is turned on.

4. Select the Moffficaffonstab and set any of the following options;

Event: Select which action you want to change the o ~

settings for. (The remaining options vary based on the

action you select) e e K

Play sound:Tumn the sound on and cff for the selected Mievsera [

avent, (To select a different sound, select the list to the AL

right of this setting, and than selact a differant scund, To R _\

praview the sound, select Play [v].) | vireats wren s st er &
| = e

Repeat- Sat whather a Reminder tone plays more than S forsme [Paes] '
once, if Play Sound is turned on. “

Display message on screen: Set whether a notification message appears onscreen
for the selacted avent.
Vibrate: Sat whether your Treo vibrates to notify you about the selected avant.
5. Selaect the Manage tab and do any of the following:
To record a sound, press Menu (— Iright scftkey) and select Mew Sound.
To praview a sound, select it and than press Play (— (left acitkey).
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To delete a sound, highlight it and then press Backspace (-],

To send a sound, highlight it, press Menu — (right scftkey), and than selact Send
Sound.

6. Press OK [@].
Display and Appearance Settings

Adiusting the Brightness
1. Press Opfion | | and then press Bactdight ).
2. Press Left < and Right » to adjust the brightness.
3. Press OK [@].

Tip Yot can fum the Glock sorean saver on and off, See "Viewing and
COpfimizing Power Safiings” on page 338 for defais

Changing the Text Size

1. Press Siart [&] and select Setiings.

Select the Systemn tab, and then select Screen 3,
Select the Text Size tab.

Press feff € and Right & to adjust the text size.
Pross O [@].

L e

If bt foodks rough around the adgas opan tha Screen Seftings sorean and
selectthe ClearType a8 Chedk the Enahle ClearType box and fhen press
Ok,
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Aligning the Screen to Correct Tapping Problems

Occasionally, your screen can move out of alignment, activating the wrong feature when you
tap the scraen. If this occurs, you need 1o align your Treo screen.

1. Press Starf 2] and select Setiings.

2. Select the System tab, and then salect Screen .

3. Onthe Allignmenttab, select Afign Screen.

4 Tapthe scresn where indicated.

Setting Display Formats
1. Press Start 2] and select Settings.
2. Selact the Systemn tab, and then select Regional Setiings 9
3. 0Onthe Region tab, select a region from the list, (The region selection sets the default
format settings.)
4 (Cptional) Select any of the following tabs to customize the - =
format settings:
Mumber: Set the decimal symbol and number of
decimal places the digit-grouping symbaol and group
size, list separators, negative number sign symbol and
format, leading zero display, and measurement system
fmetric versus U.S).
Currency: Set the currency symbol and position, the
decimal symbol and position, the digit-grouping
symbol and group size, and the negative number
format.
Time: Set the time style, separators, and AM and PM symibaols.
Date: Set the short date style, separators, and long date style.

5. Prass OK [@].
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|l You can ziso change he siekm color schamae (sea "Changing e Syskm
Color Schama” on page 374).

Application Settings

Arranging the Stait Menu

“ou can select which applications appear on the Starf manu.
You can still access the remaining applications by selecting
Programs from the Starf menu, and then selecting the
application’s ican.

1;

Fress Starf [#2] and select Settngs.

2. 0Onthe Personaltab, select Menus “"1
3. Chack the boxes naxt to the applications that you want to
see in the Start menu.
4. Prass OK [@].
Reassigning Buttons
Buttons Settings lets you select which applications are - =
associated with many of the buttons and key combinations on
wour Treo,
1. Press Starf [#2] and sslect Setiings.
2. Onthe Personaltab, select Butfons él| [
3. 0On the Program Butfons tab, highlight the button or key 4
combination that you want to change in the Sekect a bution ——— 'l_
IlSt. Frosg am Btlore _'_I'_-.L-.w\l'-'. '|I|-1_
4 Select the Assigna program list, and then select the “
application you want 1o assign 1o the button or key combination you selected in step 3
5 Press OK [@].
324 Section 6C- Customizing Your Paim® Treo™ 800w Smart Device



Tip You can also adiust the saffings for the Up and Down buling on the 5-way
Aom Buttons seffings, salect the Up/Down Control &25

Setting Up Voice Commands

YVolce commands enable you to use speech 10 aexecute some commands on the St menu
and the Programs manu.
1. Assign the Hold Side button to Microsoff® Yolce Command. (See “Reassigning Buttons”
on page 324 for details)

2. Press Start (8] and selact Setfings.

3. Onthe Personaltab, select Voice Command 3.

4. Check the Enabfe box.

5. Selact the items you want to enable, (If an itern is highlighted and the Opfions box is
active, select the Opfions box to choose the features you want enabled for the
highlighted item.)

£, (Optionall Check the Password Profected box to password protact the Voice Command
featurs.

7. Select Notifications and selact the options for how you want to receive voice command
notifications.

. . o
Using Voice Commands

Do not usa voice commands in your car Unfil you read the End Usar Nofice
about this Kind of usage; see “End User Notice” on page 2.
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Set the Ringer switch at the top of your Treo to Sound On o).

2. Hold your device about nine inches away from your mouth, and then press and release
the Voice Command button. (A tone plays and a microphone icon appears at the top of
YOUr screen.)
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3. Ina clear voica say the command. For example:
To access Help, say, “Help.”
To access your Cafendar, say, “Stant Calendar”
To access your music, say, “Start Windows Media®”

4 After Voice Command finishes speaking, a microphone icon appears at the top of your
sCreen; say your answer, (For example, say, “General” 0 access general Help topics.)

Tip You can inferupt during & gueastion by pressing the Voice Command
buffon. Assoon a8 tha microphone icon is Visibla Yol may Say your 2nsiar

Setting Input Options
1. Press Start [#2] and select Settings.
2. Cnthe Personaltab, select inpiit

Mot The Input Mathod opffons wou specify apply anly b entring information
using the strean. You can sl anter information using the kayboad on vour
Treo fegardiiess of the onscreean input method you chooss

3. Cnthe Input Method tab, set any of the following options:;
Input method: Sat which onscreen input method you want 1o use:

Biock Recognizer- Use a single stroke to write lettars, numbers, symbols, and
punctuation, which are then converted into typed texd. Use can also indicate
wheather yvou want to use a stroke instead of pressing the Return key and
Backspace Key.
Reyboard- Tap keys on the onscreen keyboard o enter text,
Leter Recognizer: Write individual letters, numbers, and punctuation, which are
comverted into typed texd.
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Large/Small keys: If you selected Keyboard, sslect M

wheather to use large or small onacrean keys. If you
selact Large keys, chack the baox if you want to use T
gestures for the spacs, backspaces, shift, and entar £ e e W smaes
keys.

Options: |f you selected Letter Recognizer, select
Options and select the options you want.

4. Select the Word Complefion tab and set any of the following
options:

Suggest words when endering text Set whether word
suggestions appear as you enter taxt, (You can also
specity how many letters you want to enter before a
suggestion appears, how many suggestions you want
to see, and whether a space appears after you insan a
suggested word.)
Clear Stored Entries: Delete the database of word
suggestions.
Enabike Auto Correct: Set whether the texd you type
adds to existing text or replaces it (This is similar to the
Insert function on a computer keyboard.)

0]

Tip To enfar 2 suggeskd word, press Down fo highfight the suggeston, and
then prass Center fo acoapi i
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5. Select the Opfons tab and sat any of the following option s:
Yoice recording format Set the format in which you save voice notes,
Defauft zoom feved for wiiting - Set the initial size of text entered Using onscreen
writing methods,
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Defaudt zoom level for typing: Set the initial size of texd
anterad using the keyboard.

Capltalize first letter of senfence: Set whether the first i e St

latter of a sentence automatically appears in T 8 o
Uppercass, without pressing the Shiff key, :
Scroff upon reaching the fast fine: Set whather the

display automatically scrolls whan you salect the last
line of visible information.

6. Press OK[@].

o

Locking Your Treo and Information

Your Treoincludes several featuras that help you protect your device from inadvertent use and
keep your information private, The built-in security software lets you use your Treo for
emergency calls, such as dialing 911, even if the phone feature is lockad.
Keyquard: Manually disable all buttons and the screen’s touch-sensitive featurs to prevent
accidental presses in your briefcase or pocket,
Atito-Keyquard and fouchscreen fockout Automatically enable Keyguard after a period
of inactivity and set whather the screen’s touch-sensitive feature is enabled during calls.
Phone Loct: Require a lock code for access to the wireless features on your Trec.

System password focf- Require a password before any information is accessible on your
Treo,

To avoid acddantally prassing onscrean bulions whie voure holding vour
Tra0 o o your ear o Speak you can disa b the sacen’s fouch-sansife
feafune dudng aclive calls Whan the soean’s foudh-sansiive faafue s
disabiad, you must use the 5-way navigator fo aceass flems on the screan.
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Using Keyguard
By default, your keyboard locks so that you don't accidentally press buttons or activate screen
tems whila your Treois in a pocket or bag.
To dismiss Keyguard, prass Center ().
To manually turn on Kewguard whean your Treo screen is on, press Oplion || and
Power/End |i .

Using Auto-Keyguard and Touchscreen Lockout
Atfo-Kewquard |ets you automatically lock the keyboard after a period of inactivity,
1. Press Start [ 2] and select Setdngs. ~— -
2. 0Onthe Personaltab, select Reyquard Sj

3. Set any of tha following options:
Atifo-Reyguard: Set the peariod of inactivity that passes
before the keyboard automatically locks or before the
auto-keyguard feature is disabled.
Disable fouchscreen: Sat whether the screen’s
touch-sensitive feature is enabled during a call. If you
disable the touchscraen, the Touchscreen Disabled 7
icon appears in the lower-right comer of the screen dUring wour calls.

4. Prass OK [@].
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il If youre using & hands-frea davica and your Trao is i 2 pockat or bag, you
can manually fun on Keyguard during 2 el fo pravent accidental fay
prassas Prass Option and Power/End & manually fum on Keyvauard.
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Using Phone Lock

You can lock your phone to prevent unauthorized use of your account. When your phone is
locked, you must enter the lock code to make calls (except for emergancy numbers and

Sprint Customer Senvice [*2]), to send messages, and to use other wireless features such as
browsing the Web.

Tip Duiring an emargancy call you can s2e the phona number on ol Treo By
selecting the onserean Phone Infa butfon,

1. Maka sure your phons is on and that you're inside a coverage area (see “Turning “our
Palm® Trec™ 800w Smart Device On and Cff” on page 34),

Prass Start 2] and selact Settings.
On the Personad tab, select Phone (.
Select the Security tab and set any of the following options:

Auto-foct: Set whether yvour Treo locks automatically
and when this occurs,

Change Lock Code: Assign or change the lock code
used to unlock your phone, (Your default lock code is S =
the last four digits of yviour wireless phone number, If this = r—
dossm’t work, call Sprint Customer Service at ficherum sk e
1-888-211-4727. It you change the lock code, salect OK |
to accept your new code.)

5. Prass OK [@],

Dy

If you &y fo make a calf when Phone Lock is on, & box appears and
prompts you fo entar vouwr 10Ck codie o unfock e phone. You do not nead
o enter your lock code o answear z call
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Using System Password Lock

To protect your personal information, you can lock the system so that you need to enter your
password to access any of your information or 1o use other features of your Treo,

If you fock Your syskim, you must enfier e exa ol password o oo it IF
you enter & incorract pa ssword, You are ghen another chance Each time
an incofact passwond isentared, You 2 given progressivaly fongar fime
periods bafwaan ol chancas b anfar the pasaword. I you forgaf the
password, vou nead @ parform g hand reset B resume using vour Treo,
Perfosming & hadd resel defeles all the antrias on your Treo, Howawer, you
can rastore ailf praviolsty synchronizsd information the net fime vou swne
(e "Connectng o Your Compulr” on page 41 In addition, vour device
might not reastabiish a Sprint Powear Vision™ sassion afler a hard rasat To
manually astzhlish 2 new Sorind Powear Vision sassion, opan e browssr fo
200858 & Web s

Press Start [ and select Settings. —~ T
©On the Personaftab, selaect Lock &, |
On the Password tab, chack the Promptif device unused for | B0 it
b to turn on the password feature, Pamwordopefoimple il =
4. Select the first list, and then selact how long a period of o
inactivity must pass before you are promptad to enter a
password to unlock the system. _I
5. Selact the Password fype list, and then select a format for “
YOUr password:
Strong alphanumeric: A strong alphanumeric password must contain at least 7
characters and must contain a combination of letters, numerals, and punctuation,
Yol must press Cption or Alt before entaring numerals or punctuation.
Simple PIN- A simple PIN must contain at least 4 characters and includes numerals
only. You do not need to press Cption before entering the PIN numerals.
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6. Selact Password, and enter your password.

Your can't see your password a8 you antr it so be careful Be sure Caps
Locw and Oplion Lock af@ not on uinkss you nead tham. For information on
how fo enfier charactiors seo "Entering Lowercase and Uppercase Laffars™
on page 64 and “Enkring Numbers, Punctualion, and Symbols” on

page 65

T Select Comfirm, and enter the password again.
2. (Optional) Select the Hinftab and enter a hint to help you recall your passwaord,
9. Prass OK (@],

IFyour Jook vour Trao and use 2 Simple AN as the password, you can dial am
ameargancy numbear by antadng the numbar in the password falf and
prassing Phonef Talk. You do nof need fo press Option before enkdng the
number Howaver, i you sakef Strong alphanumeric as e prssword e,
you must first press Option wice before ankring an emargancy numbear in
the password el

Entering Owner Information

You can enter personal information that you want to associate with wour Treg, such as your
name, company names, and phons number, You can also set whether you want this
information to appear whean you turn on your Treo. If you lose your device, this feature can
halp the person who finds it return it 1o you.
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1. Press St (5] and select Setdngs.

2. Onthe Personaftab, sslaect Owner information 3

3. Onthe Hentification tab, enter any of the contact
information you want to include,

4 Select the Mofes tab and then enter any additional text you
want to include.

5. Selact the Opfions tab and check the boxes to indicate
which information (if any) you want to appear on the screen
when wou tum on your Treo,

6. Press OK [@].

You can also display your Cwner Information on vour Today scean. Sea
“Sedeching Which fiams Appear on Your Todzy Screen” on page 318 for
detzils

Systern Settings

Setting the Date and Time
Cloctc & Alarms Seffings lets you set the time zone, time, and date for your home location and
a location that you visit,

1. Press Starf [22] and select Setiings.

2. Selact the System tab, and then selact Clock & Afarms

3. Onthe Timetab, select Home.

o
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Select the first list, and then select the time zone for your -
home location.

Select the hour, and then prass Up 4 or Down » to @ Home GTEraiic s v
increase or decrease the hour setting. (Repeat this process 1A 5P alw
for the minutas, seconds, and AM/PW sattings.) 947 pata

(Optional) Select Visiting and set the information for a
location that you visit often.

Fress OK [@]. i el

[

Visiting

If prompted, select Yes to accept your changeas.

To dispiay the fime in all your applications. selact the More &6 and chack
the Display the clock an the titlebar in all programs box To sef tha display
format for the date and me, see “Saffing Display Formats” on page 323

Synchronizing the Date, Time, and Time Zone With the Netwaork

By default, your Treo synchronizes the date, time, and time zone with your wiraless service
providers network whenever your phone is on and you are inside a coverage area.

1

L

o
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Prazs Start [22] and selact Seftings.

Select the Sysfem tab, and then selact Clock & Afarms

Select the More tab.

To enter the date and time manually, unchack the Enable focal network fme Do

If you want to use the Home or Visiting settings (see “Setting the Date and Time” on
page 333) regardless of the network time, uncheck the Use nefwork time zone b,

Press O[],
If prompted, select Yes to accept your changeas.

IF you &um off the Use network time zone setting and fater fum i on again,
you nead B fum your phone off and than on for his saffng fo he affact
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Setting System Alarms

Systern alarms let wou set alarms that are not associated with a task or appointment. For
example, you can use your Treo as an alarm clock when you travel, or set alarms to remind
wolu when it's time to take madication or pick up the Kids,

1. Press Start [a2] and select Setings.

2. Select the Sysfermn tab, and then select Clock & Afarms

3. Select the Afarms tab, -
4. Check a boxto turn on that alarm.

5. Selact the description nexd to the bax you chacked, and D Hus arer

M T wTFE
enter a description for the alarm. _':"'
6. Selact the days of the week you want the alarm to go off.

{vou can select multiple days for each alarm.)
7. Select the ime you want the alarm to go off, and then press —
oKlel (S P—
8. Selact the afarm 4, icon, and then check the boxes 1o

indicate how you want the alarm to go off, (You can choose a flashing light, a single
sound, a repeating sound, or a vibration.)

0]

Tip To change the alarm sound, saiact tha alarm sound foon, safact tha
Fay Sound fsf and then select fie alzrm sound you want o usa

9. Press OK [@] twice,
10, If prompted, select Yes to accept your changeas.

Managing fdentity Certificates

Your Treo may include preinstalled cerificates. Certificates are digital documents that are
used to authaenticate and exchange information on networks, Certificates can be issued for a
user, a device, or a senvice.
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1. Press St (5] and select Setdngs.

2. Selact the Systemn tab, and than salect Certificates :]

3. Select any of the following:
Personaf- Display certificates that establish your identity when yvou log into a
secuUred network, such as a corporate network,
Intermediate: Display cerificates issuad from a roct certificate whose purpose is to
then issue personal certificates.
Root Digplay certificates that identify the computers, such as servers, that you
connact to. (These cerificates help prevent unauthorized users from accassing your
Treo and your information.)

4. Prass OK [@].

T To delek & carfificak, fap and hold the cerfificake in the list and than sskcf
Delete from the shorfolt meant

Enabling Error Reporting

FError Reporting sends information that helps diagnose application errors for devices running
Windows Mobile® software, When an error is deteciad, a text file is created. You can review the
file and choose whather you want it deliverad to Microsoft Support. The information is used by
programming groups at Microscft for quality control and is not used for tfracking individual
users or installations for any marketing purpose. The information that is collected is technical
information about the state of your system when the error occurred. No documeants (o any
information contained in therm) are intentionally sent with the report. To ensure further security;
the report is transmitted by means of a secure connection and is kept confidential and
anonymous in a limited-access database.
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Thiz arorrgporfing mathod maats e piveoy raguizlions of the Europaan
Linfor (EU) as well a5 the Fair Informalion Praclica Principlas of the Federal
Trade Commission. To view Bhe Fair informalion Praclice Principlas, visi e
FRadaral Trade Commission Weab s af

ww fie gondiaports pove cu3Aaiinfohim

[f wour Treo is connected to your computer whean you send the error repon, you are naot billed
for sending error reponts—provided your computer is connected to the Internat, If you use the
Sprint network to send an arror report, data transfer charges apply.

1. Press Start (8] and salact Setlings.

2. Select the Sysiern tab, and then select frorReporting 4],

3. Select whether you want to enable or disable error reparting.

4. Prass OK [6],
Setting Up an BEdemal GPS Device
[f wou purchased an optional Global Positioning Systemn (GPS) recaivar, your Trao can show
your exact location on a map. The External GPS settings do not affect the built-in GPS
featuras of your device.

1. Press Starf (2] and salact Seffings.

2. Select the System tab, and then salect External GPS 4.

3. ©nthe Programsitalb, select the GPS program port list, and then selact the port for
applications to use to access GPS information. (This port must also be selected in your

GPS application’s configuration settings.)
Select the Hardware tab.

5. Selact the GPS hardware portlist, and than selact the pont to which your GPS recaiver is
connected. (This must be a different port from the one you set in step 3 as your program
port. To connact to the GPS device using Bluetooth® wireless technology, you must first
set Up a pantnarship between the two devices, See “Setting Up a Blustooth Connection”

on page 196)
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6. Selact the Accesstab and chack the Manage GPS auformaticatly box. This setting lets
more than one application simultaneously access your GPS information.

7. Press OK [@].

Viewing Memoiy Usage
1. Press Siart [a] and select Setiings.
2. Select the Systern tab, and then select Memory T,

3. Select ether of the following tabs:
Main: View the amount of memory assigned to your applications and infarmation,
as wall as the amount of mamary in use varsus the available memaory,
Storage Card:-View the amount of memaory available on an expansion card that is
insered into the expansion slat on your Treo,

4. Press OK [@].

Viewing and Optimizing Power Settings
1. Press Start [ 2] and selact Sefings.

2. Selaect the System tab, and then select Power i,‘
3. ©Onthe Batterytab, chack the Batfery Power Remaining indicator to see how much
paower ramains in your battery.
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4. Select the Advanced tab and sat whether your Treo turmns off automatically after a
specified period of inactivity, (You can assign various intervals for battery power and

external power,)
5. Selact the Screen Saver tab and set whether the clock scresn saver appears whan the
phone isturned on and the scraen is turnad cff,

6. Press OK [@].

o £ 7 N d ev)

T ranbattery:  Lilon
] I T o Batiery power:
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To conserva addifonal batkry power, adiust the display backight saifing
Prass Start and salect Settings. Salkect ha System a0 and Hhan salact
Backlight. On fhe Battery Power a8 sof whather the display bacriight
s off aufomatically affar & pariod of nachi

0]

Viewing and Mahaging Active Tasks
1. Press Start [ &2] and select Settings.
2. Selact System and then select TasikcManager [l

3. Doany of the following:
Close a specific appfication; Highlight the application’s name and prass End Task
= lleft softkey).
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Close all active applications: Press Menu — (right softkey), selact End Aff Tasks,
and then select Yes to confirm the action,

View a list of alf active processes: Press Menu — (right softkey) and select
View >Processes,

4. Press OK [@].

Tip Your can also press and hold Option + Ok fo accass Task Manager |

Connection Seltings

Turmning Wireless Services On and Off

1. Press Start [&2] and select Setings.

2. Selact the Connections tab, and then select Wireless
Manager @

3. Tum the wireless features of your Treo on or off,
{Select AM to turm all wireless features on or off)

4. Press OK[@].

il

You can also fim wislass sandcas on and off By zpping tha
sighal-strength fcon af the fop of the screan and then salacting
YWreless Manager.

To change the seftings for one of the displayed winskess feafuras, prass
Menu fight soffiay) and salect the wialass feafure you want i changa
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Managing ISP Settings
Your Treo is already set up to connect to the Intermet using a high-speed data connection on
the Sprint network, To connect to the Internat, simply start Internet Bxplorer® Mobile.,

For special situations, such as connecting to your ISP (Internet service pravider) or a remote
access senver (FAS), you can set Up another connection. Before you begin, oktain the
following information from your ISP or systerm administrator:

Obiain the following fnformation from your ISP or systam administatorn:
ISP Servar phoRé AUmber of 260288 point
¢+ Usernamea
Password,

Fress Starf [a7] and select Settngs.

Select the Connections tab, and then select Connections F__Eu.

On the Tasks tab, selact Manage existing connections.

Select the Moderm tab.

Highlight the connection you want to view or change, and then select EdR, or to create a
new connection, select Mew:

£. Follow the onscreen instructions for editing or creating the connection.

Connectingto a VPN

[f wou want to Use your Treo to accass your corporate emall account or athar files on your
corporate servar, you may need to set up a VPN {(virtual private network). A VPN enables you
tolog in to your corporate server through the company's firewall (security layer),
You need to set up a WPN to access a corporate server in either of the following situations:
Your compary’s wireless local area network (LAN) is outside the firewall.
Your compary’s wireless LAN is inside the firewall, but you are accessing the network
from outside the firewall (for example, from a public location or at home),

U
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Check with your company’s systam administrator fo sea if & VPN is feguiied
for zocassing the corpors i nafvord Ifvou nead 2 VBN vou must purchassa
and install & third-parly VEN client in order o tse this feature Befone you
begin sating up a VPN, ash your sysiam administator for the following
informaton:

Your usarname and passwond.

+ Your server’s domain name
Your senvers TCPAHFP seffings.
Your seners host name or P address

A common cause of syne problems is the prasence of prokciive sofivace,
such as VPNs or firewalls, on youwr computar or nalwork See ‘The Dastdop
Sync Soffware Doas Not Raspond B 2 Sync Aflampf” on page 360

1. Install your third-party WPN client (see “Installing Applications” on page 296).

2. Press Start [22] and selact Settngs.

3. Selact the Connections tab, and than selsct Connections Iye.

4. Onthe Tasks tab, select Add a new VPN server connection.

5. Follow the onscresen instructions for entering the sattings provided by your corporate

systern administrator,
To manually start 2 datz connecton on the Spdntnetwork or another
nefwork, go fo Connections Settings. On the Tasks &b sko Manage
existing connections. Tap and hold fa connaciion wou want fo sarf and
than selact Connect from fhe shodout ment
Setting Up a Proxy Server

1.

Prass Starf [22] and salact Seftings.

2. Selact the Connections tab, and then select Connections ff«.
3. Onthe Tasks tab, selact Set up my proxy server.
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4. Check both of the boxes near the top of the scresn.
5. Selact Proxyserver and antar the praxdy server name.

Tio To change saffngs such as the port number, proxy sanmvar iype, of
cradantials sefect Advanced,

6. Press OK (@],

Selfing & proxy Senver may prevent you fom accassing some Sprint Power
Vision Web pages

Ending a Data Connection

[f wour service plan includes minutes-of-Use fees for data connactions, you can reduce costs
by ending the data connection aftar you finish browsing the Weab,

1. Use the stylus to tap the "yl or Bl signal icon on the title bar.
2. Select Disconnect from the shortout menu.

Enrolfing a Domain

[f wour company uses Microsoft Systemn Center Mobile Davice Manager, you may neaed to use
the Domain Enroll sattings to register your Treo within your company's natwork,

0]

Affer you anroll Jour deyics i yolr Companes nefwods, your systam
administator can fum varous faatures on your Teo on and off If 2 featue
SUCH &5 the Gamera or messaging, worked praviously and fhis feature no
longer works affar enoliment contact vour systkm administrator B find out
if this feature is disabled on your Treo,
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1. Press Siarf [a] and select Setings.
2. Selact the Connections tab, and than selact Domafn Enrok *L'i
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3. Press Enrolf — (right softkey).
4 Follow the cnscrean instructions to complets the enrollmant process.

Purchasing Accessories for Your Treo

These accessories, and others, are available from your local Sprint Store or at
palm.com/treo800wsprintsupport For more information, you can also call Sprint at

1-888-211-4727 or visit www.sprint.com. Mext-day delivery is available in selected areas.

344

Vehicle Power Charger: A charger that enables you to charge your Treo in your vehicle
using the car lighter socket.

Reptlacement Batftery: & backup battery that you can use if your primary battery bacomeas
drained, is charging, or has reached the end of its useful life,

Battery Changer: A charger that enables you to charge a spare battery.

{56 Sync Cable- A replacement or spare cable (your Treo comeas with one USE sync
cabla).

Extra AC Charger: A 10040-240-volt AC charger for your Treo.

Paim® Treo™ 800 Power/Audio Adapter- An adaptar that enables you to charge your Treo
and use a wirad headset at the same time.

MicrolJSB/2 Smm adapier- An adapter that enables you to connect a wired headsst with
a 2.5mm connector 1o your Treo.

International Travef Adaplers: Snap-on adapters that enable you to use the Extra AC
charger in continental Europe, the United Kingdom, and Australia. (For use with the Bxdra
AC Charger only)

Leather Side Case With Beft Clip: A casethat you can clip to your belt or bag that
provides quick access to and protection for your Trao.

Styius: A replacament or spare stus for your Treo.
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In This Section

Transferring Information From Another Device
Trouble Installing the Desktop Software on aVdndows XP Computer?
Resetting Your Palm Treo 800w Smart Device
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Screen
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Camera
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Although we car't anticipate all the situations that might arise, this chapter provides helpful
information and answers to some of the most commonly asked questions, For additional
information and technical suppor, visit pain.com/drec800wsprint-support.

Transferring Information From Another Device

For information on transferring your information from a previous Windows Mobile® devics or
from a Palm O3® by ACCESS device to your new Falm® Treo™ 800w smart deavice, visit
palm.com/Areo300wsprint-support,

[f wou have questions about Windows Mcobile, you can also go to the Microsoft Windows
Mobile Web site (wwwwindowsmobifacom) and search for information on Palm devicas.

To pravent your Tieo fom malfunclioning, do notf use & backup ulility fo
fransfer your information from another device fo your new Treo. in addition
do nofuse & backup ulilily o back up and resfore vour informalion if you
updak the operaiing system on vour Trao,

Trouble Installing the Desktop Software on a Windows XP
Computer?

The deskiop synchronization software lets you synchronize with Microsoft® Outlook® 2003 or
later, ou must have Outlook 2003 or later (sold separately) installed on wour computer, and
you should install and open Cutlock before you install or use Microsoft® ActiveSync®
technology.

I you don’'t have Oullook 2003 or latar installed on your compur, insert the
CL info your computers CO drive sekct Palr Support Center, and then

safectMicrosoft” Outlook® 2007 (B0-day trial) fo download a frial version of
this sofiware.
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f wou want to synchronize with a different personal information manager (PIM), you must
install a third-party solution, Contact the PIM's author or vendor to find out whather scitware
is available for your Treo.

1

R

Shut down your computer, and then turn it on again.

On your computer, click Siart = Control Panet > Add or Remove Programs

Femaowve ActiveSync if it is on your computer.

Quit any active applications, including virus scanners and Intermneat security applications.

Make sure you're installing the version of the software that came with your Treo on the
Getting Started CD for Palm Treo 800w smart device. (Other versions may not work with
this Treo.)

Make sure your computer profile includes administrator rights toinstall software.
{In large organizations, these are usually granted by the systern administrator)

Resetting Your Palm® Treo™ 800w Smart Device

Petforming a Soft Reset

A soft reset is similar to restarting a computer. If your Treo is not responding or you hawve
troutle synchronizing with your computer, a soft reset may help.

1.

If your Treo responds to key pressas, press and hold Power/End |i| to turn off your
phone,

If the screen display is on, press Power/End |1 1o turn off the screen,

Femaove the battery from your Treo, and then reinsart it. {See “*Replacing the Batteny” on
page 351 for details. The reset beging when you inser the battary)

Wait for the progress bar on tha Palm logo screen to fill and the Windows Mobile screen
to transition tothe Today screen before continuing to use your Treo, (Be patient, this may
take a few minutes.)
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Performing a Hard Reset

A hard reset erases all personal information, such as appointments, contacts, and tasks, as
well as programs you have added, such as third-party softwars, on your Treo, Never doa hard
resat without first trying a soft reset, You can restore praviously synchronized information the
nex time you sync.

Renviaw the following important information before performing a hard raset;

After a hard reset, synchronize to restore your Cutlook data, such as Cutlook email,
Calendar, Contacts, Notes, and Tasks. You can also use the included Sprite Backup utility
to restore praviously backed up configurations and preferences such as speed-dials, SMS
entries, call log information, and personal sattings.

Some third-party applications do not create a backup on your computar when you
synchronize. If you do a hard reset, you may lose information in these applications and
you need to reinstall the application on your Treo after the hard reset Please contact the
daeveloper to find out if wour information is backed up during synchronization.

When you synchronize after a hard rasat the Files sync folder revants to the default folder
name,

Your Treo might not reestablish a Sprint Powar Yision™ session aftar a hard reset. To
manually establish a new Sprint Power Vision session, open the Web browser to access a
Wieb site.

A hard reset can tell you whether a problem stems from your Treo or from an application
installad on it If you do not experience the problem after you parform a hard reset, the
problem may be related to software you installed. See “Third-Party Applications” on page 373
for suggestions on diagnosing third-party software issues.

1.

If possible, synchronize your device with your computer so that your device applications
and info can be restored by synchronizing again after you perform the hard reset,

2. Remcve the battery from your Treo.
3. Press and hold Power/End |1 | while reinserting the battery, (See “Replacing the Battery”
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on page 351 for details)
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4. YWhen the Paimlogo screen appears and the progress bar begins to fill, release
Power/End |i .

5. When the “Erase all data?” prompt appears, press Up a to confirm the hard reset.

6. Wait for the prograss bar on the Pafmlogo screen to fill again and for the Windows
Mobile screen to appear.
Follow the onscreen instructions to align the screen before continuing to use your Trec.
{Optional) Sync your Treo with your computer to restore your previously synchronized
information. (Connect your Treo to your computer, press Start and then select Programs

= Activedync = Sync. If vou use Sprite Backup or ancther compatible backup utility,
you may also need to restore a backup to recaver additional information and settings.)

Replacing the Battery

“our Treo comes with a replaceable batteny, Be sure 1o use a replacemeant battary from Palm
that is compatible with the Treo 800w smart device Ses “Caring for the Batteny”™ on page 388
for information on handling the batteny safely.

Use only bafedes and chargers thatare approved By Sprnt or Palm with
your Teo, Feilure fo Usa an approved batlery or charger may pravent your
Treo from [iming on or Gharging, may void your Treo waranly, and may
increase the risk of vour Treo overheafing, cafching fire or exgploding, which
may arso resulf i sedous Bodily infury, dealh, o properly damage

Your Treo shres all your information avan when Yo ramaove the batfery

Press Power/End 1| to turn off the screen.

Gently prass the battery door while sliding it downward to remaove it from your Treo.
Place a finger in the notch between the stylus and the batteny, and lift the old battery out
of the compartmeant,

4 Align the contacts on the new battery with the contacts inside the battery compartment
and press the battery into place.

diH
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5. 5Slide the battery door onto the back of the Treo until it clicks into place.

£, Wait for the screan toturn on, and then enable the network time or sat the date and time
when prompted.

1 Battery Contacts
2 Device Contacts

Be stire I dispose of your old bafiary in an anviro nmeantaly rasponsibla and
legal way, In some areas, disposal in household or business frash is
profhibiid. Vist palim comdemdronment for more information.
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Performance

The Applications Are Running Stower Than Usual

Se sufe that third-party applications are compatible with Windows Mobie
Professional version 6.1 or fafar Applications witken for earlier versions can
have paformance problams If you can fry 2 frea varsion of the soffvane
befora purchasing it you can st it first fo make sure it works propeny

In your opean applications, save any unsavaed information you want to keep.

Press Starf [a2] and select Settngs.

Select Syslern and than select Tasi Manager .

Press Menu — iright softkey) and select End Alf Tasks

Select Yes to closa all your open applications and discard all unsaved information.
Prass OK [@].

L

Tip You can also press and hold OK or Option + OK o acoass Taskh Manager

If the previous steps don'™t fix the problem, try doing a scoft reset (see “Parforming a Soft Heset”
on page 349), If the problem persists, follow thase steps to tum off the Microsoff® Voice
Command setting, if it is enabled:

1. Press Start [ 2] and select Settings.

2. Selact the Personaftab, and then select Volce Command 3.
3. Uncheck the Enabled box
4

. Prass OK [@].
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{Can't Beam or Receive Information Via Infrared of Bluetooth® Wireless
Technology

Fress Starf [87] and selact Settngs.

Select the Connections tab, and than salact Beam «@).

Check the Recefve alf incoming beams box

Fraess OK [@],

If beaming still doas not work and your company uses Microsoft System Center Maobile

Device Manager, contact your systermn administrator to find out whether infrared or
Bluetocth® wireless technology faatures are disabled on your Treo,

oo L

{Can't Save or Access Fifes on an Expansion Card
Make sure the card is not locked or copy-protectad,

If wour company usas Microsoft System Center Mobile Device Manager, contact your
systern administrator to find out whether remaovable storage features are disabled on
your Treo,

{Can't Charge the Battery

If wou're using a new battery or a new charger, make sure the battery and charger are
approved by Sprint or Falm for use with your Treo, Failure to use an approved battery or
charger may prevent your device from tuming on or charging,

If wou're using an existing, approved battery, the battery may have reached the end of its
useful life and neeads to bea replaced. Ses “Replacing the Batteny” on page 351 for datails.
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Screen

Tip NMakia stng Sz f third-pacly apolicafons supporf 320 X 320 soian faeoltfion,
Some oider applicalons have sorean-sze mits.

The Screen Appears Blank

T

B.

The screen backlight dims when there is no keyboard activity for 30 seconds. The
screen backlight turng off automatically when the scresn turns off or when you are on a
call or playing music in the background for longear than the time pearicd spacified in
Bactdight Settings expiras. (Press any key to wake up the screen. Keep in mind that
pressing Power/End hangs up any calls in progress,)

_ Look closaly at the screen, and if you can see a dim image, try adjusting the

screen brightness (see “Adjusting the Brightness™ on page 322).
If that doesm't work, perform a soft reset (see “Performing a Scft Reset” on page 349).

_ ltthat doesn’t work, connect vour Traoto the AC charger (see “Charging the Batteny” on

page 29) and perform a scft resat again.

-l you're using a third-party application, make sure that the application supports

320320 screen resolution.
If that doesm't work, perform a hard reset (see “FPerforming a Hard Reset” on page 3507,

The Screen Doesn’t Respond Accurately to Taps of Aclivates Wrong Features

1

oo e b

Make sure there is no debris trapped undear the edges of the screen.
Press Start [(22] and select Seffings.

Select the Systerm tab, and then selact Screen 3.

On the Afignmenttab, select Afign Screen.

Follow the onscreen instructions to align the screen.
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6. Prass OK [@].

s} To find carnving cases et profect the soraan, and ofher useful accassories,
VISt palm comiles 800w sonntsupport

Network Connection

Signal Strength Is Weak

If you're standing, move about ten feet in any direction.

If you're in a building, move near a windcw, Cpan any meatal blinds,

If wou're in a building, move outdoors or to a maore open area.

If wou're outdoors, move away from large buildings, trees, or electrical wires,
If you're in a vehicle, move your Treo sothat s level with a window,

Tip Bacome familizr with low covars g areas whaie vou e commmi, ok,
and play, so yod know when i expact signatsfrength isstias

My Treo Worr't Connect to the Wireless Network

1. Try the preceding suggestions for weak: signals.

2. Turm off vour phone and turn it on again (see “Turning Your Phone On and Off” an
page 35).

3. Parform a soft reset (see “Performing a Soft Reset” on page 349),
My Treo Seems to Turn Off by fiself

If a systemn error and reset occur, the phone automatically tums on if it was on before the
resat, However, if your Treo can't determing if yvour phone was on before the reset, it does nct
automatically turn on the phone (see “Tuming Your Phone On and Off" on page 35).
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{ Can't Tell ff Data Services Are Available

TxRTT {single-carder [Tx] radio fansmission chnofogyl: A wiekass
ohnology that can provide st data fansfar and nfernet 2ccass with
averzga speads of 60--80Kbps and bursts of up fo 144K0ps

EVDO (Evolufion Dats Opimized): A wirglass broadband kohinology that is
dasigned for vary high-spead dafz fansfar with average dowinoad speads
of 400-to-600Kbps, and capable of reaching speads up o 3.2Mbps and
tplozd speads up fo TAMbps.

The following icons appear in the title bar to indicate whether data services are available, If

wou dom't see one of these icons, you cannaot open a data connection:

=M o (B3 The Sprint Mobile Broadband (EVDC) or Sprint 1xRTT network
is within range, You can make or receive calls or open a data
connection.

.i) Your Treo is connected to a Wi-Fi netwiork, You can open a
data connection.

My Treo Won't Connect to the Infefnet

Your Treo supports Sprint Mobile Broadband (EVDO), Sprint 1<RTT, and Wi-Fi wireless data
networks. To connect to the Internat, you must either subscribe to data services with Sprint or

be within range of a Wi-Fi natwork,

Contact Sprint to verify that your subscrigtion plan includes data services and that these
senvices have been correctly activated. Sprint should also be able to tell you if there are

any outages in your location.

If wour company uses Microsoft Systern Center Mobile Device Manager and you're
attermnting o make a Wi-Fi connection, contact your system administrator to find out
whether Wi-F features are disabled on your Treo.
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Press and hold Power/End i | to turn off your phone. Then press and hold the same
button toturn it back on again.

Perform a soft reset (ses “Performing a Soft Reset” on page 349),
Confirm that data services are correctly configured on yiour Treo:

. Press Start [ 2] and select Setiings.

2. Selact the Connections tab, and than selact Connections fEu.

3. ©Onthe Tasks tab, sslect Manage existing connections.

. If Power Vision appears in the list, press OK [@ ], If not, contact Sprint for assistance,

{Can't Send or Receire Text Messages

Make sure your phoneis on (see “Turning Your Phone On and O on page 35).
Contact Sprint to varify that your plan includes messaging services, that these services
have baen corractly activated, and that they are available at yvour location (Sprint should
be able to tell you if messaging services have been experiencing transmission delays).

If possible, contact the recipient of the message, and make sure the receiving device can
handla the type of massage you're sending.

If & text message amives but does nat display a notification, perform a soft resat

(mes “Parforming a Soft Resat” on page 349),

If wour company usas Microsoft System Center Mobile Davice Manager, contact your
systern administrator to find out whether messaging features are disabled on your Treo.

{ Can't Make or Recelve Calls Using a Bluetooth Hands-Free Device

Werify all of the following:

358

The Tum on SBiuetooth box is checked in Bluetooth Sefings.
“our Bluetooth device is charged and turned on.

“our Treo is within range of the hands-free device. Bluetooth range is up to 30 fest (10
meters) in optimum emvironmental conditions, which include the absence of obstacles,
radio interference from nearby electronic equipment, and other factors,

The Bluetooth Setiings screen is closed.
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The Wi-Fi feature is off. If Wi-Fi is on, press and hold Wi-F [= to turn this feature off, and

then try to use your Bluetooth device again.
You are away from other devices using the 2.4GHz radio frequency, such as cordless

phones and microwaves. If this is impossible, move the phone closer to the hands-free

device,
The device specifications are compatible with your Treo.

If wour company uses Microscft Systemn Center Mobile Davice Manager, contact your
systern administrator to find out whether Bluetooth features are disabled on your Treo.

I Lost the Connection Between My Treo and My Biuetooth Headset
Press Start [&] and then select Seténgs.

Select the Connections tab, and then select Biuelooth

Cn the Devicestab, select Add Mew Device.

Select your headsat name from the list,

In Partnership Setings, make sure the Hands Free bk is checked.,

Select Save.

Highlight the headset name.

Press and hold Cenfer () 1o open the shortcut meanu, and than select Setas
Hands-Free.

9. Test your headset by making or receiving a call.

e R T

Ifthe headseat still dossn’t work, delete the existing partnership and create a new one, To
delete the partnership, do the following:

1. Press Start [a] and then select Settings.

Select the Connections tab, and then select Biuefooth

On the Devicestal, highlight the headset device name.

Press and hold Cenfer () 1o open the shortcut meanu, and than select Dedete.
Create a new partnership (see “Setting Up a Bluetooth Connection” on page 196).

U
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Synchronization

Synchronization enables you to back up the information on your Treo onto your computer or
wour server, If vou ever need 1o perform a hard resst or otherwise erase all your information on
your Treo, you can synchronize your Treo with your computer to restore the information.

To make sure you always have an up-to-date backup of your information, synchronize
frequently.

You can synchronize email and other information directly with Exchange Server 2007 or
Exchange Server 2003 Upgraded to Senice Pack 2, Using Microsoft Exchange ActiveSyng, or
wou can synchronize your Treo with your computer, using the deskiop sync software (see
“Setting Up Your Computer for Synchronization” on page 46).

NPl You can go o fhe Windows Web sk for morg formation af
W windowsmobis com

A common cause of spne problams is fia presence of prokciive soffvane,
such as VPNS or firewalls, on your compilar or nefwork

Desklop Sync Software

This section covers issues with synchronizing using the deskiop sync software that came with
wour Treo, If you have a Windows xP computer, the deskiop sync software is called
ActiveSync® dasktop software. If you have a Windows Vista® computer, the deskiop sync
software is called Windows Mobile Device Center.

The Desldop Sync Soffware Does Not Respond o a Sync Aflempt
[f wou can successfully sync at any point during the following procedure, you do not need to
complete the remaining steps.

1. Maka sure you ars using the USE sync cable that came with your Treo or a replacement
cable that has been approved by Palm for use with a Treo 800w smart device.

2. Make sure the USE sync cable is securely connected at all points (see “Synchronizing
With a USE Connaction” on page 50).
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3. If your company uses Microsoft System Center Mobile Device Manager, contact your
systen administrator to find out whether deskiop synchronization features are disabled
on your Treo,

4. Make sure that all the files you're trying to sync are closad on both your computer and
yolr Treo,
5. Check synchronization prograss:

On your Treq, lock for the animated ActiveSync 43 icon at the top of your screen.

Onyour complter, look for the animated syncicon inthe taskbar;, & (Windows XP)
or @ Windows Vista).

6. If you did not see the correct icons, do the following:

On vour Treo: Fress Start [ ar ], select Programs, select ActiveSync &, and then
prass Ment —— (fight softkend, select Connecons, and maks sure the
Synchronize alf PCs using thisconnection box is checked and that (/S8 is selected
from the list,
Windows XP computer: Click Start == Al Programs = Microsoft ActiveSync.
Windows Vista computer: Click Start == Al Programs > Windows Moblle Device
Center.

7. Do one of the following

Windows XP computer: Double-click the ActiveSync (&) icon in your taskbar, and
then from the Fife manu, select Conneclion Settings, maks sure the Afow USE
connections bax is checkad, and then click Connect
Windows Visia computer: Click Siart > Aff Programs = Windows Mobille Device
Center. Select Comnect withoutsefting up your device, and then select Connection
seffings. Make sure the Affow USE connectionsbox is checked, and then click
Connect

8. Onyour Treo, press Start [ &2 ], selact Sefiings, select the Connections tab, and than

select USBtoPC B I the Enable advanced network functionaifty box is checked,
uncheack i, If this box is currently unchecked, then chack it.

Section 7A-Help 361

dpeH



10.
I problems persist and you're synchronizing through a USE hub, try connecting the

12

13

.

15.

362

Perform a soft reset (see “Performing a Soft Reset” on page 349).
Restart your computer and make surs the deskiop synec software is running.

sync cable to a different USE port on the hub or directly to your computer's built-in USB
port.

If you're synchronizing through a built-in USE port on the front of yvour computer, mave
the sync catble to a USE port on the back of wour computer {f yvour computer has USB
ports in both places).

For a Windows XP computar anly: Uninstall the deskiop scitware that came with your
Treo, and then inser the Getting Started CD for Palm Treo 800w smart device, and
repeat the installation process.

For a Windows XP computer only: Delete the existing partnership between your Treo
and your computer and create a naw one by doing the following steps in turn:

Disconnect your Treo and your computer from the sync cable.

Right-click the gray ActveSync (0 icon in the taskbar in the lower-right corner of
yvour computer screen, and thaen select Open Microsoff AciveSync,

Click Afe and then click Delete Moblie Device. When asked to confirm, click Yes.
Connect your Treo and your computer to the sync cable.

When the Synchronization Setfup Wizard appears, follow the steps to establish a sync
relationship between your Treo and your compLier.

If your organization uses a firawall or a VPN connection, synchronizing with ActiveSync
may not work, For a Windows XF computer only, go 1o wwwmicrosoft.com and search
for the following topics to help with spacific firewall setup situations:

ActiveSync LISE Connection Troublashooting Guide
ActiveSync with Sygate Personal Firewall

ActiveSync with Trend Micro PC-cillin Internat Security
ActiveSync with Morton Personal Firewall
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16, Verify with your computer hardware vendor that your operating system supports your
intermal USE controller,

A common cause of syne proflams is e prasance of profadiive sofivae,
sUch a8 VPNg or firswvalls, on vouwr complisr oF Neivors

If your are synchronizing fo an Sehange senerand youre unabi o change
your fook saltings, check with Wour swsem adminisfator fo fnd oufif 2
systamwides looking policy i in placs.

Synchronization Anishes But information Doest Appear Where ft Should

With the included software, your Treo can synchronize with the root folders of Contacts,
Calendar, Tasks, and MNctes. If yvou want to synchronize with a global Exchange Address
Book, wou must copy the addresses to your local Contacts list in Microscit Cifice Outlook,
Right-click the addrasses and select Add fo Personal Address Book.

Microsoft Cffice Outlook subfolders and public folders are not accessible with the
included software, You may want to use a third-party solution instead.

[f wou're trying to sync cifling, be sure 1o set your Microsoft Cffice Outlook Calendar,
Contacts, Notes, and Tasks to be available offline.

If wou're still having protlems, try the following:

1. Make sure you're synchronizing with the intended deskiop personal information
managear (PIM). The Geatting Started CD for Palm Treo 800w smart device lats you
synchronize with Microsoft Office Cutlook for Windows. If you use a different PIM, you
need 1o install third-party software to synchronize, For more information, consult the
company that makes the PIM.

2. Cpenthe deskiop sync software on your computar, and make sure the Files
synchronization option is selected (“Changing Which Applications Sync”™ on page 314).

3. Fora Windows XP computer only: Uninstall the daeskiop synchronization scitware,
reboot your computer, and then insert the Getting Started CD for Palm Treo 800w smart
davice that came with your Treo, and repeat the installation process.

&
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Synchronization Starts But Doesn't Findsh

1.

2.

Make sura that you installed the deskiop software that came with your Trao. If you're not
sure whether this software is installad, reinstall it.

If you're thving 1o syne cifling, be sure 10 set your Microsaft Office Cutlook Calendar,
Contacts, Notes, and Tasks to be available cffline.

My Windoves Media® Player Library Won't Sync

1.
2

Make sure you have Windows Media® Player 10 or later installed on vour computer.

For a Windows XP compltar anly: Reinstall vour synchronization software from the
Getting Started CD for Palm Treo 800w smart device that came with your Trac. Media
file synchronization fails if you installed the synchronization scitware before you installed
Windows Madia Player 10 or latar,

My Appoiniments Show Up In the Wrong Time Siot Affer i Sync

1.

364

Make sure the appointments are assigned tothe correct time zone, (f nat, change the
time zone. If yes, then continue to the next step.)

MMake sure that you installed the desktop software that came with your Treo. If you're not
sUre whether this software is installed, reinstall it.

Cpen Microsoft Cffice Cutlook and correct the wrong entries.

- Manually enter any information you've added to your Treo since the last time

you synchronized.

- Synchronize your Treo and your computer.
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{ Can’t Synchrontze Using a Bluetooth Connection

Do the following:

+

Maka sure your compltar fs equipped with Sluatoth wikjess
wohnology either built-in or throtigh & Slueto ofh card.

Make sure that the PC's Blualofh seffing is discovars bl

Mzt st Jour computar s set up for synchronization (see “Seffing
U Your Compliter for Synchronization” on page 46).

1. Do one of the following:

Windows XP computer: Right-click the gray ActveSyne L0 icon in the taskbar, and
select Connection Settings.

Windows Vista comptter: Click Start = Aff Programs > Windows Mobite Device Cenler,
Selact Connect without sefiing up your device, and than selact Connection satings.

2. Chack Atowconnectionsto one of the fotowing, and then selact the Bluetooth COM port
yOU sef Up on your computer,

3. Cnyour Treg, go to your Today screen (see “Accessing Your Today Screen” on
page 76), and then tap Bluetooth 3.

4 Select the Mode tab, and then check the Turn on Bluetfooth bad to tum on the Bluetooth
feature on your Trao,

Fress OK [@].

N B

Fress Starf [22] and select Programs

Select AciveSyne (.
Press Menu — (right softkey) and select Connect via Bitetfootf,
If this is the first time you're making a Bluetooth connection to this computer, follow the

onscreen prompts to set up a Blustooth partnership with this computer,

10, Selact Syne.
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1. When synchronization has finished, press Menu (— right softkey) and select
Disconnect Biuetooif,

Exchange ActiveSyne (wireless synchronization)

{ Cant Synchronfze With My Company's Bxchange Server

[f wou're unable to change your lock settings, check with your systerm administrator to find out
if a systemwide locking policy is in place.

My Scheduled Sync Doesit Worl

If wour company uses Microsoft System Center Mobile Device Manager, contact yiour
systern administrator to find out whether synchronization frequency settings are restricted
on your Treo.

By default, a scheduled sync does not work while you are roaming. This is to prevent
roaming charges on your account. If roaming charges are not a concern, follow these
steps to continue your sync schadule while roaming:

Fress Starf [22] and select Programs

Select AciveSyne (.

Press Menu — (right softkey) and select Schedude.

Check the Use above seting when roaming box.

. Press OK [@].

An Alert Tefts Me That ActiveSync Encountered a Problerm on the Server

There iz a temporary problem with the server, or the server may be temporarily overloaded.
Try again later, and if the problem persists, contact your system administrator,

An Alert Telis Me That There fs Mot Enough Free Memory to Synchronize

ActiveSync ran out of storage space. Try the following:

1. Goto fastManager and close all running programs (see “Closing Applications™ on
page 71 for details),

2. It the problem persists, see "Making Room on Your Tred” on page 374 for suggestions
of ather ways to free up space on your Treo,

S SO O S
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An Alert Tefts Me That the Server Coudd Not Be Reached

“our Treo had to wait too long to connect to the Exchange server, The connection may have
baan lost, the server may be temporarily averloaded, or the server may have encountered an
internal error, Chack your Exchange server name and proxy senver setings (see “Satting Up
Wirelass Synchronization” on page 308), and try again later,

An Alert Teffs Me That ActiveSync Encoumered a Problem With fliem Tvpef fliem Mamef

There is an arror while synchronizing a single item, This arror can usually be corraected only
by remaoving the item that caused the error. If wou sync again to see if the error persists, be
awara that items causing this type of arror are skipped and do nat show up again.

An Alert Telts Me That My Accourtt information Could Mot Be Detected

When you set up the BExchange servar sync options, the craedentials page was laft blank,
Correct the credentials (see “Setting Up Wireless Synchronization™ on page 308), or set up
wour Treo to syne only with a computer, and try to sync again.

An Alert Telts Me that My Device Timed Out White Wailing For Credentials

The Exchange server credentials screen was left open too long, Reenter the Exchange server
credentials, and try to sync again.

My Today Screen Settings Are Not Restored Affer a Hard Reset

Settings such as the background image and plug-in choices are not backed up during
synchronization, so they can't be restored after a hard reset, If you use a backup utility, such
as theincluded Sprite Backup, you may be able to restore a backup to recover your Today
scraen settings and other additional information.

When { Sync With My Exchange Server My informaition fs Mot Downfoading to My Treo

Check with vour systern administrator to obtain the name of the mail server that offers you
wirgless access (o the corporate mail systemn. If you cannct obtain the name of this server
{some companies do nat give it out, because they do not want wireless accass to their
senars), you cannct use ActiveSync to synchronize with the Exchange server, You can also
cheack the following satting:

Section 7A-Help 367

diH



Fo0d ko

Press Start [&] and select Programs

Selact AcliveSyne (.

Press Menu — (right softkey) and select Configune Server,
Make sure the SSL box is checked.

Email

{ Have Problems Using My Account

Cccasionally you may experience problems using an email account after you set it up. If you
followed the account setup procedure and are expeariencing problems using the account,
verify that the account complias with your email provider’s reguirements Dy following

these steps:

Yerify both your password and your username for your email account.

Some wireless service providers require you to be on their network to use your email
account. If this is the case, be sure to Use your provider's network as the connection type
for the account,

Some wireless senvice providers have othear requirements specific to their sarvice, Chack
with your service provider to find out whether any provider-specific requirements exist.
Service provider settings frequently change. If your email account was working but you
are currently experiencing problems, check with your service provider to find out whether
any of the account sattings have changead.

{ Have Problems Sending and Receiving Emaif

368

Short periods of ime when emall is unavailable are common, due to server problems or
poor wireless coverage, If you have problems sending or receaiving mail for an extended
period of time, check with your ISP or email service provider to verify that the service is
working properly, and check with Sprint Customer Service for outage information in your
area,
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If wour company uses Microscft Systemn Center Mobile Davice Manager, contact your
systern administrator to find out whether email features are disabled on your Treo,

Aulto Syne s Not Working

[f Auto Sync is occurring and you turn your Treo off, or if the connection to your amail service
provider is disconnected, the Auto Sync fails.

1. Check the synchronization scheduls to make sure that Auto Sync is set to occur at the
expected day and time (ses “Setting the Synchronization Schedule” on page 310 for
details).

2. Press Start 2], select Programs, and then select AciveSync (.

3. Press Menu — (right softkey) and select Add Server Source or Configure Server,

(Make sure the verify password setting is on. This is reguired for wireless
synchronization.)

{ Have Problems Sending Email

[f wou are able to receive email messages but cannct send them, try these steps:

1. Make sure your ISP or email pravider allows you to access email on a Treo, Some
providers do not offer this option at all; cther providers require an upgrade for you to
access email on a Treo.

2. Turm on ESMTP. Many services require authenticated access, or ESMTE, to use their
SMTP senvers.,

3. Press Start (57, select Programs, and then select AciveSync (.

4 Press Menu (— (right softkey) and selact Configure Server, (Make sure the S8L boxis
checked)

5. Enter the name cf a different outgoing mail server for sending mail. Many 15Ps, such as
cable companies, require that you have an Internat connaction to their network to send
email through their servers. In this case, you can almost always receive email fromthese
accounts, but if you want to send email, you must send it through ancther server.
Contact Sprint for an outgoing mail server option based on your Sprint account settings.

Section 7A-Help 369

dpeH



In cther cases, your ISP may be able to provide you with the outgoing mail server
sattings required to send mail from your Treo.

{ Have Problems Synchronizing Messages on My Treo With Messages on My
Computer
Make sure you have chosen the same settings for the account on both your Treo and your
computer. For example, if the account is set up on your Treo to use the POP pratocol, check

the AcfiveSyne settings on your computer to make sure that POP is selected as the protocol
for that account.

My vCard or val Bmaif Attachment fsn’t Forwarding Correctly

Microsoft Cffice Outlook provides several features that work with email client software on a
Windows computer, For these features to work: correctly, the emaill client software must be
properly sat up, Follow these steps to check the sattings:

1. On your complter, click Starf = Conirof Paned,

Select imfermet Oplions, and then click the Programs tab.

Make sure that the email field is set to the correct email client scftware.
Click OK

Start the email client software and make sure it is configurad as the default MAPI client.
{Consult the documentation for your deskiop email application for more information,)

Web

U

{Can't Access a Page
1. Maka sure you hawe Internet access:

Cpen Intermneat Explorer® Mobile and try to view a Web page you've loadad bafore,

To ensure that you're viewing the page directly from the Internat, press Mentd —
{right scftkey) and select Refresh.
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After confirming your Internet connection, try to view the page in question again. If it
comeas up blank, press Mentl — (right softkey) and select Refresh,

If you're still having trouble, the page may contain elements that are not supported
by Intermet Explorer Mobile, such as Flash, Shockwave, VBEScript, WL script, and
other plug-ins.

2. Some Welb sites use a redirector to their true home page (for example, if you enter the
address hfoAwwwpalm.com/support it may resolve
to hitowww palim.comdusssupport. If Internat Explorer Mobile can't follow the redirect,
try using a deskiop browser to see the landing page cf the redirector, and enter that
address in Internat Explorar Mobile.

3. It your company uses Microsoft Systermn Center Mobile Device Manager and you're
attermnpting to connedct to the Intermnat with a Wi-Fi connaction, contact your system
administrator to find out whether Wi-Fi features are disabled on your Treo,

Animage o Map s Too Small on My Treo Scieen

Internat Explorer Mobile has various viewing modeas: One Coftimn, Ft fo Screen, Desidop, and
Fuilt Sereen. Switch to Destdop to see the full-size image (ses “Viewing a Web Page” on
page 172).

A Secure Site Refuses o Permit a Transaction

Some Web sites don’t suppon certain brovesers for transactions, Flease contact the site's Web
mastar to make sure the site allows transactions Using Internat Explorar Mobile,

Camera

Here are some tips for taking good pictures with the built-in camera:
Clean the camera’s lens with a soft, lint-free cloth.

Take pictures in bright lighting conditions, Low-light images may be grainy, dus to the
sensitivity of the camera.
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Hold the camera as still as possible. Try supporting your picture-taking arm against your
body or a stationary object, such as a wall,

Keep the subject of the pictures still. Exposure time is longer with lower light levels, soyou
may see a blur,

For best results, position the brightest light source behind you, lighting the subject’s face.
Awvoid taking indoor pictures with the subject in front of a window or light.

Make sure the subject is at least 18 inches away from the camera to ensure good focus.

Rememiber that when you synchronize, your Camera images are stored in the following
folder on your hard drive (see “Synchronizing Your Media Files” on page 205):

Windows XP:- C:\Documents and Settingsi=<username>=iWy Documentsi<ldevice
name= My Documeants.

Windows Vista: C\sers\<ZJsername>=\Fictures.
My Camera Won't Take Piclures

If wour company usas Microsoft Systerm Center Mobile Device Manager, contact your system
administrator to find out whether the camera featuras are disabled on your Treo.

The Camera Preview Image [ ooks Strange

Some third-party applications overwrite the color sattings of your Treo with their own §-bit
color settings, This can affect the Camera Preview Mode, Delete third-pany applications one
by one until the preview image improvas,

fll Picturas are T6-bit color Rasolulion saffings mngea from 1600X 1200 fo
TG0 X 120 pixals. Video fesolufion seffings ranga Fom 320 K 2400 176 X
144 pivals You can change the resofufon saffing by prassing Menu ¢hght
soffey) and selkcfing Resolution (6l images) or Quality fvdeo).
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Third-Party Applications

Sometimes, third-party applications can cause conflicts on your Treo, Third-party applications
that modify wireless features may affect the performance of yvour device and may require exira
troubleshocting. Use caution when installing the following types of applications:

Fingtone managers.
Caller ID applications.
Instant messaging.

Applications that modify when your phone or data conneactions turn on or off and how
your phone behaves,

Rameambear that not alf hid-pary & pofications ware witlan with tha Treo
Kayhoard and 9-wiay navigator in mind. You may ancounfar shangs
behavior or errors in these applications if you use the fevboard and 5-way
nanigator.

[f wou recently installed an application and your Treo seems to be stuck, try the following:
1. Perform a soft reset (see “Performing a Soft Reset” on page 349).

2. Make sure the third-party application is compatible with the Windows Mobile version 6.1
operating systern on your Treo.

3. Delete the most recently installed application from your Treo (ses “Removing
Applications™ on page 3007,

If the problem persists, perform ancther scft reset.

5. If possible, synchronize or use the included Sprite Backup utility to back up your most
recent infarmation.

Perform a hard reset (see “Performing a Hard Reset” on page 350).

Synchronize or restore your backup to refresh the information in your built-in
applications.
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8. lf the problem is resobved, begin reinstalling your third-party applications one at a time.

9. Ifthe problem recurs, delete the last application you installed and report the problem to
its developer.

Getting More Help

Contact the author or vendor of any third-party software if you require further assistance.
Sprint does not provide technical support for applications that are not built into your Treo.

Making Room on Your Treo

[f wou store a large number of reconds, or install mary third-party applications, the internal

meamaory on your Treo may fill up, Here are some ways to clear space on your device:
Camera: Large imagas take up a lot of memaory, Mowve images 1o an expansion card, or
delete imageas from your Treo {see “Synchronizing Your Media Files™ on page 205).
Emali: Email attachments can consume excessive memory. Move attachments to an
axpansion card, or delete large files from your Treo (see “Managing “our Messages” on
page 161). You may also want to empty the delated items folder,

fnternet:- |t you save links to pages you've visited in Internat Explorer Motils, ywou may want
to clear all recent pages (see “Customizing Your Intarnet Explorer® Mobile S ettings™ on
page 177).

Third-party appfications: Vou can delete infrequently used applications or mova them to

an expansion card (see “Copying or Moving Applications and Files Between Your Trao
and an Bxpansion Card” on page 304).

Alsg, ramember that your Treo includes an expansion card slot, and that you can store
applications and information on expansion cards. Howewver, you still need free memory on the
davice itself to run applications from an expansion cand,
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Voice Quality

{sthe Cther Person Hearing ah Echo?

Try decreasing the volume on your Treo to avoid coupling or feedback on the cthar
persom’s end. This applies to bath the speakerphone and to the handset earpiece.

Position the Treo closer to your ear to prevent sound leaking back to the microphone.
Keap your hand away from the microphone hole in the lower-left corner of your device,

If vou're using Speateerphone mode with yvour Trao Iving on a flat surface, try turning the
daevice face-down (screen facing the surface),

Are You Hearing Your Own Voice Echo?
Ask the other person to turn down their volume or to hold the Treo closer to their ear,
Is Your Voice Too Quiet on the Other End?

Be sure to hold the bottom of the Treg, or the hands-rae microphone, close to your mouth,

Chack the signal strength-indicator, If the signal is weak, try tofind an area with
battar covarage.
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Section 7B

Glossary

TxRTT: A standard of wireless Internat connectivity that allows for persistent data connaections
as long as you are actively using your data connection. The average data fransmission rate is
about 70Kbps, although theoretical limits are 153 8Kb/s. With Sprint Power Yisiorn™ plans, you
pay a monthly rate for unlimited data transfer and you dom’t pay for connaction time.

ActiveSync®: Tha software on your Palm® Treo™ 800w smart device that exchangas and
Updates the information on your Treo with the information on your computer,

ActiveSync Desidop Software: The software on your Windows XP computer that exchanges
and updates the information on your computar with the information on your Treo, To open
ActiveSync on your computar, double-click the ActiveSyne icon in the tasklbar in the
lower-right corner of your screen. If the icon does not appear, click Start > Al Programs ==
Microsoft AciveSync. See “Installing ActiveSync® Deskiop Software: Windows XF” an

page 46,

Atffo-off interval: The time of inactivity that passes before the screen on your Treo turns off,
The wirelass featuraes on your device are unaffectad by this setting.

Beam: The process of sending or receiving an entry or application using the infrared port on
your Treo or using Blustooth™ wireless technol ogy.,

Bivetooth™ wireless fechnofogy: Technology that enables devices such as Treo smart
davices, wireless phones, and computars 1o connadt wirelessly to each other so that they can
axchange information over short distances.
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Destdop software: A PIM application for computers, such as Microsoft® Outlook® that helps
WOU manage your personal information and keep your personal information synchronized
with your Treo,

Diat-up networtdng: \Wireless technology that enables you to convert vour Treo into a wireless
modem sothat you can access the Intermeat from your computer,

Direct Push fechnology: A two-way wireless delivery meathod used between Microsoft
Exchange Server 2007, or Exchange Senver 2003 upgraded to Service Pack 2 and a Treo
with Windows Mobila® 6.1 with MSFP (Massaging and Security Feature Pack). Microsoft Diract
Push technology enables features such as Tasks Cver The Air (OTA), and IP-based push
Updating of Cutlook information (nbos, Calendar, Contacts, and Tasks).

EVDO (Evoifttion Data Optimized): A wireless broadband technology (also known as EVDO)
that is designad for very high-speed data transfer with average download speeds of 400 1o
F00Kbps and that is capable of reaching speeds up to a theoretical maximum of 3.2Mbps,
and upload speeds up to 1.8Mbps. The Sprint Mobile Broadband Network uses EVDO
technology, Your Treo supports EVDO Rev 0 and Rey Atechnologies.

Giobal Address [ ist{GAL): An online address book for Microscit BExchange Server 2007 or
Exchange Server 2003 upgraded to Service Pack 2. The GAL contains names, email
addresses, and other information, and is created and maintained by your Exchange senver
administrator.

Infrared (fR}: A way of transmitting information using light waves. The IR port on your Treo
lets you transfer information between othar IR devices within a short radius,

Lithium-ion {i-for - The rachargeable battery technology used in your deavice.

Microsoft System Center Moblie Device Manager: A security management platfonm that
enables systern administrators to set and implerment security policies by remately contralling
mobile devices. This platform also enables users 1o access corporate information on
networks with firewalls.

Mobfle Broadband Metworlc: An advanced wireless data network using the fastest
commercially available wireless network technology (BEVDO) to deliver broadband-like transfer
speeds for your data connections.
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Partnership: Two Bluatooth devices—for example, your Treo and a hands-free device—that
can connect because each device finds the same passkey on the other device, Onecea you
form a partnership with a device, yvou dom't need to enter a passkey to connect with that
device. Partnership is known on some devices as paired refationship, pairing, trusted davics,
or trustad pair,

Phone as Modem: The feature that enables your device {whean connected to the mobile
broadband network) to be used as a high-speed modem for yvour computer, Using a wired
(USB sync cable) connedction.

Phone Off- The icon that indicates when the phone feature is not connected to any wirelass
phone network, You can still Use the organizer and other features.

PiM {(personal information manager: A category of scftware that includes applications such
as Microscft Cutlook, Palm® Deskiop scftware, Lotus Notes, and ACT!L PIMs generally store
contacts, schaedules, tasks, and memos,

SMS (Short Messaging Service): The service that exchanges short text messages almost
instantly betweaen wireless devices. These messages can usually include up to 160
characters, Your Treo can send and receive text messages while yiou are on a voice call,

Sprint 1XATT: The naxt generation of wireless Interneat access that enables you to check your
email and browsea the Web,

58I The name that identifias a Wi-Fi network. If a network doas not broadcast its S5I0, you
must get the SSID from the system administrator in order to connect to the natwork,

Synchronization: The process in which information that is entered or updated on your Treo,
WOLUr computer, or a server is updated in one of the other locations either wirelessly or by
means of a cable connaction. See “Synchronizing Information”™ on page 307,

Username: The name asscciated with your Treo that distinguishes it from other Windows
Mobile devices. When you first synchronize ywour device, you are asked to give it a usarname.

WI-Fi access point- A network device with an antenna that provides wirgless connectionsto a
larger network, Also called a hotspot,

Windows Mobife® The operating system of your Treo, Your device uses the Windows Mobile
6.1 Professional edition of this operating systam.
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Windows Mobile Device Center: The software on your Windows Yista® computar that
enalbiles you 1o synchronize content and manage music, pictures, and videos betwaen your
device and your computer. To open Windows Mobile Device Center on your computer, click
Start = All Programs > Windows Mobile Device Center. Sae “Setting Up Windows Mobile
Device Cernter: Windows Vista®™ on page 47 for more information.
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Section 8A

Important Safety Information

In This Section

General Precautions

Maintaining Safe Use of and Access to Your Palm Treo 800w Smart Device
Using Your Phone With a Hearing Aid Device

Canng for the Battery

Radio Frequency (RF)Energy

Static Electricity, ESD, and Your Treo

Owners Record

UserGuide Proprietary Motice

This guide containg important operational and safaly information that helns
you safaly e your Paim®™ Treo™ 800w smartdevica Failure b read and
fotlow the information provided in this guide may &sult in sarous bodily
initiry; death, or propery damage
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General Precatitions

There are several simple guidelines for operating your Treo properly and maintaining safe,
safisfactony service.

Speak directly into the microphone.

Avoid exposing your Treo and accessories torain or liquid spills. If your Treo does get wet,
immediately turn the power off and remove the battery.

Although your Treo is quite sturdy, it is a complex piece of equipment and can be brokan.
Avoid dropping, hitting, bending, or sitting o it

Any changes or modifications to your Treo not exprassly approved inthis document could
wioid your warranty for this equipment and void your authority to operate this equipment,

Mot For the best cam of your Treo, ba sure that only Sprint authodzed personne!
SoNFoas Vour Teo and 200assorias. Failne 10 (o S0 may ba dangenous and
may Vold Your waranhy

Maintaining Safe Use of and Access fo Your Paim® Treo™ 800w
Smart Device

Da Not Rely on the Phone Feature of Your Treo for Bmergency Calls

Wireless phones, such as the one on your Treq, operate using radio signals, which cannot
guarantae connection in all conditions, Therafore you should never rely solely on any wireless
phone for essantial communication (for example, medical emergencies). Emargency calls
may not be possible on all cellular networks or when certain network servicas andfor phone
featuras are in use. Check with vour local service provider for details,
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Using Your Phone Whife Driving

Talking on your phone while driving (or operating the phone without a hands-fres device) is
prohibited in some jurisdictions, Laws vary as 1o specific rastrictions, Remember that safaty
alyays comas first,

Tip Purchasa an opfonal hands-free 2 coassory at Wour local Sprint Store or
ofdfer by phona Cail 1-866-866- 7209 or wisit wivw. sprint comyacoassoras.

Following Safely Guidelines

To operate your Treo safely and efficiently, always follow any special regulations in a given
area. Turn the phone feature of your device off in areas where use is forbidden or when it may
caluse interferance or danger.

Using Your Treo Near Other Electronic Devices

Most modern electronic aquipment is shielded from radio frequancy (RF) signals. Howeavar,
RF signals from wireless phones may affect inadequately shielded electronic equipment.

RF signals may affect improperly installed or inadeguately shialded electronic operating
systens and/or entertainment systems in motor vehicles. Check with the manufacturer or
their reprasentative to determing if these systems are adequately shielded from exdernal RF
signals, Also chack with the manufacturer regarding any equipment that has been addad to
wour wehicle.

Consult the manufacturar of any personal medical devices, such as pacemakears and hearing
aids, to determine whether they are adequately shielded from external RF signals.

Always fum off the phone in health care Boiliies and g uast parmission
before using the phone near medical equipment
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Turning Off Your Phone Before Flying

Turn off your phone before boarding any aircraft. To prevent possible interference with aircraft
systemns, the LS, Federal Aviation Administration (FAA) regulations reguire you 10 have
parmission from a craw member 1o use your phone while the plans is on the ground. To

prevant any risk of interference, FCC regulations prohibit using your phone while the plans is
in the air,

Tumning OFff Your Phone in Dangerous Areas

To avoid interfering with blasting operations, turn your phone off when in a blasting area or in
other areas with signs indicating that two-way radios should be tumed off. Construction crews
often use remate-control RF devices to set off explosives,

Turn your phone off when you're in any area that has a potentially explosive atmosphere,
Although it's rare, your phone and accessories could generate sparks, Sparks can cause an

explosion or firg, resulting in bodily injury or even death. These areas are often, but not ahways,
clearly marked. They include:

Fueling areas such as gas stations.

Below deck on boats.

Fuel or chemical transfer or storage facilities.

Areas wheare the air contains chemicals or particles such as grain, dust, or metal powders,
Ay ather area where you would normally be advised to turn off your vehicle's engine.

MNever frangport or store fammable gas, fammable figuid, or axplosias in
the compaidment of vour vahicks thal condaing yvour phonle or & 002ssonas:

Restricting Chifdren’s Access to Your Treo

Your Treo is not a toy, Do nat allow children to play with ity they could hurt themselves and
others, damage the Treo and/or its phone, or make calls that increase ywour Sprint charges.
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Using Your Phone With a Hearing Aid Device

Your Treo 800w smant device is compliant with the FCC Hearing Aid Compatibility (HAC)
requirements, For additional HAC information, including the HAC rating cf this product, please
go to wwwpain.comdreoHAC,

“our Treo has been tested for hearing aid device compatibility, When some wireless phones
are used near some hearing devicas (hearing aids and cochlear implants), users may detect
a buzzing, humming, or whining noise, Some hearing devices are more immunsa than cthers
to this interference noise, and phones also vary inthe amount of interference they generate,

The wireless telephone industry has developed ratings for some of their wireless phones, 1o
assist hearing device users in finding phones that may be compatible with their hearing
devices. Mot all phones have been rated. Phones that have been rated have a label on the
b, Your Treo 800w smart device phone hasan M4/T4 rating.

These ratings are not guarantees. Results will vany, depending on the level of immunity of your
hearing device and degree of vour hearing loss, If yvour hearing device happens to be
vulnerable to interference, yvou may not be able to use a rated phone successiully, Trying out
the phone with your hearing device is the best way to evaluate it for your personal needs.

M-Ratngs: Phones rated M3 or M4 meet FCC requirements and are likely to generate less
interference with hearing devices than phones that are not labeled. M4 is the better/higher of
the two ratings.

T-Ratings: Phones rated T3 or T4 meet FCC requirements and are likely to be more usable

with a hearing device’s telecoll (T Switch™ or “Telephone Switch™ than unrated phones, T4 is
the better/igher of the two ratings, (Note that nat all hearing devices contain telecoils,)

The more immune your hearing aid device is, the less likely you are to experience
interference noise from your wireless phone, Hearing aid devices should have ratings similar
to those of phones. Ask your hearing health care protessional for the rating of your hearing
aid. Add the rating of your hearing aid and your phone to determine probable usability:

Ay combined rating equal to or greater than six offers best Use.

Ay combined rating equal to five is considered normal Use.
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Any combined rating equal to four is considered usable.

Thus, if you pair an M3 hearing aid with an M3 phone, you have a combined rating of six for
“best use” The same applies for T ratings.

Sprint further suggests that you experiment with multiple phones (even those not labeled
M3/T3 or M4T4) while in the store to find the one that works best with your hearing aid
device, If you experience interference or find the guality of service unsatisfactory after
purchasing your device, prompthy return it to the store within 30 days of purchase, With the
Sprint 30-day Fisk-Free Guarantes, you may return the device within 30 days of purchase for
a full refund, and you will only be responsitle for charges based on your actual usage.

Gelting the Best Heating Device Expeiience With Your Treo

To further minimize interference:
There is usually |lass interfarance on the microphone satting than on the telecoil setting.

Sat the phong’s scresn and Keyboard backlight settings to ensure the minimum time
interval. See “Viewing and Optimizing Power Settings” on page 338 for instructions.

Mowe the phone around to find the point with the least interference.

For information on selecting HAC sattings, see “Selacting Your HAC Settings” on page 1045,
Caring for the Ballery

Protecting Your Battery

The following guidelines will halp you get the most out of your battery’s performanca:

Recently there have been some public reports of wireless phone batteries overheating,
catching fire, or exploding, It appears that many, if nct all, of these reponts invalve
counterfeit or inexpensive, aftermarket-brand batteries with unknown or questionable
manufacturing standards. Sprint is not aware of similar problems with Treo smart devices
resulting from the proper Use of batteries and accessorias approved by Sprint or by the
manufacturer of your phone. Use only batteries and accessories that have been approved
by Sprint or by the manufacturer of your Treo, and that are found at Sprint Stores or
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through manufacturer of your Treg, or call 1-866-343-1114 to order them. They're also
available at wwwe.sprintcom/accassonas Buying the right batteries and accessories is the
best way to ensure that they're genuine and safe.

To avoid damage, charge the battery only in temperatures that range from 32° Fto 113°F
0° Cto45° C).

Don't use the battery charger in direct sunlight or in high humidity areas such as the
bathiroom.

MNever dispose of the battery by incineration.

Keep the meatal contacts on top of the battary clean,

The battery may need recharging if it has not been used for a long period of time.

I's best to replace the battery when it no longer provides acceptable performance |t can
be recharged hundreds of times before it needs replacing.

Don’t store the battery in high-temperature areas for long periods of time. IP's best to follow
these storage rulas:

Lass than one month: —4° F to 140° F (-20° Cto 60° C)
Less than three months; —4F to 104F (-20C 1o 40C)
Lass than one year, —4F 1o 68F (-20C to 20C)

CTIA (Cellufar Telecommunications and internet Association)
Battety Handling Guidelines
Use and/or replace the battery and charging system only with the batteny or charging

systarmn specified for this phone, Use of an ungualifisd battery or charger, or impropar
battery use, may present a risk of firg, explosion, leakage, or other hazard.

Do not disassemble, open, crush, bend, deform, puncture, or shred the batteny.

Do not short-circuit the battery or allow metallic conductive objects to contact the battery
tarminals.

Do nct modify or remanufacture the batteny, attempt to insert foreign ofjects into the
battery, immersa it or expose it to water or athar liquids, or exposes it to fire, explosion, or
other hazard.

Battery usage by children should be supervised.
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Avoid dropping the phone or battery. If you drop the phone or battery, especially on a
hard surface, and you suspect damags, take it to a service center for inspection.

Promptly dispose of used batteries in accordance with local regulations.
Dispasal of Lithium-lon (Li-fon) Batteries

To avoid being burned, do not handle a damagead or lsaking lithium-ion (i-ion) battary,

For safe disposal options of your li-ion batteries, contact your nearest Sprint authorized
service center,

Special Mote: Be sure to dispose of your battery properly. In some areas, the disposal of
batteries in household or businass trash may be prohibited.

Radio Frequency (RF) Energy

Understanding How Your Phone Operates

“our phone is basically a radio tfransmitter and receiver, When its turmed on, it receives and
transmits radio frequency (F) signals, When you use your phone, the systam handling your

call controls the power level. This power can range from 0.006 watts to 0.2 watts in digital
mode,

Knowing Radio Frequency Safety

The design of your Treo complies with updated MCRP standards described below.

[ 1991 -92, the Institute of Electrical and Electronics Engineers (IEEE) and the American
MNational Standards Institute (ANS) joined in updating ANSI's 1982 standard for safety lavels
with respect to human exposure to BF signals. More than 120 scientists, engineers and
physicians from universities, government health agencies and industries developed this
updated standard after reviewing the available body of research. In 1993, the Federal
Communications Commission (FCC) adopted this updated standard in a regulation. In
August 1996, the FCC adopted a hybrid standard consisting of the existing ANSIAEEE
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standard and the guidelines published by the National Council of Radiation Protection and
Measurements (NCRP).

Body-Worn Operation

To maintain compliance with FCC RF exposure guidslines, if you wear a handseat on your
body, use the carrying case, holster, or cther body-worn accessory that is supplied by or
approved by Sprint, Use of accessories that are nor approved by Sprint may violate FCC RF
exposUre guidalines.

For maore information about RF exoosure, visit the FCC Web site at wwwefoc.goviost/safety.

Specific Absorption Rate (SAR) for Wireless Phones

The SAR is a value that corresponds to the relative amount of RF energy absorbed in the
head of a usar of a wireless handset,

The SAR value of a phone is the result of an extensive testing, measuring, and calculation
process It does not represent how much RF the phone emits, All phone models are tested at
their highest value in strict laboratony settings. But when in opearation, the SAR of a phone can
be substantially less than the level reported to the FCC. This is because of a variety of factors
including its proximity to a base station antenna, phone design, and other factors, What is
important to rememier is that each phone meets strict federal guidelines. Variations in SARS
do not represent a variation in safety.

All phones must meet the federal standard, which incorporates a substantial margin of safety
As stated above, variations in SAR values between different models of phones do not mean

variations in safety, SAR values at or below the federal standard of 1.6 W/kg are considered

safe for use by the public.
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The highest reportad (FCC) SAR values cof the Treo 800w smart device are as follows:

Maximum Scafed SAR Values (Wrtg) FCC

CDMA 2000 COMA2000 | WLAN Co-focation
Cefitdar PCS
Head 0.837 1420 0.067 1433
Body 0577 0.456 0.018 0.595

FCC Radio Frequency Emission

This phone meets the FCC Radio Frequency BEmission Guidelines and is certified with the
FCC as:

FCC D number: C8F-715
1CID number: 3905A-715

More information on the phoneg’s SAR can be found from the following FCC Wab sita;
Hitpdiwwwfoc.gov/oat/as and enter FCC 1D number O8F-715 in the FCC 1D Search,

Static Electricity, ESD, and Your Treo

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the
device, s0 you should take steps to avoid such an occurrence,

Description of ESD

Static electricity is an electrical charge caused by the buildup of excess electrons on the
surface of a material. To most people, static electricity and ESD are nothing mors than
annoyancas. For example, after walking over a carpet while scuffing your fesf, building up
electrons on your body, you may get a shock—the discharge event—when you touch a metal
doorknob, This little shock discharges the built-up static elactricity,
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ESD-Susceptible Equipment

Even a small amount of ESD can harm circuitry, so when working with electronic devices, take
measures to help protect your electronic devices, including your Palm® Treq, from ESD harm,
While Palm has built protections against ESD into its products, ESD unfortunately exists and,
unless neutralized, could build up to levels that could harm your equipment. Any electronic
davice that contains an exdarnal entry point for plugging in anything from cables to docking
stations is suscaptible to entry of ESD. Davicas that you carry with you, such as your Treg,
build up ESD in a unique way bacause the static electricity that may have built up on your
body is automatically passed to the device, Then, when the device is connected to ancthar
davice such as a docking station, a discharge event can occour,

Precautions Against ESD

Make sure to discharge any built-up static electricity from yourself and your electronic devices
before touching an electronic device or connecting one device to another, The
recommendation from Palm is that you take this precaution before connecting your Treo to
wour computer, placing the Treo in a cradle, or connecting it to any other device, You can do
this in many ways, including the following:
Ground yourself when you're holding your Treo, by simultaneously touching a metal
surface that is at earth ground. For example, if your computer has a metal case and is
plugged into a standard three-prong grounded outlat, touching the case should discharge
the ESD on your body.
Increase the relative humidity of your ervironment,
Install ESD-spedific prevention items, such as grounding mats,

Conditions That Enhance ESD Qcclifrences

Conditions that can contribute to the buildup of static electricity in the ervironment include the
following:
Low relative humidity:

Material type (the type of material gathering the charge; for example, synthetics are maore
prone to static buildup than natural fibars like cctton).
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The rapidity with which you touch, connect, or disconnect electronic devicas.

While you should always take appropriate precautions to discharge static electricity, if yvou are
in an ervironment where you notice ESD events, you may want to take extra precautions to
protect your electronic equipment against ESD.

Owner’s Record

The modsal number, regulatory numbear, and serial number are located on a nameplate inside
the battery compartment. Record the serial number in the space provided below. This will be
halpful if you need to contact us about your phone in the future,

Modet: Trao 800w Smart Davice
Seriaf No.:

User Guide Proprietary Notice

COMA Tachnology is licensed by QUALCOMM Incorporated under one or more of the
following patents:

4,901,307 508,390 5267262 5,416,797
5506,865 5544196 5657420 5101,501
5267261 5414796 5504773 5535239
5600,754 5,778,338 5,228,054 5337338
5,710,784 5,056109 5,568,483 5,659,569
5,490,165 5,511,073

User Guide template version 7B (Novemtber 2007)
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Specifications

Radio COMA 800 (Digital Cellular), 1900 (PCS), and 15GHz (GPS)
EVDO Fev 0, Rev A) and 1XRTT
Phone features Personal speakerphone
MicrolJSB standard B connector {2.0-compliant; for sync cable,
charger, and audio accessories)
External antenna port
Microphone mute option
F-way calling
HAC compatible (M4/T4 rating)
Processor Tl processor
technology
Expansion microSDYSOHC card slot
Battery Rechargeable lithium-ion
Removable for replacement
3 hours to be fully charged
Operating system Windows Mobkile® 6.1 Professional
Camera Still image capture resolution: 1600 x 1200, 2.0 megapixel
Yideo capture resolution: 176 x 144 and 320 x 240 pixals
Automatic light balance
Size 44 inxX228in x 073 In. (T2mm x S8mm x 18.5mm)
Wieight 4.94 ounces (140 grams)
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Connactivity Wi-Fi (80211b/g, 8021xwith EAP-PEAFR, EAP-TLS)
Infrared (1.2-compliant)
Bluetooth™ wireless technology (Complies with Bluetooth 2.0+EDR
specification. Suppons GAR, GOEP [OBEX], SFR, SDAF, OPF, HSF,
HFP 1.5, 420P, AvRACE, PAN, PBAF, Microsoft® ActiveSync®
technology, and BFP)

Display 320 x 320 pixel touch-sensitive LCD screen (includes stylus)
65,536 colors (16-bit colon
User-adjustable brightness

Feyboard Built-in OWERTY keyboard plus 5-way navigator

Backlight for low lighting conditions

Included software

Today/Phone (includes Speed Dial and Dial Pad)
Messaging (text and email)

Internet Explorer® Mokile (Web browser)
Maps

Camera

Pictures & Videos

Windows Madia® Player Mobile

File Explorer

Contacts

Calendar

Tasks

Motes

Calculator

ActiveSync® (device and deskiop software)
Microscit Direct Push technology
Windows Live

Section 88: Specifications
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Included software
{continued)

Excal® Mobila

Word Mobile

PowerPoint® Mokbile
OnaeMote® Mobila
Handmark Pockst Express
Solitaire

Bubble Breaker
Astraware Sudoku

Aces Texas Hold’em Limit
Yoice Command

My Treo

Cluick Tour

Search

Terminal Services

Picsel POF Viewer

Sprite Backup

Bejeweled 2 (on CDY
WorldMate (on CO)

Systemn
requirerments

Windows XP Sarvice Pack 2, or Windows Vista® with USE port,
Later varsions may also be supportead,

Some wireless features require Microscft BExchange Server 2003
with Service Pack 2 ar later.

Operating and
storage
temperature rangs

32°F to 113°F (0°C 1o 45°C)

5% 1o 90% RH

398
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Index

Mumerics account picker 147

TxATT network jcon 357 accolnts

TxRTT natworks 377 acecassing corporate 341
4171 phone calls 16 creating passwords for 40
S-way navigator 258, 56, 59, 373 customizing 135, 147-149
977 calls 328, 330, 384 dafeting email 135

anabling Sorint Fowsar Vision 114
gatting usemamas for 115

managing 16

praventing unauthorzed use of 330, 335
AC charger 29, 344 setting up email 130, 132

accanrgd Cheractsrs 69 satting up Exchange Servar 126-129
accassing troubleshooting 367, 366

account information .1 g, 40 unlocking device and 331
altarnate charactars fist 66 Accounts ab 132, 147

applications 70, 324
corporate senvers 341, 367
diractony assistanca 16 activating Treo 23, 36

GPS fthfmanﬂ 337 active call viaw 85, 86, 59
menu ftams 60 active calls 89, 90, 328

on-device help 15 See also phone calls
onhiine addrass books 142 ActiveSync 43, 135

onfing support 156 dafinad 377

Quick Tour 15 See also synchronization software
Sprint Fowsr Vision sendcas 115 ActivaSync jcon 49, 52, 377

Today screen 72, 76 ActivaSyne technology 377
voicamail 39, 64 adaptars 344

Web pages 171,172, 166 Add Contact prompt 87
accessores 344 Add Optional Attandes command 246

A
abbraviated dialing prefivas 103
About screen 115

actions 321
activating ftams on scresn 59

Index 389
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Add Recipient option 157
Add Required Attendas command 246
Add Servar Source command 308
Add to Contacts command 160
Add to Favorites command 175
adding
appointmeants 243, 244
attachmeants 137
Blusatooth devices 197
bulfetad or numbearad fists 268 286
calfer iD pictures 238
contacts 87, 141, 160, 238
axpansion cards 31
filas to playiists 232
folders 269
Intarnat connactions 341
notas 239, 251, 262, 254, 265
passwords 40
signaturas 146, 163
spead-dial buttons 92
tasks 280
untimad avants 244
YIEN conhactions 342
Viieh favorttes 174-175
VA connections 191
workshaats 279
addrass books 141, 148, 241, 363
Address tab 148
addrassas
accessing Web pages and 172
adding contact 141, 160, 239
adding muftinfe 137, 168, 169
copving 363

400

displaying 157
gatiing 141, 148 241
gatiing diractions for 164
highfighting 59
salacting 144
sanding masting requests and 246
sanding massages and 136, 157
varifving 142
ad-hoc connections 192
adjusting screan brightnass 322
Adobsa Flash Flayvar 46
advancing sidas 272
AES encryption 193
Agenda visw {calendar) 242
air fravel 386
alarm clock 335
alarm sound icon 335
alarms
adding to avants 245,249
assighing to tasks 250, 252
saiting vibrating 321
turning on and off 321, 335
Alarms tab 335
albums 216, 217
alarts. See notifications
alfgning the screen 323
alfgrmant sattings
documeants 268
Spraadshasts 272, 279
Alfow cookies option 178

Allow USB connactions chack box 361

altarmnate charactars 65
alternate charactars fist 66

fndex



altarnata phone numbears 78, 80
animated connection jcon 52
animation 272
anniversaries 244
Answar softkey 81
answaring the phone 81, 89, 98
antanna port 26
appagranca sattings 318, 322-323
Appearance tab 318
application buttons 69
applications
Seg also thirdparty applications
accassing 70, 324
associating with buttons 324
checking battary status and 31
closing B9, 71
copving 304
customizing 324-328
defating 300, 374
displaving maemory Lsage for 338
displaving menus in 60
downioading 298
gatting halp with 15
included with Treo 398
instaffing 206-299, 373
moving to axpansion cards 304
opening 69, 70, 302
plaving media flas and 233
running from axpansion cards 303, 374
running multiple 71, 86
sanding emaliand 124
Storing 374
synchwonizing 43, 45, 314

Index

troublashooting 336, 339, 355, 363, 364
turning sounds on or off for 321
appointmnant options 249
appointments
See afso avants
adding 243, 244
appeaaring in wrong fme sots 364
dafeting 248
antaning muliiple 243
marking as private 247
schaduling rapaating 244
vigiwing 242
Appointmants tab 249
ares codas 241
Assign a program options 324
attachments
adding 137
downfoading 139-140, 152
ambedding objacts jn 141
fraging internal mamony and 374
opening 139
sanding 153
storing 139, 149
troublashooting 370
Attendess command 246
audio 82, 223,227
audio accassones 97
audio filas 226
See afso meadia files
authentication 134, 369
Authentication options 192
Auto Sync tab 152
Auto Syne, roublashooting 369
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auto-compiation options 326-328
AutoCorract command 220
auto-corraction option 327

See giso spall checking
Autofifl option 278
Autofiter cormimand 281
Autofiftar sattings (spreadshasts) 273
AutoRt option 280
Atto-Kevguard faature 328, 329
Auto-Fayquard option 329
Autofock option 330

Automatic Send/Racaive option 131, 135

150
auto-off intanal 339, 377
auto-scroll optfon 328

B
background music 230
Packgrounds 212,219, 234, 318
backing up information 52, 350, 360
backlight 63, 339
Backiight icon 322
backiight shut-off settings 64, 339
Backspace kay 59
backup utiities 348, 351, 367
backups rastoring 351, 367
battary
activating Trao and 36
caning for 3856-390
charging 29-30, 344
consaning powsr for 339

craating Blustooth connections and 198

disposing of 352, 390

402

insarting 28
maximizing 31-32
replacing 29, 344, 351
vigwing ramaining powsr for 338
viewing status of 30
battary door 26, 28, 351
battary icon 30
battary spacifications 396
battarv-charge indicator 30
battaryready indicator 30
Baam. .. command 198, 201
beaming 198, 200, 201, 377
billing nformation 115
birthdays 244
Blazar. Ses Web browsing, Web pages
Block Recognizaer option 326
Biustooth davices
accessing GPS information on 337
adding 197
communicating with 196
compatibiity with 196
connecting to 196-1985 200
daleting partnarships for 198
discoviering 199
making phons calls and 95, 97
maximizing battany and 31

sanding and recaiving info ovar 198, 199
setting up Intarnat Sharing with 118-119

synchronizing over 199, 312-313
troubleshooting 199, 358, 359, 365
Blustooth feature 196, 197, 312
Blustooth jcon 196
Bluatooth FAN connections 118
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Blustooth Settihgs screan 197, 199 C

Blustooth tachnology 377 CAB filas 298
bonus softwara See bullt-in applications calcufations 256, 273 277
bookmarks 174 Calculator application 256257
bordar highlight 58 calcufator buttons 257
bordars in spraadshedts 272,279 Cafculator fcon 256
brightnass, adjusting 322 calendar
Brightnass command 213 adding appointmeants to 243 244
brightness jcons (cameara) 213,215 adding mesating reguasts 239, 246
broadband sanvices 116 adding untimed avents o 244
browsing fifes and foldars 296, 305 displaying 242
built-in applications 15, 296, 300, 398 hiding appointmeants on 247
Sea afso specific appiication moving through 2473
built-in camara, Ses camara organizing evants on 248
bullated ists 263, 268, 266 ramoving avents from 248
Burstmode (camara) 214 sating alarms for 245, 249
buttons unavaliable tima sfots on 247
assigning to plavback controls 234 Calendgar application 242-249
assighing volce commands to 325 Calendar button 25, 242
associating with applications 324 calghdar sattings 248
craating spead-dial 92 Calendar status fiald 73
disabiing 326 calandar views 242
aditing spead-cial 94 Call Back numbar option 159
hghlighting 58 call forwarding 68
navigating screan and 56, 59 Call Log option 80
opaning applications and 69 Call Sendar command 160
plaving vofcamall messagas and 64, 93 call wailting 69
reassigning 256, 324 caller (D applications 373
turning sounds on or off for 321 calfer D blocking 87
Buttons Sattings scrasn 324 calfer iD pictures 101, 212, 238
Buttons tab 234 calling cards 17

calls. Saa phona calls
camcordar fcon 212
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camera
adiusting brightnass 213, 218
battary fife and 31
capiuring videos with 214-215
changing rasolution 213 218
freaing intermal mamory and 374
satting timer for 213
taking plcturas with 212-214, 286, 371
troubleshooting 371-372
Cameara fcon 212, 214
camara fans 26
Camera Praview Mode 372
camara sattings 222-223
camera spacifications 396
Camera tab 223
cancelling onscresn salections 60, 62
capitalization 64, 328
Caps lock 64
canying cases 344
case-sahsitive searching 266, 282
call pattarns (spraadshests) 272
cartificatas 174, 335
changing
alarm sounds 335
backiight shut-off 64
connactions 341
contacts 239
date and time sattings 333
fock codas 330
passwords 40
pictura or video rasolution 213,215
spead-dial buttons 94
Spreadsheds 272
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synchronization seitings 48, 310, 314, 334
Systemn colors 318
voicamall buttons 93
Word documants 263

charactar sats 177

characters
adding passkaysand 197
capitalizing 64, 328
craating tadt massages and 157, 158
diafing phone numbers and 84, 92
ahtaring B4, 326
nsarting in spraadshests 275, 277
setting Exchange Sarvar options and 309
ping altarnate 65

charger cable 29

chargars foptional) 344

charging battary fcon 30

charging Treo 28, 30

charts 273 281, 262

Chat jcon 160

chat sassions 160, 163

Chat tab 163

chack boxes 58

chronological call fist 80

Clear Cookies option 178

Claar History option 178, 290

Claar Mow Plaving comimand 232

Clear Storad Entries option 327

Claar Volcamall lcon option 85

ClaarTvpa tab 322

clock 334

Clock & Alarms Sattings screan 3373, 334,
335
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clock scraan saver 322, 339
closing
applications 69, 71
lists in fialds G2
mahus 60
notification meassages 169
scrasns 58
colflect calls 17
color seftings 318, 372
commands Sea manu ftans; volca
commands
company fists 79
company nameas 79, 240
complated tasks 260, 261
comprassed fites 295, 295
computars. See PCs
confarence calls 88, 90, 91
Confarence softkay 90
Confidantial satting 247
Configure Sarver command 308
Configure Wiralass Natwork screen 191
Confirm meassage dafetions chack box 163
Connect command 342
Connect softkey 117, 191
Connact via Blustooth command 200, 312,
365
Connect via IR command 202, 313
connaction settngs 340-343
connactions
Seg also intaemnat connactions; wiralass
connactions
Blustooth davices and 196-198, 200
changing 341

Index

corporata sayvars and 134, 308, 341, 367
customizing WA 194
device to PCs 42, 50-51
GPS devicas and 337
making phone calls and 86
maximizing battary and 32
moniftoring status of 107
racaling amall and 124, 134, 136
rasatting device and 350
roaming and 105-107
satting up VPN 341-342
satting up WHA 190-193
starting manually 342
synchronizing over infrarad 202
timing out 367
troublashooting 356-359
Connections Saitings screen 341, 342, 343
Connections tab 199
connactivity 397
consaning battary powsr 339
consumption (battany) 31
Contacts
adding picture to 220
contacts
adding &7, 141, 160, 235
addrassing massages to 136, 167
assigning rrgtonas to 92, 101, 239
changing info for 239
diafing phone numbears for 77, 78, 80
displaying 77, 239
antaning multiple 238
ahtaring phona numbars for 102
gatiing addrassas for 141, 142, 148, 241
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finkdng speedtdial buttons to 92
fooking up 77, 136, 167
parsonalizing 101
ramoving 241
saving phona numbars for &7
safecting communication meathod for 77
sanding mesting requasts to 239, 246
Contacts application 238-241
Contacts command 238
Contacts fist 77, 141, 160
contaxt-sensitive manus 61
continuous plavback (slides) 272
cookies 178
copving
addrasses 363
applications 304
ftams in foldars 271, 296
numbers 257
phone numbers 79, 81
piciures orvidens 218
text 176, 266
copyrightad ftams 218
corporata emall accounts 134, 341, 367
corporate servers 125, 307, 341, 367
coverage area 107, 356
Cregte chat from meassages option 163
creating
appointmeants 243, 244
bulfeted or numbeared lists 268 286
calfer iD pictures 238
contacts 87, 141, 160, 238
documeant tamplates 266
documents 263, 265
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amal massages 136-137
folders 269
notas 252, 254, 285
passwords 40
plavlists 232
spead-dial buttons 92
spreadshest templatas 275
Spreadshadts 272,274,275
tasks 250
text massagas 157
untimead avents 244
Web favontes 174-175
Wb finks 286
credentisls 367
Crop command 220
cropping picturas 220
currancy symbols 323
Currency tab 323
currant phone call Ses active calls
Customn domain option 133
Customnear Sarvica (Sprint) 15, 36
Custornize the playlists. .. check box 228
customizing
applications 324-328
Calendar application 245-249
camara 222-223
Contacts appliication 241
datas and time sattings 333
display formats 323
amall accounts 135, 147-149
Excal Mobite 264
Intarnat Explorer 177
Fayboard 326-328
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Media Playar Mobile 233 Defate aff massagas option 162

Massaging application 163 Deafeta Appointmant command 248
MNotas goplication 2565 Defete Calls cormmand 283
POF Viswsar 289, 290 Defate Contact command 241
sorash 318, 322-323 Dealata Alas option 178
systam saftings 333-339 Defeta from Library command 231
systam sounds 319-322 Defate Redial List command 80
Tasks gpplication 252 Deafeta Task command 252
Today screan 318 Defated folder 149
vojcamall buttons 93 defating
VA connactions 194 applications 300, 374
Word Mobile 270 catificates 336

cutting. See delating contacts 241

diractory sendcas 142
documeants 269
amall accounts 135

D]

daily schedulas 242

dala 274, 278 282 emajl messages 145, 148, 149, 150
Seaalzo mlfomjataon avents 048

data comecgon fcops 107 flas 206

Data Encryption options 193

S ftams from media fibrarfes 231
data sanvice fcons 357

ftams in plaviists 232

data servicaes 104, 188 notas 255, 287

date formats 323 partnarshins 195

Datetab 323 pictures or videns 221

dates 278, 333 334 sounds 100, 322
Sealso calendar Spead-dial buttons 94

Day view (cafendar) 242 tasks 252

day-planner calendars 242 taxt 59

dadimal places 323

’ text massages 162, 163
dacimal symbols 323

volcamall messages 64

decomprassing ZIP fifes 295, 295 Wb favoritas 176
dafault fonmat sattings 323 workbooks 264
dafinad namas (spraadshests) 279 worksheats 264
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Dalivary Prefarances command 151

deskiop software 23, 297, 378
Seg also synchronization application

davice names 49

devices
See also Blustooth davices; Treo
baaming to 200
gatting halp with 15
making phone calls and 95, 97
satting up GPS 337-338
synchvonizing and 50
transfarring information from 348
troublashooting 336

device-to-davice connections 192

diagnostic information 336

Dial Lookup fidd 72

Digf Pad 79, 80, 81

Dial Pad tones 101

aafing T6-81, 89

diafing praferances 102-103

Digling tab 102, 103

diatup networking 378

digit grouping 323

digital carnaras 216
Ses also camera

digital cartificatas 174, 338

digital networks 106

digital notebook 285

Diract Push tachnology 126, 378

diractory assistance 16

diractory senices 141, 142, 148
See glso onling addrass books

Disable touchscrean option 329

408

Disconneact Bluatooth comimand 200, 313,
366
Disconnact command 343
discoverable satting 199
Dismiss softkey 83
dfsplay 397
See also screan
Display clock on the tile bar option 334
dfspiay formats 323
Display massage on screan chack box 321
display settings 318, 322-323
afsplaying
active caflls &5, 86, 89
appoiimants 242
avallable applications 70
calangar 242
contacts 77, 239
diagnostic information 336
documents 263, 264, 276
amalf messages 139
ftams in foldars 269, 263
maps 1684, 185, 240, 337, 371
mamony usage 338
menus 60
notas 286
notifications 321
organizar featuras 34
FOF fifas 268, 283
picturas 216, 287
plaviists 232
powar settings 338
Space on axpansion cards 338
spead-dial buttons 78
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Spreadshests 274

tasks 251, 252

text messages 159, 160

vidaos 216, 230

Web favorttes 175

Viieh pagas 172
docurmant file typas 263, 270
documeant templates 263, 265, 270
doctimentation 14, 22
doctimeants

changing 263

copving and pasting taxt in 266

cregting 263 265

dalating 269

displaving 263, 264, 276

finding and raplacing taxt in 266

formatting taxt in 267-268

opening 265

renaming 269

saving 263 267, 270

satting marging for 268

spall chacking 268
doctimeants fist 269, 270
Domain Giroll jeon 343
Download Massage command 139
Download massagas option 150
Downioad size fimit option 310
downfoading

Adobsa Flash Playar 46

attachments 139-140, 152

amail 135, 149-151, 310

files 176, 298

mages 176

Index

Media Flayar Mobile 44
Cutlook 23
rngtonas 99, 176

downwara-pointing arows 62
drawing 253

E

sarpiace 25
achoas 375

Ediit Servar Seltings screen 310

aditihg. See changig
slactronlc davices 385
amail

adding attachmants o 137
adding signaturas to 146
addrassing 136, 141, 142

craating mesting requasts and 246

craating meassagas for 136-137
dafating 145, 148, 149, 150
dialing from 79

downfoading 135, 149-151, 310

antaning contact info and 141, 239

antaning prionty settings for 137
forwarding 145

gatiing from corporata servers 341, 367

making phoneg calls and 86
racaidng 138-139, 150

recaiding attachmants with 139-140, 152

raplidng o 144, 148

saving 137

saarching 143

salacting finks in 144

sending 124, 137, 180, 151, 174
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satting outgoing mall options for 134-135
synchvonizing 138, 167
troublaeshooting 366-370
amall accounts
custonizing 135, 147-149
dafating 135
safecting 136, 147
satting up 126, 130, 132
troublashooting 368
amail goplications 124, 164
amall button 26, 130
amalil client soffware 370
amail formats 139, 151
amail providars 130, 132
E-maif Setup soresn 130, 132, 180
amall shortcuts 145
amargancy phone calls 328, 330, 384
amolicons 158, 168
Enable Auto Corract option 327
Enabla ClaarTvpe check box 322
ancoding 177
ancryption 174, 190, 193
End Confarance softkay 90
End Show command 271
Enroll tab 195
Enter Bnall Address screan 308
antaring
Fis 331
Erase all data? prompt 351
arasing Ses defating
ayor massagas 321
Error Reporting faature 336
Error Reporting scresn 337

410

arrors 336, 356
EVDO network jeon 357
EYDO tachnology 378
avent jcons 249
Evant options 321
avents
categorizing 248
craating 244
dafeting 248
disabling notifications for 321
filtaring 248
marking as sansfive 247
setting reminders for 245, 249
Evants chaeck box 321
Excal Mobile application 272-264
See afso spreadshasts
Excef Mobile icon 276
Exchange ActiveSyne 138
Exchange Addrass Books 363
Exchangsa Sanvar accounts 126-129
Exchangea sanver credentials scraan 367
Exchange server option 133
Exchangsa Senvers
accassing address books for 141, 241
sanding email ovar 133, 138, 141
safting up accounts for 308-310
synchronizing with 43, 129, 308, 310
troublashooting 363, 366, 367
axclamation point () battary icon 31
axpansion card sfot 26, 302
axpansion cards
adding 301
formatting 301
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inserting 302 fila typas

instafing applications onto 299 documeants 263, 270

moving applications to 304 music 226

moving information to 304 picturas and imagas 216

opaning ftams on 302 videos 216

plaving media Mas on 231 files

ramoving 302 adding to playfists 232

ranarming 305 bearming 201

running applications from 374 browsing 295, 305

saving fifes and 269, 283, 303 comprassing and decomprassing 295,

ssarching on 294 298

storing attachmeants on 139, 149 comving 271

storing pictures and videos on 219, 223 delating, caution for 296

transfarring fles to 227, 231, 304 displaying in foldars 269, 283

viewing avallable space on 304, 338 displayving in POF Viewsr 288, 289

vigwing ftams on 305 downfoading 176, 298
axtansions (phona) 92, 103 fraging intermal mamony and 374
Extamal GRS jcon 337 gatiing from corporate seners 341
Extarnal GPS options 337-338 moving 269, 2873, 296
axtamal powsr solrcas 339 opaning 229, 295
Exira Digits softkey 64 ssarching for 294

selecting multiple 296

F , , sending 153, 168
factory saftings, rastoring 234 sorting 295

facton-instalfad applications 300
Seag also bullt-in applications
favorites 44,174, 174-175
Ses also Web pages

storing on axpansion cards 227, 231, 304
synchronizing 2086, 260
viewdng arror infonmation and 336

: filtaring

Favoritas softkey 175 avants 248

features 15, 60, 171 information 240, 281

fialds 57, 62 tasks 251

fila Bxplorar 294, 295-296, 305, 306 Filtars tap 152

file names 265 find/Replace command 266, 282
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finding formats

data in spreadsheats 282 display 323
amall massages 143 document files 263
infornation 294 amalf 139, 151
Sprint Power Vision usamamas 115 madia filas 216, 226
text 266 slide shows 222
firewafis 344, 342, 360, 362 formatting
first-fetter capitalization 328 charts 282
fit to pags option 269 axpansion cards 301
Fit to Screan option 172 paragraphs and fists 267
At to width option 289 passwords 331
S-wiay navigator. Ses 5-way navigator Spreadshedls 272, 279-280
Aash modsa 90 taxt 267, 285
Hash Playar 46 Formatting toolbar 268
Hash softkey 91 formulas (spreqdshasats) 273, 277, 264
folders forums 15
accassing Cutfook 363 Forward command 145, 160
browsing 295, 305 forwarding
copying ftams in 271 amail 145
craating 269 phona calls 88
displiaving contents 269, 283 text messagas 160
instaliing synchronization software and 49 fornwarding codas (phong) 88
moving itams in 269, 283 296 fraging mamorny 300, 374
organizing Web favoritas in 175 Fresre Panas command 276
recaiving emal and 138 fully charged battary jcon 30
saarching 294 functions (spraadshests) 273, 277
sorting contants 296
storing picturas or videos in 212,214, 217, G
gastures 326

synchronizing and 363

fortt atibutes 264, 267, 279 gstling started 14, 36, 39, 60
fonts 264, 273 Gewr?g Started CD 23, 46, 297

forgetting passwords 331, 332 Global Address Lists (GAL) 378
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See also onfing addrass books
Global Addrass Lookup 294
Global Positioning Systam, Sas GRS davices
GPS devicas 337-338
GPS hardware port options 337
GPS navigation systam 185
GPS Settings screan 337
graphics programs 221

H

HAC sattings 105

hands-free davicas
compatibiity with 196
connacting to 196
disabiing touch-sansitivity for 329
making phone calls and 95, 97
troublashooting 358

hanging indants 268

hanging up phons 69

hard resets 350-351

Hardwara buttons chack box 321

headsat adaptars 97

headsst button 96

headsats 95-08, 196, 226, 359

Hearing Aid Compatibility (HAC)

raquirameants 387

halp 15,348, 374

Hidling
appoinimants 247
magas oh Wab pagas 173
ftams on Today screan 319
spead-dial butions 78, 93
spreadshadt slamants 280

Index

Tasks antry bar 252
Rghlighting

altamnats characters 66

ftams in fists 62

ftams on screen 57, 58

menu ftams 60, 61

multiple flas 295

text 69, 267

Web favortas 175
highspead connections 116, 341
hints (passwords) 332
History comimand 177
History fist 177, 178
Hold softkay 86
home focations 333
Home Page option 177
Hotmall 165, 167
hotspots 379
HotSync cabla See USE sync cable
HTML meassagas 139, 144
ATV option 151
hvparlinks 286, 267

See afso URLs: Web finks

|
lcons Sea speaciiic iocon or bution
Ignora commimand 62
fgnore with taxd massage command G2
S sarver option 195
N finstant massagas) 186, 164, 168
image fitas 206, 216

Ses also meadia files
Imagas 141, 176, 371, 374
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See giso picturas
MAP accounts 130, 132, 138, 140
fnbox 159, 161
Inbox application 130, 132, 136, 147
Inbox button 25,130
Inbox folders 138
Inbow status fiald 73
indanted lists 264
ndanting text 268
indicator ight 24, 30
information
accessing 40
backing up 52, 350, 360
baaming 200, 201
draining battary and 32
antaring 63, 64-66, 173, 326, 332
filtaring 240, 281
finding 294
fosing 350
moving 304
protecting 40, 328, 331
recaiving beamad 202
rastoring 360
saving 303
saarching for 294
sharing 300-301
sorting 260
storing 301, 374
synchvonizing 41, 126, 307
transfarring from previous devices 348
updating 41, 307
nfrared port 26, 313
infrared ransmissions 200-202, 313, 378

414

infraredtanabled davicas 26
Input mathod options 326
nput Mathod tab 326
Input Settings screan 326-328
Insart Picture command 266
nsart Recording comimand 266
instaflation, troublashooting 350, 373
instafing
applications 296-299, 373
Outfook 43
synchronizatfon soffware 42, 43, 48, 47
VPN clients 342
instant massages 156, 164, 168, 373
interfarance 200, 388
internal mamony 300, 338, 374
international dialing prefives 102
intarnational traval adapters 344
Intermat 116, 171, 341
Intarnat Connection Spead option 233
Internat connactions
adding 341
detacting spead of 233
ahding 343
faunching 117, 341
making phonse calls and 116, 168
opaning 69,172
safting up 116-119, 341
troublashooting 357
turning off massages for 104
ntarnat e-maill oplion 133
Internat Explorar 69, 172
Intarnat Explorer Mobile 171-178, 341, 371
Internat information Servar (I5) 195

fndex



Intarnat Massage Acceass Protocol See MAP
Intarnat sanvice providers Sae I5Ps
ntarnat Shaning feature 116
Intarnat Sharing jcon 117
nvitatfons, See maesting raguiasts
IR port Ses infrared port
[SP sattings 341
fSPs 130, 132, 341
ftams on screan
accidentally activating 329
displaving 247
Hghlighting &7, 58
moving through 57
opaning shortcut manus for 61
safecting or activating 59, 62
ftams tab 319

4
Heap copias of sent itans. .. chack box 137
Fay indax (natworks) 193
Kay indax settihg 193
Fayboard
accassing atermnate charactars on 65
customizing 326-328
atafing from 76,77, 79
antaning information with 63, 64-66, 328
avtaring passwords and 332
instafiing third-pany goplications and 373
focking 329
scroffing with 57
salecting meanu ftans from 61
sanding anaifand 145
satting key combinations for 324

Index

keyboard backiight B3
Favboard saltings 326-328
Favboard specifications 397
Kayquard 328, 329

Kayguard Sattings screen 329

L
LANS Seefocaf area networks
larga filas 374
Larga/Small keys option 327
feading zeros 323
LED fight 24, 30
Lagacy Pockat Word filas 263
fens fcamara) 26
Lattar Racognizar option 326
fibranes fmedia) 231, 232
Library command 229, 230
Library scrasn 229, 230, 234
Library tab 234
fghtning bofticon 30
[ Hon tachnology 378
See also battary
finas moving to baginning and and of 58
finking to madia libranas 231
finks. Ses Web finks
st saparators 323
Listen softkay 83
fists
closing G2
craating 268, 286
displaying 263, 264
formatting 267
Highlighting ftams in 57, 59, 62
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scrofiing through 57
salacting ftams in 62
Live Mail 165167
Live Massanger 167
Liva Segrch 164
Live Search bar 166
Live Search fiald 73, 179
Liva Search jcon 164
foca) area networks 341
focating
amail massages 143
infonrmation 294
Sprint Power Vision usernames 115
Location Privacy icon 104
Location Privacy options 104, 182, 184, 185
focation-spacific information 333, 337
fock codas 36, 328, 330
Lockjoon 172
focking
spreadshadt rows and columns 276
the kevboard 329
Treo 328, 330
logaing in to corporate savars 3441
Lookup featura 77, 294
Loop continuously option 272
losing
inforrmation 350
passwords 331, 332
Trao 52,332
fow coverage araas 356
fow fight condiions 63
fowsrcass fattars 64

418

hl
magnat 27
magnification. Saa zoom sattihgs
Make this davice discovarable option 199
Manage adsting conhactions option 341,
342, 358
Manage Folders command 138
Manage GPS automatically chack box 338
Manage tab 321
maps 184, 185, 240, 337, 371
Maps goplication 182-184, 240
marging 268
Match case chack box 266, 262
Match entire calls check box 262
Match whole words only check box 266
maasuranant units 323
meadia e tvpas 226
media flas
adding to plavlists 232
craating playlists for 232
fnking to 231
moving to axpanston cards 231
opating 229
plaving 226, 229, 233
synchronizing 44, 206-208, 227
transfaring to Trao 227
troublashooting 364
updating 231
vigwing information about 232
media fibrarias 231, 232
Madia Playar 226
Madia Plavar Mobila 44, 215, 226-234
meadia plavers 31
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mesting invitations Ses mesating requasts

masting raguasts 141, 182, 246, 249
mamony buttons (calculator) 257
Memory Sattings screan 338, 340, 353
Mamontab 178
maEmony usage 338
mamory, fraaing 300, 374
mamos. Ses messagas; notes
mant tams, sdlecting 60, 61
Meanu softkey 60
menus 60
Manus Settings screan 324
Meassage downfoad fimit option 151
Massage format option 151
Massage icon 83
Message Options command 137, 159
Massage Cptions scrasn 169
Massage Pricrity option 159
massagas
Seo also taxt massagas; voice notes
craating emall 136-137
filtaring 143 152
invalid characters in 158
recaiving amall 138-139, 150, 310
retriaving voicamall 53, 84
saving 137
searching amnall 143

sanding to multiple recipiants 137, 158,

169
Massages tabh 163
Meassaging application 157, 163
massaging applications 373
Massaging fcon 157

Index

massaging options 156
meassaging sanices 379
Massaging status fald 73
microphona 25, 86, 223, 375
microphons fcon 326
microsh) expansion cards 301
See afso expansion cards

microSDHC axpansion cards 301
Microsolt ActivaSyne. Ses ActiveSvne
Microsoft applications. Ses spacific

apnlication

Microsolt oparating systams Ses Windows

Microsoft Systam Ceanter Mobile Device

Manager 343,354, 357, 358, 359, 361, 366,

369 371,372
microllSE connactor 26
microwavas 200
miror 26, 213
Missed Call fcon 83
Mobila Broadband Matwork 378
Mobile Device Cantar 47, 49
Mobile Davice fofdar 271, 299
Mobila Favontes foldar 44, 174
Mobile to Market cartificates 297
modal numbars 394
Modam tab 341
modams 116, 379
Modify Shaats command 280, 284
monftoring phona status 107
Month view (cafendar) 242
most racently diafed numbers fist 80
mouthplace 26
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moving spesddial buttons 92

filas 269 283 296 Web favoritas 175
information 304 wiorkbooks 275, 283
media filas 231 wiorkshests 279
piciures or Videns 218 navigating in FOF files 289
spead-dial butions 94 navigating the screan 56-57
text 266 navigating through Web pagas 173
workbooks 283 navigator buttons 56, 59
moving around the screen 56-57 navigatorn Sas Sway havigator
moving through PDF filas 289 negative numbears 323
moving through Wab pagas 173 natwork connactions
multimeadia files, Sas media files custormizing W-A 194
multiphone accounts 40 raceiing emall and 134
multinle recipiants 137, 158, 169 satting up WL 190-193
music 82, 100, 227, 229, 230 troubleshooting 356-359
music filas 206, 226 Metwork key satting 193
Ses also madia filas natwork kays 193
Mute button 66 MNetwork name option 192
My Davica foldar 295 natwork protocols 233
My Davice fibrany 231 Metwork Sdlaction optons 106
My Documeants foldar 294 MNetwork tab 233
My Picturas folder 212, 214 natworks 105, 194, 334
My Plaviists category 232 Mew Appointmant command 243
My Taxt cormimand 137 MNew Sound commandg 100, 321
My Tesdt phyases 137, 157, 1568 Mew Spead Diaf command 92
My Windows Mobila-Basad Davice fcon 299 Mew Task command 2580
My Treod00 foldar 49 No Sarvice massage 107

nonwiralass fegtures See organizer fagtures

N Normal satting 247
nameas. Saa Usamamas notashool; 285
naming notas

document filas 265, 267, 269
picturas orvideos 221, 223

Ses also voica notes
adding pictures to 266
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adding tasks and 251
craaling 262, 264, 285
defating 255, 287
aisplaying 266
antaring contacts and 239
organizing 255
renaming 287
saving 265, 256
sorting 267
Motes application 262-256
Motes jcon 253
Motes list 255
notification options 159
Motification tab 163
notifications
accassing Web pages and 178
answaring phone calls and 89
beaming and 202
Blustooth devices and 199
closing 159
dfsplaving 321
praviawing sounds for 321
recaiving massagas and 159, 163
retrigving volcamall and 83
safecting 320
satting ringtonas for 99-100
troublashooting 358
turning off alarms for 321
Motifications chack box 321
Motifications tab 99, 321
Mow Playing playiist 232
Ses also playlists
numbear pad 76

Index

number sign symbol 323
Murmbear tab 323
numbered lists 268, 286
numbers
Ses also phons numbers
copving 257
antaning B, 256, 275
formatting 273, 279, 323

0]
Off Hold softkay 66
Offfce filas 260-262
See also spaciic Office application
offiina synchron/zation 3673 364
OF putton 25
On battery powsar option 35
On Bution Prass option 194
Onalote Mobile application 285-287
Onahote Mobis jcon 285
onfing addrass books
adding 141, 141-143
focating contacts and 148, 241
synchronizing with 363
online sanvices 114, 115
onfing support 15
Opan a vparlink option 267
oban atthantication 192
Opean Afe command 229
opan networks 168, 190
Opan URL command 230
opaning
applications 69, 70, 302
attachments 139
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Call Log &0
Digd Pad 79, 80
document files 265
document tamplates 265
File Explorar 295
files 229, 295
Internat Explorar 69, 172
mesating raquasts 163
Mobife Device Canter 49
FOF fifas 288
Quifck Tour 15
shortcut menus 61
spreadshest tamplatas 275
sync software 48, 49
text messages 159, 160
Today screen 72, 76
Wb finks 287
Windows Mobile Device Center 380
operating systam [devica) 3485, 379, 396
oparating systams (FCs) 46
Operator Sanvicas (Spant) 17
optimizing powsr seftings 338
Option kay 25, &7, 65
Option Lock 65
options B1, 62, 247
Options scresan
ActivaSyne 314
Cafendar 244
Input Sattings 327
Internat Explorer 177
Meassaging 163
Motes 256
Pictures & Videos 222

420

Tasks application 252
Windows Media 233

organizer featuras 31, 34

orfentation (slidas) 271

Orfentation tap 271

OTA (Tasks Ovar the Alr) feature 250

Outbox 161

outgoing mall options 134-135

Outiook
accassing folders for 363
copving addrassas to 363
dafeting amall accounts for 135
downfoading attachments and 140
downioading thiaf varsion of 23
antaning appointments and 243, 247
antaning contacts in 238
instaling 43
retrigving messages and 125, 138
setting up client software for 370
synchronizing with 43, 143, 308
troublashooting 348

ovardue tasks 251

ownar information 332, 333, 394

Owiner information screen 333

p

Palrm onfina support 15

Paim OS devices 348
paragraph formatting 267
partisl anvalopa jcon 139
partialy chargad battary fcon 31
partnarships 198, 379

pass codas 39
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passkays 197 POF filas 288 269

Password Sattihgs soreen 331 POF Viswar 288-290
Passwiord type options 331 POF Viawer icon 288
passwords parformance 339, 353
accessing corporate accounts and 309 parsonal computars See PCs
accessing volcamall and 39, 83, 64 parsonal identification numbers (FINs) 331
changing 40 parsonal information 40, 331, 332, 333
connacting to WA networks and 188, parsonal information managaers 44, 363, 379
191, 195 Parsonal setting 247
creating 40 phone
diafing phona numbars and 92 Ses also phone calls; Trao
displaving spreadshests and 273 adiusting volume for 37, 100
antaring B5, 332 anawaring 81, 89, 95
forgatting 331, 332 connacting to ntameat and 116, 188
formatting 331 diafing 76-81, 89, 103
requiring 328 disabling touch-sensitive faature for 328
sahding amaifand 127, 130, 132, 134 ahabling as modam 116
unfocking Treo and 331 gatiing forvarding codas for 68
Faste command 177 getting startad with 36
patchas 300 hanging up 89
pausing maximizing battary and 32
madia playback 233 moniftoring status of 107
video racording 215 oparating while driving 385
FCs ovarview 76, 86
connacting Treo fo 50-51 roaming and 105-107
copving files from 271 running appliications and 86
finding synchronized fles on 207 sanding of recalving text massages
installing applications from 295 and 158
ratrisving amall from 138, 140 saiting ringlonas for 99-100
safting up Blustooth devices for 199 Sifencing ringer for 62
satting up Intemnat Sharing on 116-119 troublashooting 358, 359, 375, 388
synchronizing with 42, 46-49, 50, 313, turning off and on 34, 35, 82
318 wiaking up screan for 65
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Phona as Modam feature 116, 379
phons calls

answering a second 69
bBlocking 104

anding 87, 89

forwarding 68

getting assistance with 16
ignoring 82

making T6-51, 85, 89, 98, 160
placing on hold 86

plaving music and 82
receding 81-62, 85, 686, 90
satting up confarance 88, 90, 91
transfarring to handsats 98
transfarring to volcamall 39, 62

Fhone diafog box 79

selecting 79, 144
Phona OFf messags 107, 379
phone sattings 99, 101, 102, 104
Phone Sattings screan 330
phone spacifications 396
Phone tab 101
Phona/Talk button 24,72
phone-off icon 35
photos, Saa pictures
Picsal POF Viewser 286-290
picture buttons 92
picture filas 206, 216

See afso media files
picture formats 212, 222
piciure rasoittion 212,213
picturas

phona headsats 95-98, 196, 359

Fhone Lock feature 328, 330

phone numbears
adding 102
assigning prefix to 102
assigning to speedtdial buttons 91-94
checking 37
copving 79, 81
antaring from Diaf Pad 81
antaring from kavboard 76, 77,79
antaning special charactars in 64, 92
getting from onfine address books 142
Nding spaad-dial buttons for 78, 93
hghlighting 59
including pausas in 92
redialiing most racant 80
saving 67
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adding to contact 220
adiusting contrast 220
assigning to contacts 101
craating caller ID 238
daleting 221
downfoading 176

adiing 220, 221

Hiding on Web pages 173
naming groups of 223
organizing 218
pravigwing 213, 372
rangming 221

rotating 220, 222

saving 223

sending 168, 218, 222
salting as backgrounds 219, 318
safting default size 223
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sorting 219

synchwonizing 44, 207, 208
taking 212-214, 286, 371
troublashooting 372
undoing changas to 220
vigwing 216, 287

Ficturas & Videos application 212,214, 220,

2oz
Piis 44, 363, 379
Fitds 331
Plain Taxt option 151
Play Slide Show command 217
Flay softkey 229
Play sound chack box 321
plavback
anding 230
pausing and resuming 233
plavback controfs 229, 234
Flayback screan 233
Playback tab 233 271
plaving
meadia files 226, 229, 233
PowsarPoint presantations 271
sounds 321
video clips 216, 229, 230
vojce notas 254, 287
voicamal meassages 64
playlist controls 232
plaviists 228, 230, 232
plug-ing 171,319
Pockat Outlook See inbox application
Foint of Intarast field 182, 183
Point of intarast lookup figld 72

Index

FOP accounts 130, 132, 138
ports 26, 51, 337, 362
Post Office Protocol See POP accounts
power adaptar 344
Powar Save mods 194
Power Seftings scresen 338
Power Vsion sandcas 114-115, 116
powaraudio adgaptar 344
Power/End button 25
PowearPoint Mobile application 270-272
PowsarPoint Mobiis jcon 271
precautions 384, 393
pradefined text phrases 137, 157, 1568
prefarancas, setfiing. Ses customizing
prefives (phona numbears) 102
Framium Sanvices 40
presantations 270, 271
previswing

picturas 213, 372

rngtonas 100

sounds 321

videos 215
prionty satiings 137, 189, 2560
Privacy mods 159, 163
privacy seftings 104, 247
procassor 396
Prograrm Buttons tab 324
Program Filas folder 304
Frograms chack box 321
Programms foldar 70
Programs meanu 325
programs See applications; software
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protecting
information 328, 331
Treo 328-333
protacting parsonal information 40
proxy sanvers 342
punctugtion marks 65
Furge command 162
Purge screan 162
Purge softkay 162

Q

Quality command 215
Quick Keys 78, 93
Quick Tour 15
QuickTime Playar 214

R
radio 396
radhio fraguancy (RF) sighals 385, 390
RAS connections 341
Racaive all incoming beams chack box 199
Racaiving Data massaga 202
rechargeabia battary, Sse battary
raciplants, sending fo muitiple 137, 158 169
Racord button action option 256
racording
rngtonas 100
sounds 321
videos 214-215
voice notes 253, 286, 327
Racording lcon 254
recording toolbar 254
racuring appointmants. Ses rapeating
appoihtnants

424

redialing 80
redirectors (Wab sitas) 371
Region tab 323
Ragional Sattings screan 323
reguiatory numbars 394
reminders
adding to avants 245,249
assighing to tasks 250, 252
repeating 321
setting alarms for 335
turning off 321
ramote accass saver 341
Ramove Programs jcon 300
Ramove Programs screan 300
Ramove Splt command 276
ramowing
Ses also dafating
Pattary door 28, 351
axpansion cards 302
ftams from plavlists 232
Rename command 305
FRanamaMove command 269, 283, 304
renarming
axpansion cards 305
notas 255, 287
piciuras or videos 221
Word documants 269
wiorkbooks 263
wiorkshests 280
Repaat chack box 321
Rapeaat command 230
rapeating appointmants 244
repeating currant song 229
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rapeating ramindars 321
rapeating tasks 250
Replace All option 266, 283
raplacemeant stylus 344
raplacing
dgata in spreadsheats 282
davice battary 29, 344, 351
text 266, 327
Feply All command 144, 160
Faply command 144, 160
Reply softkay 144
Raquira S5 for hcoming exmall chack
box 134
Raquira 551 for Outgoing e-mal chack
box 134
rasatting Treo 349-351
rasizing
POF files 289
spreadshest elamants 260
text 172, 322, 328
resofution 212, 214, 299, 396
rasofution (screan) 355
Fasofution command 213
rastoring
factory saftings 234
infornation 350
sounds 320
Today screen saftings 367
rasuming madia plavback 233
Figtrizve Cartificate button 195
ravarse type highlight 59
Reviaw all download sattings option 131, 135
rghi-click manus 61

Index

ring tone managers 373
Ring tone options 100
Ring tvpe options 100
Ringar switch 27, 35, 320
mngar voltme 101
rmngar, silencing &2
ringtone (Ds 101
rngtonas
assigning to contacts 92, 101, 239
downfoading 99, 176
pravigwing 100
recording 100
selfecting 99-100
Sifancing 319
roaming 99, 105-107, 311, 366
Roaming fcon 106
Roaming massags 107
roaming preferences 106
Rotate softkay 220
rotating picturas 220,222

]

safaly guidalines 383 384, 385
Save As comimand 267

Save finks... option 176

Save password chack box 127, 130, 132,

309
Save to Contact command 220
Sava to fist 303
saving
amall messagas 137
nformation 303
notas 265, 256
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phone numbers 67

piciures and Widaos 223

voice notaes 327

Word documeants 263, 267, 270

workbooks 272, 276, 284
Scan option 195
Schadulz command 310
Schadule screan 310
schedulas 242, 248

Ses also calandar

schaguling synchroniZation 129, 310-311,

366
scresn
activating ftams on 59
adiusting brightnass 322
alfgning 323
caring for 25
changing color thameas for 318
closing currant 58
disabiing touch-sensitivity for 328, 329
maximizing battary and 32
moving around on 56-57
salacting ftams on 59
troublashooting 355
turning off 34, 339
vigwing Web pagesand 172
wafing up 34, 85
scraan backlight 64, 339, 355
sorean resolution 299, 355
Screan Savertab 339
screan savars 35, 222, 322,339
Scrash Saftings scragn 322, 323
Screan taps check box 321

428

scraens retuming to pravious 58
scroff arrows 57
scroff bars 57
scroffing 57, 247, 328
50 cards. Sea axpansion cards
Search for ist 295
Search fcon 294
saarch resufts 179, 294
Search screen 294
saarching
doctmeants 266
amall messages 143
axpansion cards 294
My Documants foldar 294
Spreadshedls 282
Webh pagas 164, 172, 179
sacure natworks 188, 189
secure Web asites 172, 174,178, 371
sacurity 328-333, 335, 341
sacunity cartificates 174
sactnty settings (famall) 147
sacurity soffware 328
Security tab 178, 330
Salact Al Taxt command 177
safections cancaling B0, 62
saffportraft mirror 26, 213
Send Sound command 100, 322
Send... command 198, 201
sending 198, 201
attachments 153
copyrighted ftams 218
amall 124, 137,150, 1561, 174
masting requasts 246, 249
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picturas orvideos 218, 222
sounds 322
text messagas 4z, 158
Wb finks 173
Sensitivity options 247, 261
Sent folder 148
separators 323
sanal numbears 394
Sarvers, roublashooting 366, 367
sanvica plans 23, 114, 188
See glso accounts
Sarvices tab 104, 105, 106
Sat as Today Background command 219
saltings Sze options
Setup Exmall option 130, 132
shared authantication 192
sharing information 300-301
Shest command 276
Shests st 276, 280
Short Messaging Sendca See SMS
Messaging
shortcut fcons 71
shortcut manus 61
shortotis (amall) 145
Show alphabstical indax option 241
Show contact nameas only option 241
Show fist 216, 217, 219
Show Options command 271
Show timea stamps of sach massage
option 163
Show voice mail buttons option 93
Show without animation option 272
Show without media option 272

Index

Show without slide transition option 272
Shutfe command 230
Shutfla/Repeat command 229
Side button 24, 256
signal strength 108, 356
signakstrength icon 35, 340
signaturas 146, 163
Signaturas screen 1468, 163
sifancing ringer 62
sifencing systam sounds 319
sifent alarm 320, 321
single carrier radio tranamission 357
Skinstab 234
Skip Pass Code option 39
Slide Show tab 222
siide show toolbar 217
slide shows 217,222, 270, 272
side tmings setting 272
siider 57
anat davica Saes Trao
SIS messaging 156, 379
SMTP sarvars 134, 369
soft resats 349
softfays 24, 25,59
software 23, 206, 350, 353, 395
Ses also gpplications
Software Store 297
songs Seamusic
Sort by fist 280, 295
Sort command 162, 280
sorfing
filas 295
History dist ftams 177
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infornation 280
notas 256, 287
pictures o videns 219
tasks 251
sound effects (slides) 272
Sound On and Off fcons 320
sounds 100, 319, 320, 321, 335
Sounds & Notifications icon 99
Sounds & Notfications screen 99, 321
Sounds tab 321
speakar 26
Speakarphone button 66
Speakarphona mode 375
spacial charactars 65
specifications 396
Spead Disf Options command 94
spead-dial buttons 78, 91-94
Spall Check command 137
spall checking 137, 268
Spalling command 268
Split command 276
spreadshest templatas 272, 275, 284
Spraadshadt toolbar 276
Spreadshedts
See also workbooks
adding charts to 273, 281, 282
changing 272
creating 272
displaving 274
antaning data in 274, 278
aentaning fommulas in 273 277, 284
antaring funclions in 273, 277
filtering information i 2861

428

formatting 272, 279-280
organizing workbools in 283
protecting 273
searching 282
sorting information in 280
Sprint TxRTT natworks 379
Sprint Accassory Hotline 344
Sprint Customear Senvica 15, 36
Sprint National Matwork 116
Sprint Mavigation fcon 185
Sprint Navigation sanvice 185, 240
Sprint Opearator Sanices 17
Sprint Powsr Visfon accounts. Sas accounts
Sprint Power Vision home page 177
Sprint Power Vision sarvices 114-115, 116,
171
Sprint Pramium Sandcas 40
Sprint Software Store 297
Sprite Backup utility 52
58i0s 192, 373
standby mode (cameara) 213
Start button 24
Start menu 70, 324, 325
starting
Calendar application 242
chat sessions 160, 163
Contacts appliication 238
Excal Mobite 276
Intarnat Explorer B9, 172
Media Flayer Mobile 229
Onallotae Mobile 285
Picturas & Videos goplication 212,214
FowerPoint Mobile 271
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synchronization 48, 50, 311 synchronization

Tasks gpplication 250 battary fife and 31
Word Mobile 265 Blustooth devices and 199, 312-313
static 392 computars and 42, 46-49, 50, 313, 315
status fcons (phong) 107 dafinad 379
Stareo adapters 97 Exchange sanvers and 43, 129, 308 310
stareo headsats 97, 226 freging meamory for 366
Sl image comprassion faval option 223 nfrared connections and 202, 313
St Mode command 212 media files and 206-208, 227
Stop command 230 Office filas and 260-262
stopping media playback 230 ohling addrass books and 143
stopping synchronization 3156 overviaw 41, 43 307
Storage Card foldar 299 starting 48, 50, 311
Storage Card library 231 stopping 315
Storage Card setting 303 thira-party applications and 44
Storage tab 149 troublashooting 342, 349, 360-367
storing Windows [iva senvicaes and 166, 167
applications 374 wiralass connactions and 125, 196, 308,
document fifes 267, 263, 270 310,311,313
information 301, 374 synchronization fcons 52
spreadshadt files 2683 synchronization software
Trao 25 instaliing 42, 43, 46, 47
shvlug 27, 344 opaning 48, 49
subloldars 138 receiing amall and 138
Symbol command 275 raceiing infrared beams and 313
symbols 65, 158 troublashooting 348, 360, 367
sync cabla &1 turning on Bluatooth for 312
sync confficts 310 systam errors 356
Svne featura 42, 45, 379 systam focks 328, 331
sync schegulas 129, 310-311, 366 systam requiraments (davice) 398
sync sattings 48, 310, 314, 334 systam requirameants (FCs) 46
Syne softkey 311 Systam saftings 333-339

system sounds 319-322

Index 429
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systam warmings 321

T
tabs sefacting &7
Take Ficture command 266
taking picturas 212-214, 286, 371
tapping 27, 56, 59, 321, 326, 355
Task Managar 25
tasks
adding 250
dalating 252
displaving 251, 252
marking as complatad 251
organizing 251
priortizing 250
satting remindars for 250, 252
Tasks gpplication 250-252
Tasks entry bar 251, 252
Tasks jcon 250
Tasks list 251
Tasks Ovar the Alr (OTA) feature 250
technical stipport 348, 374
tarnpiatas
notes and 254, 256
spreadshedls 272, 275, 264
Word documents 263, 265, 270
tantativa apbointmants 244
taxt
alfgning 268, 272
copving and pasting 176, 266
corracting 137, 268, 327
dalating 59
antaring BA-B6, 326, 327
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finding and replacing 266, 327
formatting 267, 285
Highlighting 59, 267

indanting 268

resizing 172,322, 328
ssarching for 143, 164, 294

wiorchprocessing featuras for 263, 264

text buttons 92
text figfds 57
text filas 336
text massages
adding signaturas to 163
addrassing 157
craating 167
defeting 162, 163
diafing from 79
displaying 159, 160
antaning contact info and 239
forwarding 160
making phone calls and 86
recaiding 158, 169
raplying to 160
salacting iinks in 161
sanding 82, 156
setting massaging options for 158
saiting notification options for 159
sorting 162
troublashooting 358
viewing status of 161
text messaging options 156
text messaging savices 379
text phrases 137, 167, 168
Text Sizetab 322
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thamas 318
thira-panty applications
S-way havigator and 56, 373
accassing Outlook foldars and 363
backing up information and 350
compatibility with 296, 299, 349
freging internal mamory and 374
gatting halp with 299, 374
fosing 350
purchasing 299
running 358
synchronizing with 44
taking pictures and 372
troublashooting 373-374
thira-party phone calls 17
throughput 168
Thurmbnails button 215
time 333, 334
time formats 323
Time Himit for videos option 223
time slots (calandar) 247, 249
Timatab 323
tima zonas 333, 334
timer 213
Timer command 213
THIP ancryption 193
Today scraan
accassing 76
adding spead-dial buttons to 92, 94
adding Wingows Live senices fo 166
changing color thames for 318
customnizing 318
displiaving maps on 240

Index

featuras describad 72-T3
ratrigving volcamal from 83
searching Web pages from 179

selecting points of intarest on 182, 183

saiting backgrounds for 219

troublashooting 367

vigwing active calls on B85, 86, 89

viewing taxt massages on 160
Today Sattings screen 318, 319
tonas Ses ringtones; sounds
touchscraan. Sas scraen
touchscrasn fockout 328, 329
touch-sansitive faature 328, 329
transfering information, caution for 348
transition affacts (siidas) 272
Transparancy favel options 219
travel adaptars 344
Treo

activating 23, 36

charging 28, 30

compatibiity with thirdbparty vendors 296,

249, 349
componants on 24-27
componants shipped with 22
connecting to PCs 42, 50-51
disabling touch-sansitivity for 328
freaing space on 300, 374
getting help with 15

instaling thirdbparty applications and 373

focking 328, 330
fosing 52, 332

not rasponding 373
operating 384, 385

431

Xopuj



protecting information on 328-333

rasatting 349-351

satting up service for 33

storing 25

transfarring media flas to 227

troublashooting 348

turning off and on 34

uniocking 330, 331
troublashooting 348
Tum on Blustooth chack box 197, 312
turning off screan 34, 339
turning off systam sounds 319
Typing mods 256

U
unauthonzed usars 39, 330, 335
unavallable time sfots 247
Unfreaza Panas command 276
Lnfocking

spreadshadt elanants 276

Treo 330, 331
unread massages 161
untimad evants 244
Update Lbrary command 231
Lipdating

information 41, 307

meadia fles 231

oparating systam 348
Upparcass lattars 64, 328
URLs 144, 230, 270

Ses also Web finks
USE connections 50
USE connactor 26
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USA hubs 51, 362

USE ports 51, 362

USH sync cable 51, 344

Use slide timings. .. option 272
usar discussion groups 15
ussmames 115 134, 379

i
vlal attachimants 370
viard attachmants 370
vahicla powsr adaptar 344
Vibrate whean. .. chack boxas 100, 321
vibrating afanm 320, 321
Video command 215
video filzs 206, 216, 226, 227
See afso media files
vidso formats 214
video resolution 214, 215
video seftings 233
Vidao tab 223, 233
Vidaos
adding sounds to 223
adgiusting volume for 100
delating 221
aditing 221
fmiting fength of 223
organizing 218
pravigming 215
racording 214-215
ranaming 221
raplaving 229
saving 223
salacting 230
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sanding 218
sorting 219
synchronizing 44, 207, 208
vigwing 216, 230
View picture detall option 287
View Recording Toolbar command 254
vigwing
active active cafls 55, 86, 89
appointmeants 242
available applications 70
cafendar 242
contacts 77, 239
diagnostic information 336
documeants 263, 264, 276
amall massages 139
ftamns in foldars 269, 2683
maps 184, 185, 240, 337, 371
manory usage 338
menus B0
notas 286
notifications 321
organizar features 34
POF filas 288, 289
pictures 216, 267
playlists 232
powar saftings 338
Space on Sxpansion cards 338
spead-diaf buttons 78
Spreadshadts 274
tasks 251, 252
text massagas 159, 160
videos 216, 230
Web favorttes 175

Index

Wab pagas 172

virtual private networks Sas VEN connactions

Virtual Saertal Port profile 199
Yolce Command button 325
volce commands 325
volce notes 168, 253, 286, 287, 327
vojce quality 375
voica recording formats 327
vojcamail
accessing 39, 84
ratrisving 83 84
sanding calls to 62
satting ringtonas for 100
safting up 39, 83
troublashooting 102
volcamal buttons 84, 93
Volcamasl icon 83, 84, 85
Yolcamall Pass Code option 39
Yolume button 24
volumes adiusting 37, 100
VPN clients 342, 360
VPN connactions
adding 342
downfoading attachmants ang 140
raceiing emall and 124, 130
Safting up 341-342
VPN software 124

Wy
waking up sorean 34, 85
Vil whan changing ... option 178

Virn whan page contant is blockad ..

option 178
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wirnings 521
weak signals 356
Wb browsing 86,171,172, 174, 343
Weh favoritas 44, 174, 174-175
Wb flinks
craating 266
freging internal mamory and 374
Rghlighting &8
opening 2687
organizing 175
salacting 144
sanding 173
Wab pagas
accassing 171,172, 188
bookmarking 174
copying from 176
dfaling from 79
dgownfoading ftams from 176, 298
antaring information on 173, 371
fitting to scrasn 172
Hding images on 173
navigating through 173
plaving madia flas from 230
raturmning to recently viewed 174, 177
searching 164, 172, 179
sahding amall from 174
satting as home 177
troublashooting 370-371
vigwing 172
Web search fighd 172
Wab sites See ntarnat; Web pages
Waal view (cafendar) 242, 248
WEP ancryption 190, 193
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WA accass points 379
WA button 27, 189
WA connections
adding 191
custornizing 194
disconnecting 194
making phons calls and 86
maximizing battary and 32
Safting up 190-193
vigwing information about 135
WHH feature 188, 189, 194
WA feor 190
VA network fcon 357
WA networks 188, 194, 379
WIFI Frefs jcon 194
VdF Prafs screen 194
WA routars 200
Windows Live jcon 165, 167
Windows Live sarnvicaes 164
Ses also speciiic program
Windows Live sarvices chack box 166
Windows Media Player Sas Media Player
Mobile
Windows Mobile 299, 336, 348 379
Windows Mobife Davica Cantar 47, 49, 380
Ses also syne softwars
Vidndows Vista computars 47, 208
synchronizing with 262
troublashooting sync problams 3658
Vidndows XP computars 46, 206, 207, 260,
348
wired headsats 98
wireless connections 35, 114, 340
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See also VWA conneactions finding and replacing data in 262

wiralass fagturas 31, 340 moving around in 276

Wiraless Manager 340 naming 275, 263

Wiralass Manager jcon 340 ramoving calls, rows, and columns 283

wiralass modems 116 rasizing rows and columns in 280

wiralass networks 188, 341, 356 saving 272, 275, 264

wiraless phonas 200, 385 setting default tamplate for 284

wiralass sanvicas 340 salting display options for 276

wiralass synchronfzation 125, 196, 308, 310, workshaest names 273, 279, 260
311, 313 workshesats 276, 279, 284

WLANS Ses wirdless networks See afso workbooks

Woord Complation tab 327 ViPA authentication options 192

wiord matching 266 Whting mods 256

Word Mobils application 263-270

Ses also documeants i .
Woord Mobila fcon 265 Year view (calendr) 243
word procassing 263, 264 z
word-complation options 327 ZIP filas 295, 295
workbook fist 275, 276, 284 Zoom command 213
workbooks zZoom fcons (camera) 213
Seealso Bxcef Mobile application; Zoom fcons (prasatations) 271
spreadshests zo0m fevel 172
adding calls, rows, and columns to 278 zoom settings
adding range of valuas to 278, 279 input 327
adding workshasats to 279 FOF Viewsr 288
calculfating data in 273, 277 picturas 287
changing ordar of workshests in 279 spreacishests 273, 276
comparing values in 261 Word documents 267

craaling 274, 275
dafating 264
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